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Introduction to Automation Anywhere
Automation Anywhere allows you to create automated tasks with ease. It's intuitive interface provides you the essential features to
record, modify and run tasks that range from simple to more complex ones.
This topic will give you a bird's eye view of Automation Anywhere's 'Client Dashboard'. It also provides the necessary information to direct you to related topics.

Client Dashboard - A Bird's Eye View
As soon as you launch Automation Anywhere, it displays the Getting Started page:

(Image as seen in Enterprise Edition)
Note: You can directly start creating tasks or open recent one's if any.
Upon pressing close, the Client Dashboard is displayed:
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Note: The user interface will vary depending upon the features available with the product.
The Client Dashboard basically comprises of the Menu Bar, Tool Bar, Folder Panel, Task Panel and various Feature Panels. Collectively these allow you to create, record, run and modify your tasks.
1. The Tool Bar (located below the menu bar) is a combination of tool buttons and functions for recording, running and modifying
tasks:

a. Record tasks with different recording methods available on the 'Automate' window.
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b. Record keystrokes as well as mouse clicks and movements.

l

Run the selected task

l

Modify the selected task using the Task Editor.

2. Access the most frequently used functions on the tool bar, such as:
a. Web Recorder
It understands all web controls thus enabling you to record web-only tasks.
b. Object Recorder
It understands all objects and windows controls. Record, manage, run Windows actions in the background and run other programs simultaneously.
c. ROI Calculator
It displays the return on investment (ROI) accrued through use of Automation Anywhere.
Additionally, Automation Anywhere offers features to troubleshoot in the form of 'Search Help', 'Chat' and 'Client Notifications'. *
l

Access the Automation Anywhere online knowledge base with the 'Search Help' feature.

l

Chat with our online Automation Experts with the 'Live Assist' feature.

l

Receive trial status, task failure and external notifications.

* Available from version 7.5 onward.
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The Folders Panel
At the top left is the Folders panel, which lists existing tasks in the Task List panel on its the right. Right click a folder to open, create,
rename or delete that folder:

The Task List Panel
The Task List, which takes up most of the workspace, displays relevant task details in columns such as File Name, Description,
Created At, Duration, Size, Hotkeys (if any) and Status etc.
Tip: Select column view from View > Column Displayed

Located at the top-most right corner of the Task List are buttons that enable you to delete and upload the selected task.
Alternately click the Action drop-down button to carry out task relevant actions such as run, edit, upload*, copy, rename, locate and
send.

The Features Panel
Towards the bottom left are the product specific features:
a. Repository
Communicate with your Server/Control Room to register, upload and download tasks, request access privileges etc.
b. Reports
It provides graphical reports that display the status of tasks and workflows, as well as the ROI over time.
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c. Trigger Manager/Triggers
It provides a unified view of the triggers that are connected to your tasks. Use it to enable or disable selected or all triggers as
well as add, modify and delete specific triggers connected to a task.
d. Schedules
It is a convenient facility to manage automated tasks on time based scheduling capabilities. You can schedule to run the task
daily, weekly, monthly or with a trigger event.
e. Workflows
It helps you build process flow diagrams in a graphical environment. These you can subsequently use to build and run automated tasks in the program.

Panel for Task Relevant Activities
Below the Task Lists is a panel that displays task related Properties, Schedule and Trigger in the form of tabs.
a. Properties
View and set general properties such as allocating priority status or specifics such as frequency/conditions to repeat the selected task, adjusting speed, email notifications, hotkeys, security parameters to ensure authorized users run the task etc.
b. Schedule
Schedule your automated tasks to run at preferred times, without requiring supervision or intervention.
c. Trigger
Connect a trigger type to the selected task. It automatically runs the task in response to an event that occurs on your computer.
An additional tab towards the bottom right is the Description/Notes panel, which allows you to enter free text for selected task. The text
can be edited if and when you modify the task.

Disclaimer: The images displayed may vary from the actual product because of regular updates.
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Understanding the Features and Benefits
Automation Anywhere is intelligent automation software, providing unparalleled performance and scalability for greater efficiencies in
your business processes.

Capabilities: What Does Automation Anywhere Offer?
Automation Anywhere helps you to optimize the time spent on running tasks by providing the following capabilities:
l

Transform a repetitive, 20-step process to a single mouse click or keystroke.

l

Run scheduled tasks anytime by using powerful task scheduling, even when computer is locked.

l

Automate scripts that exist in disparate formats.

l

Easily manage automated processes across a single machine or multiple machines, and across a division or an enterprise.

l

Create automation tasks in minutes: record keystrokes and mouse clicks, and use easy, point-and-click wizards.

l

Easily manage automation users with a scalable server that provides true collaboration.

l

Maintain centralized systems for backup, security, and resources.

l

Capture and reuse automated processes in a central repository.

l

Manage job scheduling and execute batch data processing with ease.

l

Automate FTP/SFTP processes.

l

Download, upload, schedule & run tasks in multi-user environments like Citrix and Terminal Server.

l

Scale and extend AAE platform with MetaBots Designer to serve unique business needs. Learn more.

Unique Features: How Do We Do It?
Automation Anywhere provides the following features, making it the only solution in the market to offer complete automation capabilities:
l

SMART Automation Technology that quickly automates complex tasks, with no programming required, and is highly reliable and
accurate.

l

Centralized Enterprise Control Room that makes it easy to set up and maintain automated processes, users, and client machines.

l

Industry-leading Web Recorder and Object Recorder that recognize objects, even when they move position.

l

Over 550+ actions available, including:

1. Active Directory support for user/client management
2. Conditions and loops
3. User prompts
4. File, database, and system management
5. High-speed replay of automated tasks
6. Automatic email notifications
7. Task chaining
8. Hotkey setup and management
9. User-defined and system variables
10. Advanced error logging
11. PDF automation

Benefits: Why Do I Want To Use This Solution?
l

Enable your teams to be 30-80% more efficient.

l

Eliminate human error in data entry processes.

l

Improve collaboration between employees and divisions.

l

Increase transaction speeds.
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l

Reduce costs and achieve higher ROI on your existing IT systems

l

Integrate multiple, disparate systems and data, including legacy systems, ERP systems, partner data, and Web portals.

Value: What Can I Do With Automation Anywhere Client?
Automation Anywhere helps companies achieve process consistency across a team, department, division, or enterprise by automating
and managing workflows, processes, and tasks.
Some of the processes you might consider automating include:
l

Time-consuming data entry processes like:

1. Checking inventory
2. Re-ordering supplies
3. Formatting and running reports
l

Logging into websites, searching websites, submitting web forms, or updating records on a website.

l

Managing ERP front-end processes, including SAP, Oracle Applications, Peoplesoft, MS Dynamics, Salesforce, and more.

l

Automating data transfers, including importing/exporting data between applications or files.

l

Use the Automation Anywhere Object Recorder to manage and execute Windows controls as a background process.

l

Automate routine backups and file management tasks.

Automation Anywhere is the most complete business process automation solution available today!

Also See...
l

Installing the Automation Anywhere Client

l

Upgrading from the Trial Version

l

Verifying Automation Anywhere System Requirements

l

Contacting Automation Anywhere
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Verifying Automation Anywhere System Requirements
This section helps you determine whether your system has the proper hardware and software to install Automation Anywhere. Before
installing the Automation Anywhere, verify that your environment supports the following requirements.
Operating Systems:
l

Microsoft Windows Server 2012 (valid for AA Small Business and AA Enterprise)

l

Microsoft Windows Server 2008 R2 (valid for AA Small Business and AA Enterprise)

l

Microsoft Windows Server 2003 (valid for AA Small Business and AA Enterprise)

l

Microsoft Windows 8.1/ 8*

l

Microsoft Windows 7*
*(Home and Pro Versions for AA Standard)
(Both 32-bit and 64-bit OS versions are supported)

Processor speed: Recommended - 3 GHz or higher.
RAM: Recommended - 4 GB or higher.
Hard Disk capacity: 200 MB of free hard disk space for installation.
Note:
l

On an average an Automation Anywhere script is approximately 100-150 KB. Additional free disk
space is required to develop automation projects, as Automation Anywhere creates temporary files
like screen-shots, server logs, audit files etc. during the execution of the automation scripts.

l

The actual free space required increases with the project size and hence it is recommended to
have at least 40-50 GB of free disk space in order to implement long term projects.

Additional Requirements
l

1024 x 768 or higher resolution monitor

l

Mouse or other pointing device

l

Microsoft Internet Explorer 8.0 or later.

.NET Framework Requirements
A .NET Framework is required to run Automation Anywhere products.
l

.NET Framework 4.0

l

.NET Framework 3.5 + SP1

Note: If using Enterprise, you need to have both versions of .NET Framework installed; for Small
Business, Premier and Standard (version 8.2 or higher), only .NET Framework 4.0 should suffice.

Synchronization between Client and Server
l

To synchronize the time between the Automation Anywhere Client and the Enterprise Control Room, enable the Network Time Protocol (NTP) settings on your network. For more information modifying the NTP settings for your network, see your system administrator.

Also See...
l

Installing the Automation Anywhere Client
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Installing the Automation Anywhere Client
This topic describes how to install and uninstall the Automation Anywhere Client.

Installing the Automation Anywhere Client
To install the software, follow these steps:
1. Contact Us to purchase and download the software.
2. Locate and double-click on the setup.exe file.
3. Follow the instructions in the installation wizard.
4. After the installation is complete, launch AA Client.
If you are currently using the trial version and you decide to upgrade to the licensed version of Automation Anywhere, you do not need
to re-install the software. All functions and features will be unlocked after entering your license key.

Uninstalling the Automation Anywhere Client
To uninstall the Automation Anywhere Client, follow these steps:
1. On your Windows desktop, go to Start -> Programs.
2. Select your Automation Anywhere Product (the default program folder) and click on "Uninstall Automation Anywhere <Product>".
3. Follow the instructions in the uninstall wizard.
When you uninstall Automation Anywhere, all tasks that you have created are kept and maintained in the Automation Anywhere folder.
If you no longer plan to use Automation Anywhere, you can remove these tasks by deleting the Automation Anywhere folder from the
application path.

UAC (User Access Control) and DEP (Data Execution Prevention)
Windows introduced DEP (Data Execution Prevention) with XP SP2 and UAC (User Account Control) with Windows Vista. If the restrictions in these modules are set too high, it can restrict the overall functionality of Automation Anywhere.
Note: These changes affect the security of your operating system environment. We recommend to consult your local IT resource for more information about these functions.
The changes mentioned below will require you to reboot your computer. We therefore recommend, changing both settings at the same
time in order to avoid multiple reboots.

To modify UAC settings:
1. Login as an Administrator.
2. Go to the Control Panel and select User Accounts.
3. Click on the option - 'Change User Account Control Settings'.
4. Drag the slider all the way to the bottom where it says 'Never Notify'.
5. Login as an Administrator.
6. Go to the Control Panel and select User Accounts.
7. Click on the option - 'Change User Account Control Settings'.
8. Drag the slider all the way to the bottom where it says 'Never Notify'.
For more on the same, refer Setting User Access Control

To modify DEP settings:
1. Login as an Administrator.
2. Go to the Control Panel and select System.
3. Click on the option - Advanced System Settings.
4. Under the 'Advanced' tab, click on the 'Settings' below the 'Performance' area.

Other User
Resources:

5. Go to the 'Data Execution Prevention' tab.
6. Select the radio button - 'Turn on DEP for all programs and services except those I select:'
7. Click on the 'Add' button and add the Automation Anywhere.exe, AA Player.exe and AA Task Editor.exe from the 'Program Files
(x86)\Automation Anywhere Enterprise7.1\<Product>' folder to the allowed list.
8. Click on 'Apply' and then 'OK'.
9. After the reboot, right click on the Automation Anywhere Client icon on your desktop or under the 'Start' menu and select the 'Run
as Administrator' option to launch the program.

Also See...
l

Verifying System Requirements
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Upgrading to the Licensed Version
The Trial version of Automation Anywhere is available for download free-of-charge. This version contains most of the features that are
available in a regularly licensed version. However, several features are locked and/or offer only limited use.

Benefits of Upgrading
The following capabilities are activated when you upgrade:
l

Access product support resources

l

Certain Loop command functionality

l

In addition, registering your license enables you to:

1. Take advantage of free or discounted software upgrades.
2. Receive announcements of new product features and upgrade offers.

Upgrading to Licensed Version
To purchase the Automation Anywhere Client, visit the Contact Us page.
After completing the registration, you will receive an email containing a registration license key/file.

Also See...
l

Verifying System Requirements

l

Installing the Automation Anywhere Client
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Connecting to Automation Anywhere Control Room
Automation Anywhere allows you to monitor and administer a large multi-site complex automation infrastructure using the web
based Control Room.

(Image as seen in Enterprise edition 10.1)

Login to the Control Room
As a Client user, launch Enterprise Client.
l

Input Control Room Service URL in the 'Control Room' field of the Login screen.

l

Enter your Control Room user credentials.

Note: The Control Room administrator can create a user in web-based Control Room. Refer User Management for details on how.
If launching for first time, input the appropriate Control Room Service URL. On logging in the second time, your last login URL is
displayed. If you wish to login using another URL, simply input the appropriate URL.

Tip: Contact your Control Room administrator in case you forget your password*.

* Applicable to Enterprise edition 10.1.0
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Re-Login to Control Room
l

To re-login Control Room using a different user credentials, click Tools > Re-login.

l

Input user credentials in the Login dialog that prompts.

(Image as seen in Enterprise edition 10.0)
Note: The logged in username and status is displayed in the status bar.
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Using the Automation Anywhere Account Login
Available from version 7.5 onward
Creating your Automation Anywhere Account ensures that you are connected to your Client, online Automation Anywhere Account and
Support site.To benefit from the collaborative features of the product, login via a 'Single Sign On' - your 'Automation Anywhere Account'
.
Manage various activities such as downloading updates, upgrading to a higher edition, changing the settings or accessing the support
site to log in your ticket or comments.

Signing up for an account
A. For Enterprise
1. Register and log in into your Client,

Note: The 'Login' window is invoked as soon as you launch the Client. Also, you must 'Login'
to Control Room be able to use the application.

2. To create your online account, click 'Login' in the topmost right corner of your Client.
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3. Click the 'Create an account' link at the bottom in the 'Login' window.

4. Automation Anywhere will guide you to the 'Sign Up' page. Here, you are required to provide your credentials. Click 'Submit' once
done.

5. To activate your account, a link will be sent to the email address that you provide. Click 'Resend' if the email address is incorrect.

6.

After activating your account by clicking on the link in the mail you receive, you will be guided to the 'Finish creating your
account' page.Set your password and click on 'Submit' to conclude the sign up process.
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7. Launch the Client and provide your credentials to log in.
C. For Windows Server 2008 R2 Enterprise
If you are on Windows Server 2008 R2 Enterprise and if the 'Internet Explorer Enhanced Security' is enabled, you will be required
to configure Automation Anywhere website in the trusted sites list in order to be able to login.

Reference how to enable/disable enhanced security here.
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Resetting Account Password (from Client)
If, for any reason, you are unable to log in to your account or have forgotten your password, you can reset it by clicking the 'Reset Password' link in the 'Login' window.
1.

Enter your email credentials to send a link for resetting the password.

2. Click on the link given in the mail.
3. Enter new password details.
Note: Refer the password setting criteria as indicated.

Automation Anywhere Account - A Client Perspective
Once you are registered and logged into your client, you can manage your account from within the client. The login name displayed on
the top right corner of the client is an indicator that you are logged in.

If you click on the drop down, you will be able to either go to your account or logout.
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Note: If you are a Standard or Premier user, you will exit the Client when you select 'Logout'.

Note: If you are not registered or are not logged in, the status will be 'Login' in the right topmost panel.
You know you are logged out when the following message is displayed in the task-bar of the client to the bottom right:

Also See...
l

Introduction to Automation Anywhere

l

Installing the Automation Anywhere Client

Other User
Resources:

Recording, Editing and Running Tasks
This topic describes how to record and run basic automation tasks.
Recording and running simple automation tasks involves three basic steps:
1. Record
2. Save
3. Run

Recording an Automated Task
To record an automated task, follow these steps:
1. For recording simple tasks and which can be run on the computer they are recorded on, click the record button at the top of the
main client screen.

Refer Using the Standard Recorder for details.
l

Automation Anywhere begins recording your activity, including keystrokes, mouse movements and mouse clicks.

l

During this process, the Automation Anywhere client window disappears from view. A small "Stop Recording" window appears in
the bottom right corner of your desktop.

Note: You can also create a new automated task by clicking the New Task button at the top of the client screen.

l

A window is displayed that enables you to select from several methods for creating a task:

(Image as seen from version 10.1)
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For more information on choosing a recording method, refer Selecting a Recording Method. Alternately, you can click the 'Help me
choose an option' link to go to 'Live Assist' - our support chat option.
2. Perform the actions that you want recorded for automation. You can open applications, open new windows, click on buttons, fill in
forms, search a website, and perform any other actions you want.
3. Click the stop button to stop recording the task.

l

A Save Task window is displayed.

4. In the Save Task window, type the name of the directory where you want to save the task, or accept the default directory (My Tasks).
5. Type a file name for your task and click on Save.

6. If necessary, you can enter a password to protect the task.
l

Your task is now created.

Creating a Shortcut for a Task on Desktop
It is possible for you to provide a shortcut on your desktop to run a saved task. An icon is associated with the task to launch it quickly.
To create a shortcut on the desktop, follow these steps:
1. In the Automation Anywhere Client window, select your task in the Task List.
2. Right-click on the task, and choose "Send To -> Desktop (Create Shortcut)".
3. Locate the icon on the desktop and drag it to the desired location.

Running Your Recorded Tasks
You can run the task that you recorded by choosing one of the following methods:
l

Select the task in the Task List and click Run.

Or
l

Double-click on the task in the Task List.

Or
l

Double-click on the desktop icon.

Stopping a Running Task
To stop a task from running, take one of the following actions:
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1. Press and hold the ESC (escape) key for 2 to 3 seconds.
2. In the run-time status window, click on the Pause button.

Editing a Task
After you initially create an automated task, you might want to further customize or optimize the performance of your task. You can edit
the task file without the need to re-record it.
l

To make changes to your task, select the task in the Task List and click the Edit button.

l

The Task Editor is launched, enabling you to add functions, remove delays, and add action sequences.

For more information, see Using the Task Editor.

Also See...
l
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Using Special Keys

l

Adding Properties to a Task

l

Exiting the Automation Anywhere Client
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Adding Properties to a Task
You can add properties to increase the efficiency of a task. This topic describes in brief the properties that can be added to a task. It
also guides you to appropriate topics to enable you to directly access the one you wish to peruse.
Add the properties given below to help increase the performance, functionality and usability of your task:
1. General: View general properties such as file name, created at, last run time and log on the General tab. Also, change the priority*
of the task to determine it's precedence for queuing.

* Available for Enterprise version only.
Refer Viewing and Setting General Properties
2. Repeat: You may need to repeat a task for instance when extracting data from a website which is updated frequently. Specify when
running a task it should repeat particular number of times. Also specify that the task should repeat the run any number of hours,
minutes, or seconds.
Refer Repeating a Task
3. Speed: Specify how quickly a task should run. At times certain tasks require precise mouse movements. While recording, your
movements might be slow. After recording such a task you have the option of replaying the same at varying speed.
Refer Adjusting the Speed of a Task
4. Notification: You can specify that you want Automation Anywhere to send an e-mail to a particular e-mail address after the task
completes a run.
Refer Sending Email Notifications for a Task
6. Hotkey: Assign a keyboard shortcut to launch your automated tasks with the press of a single key termed as 'hotkey' in the program.
Refer Setting up Hotkeys for a Task
7. Screen Security*: You can specify that Automation Anywhere run the task without displaying the actions on the screen during the
run. You can also disable the keyboard and mouse while the task runs.

* Available with purchased version of Enterprise Client only.

Also See...
l

Running a Task

l

Using Special Keys
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Using Special Keys
While recording, it is possible to increase the productivity of a task, by using special keys for a task.
The following special keys are available under Automation Anywhere while recording and playing automated tasks:
l

- To stop (abort) a running task, press and hold the ESC key for 2 to 3 seconds. Automation Anywhere also provides you with
an option to configure your own hot key to stop an automation task from running.

The next time you run an aborted task, Automation Anywhere starts it from the beginning

l

- To pause an automated task while it is running, press the Pause/Break key or click on the 'Pause'
Time window. Once you pause a task, a 'Resume'
button appears on the Run Time window.

button on the Run

To continue running the task, click the Resume button.
Note: This feature is useful when you run long tasks that require interrupting in order to use the
machine for other purposes.

Also See...
l

Installing the Automation Anywhere Client

l

Recording, Editing and Running Tasks

l

Exiting the Automation Anywhere Client
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Enabling Remote Desktop Connections
This topic provides information about using Remote Desktop applications to run your automated processes.

Running Automated Tasks under a Minimized Session
When you minimize a remote desktop window (the window that displays the desktop of the remote computer), the operating system
switches the remote session to the non-GUI mode and does not display windows and controls.
As a result, Automation Anywhere is unable to interact with the application GUI. At this point, the automated GUI task fails.
To run GUI tasks on a remote computer while minimizing the remote desktop window, change the registry keys on the computer from
which you connect to the remote Automation Anywhere workstation. Complete the following steps:
1. Log into the computer from which you connect to remote computers.
2. Close all open remote desktop sessions.
3. Click Start -> Run (or Windows + R).
4. In the Run dialog window, type "regedit" and press Enter.
l

The Registry Editor starts.

5. Navigate to one of the following registry keys, depending on whether you want to modify the remote desktop settings only for the
current user or for all users on the computer:
l

HKEY_CURRENT_USER\Software\Microsoft\Terminal Server Client

l

HKEY_LOCAL_MACHINE\Software\Microsoft\Terminal Server Client

6. Create a DWORD value named RemoteDesktop_SuppressWhenMinimized and set it to 2.
7. Close the Registry Editor.
l

When you minimize the Remote Desktop Connection window on your computer, the remote computer GUI should not be affected,
making the GUI available to your automated tasks.

Note: Changes made to the registry can affect the overall performance and function of the system.
Automation Anywhere is not responsible for adverse system behavior that results from making registry
changes. Working with your system administrator is advised.

Using VNC - An alternative to Remote Desktop
In general, Remote Desktop applications do not allow automation software to run or perform tasks when you minimize or close the window. Remote Desktop creates a session for every connection made to the remote machine. Under this session, it provides the connecting machine with complete rights to control the remote machine.
However, when disconnecting from or minimizing the remote window, Remote Desktop retrieves the rights and any access to the GUI
of the remote machine is lost. This causes automated tasks to lose control of the remote system, and they do not run as expected.
Tip: Use Virtual Network Computing (VNC) to connect to the server. VNC allows you to run automated
tasks even when the session is minimized or disconnected.
l

VNC establishes connections with the remote system in a different manner from Remote Desktop. VNC physically connects to the
remote system, rather than creating sessions for each connection. The connection retains controls on the remote GUI, even when
the VNC window is minimized or disconnected.

l

Your automated tasks can continue to run in the same manner as they do on a local machine.

l

For more information on VNC, see: http://www.realvnc.com/download/vnc/
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Exiting Automation Anywhere
This topic describes how to close and exit Automation Anywhere.
You can exit the program by taking one of the following actions:
1. Click the "X" in the upper right corner of the client window.
2. Click on the File menu, and select the Exit option.
3. Simultaneously press the ALT+F4 keys on your keyboard.
Note: To exit out completely from Automation Anywhere, right click on the Automation Anywhere icon
in the System Tray available on the bottom right hand corner of your screen and select the 'Exit'
option.

Also See...
l

Installing the Automation Anywhere Client

l

Recording, Editing and Running Simple Tasks

l

Using Special Keys
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Contacting Automation Anywhere
Automation Anywhere wants to make sure that your questions are answered in the most timely fashion.
When you have a question or technical issue, you have the following options for getting help. Refer the following for details:
l

Have a Question?

l

Getting More Help

Give Us Feedback - We would love to hear from you!
More ways to contact us:
Sales: Toll Free (USA): 1-888-484-3535 x1
International Customers: 1-408-834-7676 x1
Fax Number for Purchase Order: 1-408-834-7671

Media and Press: Visit Press Room
Send all payments to:
Automation Anywhere, Inc.
P.O. Box 41363
San Jose, CA 95160

Headquarter and other offices:
Automation Anywhere, Inc.
2580 N 1st Street, Ste. 460
San Jose, CA 95131
USA
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Have a Question?
Do you have questions about Automation Anywhere?
l

Using the software and its features

l

Installing or configuring the software in your environment

l

Creating your automated tasks

l

Purchasing questions

Use any of the following methods to contact us:
l

Use the Automation Anywhere Knowledge Base Help System

l

Learn from Online Examples

l

Contact Technical Support
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Contacting Technical Support
Automation Anywhere is committed to outstanding customer care. Our support team wants to resolve your issues as quickly as possible.
Depending on the nature of your problem, please take these steps:
1. Check the Automation Anywhere Knowledge Base Help System, including Frequently Asked Questions
2. Learn from Online Examples for quick solutions to common automation use cases
3. View Online Demos and Videos
4. Open a Support Case
How to Open a Support Case
To open a support case, you may contact Technical Support. A support representative will contact you as soon as possible.
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Getting More Help
For more complex questions, use one of the following Automation Anywhere services:
1. Request a Live 1-on-1 Demo (in most cases, no fees charged)
2. Use the Ask the Expert Service (in most cases, no fees charged)
3. Use Automation Anywhere Consulting Services (fee-based services)
Contact us for pricing questions for these options.
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Requesting Live 1-on-1 Demos
l

Do you have a specific question about an Automation Anywhere feature?

l

Are you confused about how to automate a particular process?

l

Do you have questions about how to work with applications while automating processes?

For help with any of these issues, contact the Automation Anywhere Support team.
Our team members are happy to demonstrate features, answer your questions, and show you various automation scenarios.
Request a Live Demo now.

Is your issue more complicated?
Learn about our Automation Anywhere Consulting Services, and how we can help you to automate more complex processes.
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Using our Ask the Expert Service
l

Do you have a simple question about an Automation Anywhere feature?

l

Are you trying to automate a process that involves common applications, such as Word, Excel, or other Microsoft Office products?

l

Do you have a question about your account, your software version, or your environment?

If you need help with any of these topics, contact the Automation Anywhere Ask the Expert team.
Our knowledgeable team members are eager to answer your questions and help you quickly automate your processes.

Is your issue more complicated?
Learn about our Automation Anywhere Consulting Services, and how we can help you to automate more complex processes.
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Using Automation Anywhere Consulting Services
The Automation Anywhere team is led by industry experts in the business process automation field. We've helped major companies
from around the world automate their key business and IT processes.
The Automation Anywhere team is focused on streamlining the implementation of automation, and maximizing customer ROI.
We bring years of experience and best practices in dramatically reducing implementation time to ensure your team is successful.
Our services consultants are ready to provide expert, efficient hands-on training and implementation.
Both on-site and remote implementation services are available that provide:
l

Implementation and consulting for simple and complex automation projects

l

An unwavering focus on your company's objectives

l

Best practices for business and IT process automation that maximize ROI and minimize risk

l

When you engage the Automation Anywhere Consulting team, you are assigned a dedicated customer agent who is familiar with
your domain, requirements, technologies, and environment.

l

If appropriate, your consultant can remotely log into your computer to help you automate processes and guide you with your project.

Automation Anywhere helps you to automate any of the following processes:
1. Business processes
2. IT processes
3. Extraction of data from the Web
4. Data transfer from one application to another
5. ERP (Enterprise Resource Planning) data entry and integration processes
6. File and data management processes
Find out more about our consulting services by submitting the Consulting Services Request Form. A representative will contact you
shortly.

Other User
Resources:

Live Assist
Available on purchase of Chat license only

Chat with our online support executives when you require help while using our product .
Live Assist, managed by Automation Anywhere, is one of the most advanced features that the product has to offer. If you are stuck at a
point wherein you have exhausted all options of figuring out a solution to a problem and you require assistance, begin a chat with our
online Support Executives, who will answer your queries, anytime.
Note: You can avail these benefits only when you login with your Automation Anywhere Account.

Where do I locate Live Assist?

l

On Login

l

On the Main Client Dashboard

l

While creating tasks in the Task Editor

l

While configuring Commands

l

While scheduling tasks in Schedule Manager

l

While creating processes in Workflow Designer

l

While setting triggers for tasks in the Trigger Manager

l

When managing Reports and Repository

How do I connect to Live Assist?
To be connected to Live Assist you must login to your Automation Anywhere Account:
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On login, you will be attended to by one of our Chat Executives:
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l

To send your conversation(s), click

l

To Pin the chat window, click

l

To end your chat session, click

For reference, you can opt to receive a copy of your conversation and also rate your experience:

Other User
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Anywhere Support
Search online support for help while using the product.
The Automation Anywhere Support site is an interactive hotspot for users with Automation Anywhere Account to seek answers to queries, participate in discussions and suggest features that they believe would enhance their automation experience.
Note: You can avail these benefits only when you login.
You can either login through the product - Enterprise, Small Business, Premier or Standard; via search in all clients; your Automation
Anywhere Account and even from the website.

You benefit from logging in as apart from searching for topics in the online knowledge base, you can:
l

View demos

l

Download Sample Tasks

l

Refer command examples

l

Post comments

l

Suggest Features

l

Stay connected to the Automation Anywhere community

l

Participate in forum discussions

l

Analyze Case Studies, White Papers and Articles

l

Read customer testimonials

l

Submit a request for assistance

l

View your open/closed and recently solved requests

Where to Seek Help?
l

On Login

l

Working within the Client, Control Room or Server, as the case be.

l

Creating tasks in the Task Edit

l

While Scheduling tasks in Schedule Manager

l

While creating processes in Workflow Designer

l

While setting triggers for tasks in the Trigger Manager

l

While configuring Commands
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Recording an Automation Task
Automation Anywhere provides several ways to create automation tasks. To ensure that you create a reliable task, you'll want to select
the right method.
When planning your automation task, be sure to select the Recorder (or Task Editor) that best matches the behavior of your task.

Selecting a Recording Method
In most cases, the recorder you select will be based on the type of process that you want to automate. For example, for a process that is
based on web applications to extract data from websites, you would select the Web Recorder.
To record a new task, click New button at the top of the client screen.

A window is displayed that enables you to select from several methods for creating a task:

l

l

Record - It provides the easiest way to create simple automation tasks. After recording a task using the Standard Recorder, you can
make changes to it by using the Task Editor.
In most cases, recording and editing a task is much faster than creating the task manually using the Task editor.
Note: You can edit the recorded tasks using the Task Editor. Refer 'Using the Task Editor' for
details.

l

Web Recorder - It understands all web controls. Hence applicable when recording web-only tasks. If website controls on a page
move location, the program can locate the correct controls and adjust the task to run without error. If the properties of the web controls change, the automation task can be updated to ensure that the task runs successfully. Refer Using the Web Recorder for
details

l

Object Recorder - Use it to capture Windows control actions such as text in drop-down menus, list boxes, and buttons; the status of
radio buttons and check boxes, click actions, capturing tree views, and more. Refer Using the Object Recorder for details.

l

Task Editor - Use it to create tasks manually. You can assign relevant actions to the task using the commands provided in the
editor. Refer Using the Task Editor for details.
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Using the Web Recorder
If you want to automate processes (tasks) that involve a web application or browser, use the Web Recorder. It understands all web
objects and controls, such as:
l

URL command line

l

Drop-down menus and command bar icons

l

Web page text fields, graphics, and buttons

l

Navigation and hotspot links

l

Forms

Note: If the layout of a web page changes and the web controls move to a different location on the
page, Automation Anywhere is capable of locating the new position of these controls and running the
task correctly.
Common Use Cases
Most people use the Web Recorder to perform the following actions:
l

Repeatedly extracting data from multiple web pages

l

Extracting data from tables on web pages

l

Web form filling

Use the Web Recorder when you want to automate the following processes (tasks):
l

Opening web pages

l

Logging into a website

l

Navigating through search

l

Entering data into forms and submitting them

l

Extracting data and updating database records

l

Using a Web-based ERP (Enterprise Resource Planning) system

l

Extracting web data to a local file

l

Testing an online application

Also See...
l

Extracting Data from Web Sites
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Recording Web Actions with Web Recorder
The web recorder is basically used to record actions for web-only applications.
To use the Web Recorder to record actions on a web site, follow these steps:
1. In the Automation Anywhere main window, launch the Web Recorder in one of the following ways:
l

Click New Task button and select Web Recorder.

l

Or click on the Web Recorder link at the top.

l

Select 'Web Recorder' from the list of recorders:

The initial Web Recorder window is displayed.

1. Enter the website address (URL) on which you want to record actions, and click Start. You can add the URL to your Favorites for
easy access in the future.

The Web Recorder Toolbar is displayed, and Internet Explorer is launched in a new window with the website.
2. Perform your actions on the website, including clicking on buttons, clicking on links, and typing in text.
3. Click the Stop Recording button on the Web Recorder toolbar.
4. In the Save Task window, specify a task name, optionally select a folder in which to save the task, and click on Save.
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6. To run the task, double-click on the task, or select it and click on Run button.

7. To stop a running task, press and hold the escape (ESC) key for 2-3 seconds. You can also configure your own hotkeys to stop
tasks. Refer Defining Client Hotkeys for details.
Note: When you edit the task using the Task Editor, the program displays the Web Recorder commands
and objects that were used while recording the task.

Also See...
l

Extracting Regular Web Data

l

Extracting Pattern-Based Data

l

Extracting Table Data

Other User
Resources:

Extracting Data from Websites
Extracting data from web pages can take one of four forms, depending on the type of data that requires extracting:
l

Regular data: Unstructured data that has no repetitive patterns. An example is a paragraph of text.

l

Pattern-based data: Structured data that repeats a pattern, such as a row in a table or a list.

l

Table data: Data that resides in a table.

Also See...
l

Extracting Regular Web Data

l

Extracting Pattern-Based Data

l

Extracting Table Data
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Extracting Regular Web Data
To extract regular data from a web site, follow these steps:
1. In the Automation Anywhere main window, launch the Web Recorder in one of the following ways:
l

Click the New button and select Web Recorder.

l

Or click on the Web Recorder link at the top.

l

Or click on the Tools menu and select Web Recorder.

The initial Web Recorder window is displayed.

2.

Enter the website address (URL) on which you want to extract data, and click Start.
The program displays the 'Web Recorder Tip' window:
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Note: Select 'Don't show this message again ' if you do not wish the program to display the
tip.
The Web Recorder Toolbar is displayed, and Internet Explorer is launched in a new window with the website.

Note: This feature works with Internet Explorer only.
3.

You can now perform any actions you like, including mouse clicks and text entry. When you need to extract regular data from
the website, click the Extract Data button on the Web Recorder toolbar.
The Extract Data Option window is displayed.

4. Select the Regular Data radio button and click Next.
5.

You can now highlight the data you want to extract.

6. After highlighting the text, the Extract Data window is displayed, and contains the text you selected.

Other User
Resources:

6. Save this copied text to an existing variable in your task.
7. Optionally, save the control URL either as a new variable or to an existing variable in your task.
8. You can also assign Before and After Keywords for extracting data.
9. Click Save.
10. Click the Stop Recording button on the Web Recorder toolbar.
11. The Save Task window pops-up, wherein you can specify a task name. Optionally select a folder in which to save the task and click
save. You can also optionally specify a password to prevent the task from being run by unauthorized users.

12. Click Save.
Tip:
1. To stop a running task, press and hold the escape (ESC) key for 2-3 seconds.
2. You can also configure your own hot keys to stop tasks.

Also See...
l

Extracting Pattern-Based Data

l

Extracting Table Data
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Extracting Pattern-Based Data
When you need to extract data, which for instance, is spread over multiple pages and contains elements such as links you can use the
'Pattern Data' option in Extract Data .
To extract pattern-based data from a web site, follow these steps:
1. In the Automation Anywhere main window, launch the Web Recorder in one of the following ways:
l

Click the New button and select Web Recorder.

l

Click on the Web Recorder link at the top.

l

Click on the Tools menu and select Web Recorder.
The initial Web Recorder window is displayed:

2.

The program displays the 'Web Recorder Tip' window:
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Note: Select 'Don't show this message again ' if you do not wish the program to display the
tip.
The Web Recorder Toolbar is displayed, and Internet Explorer is launched in a new window with the website.

Note: This feature works with Internet Explorer only.
3.

You can now perform any actions you like, including mouse clicks and text entry. When you need to extract regular data from
the website, click the Extract Data button on the Web Recorder toolbar.
The Extract Data Option window is displayed.

4. Select the Pattern-based Data radio button and click Next.
5. You can now highlight the data you want to extract

6.

Use it to set a pattern:
a. Highlight the first line of text and click on Capture in the window that pops up:
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b. Highlight a second line of text. This will set the pattern. The Extract Data Field window is displayed.

c. Enter a name in the "Enter Column Name" field and click Save.
l

The Extract Multiple Data window is displayed, containing the column name you saved.

In the Extract Multiple Data window, you can do several things:
l

Add: Click the Add button to select additional data from the website and add another pattern that you want to capture. The data
fields will be automatically viewed in the Classified Data Fields.

l

Edit: Click the Edit button to change the name of the pattern.

l

Delete: Click the Delete button to delete one or more patterns.
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l

Copy: Click the Copy button to copy one or more patterns.

l

Paste: Click the Paste button to paste one or more copied patterns.

l

Click Next when done.
The second window of Extract Multiple Data is displayed:

l

If the website has multiple pages from which you want to extract the patterned data, click the check box: "The data spans across
multiple pages".

l

Use the Capture button to capture the control name for moving to the next page. Images extracted from multiple web pages are
saved in different folders.
l
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Click Next when done. The Preview Data section is displayed:

l

The Preview Data section displays a preview of the captured data. Save extracted images or data as CSV files in separate folders,
as required.

l

Click Finish.

l

Click the Stop Recording button on the Web Recorder toolbar.

l

The Save Task window pops-up, wherein you can specify a task name. Optionally select a folder in which to save the task and click
save.

Note: The trial version supports extracting 5 pages of data for viewing only. No such limitation exists in the purchased version.
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Also See...
l

Extracting Regular Web Data

l

Extracting Table Data
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Extracting Table Data
When you need to extract data from tables on web pages, the Web Recorder guides you with visual steps.
Many websites have data organized in HTML tables. Extract Table makes it easy to save tabular data in a CSV (comma-delimited) file
that you can open in most spreadsheet and database applications, including Excel and Access.
1. Launch the Web Recorder:

2.

Enter the website address (URL) on which you want to extract data, and click Start.
The program displays the 'Web Recorder Tip' window:

Note: Select 'Don't show this message again ' if you do not wish the program to display the
tip.
The Web Recorder Toolbar is displayed, and Internet Explorer is launched in a new window with the website.

3. You can now perform any actions you like, including mouse clicks and text entry. When you need to extract or copy table data from
the website, click the Extract Table button on the Web Recorder toolbar.
4.

Move the yellow prompt bar to the table you want to extract and click on it.

Note: If the content you click on is not a table, the yellow prompt bar will change to red.
The Extracted Table window is displayed showing a preview of the data within the table.
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5.

If the table spans multiple web pages, click the check box: "The table spans across multiple pages".
Use the Capture button to capture the control name for moving to the next page.

6. Click Next when done to preview and save the extracted table.
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7. Save the table as a CSV (comma-separated) file into a location of your choice. You can also use the "Append to an existing CSV
file" check box to append the extracted data to an existing CSV file.
8. Click Finish.
9. Click the Stop Recording button on the Web Recorder toolbar.
10. In the Save Task window, specify a task name, optionally select a folder in which to save the task, and click on Save. You can also
optionally specify a password to prevent the task from being run by unauthorized users.

Note: The trial version supports extracting 5 pages of data for viewing only. No such limitation
exists in the purchased version.

Also See...
l

Extracting Regular Web Data

l

Extracting Pattern-Based Data
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Using the Screen/Standard Recorder
You can use the Screen Recorder (known as Standard Recorder in versions less than 10.0) to record a task or a series of actions on
your computer when:
l

Building simple tasks for processes that involve mouse clicks and keyboard operations.

l

You plan to run the automated process (the recorded task) on the same computer on which it was recorded. This ensures that the
screen display coordinates are the same as they were when the task was recorded.

Tip: If using dual/multiple monitors while recording, recommend to use one monitor only; disable all
other monitors.

Recording a Task using the Screen Recorder
1. To create an automation task using the Screen Recorder, launch it one of four ways:
Note: 'Screen Recorder' should already be selected as the default recorder in the 'Record'
list-down for options 3 and 4 to work.
1. Using the 'Record' button list-down
l

In the main window, click on the 'Down Arrow' beside Record button at the top.

l

Select 'Screen Recorder' as shown:

2. Using 'Choose an Option'
l
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Click on New Task button:

l

Select Screen Recorder from the 'Choose an option' dialog:

3. Using 'Record' option from Context menu in System Tray
l

Context click the Automation Anywhere Enterprise Client in the System Tray

l

Select Record.

4. Using short-cut keys 'Ctrl + Alt + R'
l

The Automation Anywhere window is minimized, and the Recording toolbar is displayed in the lower right corner of your computer
screen.

Note: If needed, you can pause the recording operation and resume it.
2. Perform all of the actions on the computer that you want to record in the task.
Note: While recording, the Screen Recorder recognizes the various windows that are open on
your desktop.

Other User
Resources:

3. When done, click on the Stop button on the Recording toolbar.

4. Save the task by specifying a name, and optionally select a folder in which to store it. When saved, the task name is displayed in
the main Task List window.

Note:
• You can edit your recorded task using the Task Editor. Refer 'Editing a Task'.
• If Version Control is enabled, a plus sign (

Also See...
l

Using the Task Editor

l

Editing a Task

l

Running a Task

l

Open Program/File Command

l

Manage Windows Controls Command
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) will be prefixed to a new task.

Recording Tasks Using the Smart Recorder
Use the Smart Recorder to record a task or a series of actions on your computer when building tasks that require capturing objects
from applications that use technologies such as HTML, Java, WPF, Flex and Silverlight.
Note that you can record tasks in Internet Explorer 8 and above only.
Tip: If appropriate plug-ins are not installed, you can install them using Plugin Settings. Learn More

Recorded actions are saved as a set of Object Cloning commands in the Task Editor.
As it captures actions via an object window it saves the keystroke actions and mouse clicks in the 'Actions' list of the Object Cloning
command.
Note: It has the inherent ability to identify keystroke actions such as 'Shift + A' as capital A.
Also, special keystrokes such as 'Tab' and 'Enter' are saved as separate actions in the command.
Tip: To navigate across controls, it is recommended that you use 'Click' action instead of 'TAB'.

Recording a Task using the Smart Recorder
To create an automation task using the Smart Recorder, launch it one of four ways:
Note: 'Smart Recorder' should already be selected as the default recorder in the 'Record' list-down
for options 3 and 4 to work.
1. Using the 'Record' button list-down
a. In the main window, click on the 'Down Arrow' beside Record button at the top.

b. Select 'Smart Recorder' as shown:
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2. Using 'Choose an Option'
1. Click on New Task button:

2. Select Smart Recorder from the 'Choose an option' dialog:

3. Using 'Record' option from Context menu in System Tray
1. Context click the Automation Anywhere Enterprise Client in the System Tray

2. Select Record.
4. Using short-cut keys 'Ctrl + Alt + R'

Also See...
l

Using the Task Editor

l

Editing a Task

l

Object Cloning Command

l

Manage Windows Controls Command
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Creating a Task Using the Task Editor
The Automation Anywhere Task Editor is the most powerful facility in the product. Hundreds of commands and wizards are available
that enable you to automate almost any process-without programming.
If you want to manually create an automated task from scratch, you can use the Task Editor.
1. Launch the Task Editor by taking one of the following actions:
l

Click on the New button and select Task Editor.

l

Click on the File menu and select New, and select Task Editor.

l

Click on the Tools menu and select Task Editor.

2. Add actions to the new task by dragging commands from the left pane of the editor to the Task Actions List pane. After inserting
most commands, you are prompted to specify the properties that apply to those commands.

(Image as seen in Enterprise edition version 10.0)
3. Save the task.

Also See...
l

Using the Task Editor
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Using the Task List
Automation Anywhere provides a simple, visual view of your automation tasks in the Task List section. Here, you can easily navigate
task folders and work with your tasks.

Using the buttons above the Task List in the main Automation Anywhere window, you can perform the following actions:
1. Create a new task - Record tasks with different recording methods available on the 'Create New Task' window.

Refer Selecting Recording Methods for details.
2. Record a new task - Record keystrokes as well as mouse clicks and movements.

Refer Using the Standard Recorder for details.
3. Run the selected/existing task.

Refer Running a Task for details.
4. Edit/modify the selected/existing task using the Task Editor.

Refer Using the Task Editor for details.
Using the buttons in the top-right side of the Task List, you can perform additional actions:
1. Delete a task.

2. Upload a task to the Server.

4. Select an action:

l

Run: Run the selected task (the automated process).

l

Edit: Edit the selected task using the Task Editor.
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l

Check Out:Check out the selected task for modification after uploading to Version Control repository.*
Note: The option toggles to 'Undo CheckOut' once you have checked out the file for editing.
Undo CheckOut: Undo the last updates to the checked out file. You will be asked for confirmation:

l

Upload Task: Upload the selected task to the Server Task Repository.

l

Version History: Compare different versions of the task.

l

Copy Task: Create a copy of the selected task.

l

Rename: Rename the selected task.

l

Locate on Disk: Create a copy of a task as an .atmx file in the location: My Documents\Automation Anywhere\Automation Anywhere\My Tasks

l

Send To: Send a copy of a task to: Desktop(Create Shortcut), Mail Recipient, Startup Folder or My Documents.

l

Delete: Delete a task.

Also See...
l

Editing a Task

l

Deleting a Task

l

Running a Task

Other User
Resources:

Editing a Task
After initially creating an automation task, you can edit the task using the Task Editor to add, modify, or delete actions and steps to the
process.
For example, you might want to remove all built-in delays to increase the speed of the task when it is run.
You can open a task in the Task Editor in the following ways:
1. Select (highlight) the task and click the Edit button.

2. Right-click on the task, and select Edit from the pop-up menu.

3. Click on the Actions button, and select Edit.

If you want to edit a task when double-clicking on it, change the setting by following these steps:
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1. In the main Automation Anywhere window, click on Tools -> Options.
2. Click on Advanced Settings.

3. Check the "Edit Task on double click in Task List" check box.

Editing a Task when Version Control is enabled
Applicable to Enterprise edition from version 9.0 onward
The editing of a task and its properties will vary depending upon the status of the task when Version Control is enabled.
l

When the task file is not Checked Out, you will not be able to edit the task and its properties; it will open in 'view only' mode if you
click on the 'Edit' option:

Also, Properties tab will be disabled for editing and will denote "Checkout the file to enable editing the Properties."

Note: Viewing of logs will not be disabled. To view, click 'View Logs'.
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l

When the task file is Checked Out, you will be able to edit the task and its properties.

Note: You can Check Out/Undo Checkout files such as Reports, Documents, Workflows, Scripts and
Lists.

Editing a Password Protected Task
Password protection of tasks is deprecated. Hence tasks that were password protected for editing in earlier versions must be edited,
saved and re uploaded to the Control Room on display of:

Click OK. This will launch the Enter Password window. To remove the password and open the task in edit mode, provide the password.

Save the Task.
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Using the Task List
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Deleting a Task

l

Repeating a Task

l

Adjusting the Speed of a Task

l

Stopping a Task

l

Sending Email Notifications for a Task

l

Locating a Task

l

Sending a Task
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Editing a Web-only Task with Web Recorder Commands
You can use the Task Editor to edit and enhance the automation tasks that you earlier recorded using the Web Recorder.
When you launch the Task Editor, you can add any of the commands that are listed under "Web Recorder".
Using the Web Recorder commands, you can:
l

Open and close websites in browser sessions

l

Manage web controls

l

Download data

l

Extract tables

l

Test websites and locate broken links

l

Extract data

l

Navigate URLs

l

Extract Website source code

l

Search by captions

l

Navigate back

l

Execute a java script

You can add the following actions to your Web Recorder automation task.
1. Open and Close Browser Sessions
l

Open Browser: You can specify a website URL that you want the automation task to open prior to performing actions on that website. For most processes website automation, opening the browser is the first command added to the task, usually followed by commands that manage controls.
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l

Close Browser: Closes an open browser session that was previously opened using an Open Browser command.

2. Manage Web Controls
Use the Manage Web Controls command to select controls on the web page and work with them.
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For example, you can insert actions on links, check boxes, radio buttons, drop-down menus, and other objects.
To use Manage Web Controls, follow these steps:
3. In 'Specify a Website URL/Page' choose either 'Open New URL' or 'Select Page' .
If you specify 'Select Page' you are required to select a page title (html page) that is open, from the list.
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Tip: Click 'Refresh' if window is open, yet not visible.

4. Use the Capture button to capture a web control by selecting it with the yellow prompt bar:

5. The control details are displayed.
6. Click the Advanced View button if you wish to include more options.

l

Control Name / Control ID: Searches for the web control based on the control name or ID.

l

Caption: Searches for the web control based on the caption name that is entered or selected from the text box. For
example, if you record a menu object with a caption titled "Buy Now", this web control lets you search the web page for this
caption when the task runs.

l

Control Index: Searches for the web control based on the index number of the control, which is stored while recording a
web page.
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l

Attributes:Searches for the web control based on the tag attributes, which are stored while recording a web page. You can
select the tag attributes and specify their values for the web page that is being searched.
You can add or delete tag attributes, as required.
Tip: Best Practice is to use 'Search by Caption' as the first option, 'Search by Attributes' as second option, and 'Search by Index' as the third option.

7. Enable or disable 'Page Title' and/or 'Page URL' to decide whether to play in existing or new Internet Explorer window.
Note: Both are enabled by default and the task will play in existing Interenet Explorer window.
8. Specify the action that you wish to perform during task play time.
Tip: You can opt to use a Variable while using the actions Set Text and Append Text. If the
text needs to be encrypted, you can insert Credential Variables* using function key 'F2' for
enhanced security. Learn More
*Available in Enterprise edition from version 10.2.1
9. Click Save.

3. Download File
Use this command to download HTTP files. This command does not require a browser.

Common Use Cases: Downloading stock data, log files, security patches, or other files that you
routinely need to download.

4. Extract Table
Use this command to select a table on a web page and save the data to a CSV file.
After running the task, including the Extract Table command, Automation Anywhere stores the table data in a system variable named:
$Table Column(index)$
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You can use this variable to retrieve the data that you extracted in row-and-column format by using a combination of Loops for each
row in an Internet Explorer table.
Common Use Case: Transfer data from a web-based ERP system to another application, such as Excel.
Follow these steps to extract table from a website:

1. Select Extract Table
2. Launch the website you wish to extract the table from by clicking on 'Launch'.
3. Use the 'Capture Table' button to capture the table by selecting it with the yellow prompt bar:

The program will display the table number.
4. You can optionally save or append the table data to a .csv file. Or you can process the table data using loops within your task.
Refer Loop Command for details.

Other User
Resources:

5. Click on View extracted table button to preview the table data in the Extracted Table window:

6. Click the Advanced View button to add more options such as Session Name, Page Title, Page URL, Extract selected Tag Details to
a .csv file

7. Click Save.

5. Find Broken Links
Use this command to validate all links on a website or a web page.
After running the command, Automation Anywhere stores the results in a CSV file that you can open in Excel.
Using this file, you can identify any broken links.
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6. Extract Data
Extracts text data from a website or a web page.
This command enables you to specify a range of text that you want to copy, using "Before" and "After" keywords.

Other User
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Example: Given the text string "= Price: $249 xyz"
You want to capture only the price, which is $249. Specify the following range:
Before keyword: "= Price:"
After keyword: "xyz"
TIP: In some cases, the Extract Data command might skip extracting some records. If this occurs,
select "First and Last record" while capturing pattern-based data. For extensive pattern-based data
extraction, use the Web Recorder.

7. Navigate URL
Use this command to navigate to a website URL in a browser window that is already open.
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8. Extract Source
Use this command to extract source code from a web page.
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Tip: 'Capture' button disabled? Refer the section on Web Recorder in Troubleshooting for details.

9. Search by Caption
Use this command to navigate to a caption or title in a browser window that is already open. Navigation using this command is possible even if URLs change.
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10. Go Back
Use this command to navigate to the previous URL location that was used during website recording.

11. Execute Java Script
Use this command to execute Java Script internally on a web page.
Note: It is mandatory to enter the 'Function Name' without which the specific script named therein
will not be executed.
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Tip:
l

Ensure JavaScript has been enabled for Internet Explorer. If disabled, you may receive an access
denied message. For details refer the Microsoft Support section.

l

'Capture' button disabled? Refer the section on Web Recorder in Troubleshooting for details.
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l
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l

Extracting Table Data
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Editing Multiple Commands (Bulk Edit)
To make editing automation tasks easier, Automation Anywhere provides a Bulk Edit feature, which enables you to edit multiple commands at one time.

Prerequisite for Editing Multiple Commands
*Available from 9.0.2
Before you Bulk Edit multiple commands it is important to ensure that all the selected commands are of same type and enabled.
Note: Bulk Edit doesn't work if any of the selected command is disabled.

Editing Multiple Delay Commands
Using Bulk Edit, you can apply the settings for a specific delay command to multiple delay commands in your task. Follow these steps:
1. In the Task Editor, select multiple Delay commands in the task.
2. Right-click on one of the selected commands and select Bulk Edit from the pop-up menu.

3. In the Delay/Wait window, set values for the delay settings and click Save.

4. In the Task Actions List view of the task, you'll see that all of the Delay commands that were included in the Bulk Edit operation are
now changed to the new settings.
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Note: Bulk Edit works with two command types: 'Delays' and 'Keystrokes'. You can however edit
either keystrokes or delays, individually.

Use Case Scenarios
1. Set a common delay of 5 seconds to multiple Delay commands
1. Open the task in the Task Editor.
2. In the Task Actions List, select (highlight) multiple Delay commands using the Control key, or use the Filter to view all of the Delay
commands in the task.
3. Right-click on one of the selected commands and choose Bulk Edit.
4. In the Delay/Wait window, enter "2000" in the Delay field.
5. Click Save.

2. Set a common random delay for multiple Delay commands
1. Open the task in the Task Editor.
2. In the Task Actions List, select (highlight) multiple Delay commands using the Control key, or use the Filter to view all of the Delay
commands in the task.
3. Right-click on one of the selected commands and choose Bulk Edit.
4. In the Delay/Wait window, Select Random Delay.
5. Enter "5" in the 'From' field.
6. Enter "500" in the 'To' field.
7. Select the Delay in Seconds radio button.
8. Click Save.

Editing Multiple Keystroke Commands
Using Bulk Edit, you can apply the settings for a specific Keystrokes command to multiple Keystrokes commands in your task. Follow
these steps:
1. In the Task Editor, select multiple Keystrokes commands in the task.
2. Right-click on one of the selected commands and select Bulk Edit from the pop-up menu.
3. In the Insert Keystrokes window, set values in the Keystrokes settings and click Save.
l

In the Task Actions List view of the task, you'll see that all of the Keystrokes commands that were included in the Bulk Edit operation
are now changed to the new settings.
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l
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l
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l
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Changing Window Titles
If you record a task with an application for which the window title changes frequently, use the Task Editor commands for updating the
task to refer to the proper title.
For instance, several scenarios can exist:
1. The window title of a web page or a Windows application changes continuously due to dynamic content.
l

The title in Microsoft Outlook changes frequently as the user selects new folders.

l

A web page title contains a session ID for the website.

2. Copied tasks - If you copy a recorded task to create a new task, the application titles will need to be changed.
3. When you use a wild card, the 'Current Active Window' command, or variables to use for setting window titles.
Tip: You can use the Windows filter to select a particular Window name, enabling you to view task
actions that are sorted by application.This filter provides a convenient view of any or all applications that are used in your task.

How to use the Change Window Title action
To use the Change Window Title action to apply a common window title to multiple application windows, follow these steps:
1. In the Task Editor, use the Windows filter to select a particular Window name.
2. Select one or more commands with the window title for which you want to change.
3. Right-click on one of the selected windows commands and choose the Change Window Title action. You can also use the Actions
button to select the Change Window Title option.
4. Set a common Window title for the selected windows that your want to change and click OK.
l

In the Task Actions List view, you'll see that the windows titles are changed to the new title that you've assigned. Refer the example
given here:

Assign a common window title to multiple window actions
1. Open the task in Task Editor.
2. In the drop-down list of the Windows filter, select one particular application window.
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3. Using the Control key, select (highlight) multiple windows commands to edit their window titles.

4. Right-click on one of the selected commands, and choose Change Window Title from the pop-up menu of actions.

5. In the Change Window Title dialog, specify a window title to replace the current selected window titles.
l

Use the Find and Replace commands to browse and replace the title, as appropriate.

6. Click Save.
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Copying or Renaming a Task
One of the enormous benefits of using Automation Anywhere is the ability to reuse processes that you automate. Copying and renaming automation tasks allows you to reuse tasks that have been previously built.

Copying a Task
To copy a task, follow these steps:
1. In the Task List, select (highlight) the task you want to copy.
2. Copy the task using one of the following methods:
l

In the File menu, select Copy.

l

In the Actions button, select Copy from the drop-down list.

l

Right-click on the task and select Copy.

3. In the Copy Task window, select a directory location and specify a file name for the new copy of the task.

4. You can also create a desktop shortcut, if required.
5. Click Save.
l

The new task is added to the Task List view.

l

All commands in the original task are available in the new copy of the task.

Renaming a Task
To rename a task, follow these steps:
1. In the Task List, select (highlight) the task you want to rename.
2. Rename the task using one of the following methods:
l

In the File menu, select Rename.

l

In the Actions button, select Rename from the drop-down list.

l

Right-click on the task and select Rename.

3. In the Rename File window, specify a new file name for the task.

4. Click Save.
l

The renamed task is displayed in the Task List view.
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Copying and Renaming files and folders if Version Control is enabled
Applicable to Enterprise edition from version 9.0 onward
You can copy and rename files and folders in the local repository.
l

Copying and Renaming Files
l

When copying a file, if the same file exists in the repository you will not be able to over write the same.

l

When renaming a file that has been uploaded to the server repository, you will be prompted:

If the file is checked out for edit, you will be prompted:

Only the local file version will be renamed. Undo Check out to rename the file.
l

Copying and Renaming Folders
l

You can rename folders in the local repository only:

l

If selected folder comprises a file that is checked out for edit, you will not be allowed to rename the folder. In order to
rename the folder, you will have to undo checkout or upload the relevant file first.
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Deleting a Task
In some cases, you might want to delete an existing automation task.
To delete a task, follow these steps:
1. In the Task List, select (highlight) the task you want to delete.
2. Delete the task using one of the following methods:
l

In the Edit menu, select Delete.

l

In the Actions button, select Delete from the drop-down list.

l

Right-click on the task and select Delete.

3. In the Delete Task? window, click on Yes.

l

The task is removed from the Task List view.

Note: After deleting a task, you cannot restore the task on the client. Before deleting a task, be
sure you no longer have use for that task.
If the task was copied to the server, you can restore it by copying the server version to the client.
Tip: As a best practice, be sure that all tasks are copied to the server as a way of backing up your
automation projects.

Deleting a file and folder if Version Control is enabled
Applicable to Enterprise edition from version 9.0 onward
l

Deleting a Task
If you have version control enabled, while deleting the task from the Client, apart from confirmation, you will be notified that the task
will be deleted locally only.

Note: To delete the task from the server repository, you will have to select it from the relevant folder of the repository.
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l

Deleting a Folder
You can delete a folder from the local repository only:

Note: The 'Delete Folder' option is disabled if it comprises a task that has been checked out
for edit.
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Running a Task
In most cases, as you create automated tasks, you'll want to test the process to ensure that the results match your expectations. You
can test an automated process by running the task.
When running tasks, Automation Anywhere provides advanced task-queuing technology with run-time settings that you can tune.
You can run a task manually or you can schedule a task to be run at a later time.
To manually run a task, follow these steps:
1. In the main Automation Anywhere window, select (highlight) the task you want to run.
2. Run the task by using one of these methods:
a. Click the Run button.

b. Click on the File menu and select Run.
c. Click on the Actions button and select Run from the drop-down list.
d. Right-click on the task and select Run.
l

When a task begins to run, a Run-Time window is displayed.

You can pause or stop a task from running at any time.
1. To pause the task, press the Pause button on the 'Run Time Window'

2. You can resume running the task by using the Play button on the 'Run Time Window'.

3. To stop a task from running, use one of the following methods:
a. Use the Stop button.

b. Press the Escape (ESC) key on the keyboard.
Tip: You can also modify your hotkeys to use a different key to stop tasks that are running.
When stopping a task, the process does not end abruptly. The Run-Time window displays the message "Aborting" and completes any
step that is in progress.

Other User
Resources:

Note: When using the 'Run Task' command, if you have a sub-task running within the main task, the
window will display the task hierarchy.
The run-time window will display:
l

The selected and current task being executed.

l

The task's action being performed.

l

The task's line number.

l

Tool tip - if the task flow is too long to fit within the window.
Tip: Hover the cursor over the task name and the task flow is displayed as a tool tip.

Running Password Protected Tasks
In order to run a password protected task, you are prompted to edit, save and re upload the task to the Control Room as the Password
protection feature is deprecated.
While running such tasks you are displayed:
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Click OK. This will launch the Enter Password window. To remove the password and open the task in edit mode, provide the password.

Save the Task.

Also See...
l
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Stopping a Task
While running an automated task, you can pause or stop the process, as necessary. You can stop a task from running either manually
or by inserting a conditional command within the task.

Stopping a Task Manually
To stop a task manually, simply click the Pause
keyboard for 2-3 seconds.

or Stop

button on the progress window, or press the Escape (ESC) key on the

Stopping a Task Using a Condition
You can stop a task by using specific conditions by inserting a 'Stop Task' command.
A Stop Task instruction looks like this in the Task Editor:

Tip: Stop the task only when encountering a file that is larger than a particular number of megabytes
(MBs).
To know more about using this command refer Stop Task Command.

Also See...
l

Running a Task

l

Editing a Task

l

Deleting a Task

Other User
Resources:

Locating a Task on Your Computer
In some cases, you might want to locate the task file that is associated with an automated task you've created.
Automation Anywhere files have the file extension of: '.atmx'
To locate an Automation Anywhere task file on your computer, follow these steps:
1. In the main Automation Anywhere window, select the task in the Task List for which you want to locate the .atmx file.
2. Either click on the Edit menu or on the Actions button, and select 'Locate on Disk'. A Windows Explorer window is displayed showing the folder containing the task files.
3. Locate the automation task file. The task name matches the name you've assigned to the task.

Also See...
l
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Sending a Task
Occasionally, you might want to distribute your automation tasks to other people and locations. Using the 'Send To' option, you can
send a task to the following locations:
1. The Desktop - you can create a desktop shortcut to run the task with a click of a button.
2. An email recipient - Send the task to another person using an email address.
3. The Start-up folder - Enable the process to be run each time the computer starts by using the Windows Start-up folder.
4. The My Documents folder - Organize and run tasks from the My Documents folder.
To send a task to any of these locations, follow these steps:
1. Either click on the Edit menu or on the Actions button, and select 'Send To'.

2. Select one of the Send To options and complete the information, srequired.

Also See...
l
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Setting Task Properties
After you create an automation task, you can view and change its properties.

Use the Properties tab to set and adjust the settings for your task. On this tab, you can do the following:
l

View and set general properties, such as setting the priority status and viewing the date it was created.

l

Specifying the frequency or conditions to repeat the task.

l

Adjusting the speed for which a task runs.

l

Setting up email notifications for a task.

l

Specifying hot keys to use with you task.

l

Setting security parameters to ensure that only authorized users run the task.
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Viewing and Setting General Properties
After you create a task, you can view and edit the task's general properties by using the General tab.
The general properties include task name, status, last run time, and other statistics. You can also use the Description/Notes field to
enter useful comments about the task.

General Properties - An Overview
l

File Name - Displays name of the task

l

Created at - Displays the date and time of task creation

l

Status - Displays the last time the task was run.

l

View Log - Click View Log to see historic and detailed status of the task. If the task has failed, View Log shows the line number
where the task failed.

Refer the sample of the log as displayed in notepad given below:

l

Last Run Time - Displays the last time the task was run.

l

Mouse Clicks - Lists the total mouse clicks recorded in a task, automatically calculated based on the task.

l

Keystrokes - Lists the total keystrokes recorded in the task, automatically calculated based on the task.

l

Total Clicks - Lists the total clicks (Mouse Clicks + Keystrokes) recorded in the task. (Every time you run a task, you save this many
clicks and keystrokes.) Automatically calculated based on the task.

l

Priority for queuing - You can specify a priority for the task, which will decide the precedence of the task when it is in a queue. Also,
if the priority is same then rules apply for precedence of jobs.

l

Timeout - You can specify timeout for the task to ensure that the task gets aborted automatically after the specified time. Timeout
can be set only in minutes between the range of 0 to 9999. Refer Timeout for more details.

l

Enable this task to run with other similar files or window titles - By default, the task recorded will only run on the specific file(s) it
was recorded on. However, SMART Automation Technology includes an option for running the recorded task on any file within the
application it was recorded in. For example, you record a task to run on the file abc.xls. By enabling this option, you can run the task
on def.xls, xyz.xls, or any other *.xls file, without editing the task.

l

Description/Notes - Add descriptions and notes for a task in the Description/Notes window.
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Timeout
Timeout feature allows you to specify the time after which the task will be aborted automatically. The feature is especially beneficial for
tasks that are run in unattended mode. In any case, if the task gets stuck somewhere, it will automatically aborted if it doesn't get any
response within the specified time. Once a task gets timeout, the downstream tasks (the tasks in queue) can run smoothly.
To set the timeout for a particular task, follow the steps mentioned below:
1. Select the task for which you want to specify timeout.

2. Now simply input the timeout for a task in the Properties Section.

Note: Range of the Timeout is from 0 minute to 9999 minutes.
It is also important to note that Timeout for a task is not applicable:
l

If the task is run in Debug mode.

l

If the task is called through 'Run Task' command. In this case, timeout of the main task will be applicable.

For the tasks that are run in 'Repeat' mode, timeout should be specified keeping in mind the interval of repeat. For instance, a task is
set to repeat 5 times and the time between each repeat is specified as 5 minutes. In such a case, it is advised that Timeout for that task
is set after calculating the total time that it takes to finish all the repetitions.
Timeout time-frame is excluded:
l

When a task is manually paused.For instance, if Timeout is set for 1 minute and the task is paused after 40 seconds. In this case,
the task will Timeout after 20 seconds of being resumed.

l

When a low priority task is suspended and is resumed after completion of a High Priority task. For instance,if Timeout is set for 1
minute and the task is suspended after 40 seconds. In this case, the task will be timed out after 20 seconds of being resumed after
completion of the High Priority task.

l

When first task is Paused, second task is aborted and first task is resumed.
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l

When a low priority task is suspended and is resumed after the High priority task gets Timed out. For instance, ifTimeout is set for 1
min and the task is suspended at 40 seconds and High priority task is timed out. In this case the low priority task will not be
resumed.
Note: Timed out task ROI is not added to the total ROI.

For more information contact support@automationanywhere.com.

Timeout Notifications
l

When a task gets Timed Out, user is informed about it through Notifications.

l

You can also set Email Notification to be informed whenever a task is Timed Out. For more details, refer Setting Up Email Notifications.

l

You can see historic and detailed status of a Timed Out task by clicking on View Log in General Properties of the task.

l

For more information on tasks that have been Timed Out, you can view Timeout entry in System Logs. Refer Viewing System Logs
for details.

l

You can also see how many times a task has Timed Out in Visual Reports. Refer Reports for more details.
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Repeating a Task
Automation Anywhere enables you to repeat a task that is scheduled to run. This feature is especially useful while testing automated
tasks, or tasks that need to repeat upon run failure or even when running routine maintenance tasks.
Use the Repeat property in the main Automation Anywhere window:

You can set the following options for the Repeat property:
l
l

Do not repeat: The task runs only once. This is the default option.
Repeat a number of times: Repeats the task a number of times, as specified in this field.
Example: Repeat an email task 15 times to send 15 emails.

l

Repeat until I Stop it: Repeats the task until you stop it by clicking the stop button or by pressing the ESC key. Use this option
when you are not sure how many times the task needs to run.
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l

Repeat for hh:mm:ss time: Repeats the task for a time period that you specify.

Note: You can specify up to 99 hours, 59 minutes, 59 seconds (a repeat duration of just over 4
days).
l
l

Time between repeats: Sets a duration of time to wait before repeating a task.
Upon error, continue with next repeat: By default, running tasks are stopped when an error occurs. By setting this option, the
task is repeated regardless of run failure.
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Adjusting the Speed of a Task
Use the Speed property to adjust the speed at which a task runs. You can also view the duration in hours, minutes, and seconds that it
takes the task to run.

The speed of the task can be adjusted to run in 3 speeds:
l

Standard Replay - The task runs at the same speed as when it was recorded.

l

High-Speed Replay - The task runs at a faster speed than was recorded.

l

Turbo-Action Replay - The task runs at the fastest speed and excludes any mouse moves.

The Automation Anywhere SMART Automation Technology ensures that when you increase the replay speed, accuracy and reliability
are not compromised.
Tip: In some rare cases, certain pauses during the recording of a process have implicit applicationspecific meaning. In these cases, set the replay speed to the Standard Replay mode to ensure the most
accurate replay.
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Sending Email Notifications for a Task
When planning to run your tasks, you can set up email notifications that are sent to one or more email addresses that you specify.
In the Notification tab under Properties, select 'Send email notification when task finishes' and specify one or more email addresses.

If you select 'Send email notification when task finishes' check box, but do not specify an email address, Automation Anywhere uses
the email address that is specified in the 'To:' field in the Tools -> Options -> Email Notification.
Tip: If you only need to specify one email address to notify, set it using the Tools menu and selecting Options -> Email Notification. However, if you need different tasks to send status emails to different email addresses, specify these email addresses for each task individually.Refer Setting up Email
Notifications for details.
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Setting up Hotkeys for a Task
One of the distinguishing benefits of automating your tasks with Automation Anywhere is the ability to launch a task with the press of a
single key.
You can assign a hotkey to an automated task by using the Hotkey property.

To assign a hotkey, follow these steps:
1. On the Properties tab, select Hotkey.
2. Either specify a hotkey in the field provided or select a hotkey from the pop-up window. If a hotkey is being used by another process, it will be show as not selectable in the list.

Note: The automated tasks can run even when the Automation Anywhere client is not running.
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Setting Security Features for a Task
Automation Anywhere provides advanced security for running tasks in a secure manner using various features such as stealth mode
task play and disable mouse/keyboard.

Important: From Enterprise edition 10.2, Password protection in tasks is deprecated. On upgrading
to Enterprise edition 10.2, your password protected tasks will have to be manually edited to remove the
password.
The Security* property provides the following features:
Auto-Login Advanced Settings: You can specify the following advanced settings for Auto-Login:
l

Running this task in stealth mode: Use this option to prevent information from being displayed on the screen while the task is running in Auto-Login mode. Application windows and programs are hidden from your screen to avoid unauthorized users seeing the
information.

l

Disable mouse and keyboard for this task: Use this option to disable the computer mouse and keyboard while the task is running
in Auto-Login mode. Unauthorized users are prohibited from gaining control of the computer while the task runs. If the computer
recognizes an unauthorized user who is accessing the computer, Automation Anywhere automatically locks the computer, ensuring security.
Note: When nesting automation tasks, if a parent task runs a child task, the Auto-Login settings of the parent take effect, regardless of the settings of the child.

* The security feature is not available in the Trial version.
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Scheduling Tasks to Run
After creating an automated task, you can schedule the tasks to run based on a schedule or on a trigger event.

Note: In Enterprise editions 10.0 & 10.1, Bot Creators - Client users with task creation privileges
can only test run the tasks using the 'One Time Only' schedule option. However, Bot Runners - Client
users with run time privileges, can continue to schedule tasks using various options if using Enterprise edition 10.2. Learn More

Scheduling Tasks
Automation Anywhere provides a Scheduler and a Schedule Manager that you can use to run your tasks anytime you want.

Scheduling Tasks Using the Scheduler
The Automation Anywhere Scheduler provides time-based scheduling capabilities. You can schedule tasks to run on particular days,
weeks, or months of the year.
For more information on the Scheduler, see Scheduling Tasks Using the Scheduler.

Viewing Task Schedules Using the Schedule Manager
The Schedule Manager enables you to view, add, or edit the schedules of tasks that you have created.
For more information on the Schedule Manager, see Using the Schedule Manager.

Scheduling Tasks Using Triggers
To run a task based on a trigger event, use the Trigger tab on main Automation Anywhere window.
Some examples of events that can trigger a task to run include when:
l

A new window opens

l

A specific file is created

l

A file is deleted

l

An email is received in a particular in-box

For more information about using triggers, see Using the Trigger Manager
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Scheduling Tasks Using the Scheduler
The Automation Anywhere Scheduler enables you to schedule automated tasks to run at preferred times, without requiring supervision
or intervention.

Scheduling Tasks
Automated tasks and process workflows can be scheduled to run as shown:

Schedule a task using the Scheduler by following these steps:
1. Select the task that you want to schedule.
2. Click the Schedule tab.
3. Set the scheduling information for time, date, and frequency.
4. Click on Save.
5. Provide your Windows user name and password.

If you have already saved Windows Login Credentials in Login Settings option, then Scheduler
will not prompt you to input the credentials again.

6. Schedule a task to run, multiple times. To add more scheduled times, click the Add

button.

To ensure the computer is unlocked when a scheduled task runs, see Using the Auto-Login Option.
Automation Anywhere provides scheduling options for running tasks with the following frequencies:
l

Daily (for example, every day, only weekdays, or every 2 days)

l

Weekly (specific days of the week; for example, Mondays)

l

Monthly (specific days of the month; for example, January 1 and October 5)

l

One time only

l

When the computer is started

l

When you log onto the computer

l

When the computer is idle
Note: Schedules not visible after upgrade? Refer 'Migrating schedules to newer versions'.
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Entering Windows Login Information
For security reasons, when scheduling tasks to run using the Scheduler, you may be required to enter the Windows user name and
password. This security check ensures that only the machine owner can schedule tasks to run.

No User Name and Password?
Many automation users do not have passwords set on their systems. In this case, you can create a password to enable you to schedule
tasks. Use the Auto-Login option to avoid needing to enter the password each time you start the computer.
To create a password on your system, follow these steps:

For Windows 7
1. On the Windows 7 desktop, click the Start button and click on the Control Panel.
2. Double-click on User Accounts.
3. Complete the instructions for creating a password. Any valid password is acceptable, although it cannot be a blank password.
To configure your machine to use the Auto-Login option, follow these steps:
1. On the Windows 7 desktop, click the Start button and click Run.
2. Type: control userpasswords
l

The User Accounts window is displayed.

3. Go to the Advanced tab
4. Deselect the 'Require users to press Ctrl + Alt + Delete
Note: Enabling Auto-Login makes the computer more convenient to use, but can pose a security risk.
Be aware that any person can turn on the machine and access your files.
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Using the Schedule Manager
The Automation Anywhere Schedule Manager is a convenient facility that displays all task schedules that are set for your tasks. Using
the Schedule Manager, you can view, add, or edit any of your task schedules.
Note: In Enterprise editions 10.0 & 10.1, Bot Creators - Client users with task creation privileges
can only test run the tasks using the 'One Time Only' schedule option. However, Bot Runners - Client
users with run time privileges, can continue to schedule tasks using various options if using Enterprise edition 10.2.

Viewing Task Schedules
To view your task schedules, launch the Schedule Manager in one of the following ways:
l

In the main Automation Anywhere window, click on the Schedule Manager tab on the lower left side.

l

Or click on Tools -> Schedule Manager on the menu bar.
Note: Schedules not visible after upgrade? Reference 'Migrating schedules to newer versions'.

Creating, Editing, and Deleting Task Schedules
You can manage all of your task schedules by using the tabs in Schedule Manager:
1. Date and Time tab

2. System tab
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Date and Time Schedules
Within the Date and Time tab, you can use the Day, Week, and Month tabs to work with scheduled tasks.

You can add, edit, or delete scheduled task to run by using any of these views:
l

Day: The Day view displays the time and description for each scheduled task. You can add, edit, or delete scheduled tasks. Use
this if you need to run your tasks daily and with more frequency.

l

Week: The Week view displays the date and time of scheduled tasks for the week, and includes a description. Use this option
when you wish to schedule to run your task on a weekly basis.

l

Month: The Month view displays the date and description of scheduled tasks for the month. Use this option when the frequency of
running your tasks could be scheduled monthly.

l

Date Range: In the Select Date section on the left, you can specify a date range for scheduled tasks by clicking and holding the
mouse button on a start date and dragging it to the end date, highlighting the range. The Month view automatically opens to display
scheduled tasks within that date range.
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Adding, Editing and Deleting Schedules
As a Bot Runner you can add, edit and delete schedules for tasks on your Client machine using various options:
l

Daily (for example, every day, only weekdays, or every 2 days)

l

Weekly (specific days of the week; for example, Mondays)

l

Monthly (specific days of the month; for example, January 1 and October 5)

l

One time only

To add a schedule, click on
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and select the required option and save.

To edit a schedule, select the schedule and click on
form similar actions by clicking on

or double click or context click and select 'Edit'. You can per-

to delete a schedule.

System Command Schedules
Use the System Tab to view tasks that are scheduled to run based on system events, such as triggers.
Using this view, you can add, edit, or delete task schedules that use triggers to initiate a run.

The following system triggers are available:
l

When My Computer Starts

l

When I Log On

To add a System event schedule, click on

and select the required option and save.

To edit a schedule, select the schedule and click on
ilar actions by clicking on
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to delete a schedule.

or double click or context click and select 'Edit'. You can perform sim-

Changing the Filter View of Task Schedules
You can change the view of scheduled tasks by clicking on Change Filter on the extreme right of the systems tab in the Schedule Manager.

Select tasks to view by taking one of the following actions:
l

Browse to the required file or folder, and select the task.

l

Select multiple tasks by holding the Control (Ctrl) key and selecting the tasks.

l

Select "All" to view all scheduled tasks for the system.
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Scheduling Task on Client
The Automation Anywhere Scheduler enables Development Clients to schedule automated tasks once to run at preferred times,
without requiring supervision or intervention.
It is important to note that Bot Creators - Client users with task creation privileges and Bot Runners - Client users with run time privileges, can only test run the tasks using the 'One Time Only' schedule option. However, the Bot Runners can continue to schedule
tasks using various options if using Enterprise edition 10.2.
To run a scheduled task on a Bot Runner, the Control Room Administrator can create a schedule using Tasks Schedule console in
Control Room.
Note: Both - Bot Creators (Development Clients) and Bot Runners (Runtime Clients) on Enterprise edition 9.0 and below can schedule a task using scheduler. Refer Scheduling Tasks Using Scheduler for details
on how.

Scheduling Tasks
A. Bot Creators i.e. Clients with Development privileges can schedule an automated task to run for 'One Time Only' as shown below:
1. Select the task that you want to schedule.
2. Click the Schedule tab.

3. Select 'One Time Only' option from a drop down.
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4. Set the scheduling information for time and date.

5. Click on Save.
6. Provide your Windows username and password.
B. Bot Runners i.e. Clients with only run-time privileges can schedule tasks using various options with the following frequencies:

l

Daily (for example, every day, only weekdays, or every 2 days)

l

Weekly (specific days of the week; for example, Mondays)

l

Monthly (specific days of the month; for example, January 1 and October 5)

l

One time only

l

When the computer is started

l

When you log onto the computer

l

When the computer is idle

If you have already saved Windows Login Credentials in Login Settings option, then Scheduler will
not prompt you to input the credentials again.
To ensure the computer is unlocked when a scheduled task runs, see Using the Login Settings Option.
Note: Schedules not visible after upgrade? Refer 'Migrating schedules to newer versions' section in
Troubleshooting for details.
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Scheduling Tasks Using Triggers
In addition to scheduling a task to run based on a date and time, you can use trigger events to start your automated tasks.
The Trigger feature enables a task to run automatically in response to an event that occurs on your computer. You can use triggers to
run a task when, for example, a new window opens or a specific file is created.
To use triggers, select an automation task and click on the Trigger tab in the main Automation Anywhere window and select the trigger
type that suits the selected task.
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Adding Triggers to a Task
An Automation AnywhereTrigger automatically runs a task in response to an event that occurs on your computer. You can use triggers
to run a task when, for example, a new window opens or a specific file is created.
Automation Anywhere provides the following types of trigger events:

Using Window Triggers

Window triggers launch an automated task when an application window action takes place. Automation Anywhere provides the list of
open applications on your computer and enables you to refresh the list at any time. You can select from either of the following options
as the trigger event:
l

When an application window opens

l

When an application window closes
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Using File Triggers

File triggers launch an automated task when a file action takes place. You can select from any of the following options as the trigger
event:
l

When a new file is created

l

When an existing file is deleted

l

When a file is renamed

l

When a file is modified

Using Folder Triggers

Folder triggers launch an automated task when events affect folders on your computer. You can select from any of the following options
as the trigger event:
l

When a new file is created in the folder

l

When an existing file is deleted in the folder

l

When a file is renamed in the folder

l

When a new folder is created

l

When an existing folder is deleted

l

When a folder is renamed

l

When a folder is modified
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Using Performance Triggers

Performance triggers launch an automated task when particular computer resources reach a threshold or certain criteria are met. You
can select from the following options as the trigger event:
l

CPU Usage: The computer CPU usage reaches a level that you specify (in %).

l

Free Disk Space: A certain amount of free disk space is reached that you specify in megabytes (MB).

l

Process Count: When a particular number of processes that you specify are running.

Using Process Triggers

Process triggers launch an automated task when a system process starts or stops. Automation Anywhere provides the list of available
processes for your computer and enables you to refresh the list at any time. You can select from either of the following options as the
trigger event:
l

When a process starts running

l

When a process stops running

Using Service Triggers
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Service triggers launch an automated task when a system service takes action. Automation Anywhere provides the list of available services for your computer and enables you to refresh the list at any time. You can select from any of the following options as the trigger
event:
l

When a service starts running

l

When a service stops running

l

When a service resumes running

l

When a service pauses

Using Email Message Triggers

Email Message triggers launch an automated task when an email is received in the email account that you specify. To specify a trigger
for new incoming email messages on a mail server, specify the following:
l

Host name

l

Port details

l

User name

l

Password

l

A time interval to use between checking for new messages

l

If the email account uses SSL, check the "Server Uses Secure Connection (SSL)" check box.

Examples of Using Triggers
Example 1: Run an automated task each time a 'Microsoft Excel' window opens:
1. For Trigger type, select Window.
2. From the Window Title drop-down menu, select the title Evaluation Users - Excel. If the window is not available in the list, open the
application and click on Refresh.
3. Under Action, select 'When window opens'.
4. Save the trigger by clicking the Save button. The task will now run each time Microsoft Excel opens.
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Example 2: Run an automated task that sends an email whenever a file is deleted from a critical work folder on the computer.
1. For Trigger type, select Folder.
2. For Folder Name, click on the ellipsis (...) and select the folder that you want to monitor.
3. For Action, select 'When any file is deleted.'
4. Save the trigger by clicking on the Save button. When a file is deleted from the selected folder, the task will run and send a notification email.

Recommendations for Using Triggers
Automation Anywhere recommends you follow these guidelines with using triggers to run your tasks:
l

If you are running a task on a locked computer, use the Auto-login feature to unlock the computer when the triggered task runs. See
Using the Auto-Login Option. Refer Using the Auto-Login Option for details.

l

You can assign a system variable to a trigger action that returns the name of the file, folder, or window that used to trigger the task.
Refer Trigger Variables for details

l

Use triggers to run process work flows. Refer Scheduling Tasks Using Triggers for details.
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Using the Trigger Manager
Over time, you might create several triggers that run various automated tasks. For example, a single task might be run using five different triggers, or a single trigger might run five different tasks. As the number of tasks and triggers grow in number, you will want to
organize and manage these triggers.
You can use the Trigger Manager to display, add, modify, and delete triggers you have set for your tasks.
Using the Trigger Manager, you can:
l

Add a trigger

l

Modify a trigger

l

Delete a trigger

l

Enable a trigger

l

Disable a trigger

To use the Trigger Manager, follow these steps:
1. In the main Automation Anywhere window, click on Trigger Manager tab on the left side. The Trigger Manager window is displayed,
showing the tasks that are driven by each trigger.

2. Add additional triggers or work with your existing triggers:
l

To add a new trigger, click the Add button.

l

To edit an existing trigger, click the Edit button.

l

To delete an existing trigger, click the Delete button and click "Yes" to confirm.

l

To enable a trigger, ensure that the check box in the far left column is checked.

l

To disable a trigger, un-check the check box in the far left column.

You can enable or disable all triggers at once by checking or un-checking the check box at the top of the Trigger Manager window.
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Troubleshooting Scheduled Tasks
Having trouble running a scheduled task?
If your scheduled task fails to run, follow these steps:
1.

Ensure that you have provided the user name/password.
For security reasons, you may be required to enter your user name and password to run a scheduled task.

2.

If you have multiple accounts, verify that the correct user name/password are used.
If you have multiple accounts on the same computer, such as a domain account and a local account, verify that the user name
you specified is the same user name that was used to log into the computer. Scheduled tasks will not run if the scheduled task
attempts to run under a different user account. Automation Anywhere pre-fills the user name field with the user name you used
to log in.

3.

Check the task status in Control Panel.
To check the status of the task in the Control Panel, follow these steps:
1. Open the Control Panel and click on Scheduled Tasks.
2. Select the task that corresponds to your task (the file starts with your task name).
3. Right-click on the task and select Run. If the task does not run, check the Status column.

4.

Schedule the Calculator Application.
If your task still does not run, follow these steps:
1. Open the Control Panel and click on Administrative Tools.
2. Click on the Task Scheduler.
3. In the Active Tasks drop-down, select Calculator (see figure below). If the calculator does not run, the scheduler service is
not installed properly on your computer.

5.

Verify that the Task Scheduler service is started.

Other User
Resources:

By default, the Scheduler service is started on all Windows XP machines. Verify that the service is started by following these
steps:
1. Open the Control Panel and click on Administrative Tools. Select Services.
2. Verify that the status of the Task Scheduler service is "Started."
3. If the status is not "Started", right-click on it and select Start.
4. Verify that the 'Startup type' is set to 'Automatic'. This ensures that the service will start automatically in the future.
6.

Restart the Task Scheduler.
If the problem persists, restart the Task Scheduler by following these steps:
1. Open the Control Panel and click on Scheduled Tasks.
2. In the Advanced Menu, click on 'Stop using Task Scheduler.'
3. Wait 10 minutes.
4. Click on "Start using Task Scheduler" to restart the Task Scheduler service.

7.

Contact Technical Support.
After completing these steps, if you are not able to run the task as scheduled, it is likely that the scheduler service is not
installed correctly on the computer. Contact Technical Support at: Open a Support Case.
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Using Caps Lock in Your Tasks
As a best practice, make sure that the Caps Lock key is turned OFF prior to creating your automation tasks.
When you create a new automation task, Automation Anywhere records the state of the Caps Lock key during the recording.
When running the task, Automation Anywhere changes the state of Caps Lock key to match the state that existed prior to recording the
task.

Recording with Caps Lock ON
If the Caps Lock key is turned ON when you start recording, Automation Anywhere records the task with Caps Lock ON.
When you run this task:
l

Automation Anywhere checks the state of the Caps Lock key.

l

If the Caps Lock key is OFF at the time it is run, Automation Anywhere turns Caps Lock to ON before running any of the steps.

l

If you use Insert Keystrokes commands within the task, upon running the task Automation Anywhere toggles the state of Caps Lock
to OFF, resulting in lowercase characters.

Recording with Caps Lock OFF
If the Caps Lock key is turned OFF when you start recording, and you use Insert Keystrokes commands within the task to type uppercase characters, Automation Anywhere turns Caps Lock ON.
Note: Be aware that when you use Insert Keystrokes commands, no indicator exists for changes to the
Caps Lock key status. Changes are carried out internally.
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Debugging Tasks
For advanced users, Automation Anywhere provides the capability to debug automation tasks. Although Automation Anywhere
enables you to easily create simple tasks, some longer, more complex tasks might require debugging.
Automation Anywhere provides a Debug Toolbar to manage your debugging. Follow these steps to enable debugging mode:
1.

Display the Debug Toolbar either by clicking on the Enable Debugging button or by clicking on the Debug menu and selecting
Enable Debugging.

The ' Variable(s) Watch Table' window is displayed. To understand more about this feature refer Watching Variables.

2. Use the Debug Toolbar to insert Breakpoints in your task. To insert a Breakpoint, select a command and insert a Breakpoint by
either clicking the Toggle Breakpoint button on the Debug Toolbar or by pressing the F9 function key.

3. Debug the task action-by-action by using the Step Over button (or the F10 function key).

4. Run your task in Debug mode (one command at a time) to isolate any errors.
5. To remove a Breakpoint, select the command and either click the Toggle Breakpoint button or press F9. To clear all Breakpoints,
click the Clear All Breakpoints button on the Debug Toolbar.

6. Use the Set SnapPoint button in a task to capture images of the task while it runs. Use the Visualize button to view the images that
are captured when using the Set SnapPoint option in Debug mode.

7. To stop debugging, either click on the Disable Debugging button or click on the Debug menu and select Disable Debugging.

Note: Automation Anywhere does not store debugging information (Breakpoints); therefore, when exiting application, be aware that all Breakpoint information will be lost.
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Calling Tasks from Programs or Scripts
You can call Automation Anywhere tasks from other programs, scripts, or batch files.
By default, Automation Anywhere saves all tasks in the folder named:
My Documents\Automation Anywhere Files\Automation Anywhere

Calling a Task from a Batch File
Task-name: download-emails.atmx
l

Call the task named download-emails.atmx from a batch file by adding the following line in the batch file:

"C:\Program Files\Automation Anywhere Enterprise 7.0\Client\AA.Player.exe"
"/fD:\My Documents\Automation Anywhere Files\Automation Anywhere\My Tasks\download-emails.atmx/e"

Calling a Task from an Excel Macro
Task-name: download-data.atmx
l

To call the download-data.atmx task from an Excel macro, add the following text to the Excel macro:

Dim RetVal
RetVal = Shell("C:\Program Files\Automation Anywhere Enterprise 7.0\Client\AA.Player.exe "/fD:\My Documents\Automation Anywhere Files\Automation
Anywhere\My Tasks\download-data.atmx"/e", 1)
l

If the task is successful, it returns 0 to the calling program. If it encounters an error, it returns 1.
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Viewing Version History
Use Version History to view the history of updates to the selected file. Also compare and roll back updates, if required.
On selecting Version History, you will be able to view a list of all revisions created for the selected file

Viewing history of file versions
You can view 'Version History' of the selected file from:
1. The Context Menu:

OR
2. Actions list:

3. On selecting Version History, you will be able to view versioning details for the selected file
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The Version History is displayed in descending order of the time-stamp i.e. the latest revision at the top and the first revision at
the bottom. It allows you to identify the user and relevant 'Action' that was performed during a specific 'Date and time' with relevant check in 'Comments'.
Here, you can:
1. Compare two versions of a file.
2. Roll back the updates to a specific version.

1. Compare: Use this to compare different file versions.

Tip: Press the Control key to select two file versions.
In the Compare window, the updates between the selected files are displayed:
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Note: The latest version is displayed in the right window.
It is recommended that before checking in any file, compare the latest file that has been updated with the local file to ensure all
updates are included.
When a file is checked out for editing, the changes to the file are saved locally. Before the changes are checked in, it is recommended you compare it with the latest version of the file. To do this, select the latest version in the list and click 'Compare'. The Compare window will compare the latest version with local version as shown below:
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2. Rollback:Use this to revert updates/changes in the selected file to the selected version from the version history.

Select the version to which you want the updates to be rolled back and confirm:

On confirming, all the changes done since the selected version to the latest version will be rolled back.
Note: It is recommended you check in (upload) the file once it is rolled back to the selected
version so that the latest version reflects the updates.
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Upload Comments
Available with Enterprise Edition on purchase of a Version Control license only.
If you are enabled for version control, you will have to include comments while uploading your files. This ensures that the version history can be used as a reference point.

Uploading a Task to the Server
You can upload tasks to the Control Room Repository Manager using any of the four methods:
1. Selecting Upload from the Action button drop-down list

2. Clicking the 'Upload' button at the top right 'Task List' pane
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3. Right clicking the selected task and choosing 'Upload'

4. Selecting the task from the Repository feature:

l

When the task is successfully uploaded, a confirmation window is displayed. Click OK.

l

The task is displayed in the Server Repository Manager.

Downloading a Task from the Server
To download a task from the Repository Manager, you must follow these steps:
1. In the main Automation Anywhere window, click on Manage > Repository tab. The Repository is displayed, with a split screen showing files that reside on the server- Control Room as well as the client.
2. Highlight the task file that you want to download to the client.
3. Click the Download button. The task is copied to the client.
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Note: Be aware that files that are downloaded to the client with same names will be overwritten.
Before downloading files, be sure that the latest version of the task is on the server.
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Using the Task Editor
The Automation Anywhere Task Editor is the most powerful component of the product, providing business process specialists and IT
staff with all the tools necessary for enhancing, streamlining, and deploying automated processes.
The Task Editor provides hundreds of commands that you can use to create automated processes for your organization. It is unique in
the software automation industry: non-technical business users can quickly build and deploy automated processes with simple dragand-drop operations, yet the solution is flexible and robust enough for technical IT staff to build more complex, integrated, end-to-end
processes.

Opening the Task Editor
From the main window, you can open a task in the Task Editor any of the following ways:
l

Select a task from the Task List and click the Edit button.

l

Double-click on a task in the Task List, provided that double-click editing is enabled in the Advanced Settings for Edit Task. By
default, this setting runs a task when double-clicking. For more information, see Editing a Task.

l

Create a new task in the Task Editor by clicking on the New button, and select Task Editor.

Task Editor Components
The Task Editor provides the following components that make up the user interface:
l

Commands panel

l

Task Actions List

l

Action buttons

l

Error View and Variable Manager panel

l

Filters

Using the Commands Panel
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The left panel contains all of the Automation Anywhere commands that you can use to build and enhance automation tasks. You can
drag and drop these commands into the Task Actions List panel, move commands, and edit commands in bulk, if necessary.

Using the Task Actions List
For your convenience, the Task Editor can display multiple tasks at once using tabs at the top of the Task Actions List. Using these
tabs, you can open multiple tasks and edit them side-by-side, making copy/paste and reuse very easy. This also makes building larger
tasks easier: you can record smaller processes, refine them, and then combine them into one large, end-to-end complete process. For
more information, see Using the Task Actions List.

Using the Actions Buttons
At the top of the Task Editor window, several action buttons are available. These involve actions for creating a new task, running the
current task that is open in the Task Editor, saving the task, enabling debugging and setting snap points for certain commands.

1. New button to create a new task.

2. Record button to start recording in the current task.

Your mouse click and keystroke actions will be recorded with the Recorder:

Note: The recorded actions will be saved as Object Cloning command(s). Learn More.
3. Run button to run the current task.

4. Save button to save the current task.
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5. 'Enable Debugging' while creating tasks for complex processes.

6. 'Set SnapPoint' to capture screen-shots while the task is playing.

7. The 'Normal/Visualize' buttons to switch views - between task details (Normal) and a screen shot view of your task (Visualize).

l

While using the Task Editor, if you change the resolution of your screen, it is recommended that you restart Automation Anywhere.

l

At lower screen resolutions; say 1024 X 768, the buttons Undo, Redo, Edit, Delete, Copy and Paste might not display. To perform
those actions, use 'Actions' or the 'Context' menu.

(Image as seen in Enterprise Edition 8.2.1)
Note: On the same bar, actions are available for manipulating commands in the Task Actions List. For
more information on these buttons, see Using the Task Actions List.

Using Error View and Variable Manager
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You can use the Error View tab to manage errors that might occur in your task. The view is automatically updated as you make
changes to the task. The Error View panel is useful when you want to track the progress of longer tasks and debug them when errors
occur. Use the Error View panel in conjunction with the Error Handling capability to properly debug your tasks. For more information,
see Debugging Tasks.
The Variable Manager panel is useful when using several variables in your tasks. The Variable Manager displays the local variables
that are defined by the user for a particular task. You can use the Variable Manager to add, modify, and copy variables within automation tasks. For more information on how to use the Variable Manager, see Using the Variable Manager.

Using Filters
You can use the Filters bar to manage long tasks. When selecting these check boxes, the commands are made visible in the Task
Actions List. Using these filters can make isolating problems and viewing specific commands easier.
For more information on using the Task Editor Filters, see Using Filters in the Task Editor.

Editing a Task Using the Keyboard
If you prefer not to use the mouse to drag and drop commands, Automation Anywhere makes it possible to insert commands in your
task by using keyboard strokes. The Commands panel supports using Arrows, Tab, and Enter keys.
To open command windows, press the Enter key and complete the steps to specify command parameters.
This capability is useful for people who prefer to use quick keyboard shortcuts.
Tip: Type the first letter of a command to highlight it and ease navigation to that command. For
example, typing an "e" will highlight the Email Automation command.
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Saving as, Copying and Adding a New Task when Version Control is enabled
If you provide a new file name using any of the options - Save As, Copy or New, you will be able to add unique names only in the
respective folder in which it is being created. If you attempt to add an existing file name, you will not be allowed to do so:

Also See...
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Using the Task Actions List
The Task Actions List is the main workspace for building your automation tasks.

You can insert commands by dragging them from the Commands list. After you insert commands, you can modify them using the following options:
1. To edit the parameters (settings) for a command, double-click on the command.
2. To take action on the command, such as copying it, right-click on the command to view the options.
3. The Task Actions List bar provides buttons for manipulating commands. The following options are available:
l

Edit: Opens the command settings window to enable you to edit them.

l

Delete: Removes the command from the Task Actions List.

l

Copy: Copies a command for use in another location of the task.

l

Paste: Pastes a copied command at the location below the cursor.

l

Actions: Click on the Actions button to select one of the following actions:
a. Bulk Edit: Make changes to multiple Delay or Keystroke commands simultaneously.
b. Duplicate: Duplicate a command in the location below the selected command.
c. Convert to Variable: Convert a Keystroke command to a variable.
d. Convert to Prompt: Convert a Keystroke command to a prompt message.
e. Convert to if Web Control Exists: Runs the command if the specified Web control exists.
f. Convert If Windows Control Exists: Runs the command if the specified Windows control exists.
g. Insert If Condition: Inserts an IF condition for a selected block of commands.
h. Insert Error Handling: Inserts an Error Handling command for a selected block of commands.
i. Change Window Title: Change the name of a window title to one or more application windows.
j. Run from this Step: Runs the task when encountering this command.
k. Enable: Activates a command.
l. Disable: Disables a command.
m. Move Up:Moves a command up in the Task Action List.
n. Move Down:Moves a command down in the Task Action List.
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Using Filters in the Task Editor
By default, automated tasks are shown in the Automation Anywhere Task Editor with all commands and actions in chronological order
(sorted by time). However, to make working with tasks easier, it provides useful filters to enable you to customize your view. Filters are
particularly helpful when working with larger tasks.
Filters do not modify a task; rather, they enable you to focus on specific commands within a task without needing to modify the entire
task.

To view or hide particular commands in a task, select or deselect the filters in the Filter Bar in the Task Actions List.
The commands that you can filter include:
l

Mouse Moves: Display or hide all mouse move actions from the editor.

l

Keystrokes: Display or hide all Insert Keystrokes commands and actions from the editor.

l

Mouse Clicks: Display or hide all mouse click actions from the editor.

l

Delays: Display or hide all Delay commands from the editor.

l

Other: Display or hide all commands from the editor that are not mouse moves, keystrokes, mouse clicks or delays.

l

Windows: View all actions by application window. The drop-down list displays all application windows that are used in the task.

Using the Find Text Search Field
Use the Find Text search field to search within a task for names, text, variables, and other items. This can be helpful when editing
longer tasks.

Using the Windows Filter
You can use the Windows filter when a task involves two or more applications, such as the Calculator, Notepad, and Explorer. Use the
Windows filter when you want to view actions sorted by application.
In the drop-down list, select ALL, NONE, or the application title for which you want to view commands.

Also See...
l

Using the Task Actions List

Other User
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Active Directory Command
Available in Enterprise edition only.
Use this command to manage your Active Directory and create, modify, and delete users in the system with centralized control.

Overview
An Active Directory is a directory service that is provided by Microsoft. This facility assists the Administrator in managing users across a
group or wider organization.
Tip: All fields for the Active Directory command support the use of variables.
Automation Anywhere Enterprise uses LDAP (Lightweight Directory Access Protocol) to read from and edit users in the Active Directory. The Server name and Domain name are combined to create an LDAP path, which is used to connect to the Active Directory.

Establishing a Connection with Active Directory
To manage users in the Active Directory, ensure that a connection is established between the Administrator and the Active Directory
server. Users who are logged into the Active Directory should have privileges for connecting to the Active Directory server and viewing
the Server name, Domain name, user name and password details.

Sub-Commands
The Active Directory command provides the following sub-commands:
l

Create User

l

Modify User

l

Create Group

l

Modify Group

l

Create Object

l

Modify Object

l

Search

l

Get Property

Using the Sub-Commands
Follow these steps to insert Active Directory commands.
l

Create User Command:
This command creates a new user in the location specified in the Active Directory connection string. Follow these steps to insert
the Active Directory - Create User command.
1. Double-click or drag the Active Directory - Create User command to the Task Actions List pane. The Active Directory main
window is displayed.
2. To establish a connection with the Active Directory, provide the Login User name and Login Password or assign a variable
by pressing the function key 'F2'.
Tip: You can opt to input 'Credential Variables'* by selecting the required credential
keys from the list of 'Credential Variables' for enhanced security. Learn More
*Applicable from version 10.2.1

Other User
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3. Specify the Parent path in the Enter LDAP Path field.

3. If you do not know the Parent path, use the browse button to locate it.

Other User
Resources:

4. The Active Directory Object Browser window is displayed.

<update>
5. Enter the details for a new user. Check the password option check boxes as needed.
6. Click Save to complete the process.
l

Modify User Command:
This command enables you to modify or rename users in the Active Directory. Follow these steps to insert the Active Directory Modify User command.
1. Double-click or drag the Active Directory - Modify User command to the Task Actions List pane. The Active Directory main
window is displayed.
2. Select one of the options in the 'Select User Action' drop-down menu.

A. Rename User: Use the check boxes in the 'Enter Modify User Details to rename the user logon name and/or the
user account name.
B. Enable User Account: Enables a user account.

Other User
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C. Disable User Account: Disables a user account. Select the User Name or Logon Name to disable either one, in the
'Enter Modify User Details' section.

D. Delete User: Deletes the user from the Active Directory. Select the User Name or Logon Name to delete either one,
in the 'Enter Modify User Details' section.

E. Update User Details: Use this option to update the user's details.
F. Update Account Options: Use this option to set account attributes for the user. Select from four attributes: User must
change password at next login, Is Active, User cannot change password, and Password never expires.
G. Change Password: Use this option to change a user's password.
H. Set Property: Use this option to assign a value to a user property , view the current details and update them.
Tip: Alternately, if you are unsure of the 'User Name' that has to be modified, click the
browse button in 'Enter LDAP Path' section. You will be guided to the 'Active Directory Object
Browser'; select a user from the list to perform any of the above 'User Actions'.

Other User
Resources:

l

Create Group Command:
This command enables you to create a group in the Active Directory. Follow these steps to insert the Active Directory - Create
Group command.
1. Double-click or drag the Active Directory - Create Group command to the Task Actions List pane. The Active Directory main
window is displayed.
2. Select options for GroupName, Description, Group Scope and Group Type.

Other User
Resources:

Modify Group Command:
This command enables you to modify a group in the Active Directory. Follow these steps to insert the Active Directory - Modify Group
command.
1. Double-click or drag the Active Directory - Modify Group command to the Task Actions List pane. The Active Directory main window is displayed.
2. Select options for: Rename Group, Delete Group, Add Users To Group, Remove Users From Group and Set Property.
A. Rename Group: Use this option to rename an existing group.
B. Delete Group: Use this option to delete an existing group.
C. Add Users to Group: Use this option to add additional users to a group. A user list is displayed. Use the Add, Remove and Edit buttons and click on Add Users to the group.

Other User
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a. Adding/Editing/Removing multiple users in a Group: You can select a user or enter multiple users to add/edit/remove in/from a group from within the group list of the 'Active Directory Object Browser' Window.
Input the user names in the 'Enter user(s)' text box. If assigned, you can also insert variables.
Note: Multiple user names/variables must be separated with a ';' (semi-colon).

Other User
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b.

Adding Logon Names as User(s): If your Active Directory comprises users with same names, you can add 'Logon'
names instead as 'User(s)'. To do so, select the option 'The above names are Logon Names' in the 'Active Directory
Object Browser' window. Optionally, insert variable(s), if assigned.

c.

Editing Logon/User Names: You can edit your Logon Name, User Name and even the LDAP string, if input incorrectly.Select the User, Click 'Edit' and you shall be guided to the 'Active Directory Object Browser' window, wherein you
will be able to input the necessary changes. Click 'Save' once done.
Note: When editing a User Name, you can also select the 'Logon Name' option.

D. Remove Users from Group: Use this option to remove users from a group. A user list is displayed. Use the Add and Remove buttons and click on Remove Users.
E. Set Property:Use this option to assign a value to a group property.

Other User
Resources:

l

Create Object Command:
This command enables you to create a new object, either for Computer or for Organizational Unit, in the Active Directory. Follow
these steps to insert the Active Directory - Create Object command.
1. Double-click or drag the Active Directory - Create Object command to the Task Actions List pane. The Active Directory main
window is displayed.
2. Select the option for creating either a new Organizational Unit or a new Computer by using the radio button.

l

Modify Object Command:
This command enables you to modify an object in the Active Directory. Follow these steps to insert the Active Directory Modify Object command.
1. Double-click or drag the Active Directory - Modify Object command to the Task Actions List pane. The Active Directory main window is displayed.
2. Select options for: Rename Object, Delete Object, Move Object, and Set Property.
A. Rename Object: Use this option to rename an existing computer or organizational unit.
B. Delete Object: Use this option to delete an existing computer or organizational unit.
C. Move Object: Use this option to change the location of an existing computer or organizational unit.
D. Set Property: Use this option to assign a value to an object property.

Other User
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Search Command:
This command enables you to search the Active Directory for users of a group or run a query on the Active Directory. Follow
these steps to insert the Active Directory - Search command.
1. Double-click or drag the Active Directory - Search command to the Task Actions List pane. The Active Directory main window is displayed.
2. Select one of the following options from the drop-down window:
A. Get All Users of a group: Use this option to find all users that are members of a group, and stores them in a list variable.
Depending on the return type of the list variable, it contains the user names or the LDAP paths for the members.
B. Run Query: Use this option to specify an Active Directory query and run it. The query results are stored in a list variable,
either for object names or LDAP paths, depending on the option selected.

Other User
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Tip: For Active Directory (LDAP) queries, you may refer this link.
l

Get Property Command:
This command enables you to retrieve a specific property value for an object (user name, group name, computer, or organizational unit) to a variable. Follow these steps to insert the Active Directory - Get Property command.
1. Double-click or drag the Active Directory - Get Property command to the Task Actions List pane. The Active Directory main
window is displayed.
2. Select the object type: user, group, computer, or organizational unit.

Other User
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Also See...
l

Active Directory Command - Examples

l

Printer Settings Command

l

Services Command

l

SNMP Command

Other User
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App Integration Command
Available in Enterprise and Small Business editions only.
Use this command to integrate applications with your automated task and capture text data.

Overview
Automation Anywhere makes it easy for you to integrate any application with your automated tasks using simple drag-and-drop operations. The App Integration command supports a large number of applications, including Java and Windows applications.

Sub-Commands
The App Integration command provides the following sub-commands:
l

Browsers, such as Microsoft Internet Explorer and Mozilla Firefox

l

DOS command prompts

l

Java applications

l

Java Applets

l

Telnet Unix Shell

l

Windows applications

l

Other

Using the Command
To insert an App Integration command in your task, follow these steps:

Other User
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1. Double-click or drag one of the App Integration commands to the Task Actions List pane. The App Integration window is displayed.

2. Select the application type from the drop-down window.
3. Select a capture option. You can capture text data from any application window by using the following options:
l

Capture Window: Specify an application window title. When running the task, Automation Anywhere will capture the window as an image.

l

Capture Area: Specify a specific area of an application window to capture.

l

Capture Scrollable Text: Specify an area with scrollable text to capture all of the text in that area.

4. Select a window from which you want to capture the text.
5. Optionally specify a range of text, and assign the captured text to a variable.
The App Integration command is flexible, enabling you to specify a range of text to capture. Use the Before and After keywords to specify the range.
Example: In the text string:
"Version 5.1 (Build 2600.xpsp_sp3_gdr.090206-1234 : Service Pack 3) Copyright"
l

Specify "Version" in the Before keyword field, and "Copyright" in the After keyword field.

l

You can also specify that you want to trim the captured text to remove leading and trailing spaces.

l

Use this command to capture scrollable text that you cannot normally copy from documents like PDFs.
Note: Non-standard Windows controls are supported.

Other User
Resources:

Also See...
l

App Integration Command - Examples

l

Database Command

l

Email Automation Command

l

Excel Command

l

OCR Command

l

PDF Integration Command

l

Read from CSV/ Text Files Command

l

Terminal Emulator Command

l

XML Command

Other User
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Clipboard Command
Available in Enterprise and Small Business editions only.
Use this command to automate Windows clipboard activities.

Overview
The Windows Clipboard is a very common application, and is used for a wide variety of purposes. When you copy text to the Clipboard
(for example, by using Ctrl+C), you can then paste this text in another application (by using Ctrl+V). Automation Anywhere provides a
system variable, named $Clipboard$, that you can use to retrieve text that has been copied to the Clipboard.

Sub-Commands
The Clipboard command provides the following sub-commands:
l

Clear Clipboard

l

Assign to Clipboard

l

Assign from Clipboard

Using the Sub-Commands
To insert a Clipboard command in your task, follow these steps:
1. Double-click or drag one of the Clipboard commands to the Task Actions List pane. The Clipboard window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Clear Clipboard Command:
Use this command to clear the contents of the Clipboard.

Assign To Clipboard Command:
Use this command to assign the value of any variable that has been created using the Variable Manager to the Clipboard. You can
then access this value by using the $Clipboard$ system variable.

Other User
Resources:

Assign From Clipboard Command:
Use this command to assign the value contained in the Clipboard to any value type variable that has been created using the Variable
Manager.

Also See...
l

Clipboard Command - Examples

l

Using the Variable Manager

l

Using Variables

l

Value Type Variables

l

System Variables

l

Comment Command

l

Error Handling Command

l

Image Recognition Command

l

Screen Capture Command

Other User
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l

Play Sound Command

l

String Operation Command

l

Variable Operation Command

Other User
Resources:

Comment Command
Use this command to insert comments in your automation tasks to provide additional information about the task. Comments are
ignored when the task runs.
Comments are useful in annotating the task steps. Some people use comments to extensively document details about their tasks.
Some people use fewer comments just as reminders.

Inserting a Comment
To insert a comment, follow these steps:
1. Open the task in the Task Editor.
2. In the commands list, drag a Comment command to the Task Actions List, in the location where you want the comment to be displayed. Or, you can double-click the Comment command to insert it at the current location.
3. Type your comments in the Comment text box provided.
4. Click Save.
5. A comment is inserted in the task. You can copy this comment to add multiple comments, or move the comment to another position
in the task simply by dragging it.
The comment is displayed in green in the Task Actions List, and is always saved as a single line. Multiple-line comments are displayed
as a single line when the comment is saved.

Note: Though a command, a comment line is not executed.

Sample Comments

Other User
Resources:

Also See...
l

Comment Command - Examples

l

Clipboard Command

l

Error Handling Command

l

Image Recognition Command

l

Screen Capture Command

l

Play Sound Command

l

String Operation Command

l

Variable Operation Command

Other User
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Database Command
Use this command to integrate databases with your automated task and move or capture data.

Sub-Commands
The App Integration command provides the following sub-commands:
l

Connect

l

Disconnect

l

SQL Query

l

Insert/Update/Delete

l

Run Stored Procedure

Overview
Automation Anywhere enables you to transfer data between a database and other applications. You can import or export data, in various formats, and convert data from one format to another. For example, you might want to transfer and convert data while completing a
data migration project.
You can also transfer data from a custom database to a Microsoft Excel spreadsheet, or from one database to another in predefined
formats.
Restriction: For the Database command, Microsoft Access 2007 and Access 2010 users are required to use Microsoft Office 12.0
Access Database Engine OLE DB Provider.

Using the Sub-Commands
To insert a Database command in your task, follow these steps:
1. Double-click or drag one of the Database commands to the Task Actions List pane. The Database window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Connect Command:
Use this command to connect to a database by providing a session name and a connection string.
To complete the connection string, click the browse button to display the Data Link Properties window. Select the database provider
and type the full path of the data source. When done, click on Save.
You can opt to insert 'Credential Variable'* as a Connecting String by pressing function key 'F2' for enhanced security instead of building the Connection String. Select the required Credential Key and it's Attribute. Learn More.

*Available in Enterprise edition only from version 10.2.1
Tip: When using the 'Connect' command to select a target database, click on the 'Test Connection' button in the 'Data Link Properties' window to ensure that the database connection is working.
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Disconnect Command:
Use this command to disconnect from a database.

Other User
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SQL Query Command:
Use this command to issue SQL queries using a Select statement.
Tip: If you must use wildcards when executing SQL queries, insert "*" if using MSAccess or "%" in
MSSQL.
Optionally, you can:
l

Specify the number of records to fetch

l

Specify a timeout value for the query

l

Export the data file as a CSV (comma-separated) file in a specified location. Exporting data to CSV files support ANSI, UNICODE,
and UTF8 encoding.

Other User
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Insert/Update/Delete Command:
Use this command to specify an Insert, Update, or Delete operation by using a Select statement.

Other User
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Run Stored Procedure Command:
Use this command to run an existing procedure that is stored in your database. You can add and update by providing Input and Output
types of parameters.
You can export the data file to a CSV file in a specified location.

Other User
Resources:

Sample Scenario: Transferring Data from a Database
The following code snippet illustrates how a task can use a LOOP command to transfer data from a database to a target application.

Other User
Resources:

Tip: Use LOOP commands in conjunction with the Database commands to transfer data from a database to
another application. For example, you might loop 'Each row in an SQL Query dataset'.

Also See...
l

Database Command - Examples

l

App Integration Command

l

Email Automation Command

l

Excel Command

l

Loop Command

l

OCR Command

l

PDF Integration Command

l

Read from CSV-Text Command

l

Terminal Emulator Command

l

XML Command

Other User
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Delay/Wait Commands
Use the delay command to add a delay at a particular point in an automated task. Or the wait command to insert a wait condition in an
automated task.

Delay Command
l

In certain cases, you might want a task to wait a certain amount of time before moving to the next command. You can use a Delay
command to make the task wait, and you can specify the amount of wait time.

l

The Loop command is one of the more powerful commands in Automation Anywhere. When using loops, inserting delays can be
helpful for performing the subsequent actions in the task, optimizing the timing that occurs.

Using the Delay Command
To insert a Delay command, follow these steps:
1. Open the task in the Task Editor.
2. In the commands list, drag a Delay command to the Task Actions List, in the location where you want to the task to delay before
moving to the next command. Or, you can double-click the Delay command to insert it at the current location.
3. A Delay command is inserted in the task. You can copy this command to add multiple delays, or move the delay to another position
in the task simply by dragging it.
4. Optionally specify that the delay be in milliseconds or seconds. Or, insert a random delay by providing a range of numbers that
Automation Anywhere can use to generate a random number for the delay time.

Note: You can assign a variable to 'Regular Delay > Delay' and 'Random Delay > From and To' options.

Wait Command
l

For some applications, automating actions might require waiting for a screen to change, or another window to open. Let's say you
want to wait for the contents of a screen (or an area within your application) to change before performing the next set of actions
(such as commands, mouse clicks, or keystrokes). This is useful in many application windows where the text is not a selectable
format.

l

In this case, you might mark the area by using the capture button. An image will be displayed in the image preview so that you can
verify the captured portion. Keep in mind that the sample image is not used for comparison while the task is running; it is only used
to verify that the image was captured correctly. When the task runs, a screen shot of the area is captured, using the coordinates relative to the screen or window that you've specified. Here, let's call this image 'imageA.'

l

Automation Anywhere now waits for the amount of time to pass that you've specified, then begins comparing the images on the
page to imageA. It continues to compare the image in the marked rectangular section to imageA, and when differences occur, the
comparison stops and the task proceeds to the next command.

l

However, if the images never differ within the specified time, it either stops the task or proceeds to the next command.

Other User
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Sub-Commands
The Wait command provides the following sub-commands:
l

Wait for Window

l

Wait for Screen Change

Wait For Window Command
Use the Wait For Window command to wait for a specified window to open or close before the task performs the next command.

Wait For Screen Change Command
Use this command to wait until a rectangular image on the screen changes before the task performs the next command.

Other User
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Note: You can assign a variable when selecting a window in 'Wait for Window' and 'Wait for Screen
Change'.

Also See...
l

Delay Command - Examples

l

Wait Command - Examples

l

Loop Command

l

Pause Command

l

Run Task Command

l

Stop Task Command

Other User
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Email Automation Command
Available in Enterprise and Small Business editions only.
Use this command to automatically manage your email messages with your Automation Anywhere task.

Overview
You can use the Email Automation command to intelligently automate your mail server functions and handle incoming email messages. Specifically, you can automate the following activities:
l

Manage your incoming email messages and download attachments to specific folders.

l

Clear unwanted email messages.

l

Communicate with your mail server and monitor email activity.

l

Extract email data (such as Subject, Message, From:, To: , CC:, and attachments) to applications (Excel, Word, Notepad, and others) or folders on your computer.

l

Select either IMAP or POP3 servers.

l

Organize email messages while downloading them, based on status (All, Read, and Unread).

l

Select either HTML and Plain text formats for your email messages.

Sub-Commands
The Email Automation command provides the following sub-commands:
l

Get All Messages

l

Delete All Messages

l

Delete Message

Using the Sub-Commands
To insert an Email Automation command in your task, follow these steps:
1. Double-click or drag one of the Email Automation commands to the Task Actions List pane. The Email Automation window is displayed.
2. Specify the email server information in the Email Server Details fields. Provide a Host name, user name, and password.
Tip: You can provide Credential Variables* from the list by pressing function key F2 for
enhanced security. Learn More

* Applicable to Enterprise edition only from version 10.2.1
Optionally check the Server uses secure connection (SSL) check box for secure connections.
3. Select a server type. Depending on the email server in your environment, select either IMAP or POP3.
4. Select an email status (All, Read, or Unread).
5. Select a message format. You can download messages in HTML or plain text format.
6. Optionally specify a location to which you want to download the email data.
7. Click Save to save the command to your automation task.

Get All Messages Command
Use this command to download all incoming email messages from the mail server to a specified folder on your computer.

Other User
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The following screen shot shows how you can download messages from a POP3 server in HTML format.

Other User
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Delete All Messages Command
Use this command to delete all email messages from the mail server.

Other User
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Delete Message Command
Use this command to delete the most recent email message from the Inbox. Use a LOOP command with the Email Automation command.

Also See...
l

Email Automation Command - Examples

l

Database Command

l

Excel Command

l

Loop Command

l

PDF Integration Command

l

Read from CSV-Text Command

Other User
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l

Terminal Emulator Command

l

XML Command

Other User
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Error Handling Command
Use this command to handle errors while running a task, to aid in debugging the task.

Overview
By using the Error Handling commands, you can isolate errors that occur when running your tasks.
When an error occurs, you can continue the task after the error, or stop the task.

Sub-Commands
The Error Handling command provides the following sub-commands:
l

Begin Error Handling

l

End Error Handling

Other User
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Error Handling Options
Automation Anywhere provides the following options for error handling when an error occurs:
1. Take Snapshot: In case of any error, take a snapshot of the screen.
2. Run Task: Run another task when the current task encounters an error.
3. Log data into file: Log the error into a file.
l

For example, you can log the Error Line No. and Description, then use the system variables $Error Line Number$ and $Error Description$.

4. Send Email : Send an email when the error occurs. Optionally 'Attach Snapshot' and/or 'Attach Variable'. You can configure email
settings from Tools > Options > Email Settings
l

On selecting 'Attach Snapshot', a snapshot of the screen is attached to the email.

l

On selecting 'Attach Variable', a text file that lists the values of all Variables (System Variables + User Defined Variables) is
attached to the email.
Note: The System Variable Excel Cell will not be attached as the values input are
dynamic.

5.

Variable Assignment: Specify a value to be assigned to a variable and Set Task Status Pass or Fail depending on the Error
handling action.
l

This is more useful when one wants to Continue running a task, and thus in that case the user wants to set a specific value
to a particular variable.

Use any or all four of these options in combination. For example, you can run a task and log data to a file.
When any of the Begin Error Handling option is selected, End Error Handling is automatically inserted in the task editor. However, one
can also specifically select End Error Handling action when the related actions are completed.

Also See...
l

Error Handling Command - Examples

l

Using the Variable Manager

l

Using Variables

l

Value Type Variables

l

System Variables

l

Variable Operation Command

Other User
Resources:

Excel Command
Use this command to transfer data to and from Microsoft Excel spreadsheets.

Overview
The Excel command is one of the most powerful commands provided by Automation Anywhere. Microsoft Excel is one of the most
highly used applications in the world today. Most operations that involve using spreadsheets require repetitive tasks that can be automated.
Many Excel automation scenarios have been implemented by companies worldwide. Some common scenarios include:
l

Copying data from one Excel spreadsheet to another.

l

Extracting data from an application to an Excel spreadsheet.

l

Extracting data from a website to an Excel spreadsheet.

l

Moving data from an Excel spreadsheet to another application.

l

Transfer data from Microsoft Access to Excel.

l

Transfer Excel data to a website form.

l

Delete rows or columns in Excel.

l

Compare two columns or two cells in an Excel spreadsheet.

l

Sort data in Excel spreadsheets and delete duplicate rows.

You can also run Excel macros as part of complete, end-to-end processes.
Note: The Excel command is only supported for Microsoft Office 2000 and later.

Sub-Commands
The Excel command provides the following sub-commands:
l

Open Spreadsheet

l

Close Spreadsheet

l

Activate Sheet

l

Get Cell

l

Set Cells

l

Go To Cell

l

Run Excel Macro

l

Delete Cells

l

Save Spreadsheet

l

Find/Replace

Other User
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Open Spreadsheet Command
Use this command to open an Excel spreadsheet. If your task involves working with many spreadsheets and workbooks, you can specify the session name, sheet name and even passwords for users with read only or edit rights. Also, fetch data from spreadsheets with
headings.
Enabling Contains Header option -You can retrieve/fetch data from cells in spreadsheet(s) that contain headings in the first row. You
can enable the option in Open Spreadsheet to be able to apply it to relevant sub-commands for that particular session.
Refer Excel Command - Contains Header for details.
l

Excel Cell System Variable - has been introduce exclusively for the 'Contains Header' option; hence we recommended you use it
when configuring Excel operations - Get Cells, Set Cell, Go to Cell, Find/Replace and Delete Cells.

Note: For Automation tasks created in versions 8.1 and below, the Contains Header was applicable to
Get Cells command only. Hence to ensure that those tasks run properly, it is recommended that you reconfigure the command.

(Image as seen in Enterprise Edition 8.2)
Spreadsheet Password - Password options can be enabled in 'Advanced View'. You can open/edit your password protected spreadsheet(s)and workbook(s) by enabling the 'Spreadsheet Password' option. Specify the password(s) to open and/or modify your spreadsheet(s).

(Image as seen in Enterprise Edition 8.2)
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If you wish, you can assign a variable to your password(s). The specified password(s) are secure as they are encrypted. You can opt to
provide a local variable or a 'Credential Variable' for enhanced security* by clicking function key 'F2'. Learn More
*Applicable to Enterpise Editon only from version 10.2.1
Note: When enabling the 'Spreadsheet Password' option, ensure that you specify either the 'Read
Only' or 'Editable' mode listed in the 'Open Read-Only Recommended Spreadsheet' option.
Open Read-Only Recommended Spreadsheet - You can also select 'Open Read-Only Recommended Spreadsheet' independently to
open these in 'Read Only' or 'Editable' Mode.
l

For instance, if your spreadsheet is password protected and read only you will be required to specify the 'Password to Open' plus
select 'Read Only Mode'.

l

If, however, you specify passwords to 'Open' and 'Modify', you have the option to open the spreadsheet in either 'Read Only' or 'Editable' Mode, as required.

Close Spreadsheet Command
Use this command to complement the Open Spreadsheet command. It closes a spreadsheet that is previously opened using an Open
Spreadsheet command. The command identifies the spreadsheet using the session name that was provided in the Open Spreadsheet
command.

(Image as seen in Enterprise Edition 8.2)
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Activate Sheet Command
Use this command to activate a specific spreadsheet in an open workbook.

(Image as seen in Enterprise Edition 8.2)

Get Cells Command
Use this command to retrieve the values of the active cell or a specific cell, as well as a range of cells from the spreadsheet opened by
the Open Spreadsheet command. When you retrieve values for an active or specific cell, you can assign the value to a variable.

(Image as seen in Enterprise Edition 8.2)
When retrieving values from multiple cells, the values are assigned to an $Excel Column (index)$ system variable. You can use this
variable in subsequent commands, for example, to loop through each row in the spreadsheet.

Other User
Resources:

Set Cells Command
Use this command to set the value of the active cell or a specific cell in an Excel spreadsheet previously opened using the Open
Spreadsheet command. You can also use a variable to assign the value in the cell.

(Image as seen in Enterprise Edition 8.2)

Go to Cell Command
Use this command to move to a specific cell. The movement options include:
l

Move one cell to the left or to the right of the active cell

l

Move one cell above or below the active cell

l

Move to the beginning or end of a row or column within a spreadsheet that was previously opened using the Open Spreadsheet
command.

Note: In Active Cell, End of the row/column refers to "end of the row/column where the data
ends"; not the end of spreadsheet row/column.

Other User
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(Image as seen in Enterprise Edition 8.2)

Run Excel Macro Command
Use this command to run an Excel macro that is stored within an Excel spreadsheet that was previously opened with the Open Spreadsheet command.

(Image as seen in Enterprise Edition 8.2)
Note: Automation Anywhere

Other User
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now enables you to Run Local and Global Macros seamlessly.

Delete Cells Command
Use this command to delete the values in the active cell or in a specific cell within an Excel spreadsheet that was previously opened
using the Open Spreadsheet command.

(Image as seen in Enterprise Edition 8.2)

Save Spreadsheet Command
Use this command to save a spreadsheet in an open workbook.

(Image as seen in Enterprise Edition 8.2)

Other User
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Find/Replace Command
Use this command to find and replace data in a spreadsheet within an open workbook. You can specify a cell range with specific
search options.

(Image as seen in Enterprise Edition 8.2

Using the Load Add-ins Option
Use this option when opening an Excel spreadsheet in which Add-ins are required.

Using the Sub-Commands
To insert an Excel command in your task, follow these steps:
1. Double-click or drag one of the Excel commands to the Task Actions List pane. The Excel window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Other User
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Use Case Scenario
Copying data from Excel to Notepad
To copy the content (data) of selected cells from Excel to notepad, follow the steps given below:
1. Launch the Task Editor.
2. Drag and drop or double click the 'Open Spreadsheet' option under the 'Excel Command' node to the Task Actions List pane.

(Image as seen in Enterprise Edition 8.2)
a. Specify the session name and spreadsheet path. Select the option 'Specific Sheet Name' if it has more than one spreadsheet worth of data.
b. Also select the 'Load Add-in' option, if applicable.
c. Click Save.
3. Drag and drop/double click the 'Get Cell' option under Excel Command to copy the cell data.

(Image as seen in Enterprise Edition 8.2)

Other User
Resources:

a. Specify the option 'Get Multiple Cells', session name and cell range in the 'From Specific Cell' & 'To Specific Cell' to copy
multiple cells from the spreadsheet.
b. Click save.
l

The next step involves opening the application to which the cells are to be copied.

5. Drag and drop/double click the 'Open File/Folder' command.

(Image as seen in Enterprise Edition 8.0)
a. Specify the file name or select from a specific path by clicking

.

b. You can provide the 'Start in' Path or set 'Parameters' and 'Launch Program/File' optionally.
c. Click save.
l

At this juncture, you need to insert a loop that allows you to copy each row from the spreadsheet specified in the 'Open Spreadsheet' session.

6. Drag and drop/double click the 'Loop' command.

(Image as seen in Enterprise Edition 8.2)
a. Select 'Each row in an Excel dataset' and save.

Other User
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l

Now assign the copied data to a variable.

7. Drag and drop/double click the 'Insert Keystroke' Command.

(Image as seen in Enterprise Edition 8.2)
a. Select the file to which the data is to be copied from the 'Select Window' drop down.
b. Select 'Encrypt Keystrokes' to enable encryption.
c. Insert appropriate keystrokes and variables and click save.
8. Include the following comment and save:

(Image as seen in Enterprise Edition 8.0)
Note: This will mark end of the loop.

Other User
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9. Drag and drop/double click the 'Close Spreadsheet' option:

(Image as seen in Enterprise Edition 8.2)
a. Specify the 'Session Name' and save.
l

The following depicts the above created task:

10. Save the task.
Learn more about similar examples from our online section Excel Automation
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Email Automation Command
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OCR Command
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PDF Integration Command
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Read from CSV-Text Command
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Terminal Emulator Command
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XML Command
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Excel Command - Contains Header
Applicable from version 8.1.2 onward
When using Excel operations for fetching/retrieving large amounts of data from excel spreadsheets that has its first row defined as a
heading, you need to specify the rows and columns in a manner that they take those headings into consideration.
The 'Contains Header' option allows you to configure the command parameters to include or exclude headers; as the case may be.
l

A sample Excel spreadsheet with Headings:

Contains Headers in Excel operations
Contains Header allows you to retrieve/fetch data from the active spreadsheet that has its first row defined as a header. You can define
the option in Open Spreadsheet for a particular session. It is applicable to Excel operations Get Cells, Set Cell, Go to Cell, Find/Replace and Delete Cell for that particular session (as configured in Open Spreadsheet).
Also, in cases where one or more columns of the target Excel spreadsheet change position due to any update (i.e. introducing new
columns/deleting existing columns), the corresponding automation task has to be updated to accommodate the change. Using 'Contains Header' you can enable the task to automatically map re-positioned columns of the target Excel spreadsheet.
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Excel Cell Variable - a must for Contains Header option
You can use the System Variable - Excel Cell when configuring Contains Header. This variable is exclusive to Contains Header.

Excel Cell should be used while configuring Excel commands Get Cells, Set Cell, Go to Cell, Find/Replace and Delete Cell. During
play time, the variable will indicate the column name and position of the cell from the header. It gives the column reference to the
defined cell; e.g cell defined is A5, it will refer to Row A , Column 6, if 'Contains Header' is enabled.
Note: The string defined in the variable has to be an exact match. For instance, while retrieving/fetching data from each cell/specified cells under the heading 'Id', use the System variable $Excel
Cell(Id,2)$; variables such as '$Excel Cell(id,2)$' or '$Excel Cell(<space>Id<space>),2$' will be considered invalid.
When you use this variable, without configuring the Open Spreadsheet command, the program throws an error during play time - "To
enable Excel Cell variable configure Open Spreadsheet command."
To know more about the variable, refer Excel System Variables.

The where and how of Contains Header
You can apply the Contains Header option for Excel operations:
1. Open Spreadsheet - Contains Header option is controlled from this sub-command as it is configured to the session specified here.
Consequent Excel operations will consider the option; whether selected or not for the session specified in this command. Hence,
configuring this command is a must.
Reference Points:
l

When you open multiple spreadsheets during automation, the program considers the last spreadsheet action. It means that
if 'Contains Header' is enabled in Session 1 and not in Session 2, the consequent command will not have Contains Header
enabled unless you specify the particular session that has Contains Header (Session 1 in this case).

l

In spreadsheets with duplicate header name/content, the program will consider the first occurrence of the header name/content.

l

If you include an invalid value or the header row mismatches, the program will throw an error during play time.

l

You can input maximum three (3) alphabets for a Column title (e.g. ABC); if you input more then you will encounter an error
"Check the value specified in the Column Title. You can input up to 3 alphabets only."

2. Get Cells - For the 'Get Single Cell' or ' Get Multiple Cells' parameters, include the Excel Cell variable in the 'Specific Cell' or 'From
Specific Cell' and 'To Specific Cell' text boxes as shown:

In the variable, input the cell heading title. For e.g. if the cell range specified is A5 through A10, define the variable with heading
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title as given in cell A1; in this case "Id".

Note: In editions earlier to 8.1, Contains Header was applicable and available in Get Cells
command only. If you are re-configuring a task that uses that version with 'Contains Header'
enabled, it will be "grayed out." It is recommended that you re-configure the command in the task
if you want the task to run properly in the current edition.

l

Set Cell - You can apply the 'Contains Header' option to parameters Active Cell and Specific Cell when configuring the Set Cell
command. If the cell position shifts, values in the specified cells will be set appropriately.
You cannot, however, reset value in the cells if the selected cell, is a header cell. You will encounter the error "The specified cell is
part of the header row. You cannot set value in it as 'Contains Header' is enabled." during play time.
You will also not be allowed to set the value of a cell that is defined as a header title. Same is true, if it's in edit mode and the option
is enabled.

l

Go to Cell - You can Go to a specific or active cell when 'Contains Header' is enabled. All conditions that are applicable during Set
Cell are also applicable here.

Note: In Automation Anywhere Excel Command, Active Cell > End of the row/column refers to "end
of the row/column of data"; not the end of spreadsheet row/column.

l

Delete Cells - When using this command for 'Contains Header', you will not be allowed to delete the cells that have a header title
defined i.e. the first row of the spreadsheet. If you have specified a cell that is defined as a header - either by using the active or specific cell parameter, you will encounter the error "The specified cell is part of a header row. You cannot delete it as 'Contains
Header' is enabled." during play time.

l

Find/Replace -When using this command for 'Contains Header', you will be allowed to Find a cell value by Row/Column but
Replace the content in only those cells that are not defined as header titles. If you specify a cell that is defined as a header, you
will encounter the error "The specified cell is part of a header row. You cannot replace its value as 'Contains Header' is enabled."
during play time.
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Excel System Variables
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File and Folder Commands
Use the File and Folder commands to automate common operations that involve manipulating files and folders.

Overview
These days, most occupations require the organizing and manipulation of files and folders on computer systems. Automating these
tedious tasks can help organizations become more efficient. In addition, less human error occurs when automating.
The File and Folder commands provide an easy way to automate creating, opening, copying, moving, renaming, deleting, and organizing files and folders.
The File and Folder commands also offer advanced operations for working with files and folders based on their size and date created
or modified.

Using the Sub-Commands
Open File Command
Use this command to open an existing file.
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Open Folder Command
Use this command to open an existing folder.

Copy Files Command
Use this command to copy an existing file.

Other User
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Copy Folder Command
Use this command to copy an existing folder.

Rename Files Command
Use this command to rename an existing file.

Other User
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Rename Folder Command
Use this command to rename an existing folder.

Delete Files Command
Use this command to delete an existing file.

Other User
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Delete Folder Command
Use this command to delete an existing folder.

Create File Command
Use this command to create a new file.
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Create Folder Command
Use this command to create a new folder.

Zip Files Command
Use this command to compress a group of files into a ZIP file.
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Unzip Files Command
Use this command to unzip and extract a group of files that has previously been zipped.

Print File Command
Use this command to print a file.

Other User
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Print Multiple Files in a Folder Command
Use this command to print all of the files that reside in a folder.

Create File Shortcut Command
Use this command to create a shortcut for opening a file. For example, you might want to create a shortcut to a file on a user's desktop.

Other User
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Create Folder Shortcut Command
Use this command to create a shortcut for opening a folder. For example, you might want to create a shortcut to a folder on a user's
desktop.

Also See...
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FTP/SFTP Command
Use the Automation Anywhere FTP/SFTP command to automate any FTP task.

Overview
FTP (File Transfer Protocol) is a standard network protocol used to transfer files from one host to another host over a TCP-based network, such as the Internet.
You can use the Automation Anywhere FTP/SFTP command to automate the following:
l

Use FTP for file uploads and downloads

l

Back up websites

l

Use Secure FTP for secure remote file transfer

The FTP/SFTP command provides an Advanced View option for working with files and folders based on when they are created or modified.

Using the FTP/SFTP Command
To insert an FTP/SFTP command in your task, follow these steps:
1. Double-click or drag one of the FTP/SFTP commands to the Task Actions List pane. The FTP window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.
The FTP/SFTP command includes the following options:
l

Connect to FTP/SFTP server: Specify the FTP/SFTP server name, user name, and password. Anonymous login to FTP/SFTP servers is supported. Click the Advanced View button to set advanced connection options.
Tip: For enhanced security, insert 'Credential Variables' from the list of variables using the
function key 'F2'.Learn More.
* Available in Enterprise edition only from version 10.2.1

l

Disconnect from FTP/SFTP server: Terminates the connection to an FTP/SFTP server.

l

Put Files: Uploads one or more files from a folder.

l

Get Files: Downloads one or more files to a local machine from an FTP/SFTP folder.
The FTP/SFTP command also offers advanced operations for working with files based on the date they are created or modified.

l

l

Put Folder: Upload an entire folder from a local machine to an FTP/SFTP server. You can specify filters using wild card characters
to restrict uploads to specific types of files.
Get Folder: Download an entire folder from an FTP/SFTP server to a local machine. You can specify filters using wild card characters to download only specific types of files.
The FTP/SFTP command also offers advanced operations for working with folders based on the date they are created or modified.

l

Delete Files: Delete one or more files from an FTP/SFTP folder.

l

Rename Files: Rename one or more files in an FTP/SFTP folder.

l

Create Folder: Create a folder on an FTP/SFTP server.

l

Delete Folder: Delete a folder (including all sub-folders and files within it) from an FTP/SFTP server.

l

Change Folder: Move to a different folder on an FTP/SFTP server. Use this option when you want to download or upload files in

Other User
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more than one directory on your FTP/SFTP server.
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IF/ELSE Command
Use this command to add conditional logic and actions to your automated task.

Sub-Commands
The IF/ELSE command provides the following sub-commands:
l

File Exists / File Does Not Exist

l

Folder Exists / Folder Does Not Exist

l

Window Exists / Window Does Not Exist

l

Application Running / Application Not Running

l

Script Successful / Script Unsuccessful

l

Task Successful / Task Unsuccessful

l

Ping Successful / Ping Unsuccessful

l

Variable

l

File Size

l

File Date

l

Web Control

l

Image Recognition

l

Service Running / Service Not Running

l

Windows Control

l

Else If

l

Else

l

End If

Overview
One of the most powerful features of Automation Anywhere is the IF/ELSE command. You can use the sub-commands to perform
actions when certain conditions exist.
When using most of the conditional sub-commands, you can specify how long to wait for the condition to be true before taking another
action.

Using the Sub-Commands
To insert an IF/ELSE command in your task, follow these steps:
1. Double-click or drag one of the IF/ELSE commands to the Task Actions List pane. The IF/ELSE window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Other User
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File Exists/File Does Not Exist Commands
Use these commands when you want to perform an action based on whether a file exists. For example, if a data file exists, you might
format the file and upload it to a database.

Folder Exists/Folder Does Not Exist Commands
Use these commands when you want to perform an action based on whether a folder exists.

Other User
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Window Exists/Window Does Not Exist Commands
Use these commands to do the following:
l

Check or verify that a specific application is open.

l

Check whether an error has occurred.

l

Check whether a file download has completed.

These are some of the most frequently used commands in Automation Anywhere.

Application Running/Application Not Running Commands
Use these commands to perform an action based on whether an application is running. When a program is running in the background,
you can still perform actions by using this command.

Other User
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Script Successful/Script Unsuccessful Commands
Use these commands to integrate third-party scripts with your automation task. After the script runs and issues a return code, Automation Anywhere can determine if the script ran successfully.
For scripts that you have already developed, you can use this command to integrate them with your automation task.

Task Successful/Task Unsuccessful Commands
Use these commands to run several Automation Anywhere tasks, one after another. The command runs the selected task, and depending on the return code, determines if it ran successfully and takes appropriate actions based on the result. For example, if a task that
monitors your website runs successfully, it means that your website is up and no action is required. However, if the task is unsuccessful, it means that the website is down and you need to take action.
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Ping successful/Ping Unsuccessful Commands
Use these commands to check whether a machine or server is running, and take appropriate action based on the result.

Variable Command
This command, though it looks simple, is perhaps the most powerful conditional command. Use this command to perform hundreds of
checks.

For example, you can copy data from an application or website and verify that the data you copied matches a specific text string. You
can also verify a numeric string, or check to see if it is greater than or less than a variable or a fixed value.

Other User
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Using AND or OR conditions in IF Variable command*
* Available from version 7.5.2 onward
When you need to include the 'AND' or 'OR' conditions in conjunction with the 'Variable' sub-command, use the 'Add
more conditions' option. It offers you the luxury of including all your AND or OR conditions within a single parameter,
instead of specifying separate parameters for each condition as was the case in earlier editions of Automation Anywhere.

(Image as seen in Enterprise Edition 8.0)
Enable the 'Match Any' option for 'OR' conditions or 'Match All' for 'AND' conditions (refer image below)

(Image as seen in Enterprise Edition 8.0)
Note: You cannot include both; 'Match Any' + 'Match All' within a parameter. You are
required to specify them within a task, separately.
Reference the examples topic to understand how to shorten your tasks when using 'AND' or 'OR' conditions.

File Size Command
Use this command to check whether a file is larger, smaller, or the same as a size you specify.

Other User
Resources:

File Date Command
Use this command to check the date and time that a file was created or last modified. You can specify a date range using 'between' or
'before' keywords. You can also specify a range using a number of days or a time schedule hh:mm:ss format.

Web Control Command
Use this command to identify whether a specific web control exists on a Web page. For example, your task can check for links, text
boxes, and drop-down menus.
Use this command when editing tasks that are created using the Web Recorder.
Note: If you have upgraded to version 8.1.2 and change the parameter to 'Select Page', you will have
to re-capture the control. Refer Editing a Web-only Task with Web Recorder Command for details.

Other User
Resources:

Image Recognition Command
Use this command to check whether an image exists within another image. Automation Anywhere can recognize images that are
stored in files or captured from a window when the task runs. You can even specify a minimum 'percentage match' for the If command
to be true. Image Recognition also provides a powerful tool that enables you to click on an image if it is found within the larger image.

Service Running/Service Not Running Commands
Use these commands to check whether a particular service is running.

Other User
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Windows Control Command
Use this command to check whether a specific control exists in an active window. For example, you might check for command buttons,
list box items, text boxes, or menu tabs.

Setting a Wait Time for Conditions
Most of the conditional commands let you specify how long to wait for a condition to be true.
Let's say you want to perform an action only if a specific window exists. You know that it might take from 5 seconds to 5 minutes for the
window to open. Obviously, you don't want to wait 5 minutes when the window comes up in just 30 seconds. Automation Anywhere
takes care of this for you by following this model:
Using the IF command, you can select IF and 'Window does not exist,' and type the maximum time in seconds to wait for the window to
be displayed. (In this case, 5 minutes, or 300 seconds.)
Automation Anywhere checks for the window to be displayed. If it appears in 30 seconds, Automation Anywhere immediately begins
running the commands you specified within the conditional IF.
If you leave the 'How long would you like to wait...?' field empty, or enter '0 (zero)', Automation Anywhere checks for the condition immediately and runs the actions. If the condition does not exist, these actions are skipped and the actions that follow the ENDIF are run.

Also See...
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Loop Command
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Image Recognition Command
Feature also available in Standard edition version 8.1.2 or higher.
Image recognition command provides a visual approach to make your automation task work with the applications and interfaces with
stunning accuracy. It acts as a "human eye" would act, accounting for the various parts of the image. Thus, Image recognition command makes it easy to divide and manipulate images.
Use this command to quickly search for a desired image within a source image and to readily automate any application that uses
visual elements. Another major benefit of using image recognition is to locate an image after the image might be moved, for example,
from one location on a web page to another.

Using the Image Recognition Command
To use the Image Recognition command, follow these steps:
1. Select an image file from a folder or that is captured from an application window. This image can be standalone or contained within
another image that is captured dynamically at run time.
2. To locate the image at run time, specify the minimum percentage match for which you want the command to return TRUE.
3. Select an option for clicking on the image when it is found within a larger image. You can select Left Click, Double-Click, or Right
Click.
If you are using the command for a window application, you also have the flexibility to position your click location. Just position the '
cross-hair* ' at the spot where you wish to click during run time when the image is found.

Note: If using in conjunction with 'If - Else' command, select the option 'If the image is
found, click on it'. for the crosshair to appear.
For larger images, you can scroll and position the 'cross-hair' as required.
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* Available from version 7.5.1 onward
Tip: To get back to the default cross-hair position (center of the image), simply click 'Reset
Crosshair'.
Select the options - Match Percentage, Tolerance and Comparison Mode:
l

Match Percentage: A 0 (zero) Match Percentage means none of the pixels should mismatch between the two images. A Match Percentage of 20 means that even if up to 20% of pixels mismatch between the two images, the images will be considered to match.
Use for images that are quite similar, yet are not matched.

l

Tolerance: A 0% Tolerance means the individual RGB values of the pixels being compared must match, exactly. Similarly, a 20%
tolerance could allow the individual RGB values of the pixels to vary from + 20% to - 20% for a successful match.
a. While Match Percentage defines the extent of overall mismatch allowed between Image1 and Image2, Tolerance defines
the extent of mismatch allowed between any two pixels under comparison.
b. The RGB color space uses 8 bits each for red, green and blue and can have integer values ranging from 0 to 255.
For instance when using Tolerance,
l

Case1 - mismatch with 20% Tolerance Image1 pixel values:
Image2 pixel values:

l

Case2 - successful match with 20% Tolerance Image1 pixel values:
Image2 pixel values:
In Case1, the images are clearly a mismatch. The difference in R value of both images exceeds the Tolerance limit by 10
(20% of 255 is approximately 50 and 250 - 190 > 50). While in Case2 it's a successful match as the difference between the
R,G and B values of both images fall within the Tolerance limit.

l

Comparison Mode: Select one of the methods of comparison:
a. Normal mode: Compares the RGB components of the pixels with the source. Use this when you are not bothered about the
speed and want exact color match in complex scenarios.
b. Gray-scaled mode: Converts pixels to an appropriate level of gray-scale prior to comparing. Use this when colors are of limited benefit in comparison and you want your test to run faster.
c. Monochrome mode with Threshold: Converts pixels to either black or white prior to comparing. The threshold value is used
while converting the RGB or Gray-Scaled pixels to either black or white (a pixel value less than the threshold value is black;
greater is white). Use this when you want to recognize multi-colored text against multi-colored backgrounds.

l

A 'Quick Test': Use the 'Quick Test' button to quickly ascertain the output is as required. This eliminates the need to run the entire
test.
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a. A 'Quick Test', being similar to an actual test, includes the parameters provided for Match Percentage, Tolerance and Comparison Mode.
b. If variables are used in the task, 'Quick Test' will not be applicable.
c. For tasks created in earlier versions (prior to 7.5), 'Quick Test' will work only after you recapture the image as this feature is
available from version 7.5 onward.

Tips and Tricks:
l

Click on Image1 to preview in the default picture viewer.

l

For faster image recognition, if a particular color dominates the entire screen (say gray),
make sure that the starting pixel of image 2 (the one on the upper left corner) doesn’t include
that color.

l

For Faster image recognition, ensure Image2 to be recognized is as small as possible.

l

Use delay wisely.
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Insert Keystrokes Command
Use this command to automate the typing of keystrokes in an application using your automation task.
To insert keystrokes, follow these steps:
1. Open the task in the Task Editor.
2. Double-click or drag the Insert Keystrokes command to the Task Actions List pane. The Insert Keystrokes window is displayed.

3.

In the Select Window drop-down list, select the title of the application in which you want to type keystrokes.
Note: You can insert a variable here by pressing the function key 'F2'. You can opt to insert
either User (Local) variables or Credential Variables for enhanced security.
Learn More about benefits of using Credential Variables*.
* Available in Enterprise edition only from version 10.2
Applications that you have already referenced in the task are listed at the top of the drop-down list. Applications that are currently open are listed below the dotted line in the list.
Tip: Before using the Insert Keystrokes command, verify that the application window is open. If
the application is not listed in the Select Window drop-down list, open the application and click
the Refresh button in the Insert Keystrokes Select Window drop-down list.

4.

In the Keystrokes text box, type (or cut/paste) the text you want inserted when the task runs.
To insert special keystrokes such as Control, Shift, or Tab, click the button in the Special Keystrokes box.
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l

5.

For example, if you want the task to type Ctrl + C in an application, click Ctrl Down, type 'c,' then click Ctrl Up. The following
commands and text in the Keystrokes window will be displayed: [CTRL DOWN]c[CTRL UP]. Similarly, if you want to type
Ctrl + Shift + a, click Ctrl Down, Shift Down, type 'a,' and click Shift Up and Ctrl Up.

To prevent your tasks from being altered by unauthorized users, use the Keystroke Encryption option. This option hides sensitive information or passwords that are typed using the Insert Keystrokes command.

To prevent unauthorized users from turning off this option, password protect the automation task. For more information on security, see Setting Security Features for a Task.
6.

If required, you can add a delay to this command.
Note: The default delay is 0 (Zero) milliseconds.
You can even associate a variable with delay:

7. Click Save to save the command to your automation task.

Using Wild Cards
In the Select Window text box, you can type a wildcard character (*) at the start or end of the window title. This is helpful, for example, if
you expect the window title to change over time. For example, you can type 'Microsoft Excel*' or '*Excel' or '*Excel*,' so that the window
will still be selected when the task runs, even if the window title has changed to reflect the name of an open document. However, if you
know the exact title of the window, we recommend that you type the complete window title to ensure that the actions will always performed only in that window.

Also See...
l
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l

Insert Mouse Click Command

l

Insert Mouse Move Command

l

Insert Mouse Scroll Command

Other User
Resources:

Insert Mouse Click Command
Use this command to automate mouse clicks in your automation task.
To insert a mouse click command, follow these steps:
1. Open the application in which you want to enter a mouse click.
2. In the Automation Anywhere Task List, select the task and click Edit.
3. In the Task Editor, drag or double-click the Insert Mouse Click command. The Insert Mouse Click window is displayed.

4. In the drop-down list at the top, all open applications are listed. Select the application in which you want to enter a mouse click. A
small graphic image of the window you selected is displayed.
If you do not see the application in the drop-down list, make sure the application is open and click Refresh.
5. For Applications that change titles: If the name of the application window title changes over time, you can use a wild card character (*) at the start or end of the window title that you specify. This ensures that the application is consistently found when running
the task.
For example, to ensure the Microsoft Excel application is always found, use 'Microsoft Excel*' or '*Excel' or '*Excel*'.

Note: If you anticipate that the application title will never change, specify the exact name to
ensure that the task references the correct application window.
6. Click Capture. Automation Anywhere activates the window you selected in step 4. Click in the window in the location where you
want to insert the mouse click. Optionally, you can click Advanced View and set the following options:
l

Select the mouse button to click: Left Button, Middle Button, or Right Button.

l

Select the type of click: Click, Double Click, Button Down, or Button Up.

l

Select Relative To Screen or Window. Use the Window option when you work with varying screen resolutions (for example,
a dual-monitor).

7. Click Save.

Other User
Resources:

Also See...
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Insert Keystrokes Command

l

Insert Mouse Move Command

l

Insert Mouse Scroll Command

Other User
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Insert Mouse Move Command
Use the Insert Mouse Move command to automate the movement of a mouse from one location to another.
The Mouse Move command is useful in automating menu navigation, such as when using the Windows Start menu, where moving the
mouse over an item displays a new sub-menu. Inserting mouse clicks do not require moving the mouse to the click location.
To record mouse cursor movements, follow these steps:
1. Open the application in which you want to insert a mouse movement.
2. Open the task in the Task Editor.
3. In the Task Actions List, select the action after which you want to insert a mouse movement.
4. In the Commands list, double-click or drag the Insert Mouse Move command. The Insert Mouse Move window is displayed.

5. Select the Mouse Position (From) and click the Capture button to insert the mouse movement. Alternately, you can specify numeric
values, or press the F2 key to insert variables for the X and Y coordinates in Mouse Position (From).
6. After you click on Capture, Automation Anywhere switches to the active window in the application.
7. In the active window, click on the left mouse button and drag the cursor to the location in which you want the mouse movement to
begin. Release the mouse button. This step automatically captures the required information regarding the start location of the
mouse movement.
8. In the Insert Mouse Move window, select the Mouse Position (To) and click on Capture. Alternately, you can specify numeric values, or press the F2 key to insert existing variables for the X and Y coordinates in Mouse Position (To). The yellow prompt bar will
change to red if the content you click is not a table.
9. After you click on Capture, Automation Anywhere switches to the active window in the application.
10. Click on the left mouse button and drag the mouse cursor to the location in which you want the mouse movement to end. Release
the mouse button.
11. Optionally add a delay in milliseconds.
12. Click Save.

Also See...
l
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Insert Keystrokes Command

l

Insert Mouse Click Command

l

Insert Mouse Scroll Command

Other User
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Insert Mouse Scroll Command
Use this command to automate the action of mouse scrolling. Use this command in conjunction with the Insert Mouse Click command.

To insert a mouse scroll command, follow these steps:
1. Select a the application window in which you want to insert a mouse scroll action.
2. Open the task in the Task Editor.
3. Double-click or drag the Insert Mouse Scroll command to the location required in the Task Actions List. The Insert Mouse Scroll window is displayed.
4. Select a scrolling direction option, either Up or Down .
5. Enter number of iterations.
6. Specify the delay time required.
7. Click Save. The mouse scrolling action is inserted in the task.

Also See...
l
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l

Insert Keystrokes Command

l

Insert Mouse Click Command

l

Insert Mouse Move Command

Other User
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Internet Connection Command
Use this command to have your task automatically connect to the Internet using a dial-up connection.

Using the Internet Connection Command
To insert an Internet Connection command in your task, follow these steps:
1. Double-click or drag the Internet Connection command to the Task Actions List pane. The Internet Connection window is displayed.
2. Select the dial-up connection from the drop-down list.
3. Specify whether you want to repeat the connection attempt if it fails. You can specify the number of times to attempt the connection,
and the time interval between connection attempts.
4. Click Save to save the command to your automation task.
You can also insert a Disconnect command in the task to disconnect the dial-up connection.

Error Messages
If you do not select or specify a connection from the drop-down list, the program will display an error.
Note: Only dial-up connections can be used with this command.

Also See...
l
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l
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l

Launch Website Command

l

Send Email Command

l

Web Recorder Command

l

Web Service Command

Other User
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Launch Website Command
Use this command to launch a website from within an automated task.

Using the Launch Website Command
To launch a website from your task, follow these steps:
1. Open the task in the Task Editor.
2. Double-click on or drag the Launch Website command to the Task Actions List. The Launch Website window is displayed.
3. Specify the URL of the website to launch.
4. Click Launch.
5. Select the title of the website. If you do not see the title, click Refresh.
6. Save the command.

Also See...
l
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l

FTP-SFTP Command

l

Internet Connection Command

l

Send Email Command

l

Web Recorder Command

l

Web Service Command

Other User
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Log-to-File Command
Use the Log to File command to create a log file in which task information can be stored as the task runs.

Overview
Logging detailed task information is an important aspect of optimizing and debugging your automation tasks. Automation Anywhere
provides an easy was for you to create a log file that is full of useful data about the events that occur as your task runs.
Log files can be saved in the several file formats, including .csv and .txt files. Encoding is provided for log files with options for ANSI,
UNICODE, and UTF8.

The Log to File command helps you to do the following:
l

Verify that a task has run properly, especially if the task has complex conditional and looping commands.

l

Create a new log file if one does not already exist.

l

Specify custom text to be included in the log file.

l

Add a time stamp to the log file.

l

Use a log file as a variable.

Also See...
l
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File and Folder Commands

l

Windows Actions Command

Other User
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Loop Command
Use this command to create loop structures in your automation task to automate repetitive tasks.

Overview
The Loop commands are some of the most powerful commands in Automation Anywhere. Four types of loop structures are provided:
l

Start Loop

l

End Loop

l

Exit Loop

l

Continue Loop

Sub-Commands
The LOOP command provides the following sub-commands:
l

Start Loop
l

Times

l

List

l

Condition

l

Each Row in an Excel Dataset

l

Each Row in an Internet Explorer Table

l

Each Row in an SQL Query Dataset

l

Each File in a Folder

l

Each Folder in a Folder

l

Each Row in a CSV/Text File

l

Each Email Message on Server

l

Each Node in an XML Dataset

l

End Loop

l

Exit Loop

l

Continue Loop

Using the Sub-Commands
To insert an Loop command in your task, follow these steps:
1. Double-click or drag one of the Loop commands to the Task Actions List pane. The Loop window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Other User
Resources:

Start Loop Commands
The following commands are Start Loop commands:
1. Times: Use this command to loop for a number of times. The command loops the actions between the Start Loop and End Loop
commands for the number of times you specify. For example, if you want to repeat the action 5 times, place the actions between
Start Loop and End Loop commands and specify 5.

2. List: Use this command when you do not know how many times a task needs to loop. If you have a list variable that contains several values, you can use the List command to loop through the entire list until it reaches the end. Using this command, you can
repeat the actions within the Start Loop/End Loop block as many times as necessary to reach the end of the list. You can access
the list variable values within the loop. For example, the first time the loop runs you can get the first value of the list variable, the
second time you get the second value of the list variable, and so on.

Other User
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3. Condition: Use this command to run actions based on conditions that exist. For example, you might want to repeat a set of actions
based on whether a file exists. You can check the condition at the end of the iteration by selecting the check box.
Optionally, you can add a 'Wait' time for the condition to be true.

Other User
Resources:

Using AND or OR operators in Loop While > Variable command*
* Available from version 7.5.2 onward
When you need to include the 'AND' or 'OR' conditions in conjunction with the 'Variable' sub-command, use the 'Add more conditions' option. It offers you the luxury of including all your 'AND' or 'OR' conditions within a single parameter, instead of specifying separate parameters for each condition.

Enable the 'Match Any' option for 'OR' conditions or 'Match All' for 'AND' conditions (refer image below)

Note: You cannot include both; 'Match Any' + 'Match All'. You are required to specify them
within a task, separately.
Similar conditions are used in If Variable command. Reference If-Else Command for details.

Other User
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4. Each Row in an Excel Dataset: Use this command in conjunction with the Get Multiple Cells sub-command of the Excel command.
When you have retrieved a range of cells from Excel using Excel > Get Cells > Get Multiple Cells, the rows and
columns of the range are stored in the system variable $Excel Column$.

For example, if you retrieve a range of cells from Excel that has five columns, you can access the five columns of the table by
calling $Excel Column(1)$, $Excel Column(2)$, $Excel Column(3)$, $Excel Column(4)$, $Excel Column(5)
$. This command is extremely useful for transferring data from one Excel spreadsheet to another, or to any other application.
5. Each Row in an Internet Explorer Table: Use this command in conjunction with the Extract Table sub-command of the Web
Recorder command. When you extract a table by using the Web Recorder Extract Table command, the rows and columns of the
table are stored in the system variable $Table Column$. For example, if you extract a table with five columns, you can access the
five columns by calling $Table Column(1)$, $Table Column(2)$, $Table Column(3)$, $Table Column(4)$, $Table
Column(5)$. This command is extremely useful for transferring data from a Web page table to other applications, such as other
Web pages or an Excel spreadsheet.
6. Each Row in an SQL Query Dataset: Use this command in conjunction with the Database commands. When you issue an SQL
query using the Automation Anywhere Database SQL Query command, the result set for the SQL query is stored in the system variable $Dataset Column$.
For example, if you issue an SQL query to a database for five columns of data. You can access the five columns from the result
set by calling $Dataset Column(1)$, $Dataset Column(2)$, $Dataset Column(3)$, $Dataset Column(4)$,
$Dataset Column(5)$. This command is extremely useful for transferring data from a database to other applications, such as
a Web page or an Excel spreadsheet.
7. Each File in a Folder: Use this command to perform an action on all files in a folder. Often times, the number of files in a folder can
change. You can specify a folder and loop through all files in that folder.
You can obtain information about the files and folder by using the following system variables:
l

$FileName$ - Use this variable to obtain the name of a file.

l

$Extension$ - Use this variable to obtain a file's extension.

l

$CurrentDirectory$ - Use this variable to obtain the path of the folder in which the filesa are stored.

All of these system variables return an empty value when used outside the looping command.
8. Each Folder in a Folder: Use this command to perform an action on one or more folders. To access the folder name within the loop,
use the system variable $FolderName$.
9. Each Row in a CSV/Text File: Use this command to loop through each row in a CSV or text file.

Other User
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10. Loop For Each Message in Server: Use this command to perform an action on each message that resides on your mail server. You
might use this command to save mail attributes, such as Subject, Message, To:, Cc:, and Attachment.
11. Each Node in an XML Dataset: Use this command to loop through each node of an XML data set to obtain values from multiple
nodes.

End Loop Command
Use this command to end the loop. The actions that exist between the Start Loop and End Loop commands will repeat based on the
type of loop you have selected.
Whenever you insert a Start Loop command, an End Loop command is also inserted. If the End Loop is mistakenly deleted, you can
insert an new one.

Exit Loop Command
Use this command to break out from a loop when a particular action or condition occurs. The Exit Loop command can exist only
between the Start Loop and End Loop commands.

Continue Loop Command
Use this command to continue the next iteration of a loop when a particular action or condition occurs. When a Continue Loop command is reached, the commands up to End Loop are skipped and the next iteration of the loop is run.

Also See...
l

If Else Command

l

If Endif Command - Examples

Other User
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Manage Windows Controls Command
Feature also available in Standard edition version 8.1.2 or higher.
Use this command to capture Windows control properties, such as buttons, list box items, text boxes, menu tabs, combo boxes, check
boxes, and tables.
Using this command, you can perform actions on these controls or assign the captured properties to variables.
You can also use this command to simultaneously record actions that you perform.
The following list shows the Windows controls that you can capture and the actions that are available.
Control

- Actions

1. Button - Click, Get Text
2. Edit (Text box) - Get Text, Set Text, Append Text, Click On Link
Note: You can insert variables while using Set/Append Text. If the text needs to be encrypted,
you can use Credential Variables* for enhanced security. Learn More
*Available in Enterprise edition from version 10.2.1
3. RadioButton - Get Radio Button Status, Select Radio Button
4. Checkbox - Set Check Box Status, Get Check Box Status
5. ComboBox/Drop Down - Get Total Items, Get Selected Index, Get Selected Item, Select Item by Index, Select Item by Text
6. Get Text - Click on link, Get Name of All Children, Get Value of All Children, Get Value Text, Get Name Text
7. Tab / TabItem - Get Total Items, Get Selected Index, Get Selected Item, Select Tab By Index, Select Tab by Text
8. List / ListItem - Get Total Items, Get Selected Index, Get Selected Item, Select Item by Index, Select Item by Text
9. Menu/MenuBar/MenuItem - Get Total Items, Get Text by Index, Get Index by Text, Click Item By Index, Click Item by Text
10. Tree / Tree Item - Get Total Items, Get Selected Index, Get Selected Item, Select Item By Index, Select Item by Text
11. Table - Exports To CSV, Get Cell By Index, Get Cell By Text, Total Row, Total Column, Set Cell By Index, Set Cell By Text
The following actions are common to all Windows controls:
l

Left mouse click

l

Right mouse click

l

Double-click

Other User
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Capturing a Control of a Specific Type
Use the Capture a control of a specific type check box to select from a list of controls to capture. Only this control is captured when
using this option. This option can help in avoiding errors that might occur when clicking on certain controls that possess different attributes.

Other User
Resources:

The controls that are captured are displayed under Control Properties, showing the Control Type, Name, Value and its Location
(coordinates).
Note: Automation Anywhere can perform actions that use only standard Windows controls. If your
application contains customized controls, Automation Anywhere might not be able to capture them.

Capturing Web Controls
To capture web controls, be sure to use the Manage Web Controls sub-command in Web Recorder Command, as opposed to the Manage Windows Controls command. Internet Explorer controls are recognized by the Manage Web Controls command.

Also See...
l

Manage Windows Controls Command - Examples

l

Log-to-File Command

l

Windows Actions Command

Other User
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Message Box Command
Use this command to insert a message box in an automated task.

Overview
The Message Box command enables you to insert a message box in a task when you want to display a message to the user when the
task runs. You can specify a custom caption for the message box.
You can specify the following components in a message box:
l

Caption: Enter a caption name for your message box.

l

Message: Enter your message in the dialog box.

l

Scroll bar: Insert a scroll bar in your message. The minimum message length for a scroll bar to be displayed is 10 lines.

l

Close Message Box: Enter the seconds value after which the message box should close.

Common Use Case: Message boxes are useful for issuing a message to the user whenever the task concludes running. For example,
when a web form task completes a run, you might issue a message that states: "Web Form Filled and Complete."

Also See...
l

Message Box Command - Examples

l

Prompt Command

Other User
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Object Cloning Command
Available with Enterprise edition only
In order that you can create and play tasks that use technology specific applications, Automation Anywhere offers the Object Cloning
Command.
The Object Cloning Command is specifically useful if you wish to capture objects within windows that use technologies such as Flex,
Silverlight, Java and Html etc.
Using this command, you can capture objects, its co-ordinates and images. You can then select an action that can be performed on the
captured object(s).

Selecting a Window
To capture an object and its parameters such as co-ordinates and image, you will be required to open the specific window and follow
these steps:
1. Select the window from which you wish to capture the object(s).

Other User
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Tip: Click 'Refresh' if unavailable in the drop-down list.
2. Click 'Capture', hold the mouse and drag it to the object to be captured.

Note: The selected object will be highlighted with a red border.
l

The object is captured and displayed in the 'Object' tab.

Note: The command captures the co-ordinates and image of the object, simultaneously.

Selecting the Play Mode
Coordinates: Use this option in 'Select Play Mode' if the objects are in fixed positions.

Image: Use this option, when the image is static.

Other User
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Tip: Click 'Recapture Position/Recapture Image' in case of any discrepancy in captured co-ordinates
or image.

/

Selecting an Action to Perform
After capturing the object and its parameters, you can select an action that needs to be performed when running your task.
Note: Select Action to Perform will vary depending on the object or its coordinates captured.
Some of the options that are available to you are:
l

Get Name - Usually applicable to text-box, button, label

l

Get All Children Name

l

Get Value

l

Get All Children Value

l

Click Actions - Left Click, Right Click, Double Click

l

Append / Set / Get Text
Tip: You can opt to use a Variable while using the actions Set Text and Append Text. If the
text needs to be encrypted, you can insert Credential Variables* using function key 'F2' for
enhanced security. Learn More
*Available in Enterprise edition from version 10.2.1

l

Get/Set Cell

l

Set Cell by Index

l

Set Cell by Text

l

Get Cell Text by Index

l

Get Cell Index by Text

l

Get Total Columns

l

Get Total Rows

l

Export to CSV

l

Get Property - Use this to capture object properties of multiple controls; namely Silverlight, Flex and Web applications. Assign the
values of the captured object properties to a variable.

Other User
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l

Properties that can be captured using the Get Property action are:

Editing the Search Criteria
If you wish to change the properties of an object, you can do so by using the 'Search Criteria' option.
1. Click on 'Expand Search Criteria' icon -

Other User
Resources:

.

l

The 'Object Cloning - Search Criteria' window pops up.

2. Change search criteria by adding or removing the search criteria icon -

in the column prior to 'Property'.

Note: You cannot set a search criterion for the property 'Path'.

Also See...
l

Using Plugin Settings

l

Using Java Settings

l

If-Else Command

l

Loop-While Command

l

Object Cloning Command - Examples
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OCR Command
Available in Enterprise and Small Business editions only.

Overview
OCR (Optical Character Recognition) is a common technology for reading an image as a text file.
Use this command to capture an image or picture, convert it to text, and transfer the data to another application.
Note:
l

The OCR command requires that Microsoft Office 2003 or later be installed on the computer.

l

For Microsoft Office 2007, ensure that the sub-component "Scanning, OCR, and Indexing Service Fil ter" (under Microsoft Office
Document Imaging) is selected during installation.

l

If using Microsoft Office 2010 and above, you will be required to install the component separately; click here for details.

Sub-Commands
The OCR command provides the following sub-commands:
l

Capture Window - Use this command to specify an application window title and capture the window as an image.

l

Capture Area - Use this command to capture a specific area of an application window.

l

Capture Image by Path - Use this command when text that you want to capture is contained in an image that is stored on your local
computer or network drive. Specify a path name by typing it or browsing to the path.
Note: When running the automated task, the network drive that is specified must be accesible.

l

Capture Image by URL- Use this command to capture an image located on a website URL.

Using the Sub-Commands
To insert an OCR command in your task, follow these steps:
1. Double-click or drag the required OCR command to the Task Actions List pane.
2. Select/input an appropriate window/area/path/url based on sub-command selected.
Optionally, assign a variable by pressing F2.
3. Specify the OCR Engine; either TOCR or MODI.
l

Other User
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By default MODI is selected. However, TOCR will be the default engine, if both installed.

Tip: If you have upgraded to 8.0.1 and more than one OCR engine is installed to your system, it is
recommended that you select the relevant OCR engine to ensure your existing tasks run fine.
4. Specify a threshold value for processing the image, either by dragging the bar or inputting the value in the text-box. This, to ensure
that the captured text is as accurate as possible.
l

Other User
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For instance, if you wish to capture the text from the given image:

l

In absence of the threshold option, the result could possibly be:

l

However on specifying the threshold value, the result can be as accurate as possible:

5. View the Captured Text and adjust the threshold value till you achieve expected result.

Other User
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6. Assign the captured text to a variable. Optionally, specify the parameters for filtering the text strings using 'Before' and 'After' and
trimming leading/trailing spaces.
l

For example, in the text string "Name: ABC Inc. Location:", if you require "ABC Inc.", specify Before = "Location"
and After = "Name:".

7. Save the command to your automation task.

Using Wildcards (*)
You can specify wildcards (*) in a window title.
For example, use wildcards to perform an operation in any window that contains the word "Untitled" anywhere in the title. You can
place the wildcard character before or after "Untitled" to capture variations, such as "Window 1: Untitled" or "Untitled - Text Document".
To capture all variations of "Untitled," simply specify *Untitled*.
Automation Anywhere searches for a window with a title of exactly "Untitled" first. If it does not exist, Automation Anywhere searches for
windows with the word "Untitled" anywhere in the title.

Also See...
l

OCR Command - Examples

l

App Integration Command

l

Database Command

l

Email Automation Command

l

Excel Command

l

PDF Integration Command

l

Read from CSV-Text Command

l

Terminal Emulator Command

l

XML Command
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Open Program/File Command
Use this command to automatically launch a program or open a file.
You can perform the following actions in a task by using the Open Program/File command:
l

If your program requires command line parameters, you can provide these parameters in the Parameters text box.

l

If required, provide the directory path for your program in the 'Start in' Path text box. Automation Anywhere will verify that this path is
valid.

l

You can insert the current window title in a task.

l

You can enter variables in a file path.

Also See...
l

Open Program/File Command - Examples

l

File and Folder Commands

l

Log-to-File Command

l

Manage Windows Controls Command

l

System Command

l

Windows Actions Command

Other User
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Pause Command
Use this command to pause an automated task at a particular point when it runs.

Overview
Inserting pauses into your tasks enables you to enter or modify information before a task completes a run.
Insert a pause in your task when you need to check the status of attributes while the task is running. This is a great way to test and
debug your tasks.
When a task reaches a pause, a Resume button is displayed. When you click on the Resume button, the task continues to run again.

Using the Pause Command
To insert a Pause command, follow these steps:
1. Open the task in the Task Editor.
2. In the commands list, under Task, drag a Pause command to the Task Actions List, in the location where you want to the task to
pause when running. Or, you can double-click the Pause command to insert it at the current location.
3. A Pause command is inserted in the task. You can copy this command to add multiple pauses, or move the pause to another position in the task simply by dragging it.

Also See...
l

Delay/Wait Command

l

Run Task Command

l

Stop Task Command
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PDF Integration Command
Available in Enterprise edition only.

Overview
The Automation Anywhere PDF Integration command takes process automation to a new level. PDF files are pervasive on the web, in
email, and across all sizes and shapes of business. It's become critical to automate routine tasks that involve manipulating and uploading these documents to databases, websites, and other repositories.
All sub-commands provide an option for overwriting existing output files. If you check the Overwrite check box, and the file name exists,
the file is overwritten.
Tip: It is recommended that you use variables with the command as many fields support variables.

Sub-Commands
The PDF Integration command provides the following sub-commands:
l

PDF to Image

l

Extract Form Fields

l

Extract Text

l

Merge Documents

l

Split Document

l

Encrypt Document

l

Decrypt Document

Using the Sub-Commands
To insert a PDF Integration command in your task, follow these steps:
1. Double-click or drag one of the PDF Integration commands to the Task Actions List pane. The PDF Integration window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

PDF to Image Command
Use this command to create separate images for each page of a PDF file. Follow these steps:
1. Select the PDF file using the Browse button. For encrypted PDFs, provide the user or owner passwords.
Tip: For enhanced security, you can opt to insert Credential Variables* using the function key
'F2' for user name and password. Learn More
* Available in Enterprise edition from version 10.2.1
2. Specify a page range for the pages that you want converted to images.
3. Complete the Output Image Details section:
a. Type: Select an output type from the drop-down list. The following types are available: TIFF, BMP, JPG, GIF, PNG, WMF,
EMF, EXIF. For JPG output, specify a JPEG Quality.
b. Folder Path: Specify a folder in which the images will be saved.
c. Image Prefix: Specify an image name as a prefix for the image files. The files will be suffixed with index numbers.
4. Using the Advanced View section:
a. Modify the X Resolution, Y Resolution, and Color for the output images. The default resolutions are 200 dpi.
b. Select an output image type (either color or grayscale).
c. Select a color property. The default is True Color (32 bits).
d. For TIFF files, select a TIFF compression type.

Other User
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Extract Form Fields Command
Use this command to extract all form field data and selected text to variables. Follow these steps:
1. Select the PDF file and click the Add button. A PDF Viewer window is displayed, showing all of the fields as dotted red boxes.

Other User
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2. Right-click and select Add Field - here a solid red box is visible.
3. The Field Form is displayed, where a variable is assigned to the field. Click OK to view the inserted fields on the right side table of
Inserted Fields.
4. You can also select particular text to store in a variable, if required.

5. Click Save to view the inserted fields in the command. Modify them by using the Add, Edit, and Delete buttons.

Other User
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6. Save the command. The inserted field values are stored in the variables when the task is run.

Extract Text Command
Use this command to extract text from a PDF to a text file. Follow these steps:
1. Select the PDF file using the Browse button. Enter passwords for encrypted PDF files.
Tip: For enhanced security, you can opt to insert Credential Variables.
2. Select a text type:
l

Plain Text: Similar to a simple copy/paste of the entire PDF file

l

Structured Text: Preserves the formatting from the original PDF file

3. Specify a page range.
4.

For Export Data To Text File, specify an output file name with a .txt extension.

Merge Documents Command
Use this command to merge selected PDF documents into a single PDF file. Both encrypted and unencrypted PDFs are supported. Follow these steps:
1. To select the PDF files for merging, click the Add button. For encrypted PDFs, user or owner passwords must be specified.
2. For each PDF file added, specify the Pages to Include. After all files are added, you can modify the pages to include by selecting
each PDF file.

Other User
Resources:

3. Specify an output file path for the merged PDF file.

Split Document Command
Use this command to split a PDF file. Follow these steps:
1. Select the PDF file to be split and enter user or owner passwords if the file is encrypted.
2. Specify the Output File Creation options:
l

Pages Per File: Specify how many pages each new output file will contain (such as 5 pages for each split).

l

Single File With Page Range: Select this option to create a single output file that contains the page numbers specified.

l

Blank Page As A Separator: When selecting this option, a new output file is created whenever a blank page appears within
the PDF document.

l

Bookmark Level Per File: Splits the file according to the bookmark level that the PDF contains. If 3 levels are present, the
drop-down will show Level1, Level2, and Level3 as options. Split the PDF by selecting the appropriate bookmark level.

3. Specify Output File Details:
l

Folder Path: Specify a folder location in which all output files will be saved.

l

File Prefix: Specify the file name, with a .pdf extension, to be used for each output file (and suffixed using index numbers).

Other User
Resources:

Encrypt Document Command
Use this command to encrypt PDF documents and grant permissions to users. Follow these steps:
1. Select a PDF you want to encrypt and set user and owner passwords for the encrypted file.
2. Select one or more permissions to apply to the encrypted document for the user.
3. Select an encryption level (RC4 40-bit, RC4 128-bit, or AES 128-bit).

Other User
Resources:

4. Specify the name of the output file, with a .pdf extension.

Decrypt Document Command
Use this command to decrypt a PDF document that was previously encrypted. Follow these steps:
1. Select an encrypted PDF document to decrypt, and enter the user/owner password.
2. Specify an output file name with .pdf extension to save the decrypted PDF. The password security is removed for the decrypted file.
All permissions that existed for the encrypted file remain, without password protection. This ensures that all document restrictions

Other User
Resources:

remain for security in the newly created decrypted file.

Also See...
l

PDF Integration Command - Examples

l

App Integration Command

l

Database Command

l

Email Automation Command

l

Excel Command

l

Loop Command

l

OCR Command

l

Printer Settings Command

l

Read from CSV-Text Command

l

Terminal Emulator Command

l

XML Command

Other User
Resources:

PGP Command
Available in Enterprise edition only.
Use the PGP (Pretty Good Privacy) command to automatically encrypt and decrypt files for security.

Overview
The PGP command helps you to automate the process of encrypting and decrypting files.
The command supports both types of encryption: symmetric (passphrase) and asymmetric (public/private keys):
l

PGP Passphrase: Requires a pass phrase to encrypt and decrypt.

l

PGP Public/Private Key: Requires a PGP public and private key file to encrypt and decrypt.

Sub-Commands
l

Encrypt Files

l

Decrypt Files

l

Create Keys

Using the Sub-Commands
To insert a PGP command in your task, follow these steps:
1. Double-click or drag one of the PGP commands to the Task Actions List pane. The PGP window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Encrypt Files Command
Use this command to encrypt one or more files using one of the encryption methods: either passphrase or public/private key.
To encrypt files, follow these steps:
1. Select the 'Passphrase' encryption type and enter a pass phrase. Alternatively, select the Public/Private Key encryption type. For
this type, locate or specify the Public Key File path. Create public key if necessary.
Note: All other options are the same for both encryption types.

Other User
Resources:

Tip: For enhanced security, you can opt to insert Credential Variables* using the function
key 'F2' for the Passphrase. Learn More
* Available in Enterprise edition from version 10.2.1
2. Select a symmetric algorithm. The algorithm options are:
l

Idea

l

TripleDES

l

CAST5

l

Blowfish

l

AES128

l

AES192

l

AES256

l

Twofish256

3. Locate or specify the source file path.
4. Locate or specify the destination file path.
5. Check the option for overwrite files/folder, if necessary.
6. If required, append the extension for the destination file. For example, .enc.
7. Compress the encrypted files using one of the compression algorithms:
l

Zip

l

Bzip2

Other User
Resources:

l

Zlib

8. If required, check the Armor data (text output) option to enable ASCII Armor output.

Tip: For Source or Destination path, use '*.*' or '*.txt' to select multiple files in a folder.

Decrypt Files Command
Use this command to decrypt one or more files that have been previously encrypted. You can decrypt files that are encrypted with
either Passphrase or Public/Private Key encryption type.
To decrypt a file, follow these steps:
1. Select the Passphrase encryption type, which requires a specific pass phrase.
Alternatively, select the Public/Private Key encryption type. For this type, locate or specify the Private Key file. While using password-protected private keys, enter the password.
Tip: For enhanced security, you can opt to use Credential Variables using the function key
'F2'. Select a relevant Credential Key and its Attributes for the password.
All other options are same for both encryption types.

2. Enter the pass phrase for decryption.
3. Locate or specify a source file path for decryption.
4. Locate or specify a destination file path.

Other User
Resources:

5. If required, check the option to overwrite files/folder.
6. If required, select the Remove extension option.

Create Keys Command
Use this command to create public and private encryption keys. You can add additional security to the keys by specifying a password
that encrypts the keys.

To create new keys, follow these steps:
1. Select the Create Keys option.
2. Locate or specify a Public Key File.
3. Locate or specify a Private Key File.
4. Optionally specify a password that encrypts the key files.
Tip: For enhanced security, you can opt to use Credential Variables using the function key
'F2'. Select a relevant Credential Key and its Attributes for the password.
5. If required, select the Overwrite Files option.

Also See...
l

Setting Security Features for a Task

l

PGP Command - Examples

Other User
Resources:

Play Sound Command
Use this command to insert and play sounds in your automated tasks.

Sub-Commands
The Play Sound command provides the following sub-commands:
l

Play Beep

l

Play Media File

Overview
You can insert a Play Sound command in your automated task to play a beep or another media file before/after it runs a particular command.

Using the Sub-Commands
To insert a Play Sound command in your task, follow these steps:
1. Double-click or drag one of the Play Sound commands to the Task Actions List pane. The Play Sound window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Play Beep Command
Use this command to play a beep sound when the task encounters the Play Beep command. You can use a beep sound to alert users
when particular actions take place, or to alert you when prompted for input.

Play Media File Command
Use this command to play a media file in your automation task. When the task plays the media file, it does not proceed to the next automation task command until the media file finishes playing.

Other User
Resources:

Also See...
l

Play Sound Command - Examples

l

Clipboard Command

l

Comment Command

l

Error Handling Command

l

Image Recognition Command

l

Prompt Command

l

Screen Capture Command

l

String Operation Command

l

Variable Operation Command

Other User
Resources:

Printer Settings Command
Use this command to automate printer settings in your task.

Overview
One of the most manually intensive activities of any IT staff involve managing printer settings for individuals and groups. Using the
Printer Settings command, you can automate many of these tasks.

Sub-Commands
The Printer command provides the following sub-commands for managing printer settings:
l

Get Default Printer

l

Set Default Printer

l

Remove Printer

Using the Sub-Commands
To insert a Printers command in your task, follow these steps:
1. Double-click or drag one of the Printers commands to the Task Actions List pane. The Printers window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Get Default Printer Command
To get the default printer using your automated task, follow these steps:
1. Open the Task Editor.
2. Double-click the Get Default Printer command.
3. Click Save.

Set Default Printer Command
To change the default printer using your automated task, follow these steps:
1. Open the Task Editor.
2. Double-click the Set Default Printer command.
3. Select a printer from the list of installed printers.
4. Click Save.

Other User
Resources:

Remove Printer Command
To remove a printer using your automated task, follow these steps:
1. Open the Task Editor.
2. Double-click the Remove Printer command.
3. Select a printer from the list of installed printers.
4. Click the Run Script command.
5. Click Save.

Also See...
l

Printer Settings Command - Examples

l

Active Directory Command

l

System Command

l

SNMP Command

Other User
Resources:

Prompt Command
Use this command to insert a user prompt that requests input from a user when running an automated task.

Overview
Some tasks that are interactive, require the user to provide inputs. The Prompt command allows you to request inputs such as inputting
values, opening a file/folder or/and choosing between yes and no whenever required while running such automated tasks.

Sub-Commands
The Prompt command provides the following sub-commands:
l

Prompt for Value

l

Prompt for File

l

Prompt for Folder

l

Prompt for Yes/No

Using the Sub-Commands
To insert a Prompt command in your task, follow these steps:
1. Double-click or drag one of the Prompt commands to the Task Actions List pane. The Prompt window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Prompt for Value Command
Use this command in tasks where the values change frequently. For example, for tasks that interact with online forms, you can ensure
that the user enters the proper values when the task runs.
Further, the value that the user enters during task playback can be assigned to a variable. The variable can be used in other places
within the task, instead of prompting again.

(Image as seen in Enterprise edition version 8.1)
You can also prompt users for passwords and encrypt the keystrokes during playback by enabling the 'Encrypt Keystrokes' option*.
You will not be able to assign the value to a variable though, if it is enabled.
* Available from version 8.1 onward

Other User
Resources:

(Image as seen in Enterprise edition version 8.1)

Prompt for File Command
Use this command to prompt the user for one or more files from a single folder. The value of the files selected can be assigned to a list
variable. You can also configure a caption for the prompt window.

(Image as seen in Enterprise edition version 8.1)

Other User
Resources:

Prompt for Folder Command
Use this command to prompt the user for a single folder. The value of the folder selected can be assigned to a value variable. You can
configure a caption for the prompt window.

(Image as seen in Enterprise edition version 8.1)

If Command
Use this command to prompt the user for a response (Yes or No) to a question while the task is running. The value selected during playback can be assigned to a value variable.

(Image as seen in Enterprise edition version 8.1)

Other User
Resources:

Also See...
l

Prompt Command - Examples

l

Message Box Command

l

Variable Operation Command

l

Knowing When to Use Variables

Other User
Resources:

Read from CSV/Text Command
Overview
You can use this command to automate the process of reading data from various files and file formats. You can do the following:
l

Read comma or tab-delimited data from a CSV file.

l

Read multiple lines in CSV or text files

l

Use encoding options: ANSI, UNICODE, and UTF8.

CSV
Use this option to read data using Comma or Tab delimiters from a CSV file.

Text
Using this command, read data using Newline, Comma, Tab or Other delimiters from a Text file.

Other User
Resources:

Also See...
l

Read from CSV/Text Command - Examples

l

App Integration Command

l

Database Command

l

Email Automation Command

l

Excel Command

l

OCR Command

l

PDF Integration Command

l

Terminal Emulator Command

l

XML Command

Other User
Resources:

REST Web Service Command
Web services are usually associated with SOAP. However, REST Web Services are getting more popular and thus, Automation Anywhere now supports testing of these REST Web Services. REST means using REpresentational State Transfer architecture, to realize
Web services. In REST the HTTP methods GET, PUT, POST and DELETE are supported.

Methods
1. Get Method
2. POST Method
3. PUT Method
4. DELETE Method

1. Get Method
The GET method means retrieve whatever information (in the form of an entity) which is identified by the Request-URI.
Follow the below steps as an example for Get Method.
i. URI: Specify the URI for the REST Web Service we want to connect to.
ii. Method: Select the GET Method from drop down.

Tip: Use Tab keys and the sub-tabs for Request and Parameter will be populated automatically.
iii. Request:

Other User
Resources:

l

URI Header: Below Keys with their Value pairs are displayed.

l

HTTPS: When the HTTPS connection is used it will be True.

l

Server URL: Indicates the main host or the server where the web service is being tested.

l

Port No: Displays the port number used for connection to the web service.

l

URL Path: Displays relative URL of the specific web service.

Header
Each Key and Value pair for the Header is displayed if applicable. One can customize these header key-value pair using action buttons.
Actions
1. Add: You can add a Key and Value to a web service request. This can be useful if a recorded request has additional fields or parameters added to it.
Tip: The user can manually add them. The changes will then be reflected while playing of the
command.

2. Delete: User can delete a particular Key and its value by selecting it from request header. This is useful when changes to a particular key and its values are known. The changes will then be reflected while playing of the command.

Other User
Resources:

Use the Send Request button to send the request. This will automatically fill in the Response and can be saved to a variable for
ease of processing.
Tip: You can opt to insert a Credential Variable* using function key 'F2' for enhanced security. Learn More
*Available in Enterprise edition from version 10.2.1

Parameter
URL: Displays the URL Parameters for the current web service request with Key and Value pairs.
1. Add: You can add a URL/Post Parameters and Value to a recorded request. This can be useful if the request has additional fields
or parameters added to it.
The user can manually add them. The changes will then be reflected in the URI when Send Request is clicked and/or playing of the
command.
2. Delete: Select a particular Parameter for Post or URL which you want to remove. Click Delete button. This is useful when changes
to a particular Post or URL parameter is known.

Other User
Resources:

POST Parameter:Displays the Post Parameters for the current request. Applicable when Method is POST or PUT.
Authorization: REST Web Service supports HTTP Basic authentication implementation using this Authorization tab.

Click Send Request and the Response will be filled in automatically.

Other User
Resources:

Tip: The response should be stored in a variable (User or Credential) for further processing.

Response
The response for web service supports both XML and JSON formats.
1. Header: Displays the detail keys and values of response header for the request.

2. Body: Displays the response body for the selected request.

Other User
Resources:

This response body should be saved to an appropriate variable for testing of the REST Web Service, Get Method.
3. Save Response To : Select the variable from the drop down. The entire response will be saved to the selected variable.

4. Save the command and during Play Time the Response will be stored in the variable.

2. POST Method
The Post method is used as a requests that the server accepts the entity enclosed in the request as a new subordinate of the web
resource identified.
REST Web Service command supports three content types: application/JSON, application/XML, and default format (x-www-form-urlencoded).
1. Enter URI where you want to Post your response.
2. Select the POST Method.
In the Request Header a drop down will be displayed for the content type. By default, text format is displayed.

Other User
Resources:

3. For the Parameter tab, use the Add button to Add the value and key pairs when content type is of default format.

4. Click Send Request button.
5. If the content type is JSON or XML, a multi-line text box is displayed for the POST Parameters for ease of use. See below example:

Other User
Resources:

6. In Response Header and Body, you can validate the response posted.
7. Save Response To: Select the variable from the drop down. The entire response body will be saved to the selected variable.

8. Save the command and during run time, the values will be posted to the URI automatically.

Other User
Resources:

3. PUT Method
The PUT method is useful to update data for a particular web service URI. It can also be used to pass different URI parameters based
on the key value pair for updation. Thus a record can be updated using a key value pair using PUT method with request header.
1. Enter the URI.
2. Select the PUT Method.
3. For the URL Parameters, modify the values as shown in the below example.

4. Click the Send Request button.

Other User
Resources:

5. You will see an HTTP/1.1 200 OK response with the updated Body Parameters.

6. Save Response to a variable and click Save.

4. DELETE Method
The DELETE method requests that the origin server deletes the resource identified by the Request-URI.
In below example we see how for a URI, passing the appropriate Parameter, and sending the Request the record gets deleted.
1. Enter URI.
2. Select the Method as Delete.

Other User
Resources:

3. Add the URL Parameter to be deleted.

4. Click on Send Request button.
5. The Response will be displayed as success and the record will be deleted successfully.

Variable Support for REST Web Service using F2
l

URL Parameterization: You can use variables in Request - Header tab for values.

l

Parameter: You can use variables for Parameter tab values which includes URL Values, Post values and Authorization Values.

Other User
Resources:

The following illustrates the use of POST Parameterization of a REST Web Service.

Note: We have used POST Parameter using Variables.
1. Click Send Request, will display the Set Variable From with values of the variables.

Note: In Request Header or POST Parameter, if a Credential Variable is used then on clicking
‘Send Request’ the ‘Set Variable Value’ will not list the Credential Variable. However its value
will be used to generate the output.
You will be displayed a message notifiying that Credential variable(s) are excluded from the list
of variables.
2. Now, Click Get Output to get the Response.
Note: If your REST Web Service is using a proxy server, go to Tools -> Options -> Advanced Settings.

Other User
Resources:

Also See
l

REST Web Service Command - Examples

l

SOAP Web Service Command

Other User
Resources:

Run Script Command
Overview
You can use this command to run various scripts from your task.
Use a Run Script command when you want to:
l

Run a VB Script (*.vbs) or JScript (*.js) in the task.

l

Pass parameters to your scripts.

l

Specify the Return Value in your scripts.

Also See...
l

Run Script Command - Examples

l

Run Task Command

l

Variable Operation Command

Other User
Resources:

Run Task Command
Overview
Using the Run Task command, you can run several small tasks from within a larger task. You can create a single task, and within the
task run other tasks, one after the other. This is called "nesting tasks".
Using this command, scheduling becomes easier. You can imbed several tasks into a single, master task, and simply schedule the
master task. This enables you to avoid having to schedule each of the smaller tasks.

Using the Run Task Command
To insert a Run Task command in your task, follow these steps:
1. Double-click or drag the Run Task command to the Task Actions List pane. The Run Task window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.
The Run Task command includes the following options:
l

Repeat: Use the Repeat option to run the selected task multiple times. You can repeat the task a specified number of times or for a
number of hours. You can also repeat the task until you choose to stop it.

l

Speed: Use the Speed option to set the replay speed of the task. Three speeds are available: Standard (same speed as recorded),
High Speed, and Turbo Action replay (mouse moves are removed).

Other User
Resources:

l

Variable: Use this option to pass (associate) a variable from the master task - 'Main Task Variable' to the sub task - 'Run Task
Variable'.
Use the Add and/or Delete buttons to add and/or delete the variables.
n

Inserting variables in 'Run Task Variable': In order to specify the mapping variables for Run Task, you can either select a
variable from the existing variables list or you can enter a new variable.

n

Quick Mapping of Variables *: A 'Quick Map' ensures that a large number of variables with same nomenclature are associated between tasks.

* Available from version 7.5.2 onward.
Variables mapped between tasks in earlier versions (below 7.5.2), will have to be re-mapped. Also, on selection of another
task (using browse), the current mapping will be lost.
Mapping of 'Workflow Variables' is also possible in similar fashion.

Note: 'Quick Map' is disabled if no similar variables are found.

Note: It is possible to pass value type variables marked as Regular Expression. Refer 'Value
Type Variables' to know more.
Use Case Scenario
A task named T1 has a variable firstname with a value of 'John' declared. By using the Run Task command, another task, T2, is
called and firstname is passed as an argument. Now, in task T2, the firstname value is changed to 'Michael'. When the Run Task
command finishes in task T1, the variable firstname contains the value 'Michael'.

Also See...
l

Run Task Command - Examples

l

Run Script Command

l

Stop Task Command

l

Pause Command

Other User
Resources:

Screen Capture Command
Use this command to automate the process of capturing screen shots.

Overview
As part of your automation task, you can capture the entire computer screen or an active open window.

Sub-Commands
The Screen Capture command provides the following sub-commands:
l

Capture Desktop

l

Capture Window

l

Capture Area

Using the Sub-Commands
To insert a Screen Capture command in your task, follow these steps:
1. Double-click or drag one of the Screen Capture commands to the Task Actions List pane. The Screen Capture window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Capture Desktop Command
Use this command to capture the full desktop on your computer. The image is saved to a location you specify. You can capture the
image in various formats.

Capture Window Command
Use this command to capture an image of an open application window. Select the window by clicking on the name in the drop-down
list.
The image is saved to a location you specify. You can capture the image in various formats.

Other User
Resources:

Capture Area Command
Use this command to capture an area of the screen. Select the area by first selecting the application window, and then dragging the
mouse over the area that you want to capture.
The image is saved to a location you specify. You can capture the image in various formats.

Use the Overwrite File option to overwrite older existing images.

Other User
Resources:

Using Wild Cards
You can specify wild cards, using the asterisk (*) symbol, when selecting window titles. For example, you might use a wild card capture
any window that contains the word "Untitled" in the title.
You might also want to capture any window that contains any text before or after the word "Untitled" in the window title. To specify this,
use *Untitled* for the window title. In this case, Automation Anywhere searches for the exact window title ("Untitled"). If it is not
found, Automation Anywhere searches for windows that contain the word "Untitled" in the title.
You can use a wild card character (*) at the beginning or at the end of a window title.

Also See...
l

Screen Capture Command - Examples

l

Clipboard Command

l

Comment Command

l

Error Handling Command

l

Image Recognition Command

l

Play Sound Command

l

String Operation Command

l

Variable Operation Command

Other User
Resources:

Send Email Command
Overview
Automating email processes is one of the most powerful uses of Automation Anywhere. Sending repetitive emails can bog down the
most productive organizations.
Using the Send Email command, you can:
l

Send multiple emails at once. Use a semi-colon between each email address.

l

Include attachments with the email.

l

Format the message in HTML.

Using the Send Email Command
To send an email from your task, follow these steps:
1. Click on the Tools menu, and select Options. In the Email Settings, enter a Host Name and Port:
l

Host: The SMTP Host allows you to send email from Automation Anywhere. You can obtain this information from your email
provider, or from the configuration settings in your email program.

l

Port: This setting defines the TCP/IP port that Automation Anywhere uses to send email. (The default port is 25.)
Refer Setting Email Notifications for details

3. Double-click on or drag the Send Email command to the Task Actions List in the Task Editor. The Send Email window is displayed.

Other User
Resources:

(Image as seen in Enterprise edition version 8.1)
4. Enter the From, To, CC, and BCC email addresses.
5. Enter a subject.
6. Attach files you want to send with the email.
l

If you want to attach any file type, click the 'Attach' button.

l

If you want to attach values of all variables, click the 'Variables' button*.
* Available from version 8.1 onward

This will append a text file that lists values of all the variables (System and User Defined) used in the task.

(Image as seen in Enterprise edition version 8.1)

Other User
Resources:

Note: The System Variable Excel Cell will not be attached as the values input are
dynamic.

7. Select either Text or HTML for email format.
8. Enter the message in the message box.
9. Save the command.

Also See...
l

Send Email Command - Examples

l

FTP-SFTP Command

l

Internet Connection Command

l

Launch Website Command

l

Web Recorder Command

l

Web Service Command

Other User
Resources:

Services Command
Use this command to automate your Windows and application services.

Overview
You can use the Services command to start, stop, pause, resume, or get the status of any available services.

Sub-Commands
The Services command provides the following sub-commands:
l

Get Service Status

l

Start Service

l

Stop Service

l

Pause Service

l

Resume Service

Using the Sub-Commands
To insert a Services command in your task, follow these steps:
1. Double-click or drag one of the Services commands to the Task Actions List pane. The Services window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Get Service Status Command
Use this command to obtain the current status of a Windows or application service. For example, the Windows Audio service status
might be "running". You can assign the status value to a variable.

Start Service Command
Use this command to start a Windows or application service when your task runs.

Stop Service Command
Use this command to stop a Windows or application service that is currently running.

Other User
Resources:

Pause Service Command
Use this command to pause a Windows or application service that is currently running.

Resume Service Command
Use this command to re-start a Windows or application service that you have previously paused using a Pause Service command.

Also See...
l

Services Command - Examples

l

Active Directory Command

l

Printer Settings Command

l

SNMP Command

Other User
Resources:

SNMP Command
Use this command to automate the management of your network.

Overview
Simple Network Management Protocol (SNMP) is used to locate the network management component on one or more computers and
the managed component on multiple network devices.
The Automation Anywhere SNMP command offers powerful network management. Using this command you can easily monitor network devices configured with SNMP agent software. Network devices such as servers, workstations, printers, routers, bridges, and
hubs, as well as services such as Dynamic Host Configuration Protocol (DHCP) or Windows Internet Name Service (WINS) can be
monitored.

Sub-Commands
The SNMP command provides the following sub-commands:
l

Get

l

Get Next

l

Set

l

Walk

l

Send Trap

Using the Sub-Commands
To insert a Services command in your task, follow these steps:
1. Double-click or drag one of the SNMP commands to the Task Actions List pane. The SNMP window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

SNMP Get Command
Use this command to retrieve data from an SNMP agent.

Other User
Resources:

SNMP Set Command
Use this command to modify data on an SNMP agent.

Note: Select a 'Value Type' when providing the OID Specifications.

Other User
Resources:

SNMP Get Next Command
Use this extended request command to browse the entire hierarchy of management objects.

SNMP Walk Command
Use this command to retrieve a sub-tree of management values using SNMP GET-NEXT requests.
You can specify a Walk type of All or Within.

Other User
Resources:

SNMP Trap Command
Use this command to send trap messages to the SNMP Manager from an SNMP Agent. These messages are sent by an SNMP Agent
whenever certain events occur, such as a system restart.

Note: Select any of the Trap Type given when setting the trap.

Using the SNMP Command Views
Using the Normal View
To use the normal SNMP command view, follow these steps:
1. Select an SNMP Operations Command: Select a command (Get, Get Next, Set, Walk, or Send Trap).
2. SNMP Agent: Specify an agent and community details.
l

Agent: Specify an IP Address or host name.

l

Community: Specify a community string. This string is used for read-only access to a network element.

Other User
Resources:

3. OID Specifications: Specify the Object Identifier, which the SNMP Manager requests (for example, Get, Set, etc.)
l

Object ID: Specify the IP Address or host name.

l

Data Type: Select from ASCII or Hex.

l

Set value: Set value if the message type is Set.

l

Walk Type: Select Walk Type of All or Within when the message type is Walk. For type Within, all variables in the sub-tree
below the given OID are queried. Using All displays the variables that are equal to the specified OID for the given tree type
structure.

l

Trap type: Select a trap type from the following:
a. Cold start: Occurs when the SNMP agent initializes its configuration tables.
b. Warm start: Occurs when the SNMP agent re-initializes its configuration tables.
c. Link Down: Occurs when the state of a network adapter on the SNMP agent changes from up to down.
d. Link Up: Occurs when the state of a network adapter on SNMP agent changes from down to up.
e. Authentication Fail: Occurs when the SNMP agent receives a message from an SNMP manager with an invalid community name.
f. EGP Neighbor loss: Occurs when the SNMP agent cannot communicate with its Exterior Gateway Protocol (EGP)
peer.
g. Enterprise specific: Occurs when specific error conditions and error codes are defined in the system. The user must
provide a Trap Specific Number for this option.

4. Result:
l

Log File: View the SNMP log data in the selected log file.

l

Assign the value to an existing variable: Specify a variable value.

Using the Advanced View
When you click on the Advanced View button, additional SNMP options are provided. The SNMP advanced options include the following:
l

SNMP Version: Select any of device versions - V1, V2 or V3

l

Timeout(ms): Specify the response time in milliseconds for the action to wait for before generating an error.

l

Remote Port: Specify the TCP/IP port to be used for the Get request. The default is 161.

l

Retries: Specify the number of times to retry the message.

V3 allows you to select authentication levels to ensure a more secure environment (compared to V1 and V2). The options provided
therein are:

l

Authentication Level: Choose from 'None', 'Authentication Only' or 'Authentication with privacy'.

Other User
Resources:

l

Authentication Method: Select either MD5 or SHA.

Note: Applicable only if Authentication Level selected is other than 'None'. You are also
required to input a 'Password'.

l

Password:Input a password for connecting to the device.

l

Privacy Method:Select the either 'DES' or 'AES' as the privacy method. This privacy method ensures that your password is protected with a private key as the program encrypts the same.

Note: Available only if authentication level selected is 'Authentication with privacy'.

l

Private Key:Input the private key generated when the authentication level selected is 'Authentication with privacy'.

Also See...
l

SNMP Command - Examples

l

Active Directory Command

l

Services Command

l

Printer Settings Command

Other User
Resources:

Stop Task Command
Use this command to stop an automation task from running.

Overview
You can stop an automation task at any point by inserting a Stop Task command in the Task Actions. For example, you can stop the
task if a specific condition is met, such as when encountering a file larger than 100 MB.

Using the Stop Task Command
To insert a Prompt command in your task, follow these steps:
1. Open the task in the Task Editor.
2. Double-click or drag the Stop Task command to the Task Actions List pane.
3. To change the location of the Stop Task command, simply cut/paste it or drag it to another location within the automation task.
Automation Anywhere inserts the Stop Task command above the currently selected line in the Task Actions List.

Also See...
l

Run Task Command

l

Run Script Command

Other User
Resources:

String Operation Command
Use this command to manipulate a text string or extract part of a string and store it in a variable.

Overview
String operations are very useful when automating business processes. For example, you might want to extract a portion of a text block
from an email, a website, or an application window.
You can also manipulate strings after capturing them. You might search the string for particular phrases, compare two strings, convert a
string to upper or lowercase, or obtain the length of a string.

Sub-Commands
The String Operation command provides the following sub-commands:
l

Before/After

l

Compare

l

Find

l

Join

l

Length

l

Lower Case

l

Replace

l

Reverse

l

Split

l

Sub-String

l

Trim

l

Upper Case

Using the Sub-Commands
To insert a String Operation command in your task, follow these steps:
1. Double-click or drag one of the String Operation commands to the Task Actions List pane. The String Operation window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Before/After Command
Use this command to specify a range of text to extract, using Before and After keywords.
You can insert 'Enter' and 'Tab' variables by using the F2 function key. These variables act as separators for your string between the
Before and After keywords.
To refine your 'Before-After' string command, you can use the 'OR' or 'AND' Logical Operators.
l

Use the 'AND' operator to ensure 'Before' and the 'After' conditions are met.
n

l

For instance, when you input a string in 'Before' and if not found, the search will be aborted. The program will not search the
string input in 'After'.

Use the 'OR' operator to ensure either 'Before' or 'After' condition is met.
n

For instance, when you input a string in 'Before' and if not found, the program will continue to search for the string input in
'After'.

Note: The default Logical Operator is 'OR'

Other User
Resources:

Example: In the text string, 'Name of Applicant James Smith Applicant Location,' let's copy only 'James Smith'. We specify Before =
'Applicant' with an Occurrence of 1. We also specify After = 'Applicant' with an Occurrence of 1. This is the first occurrence after the
Before keyword, although it is the second occurrence from the beginning of the string.
You can also specify the number of characters to be extracted, starting from the first character after the Before keyword. The extracted
string can be trimmed to remove leading or trailing spaces, and you can save the string to a variable.
Tip:
l

When using the Before/After command, enter a space as a separator between strings using the SPACE BAR
key on the keyboard.

l

In some cases, content extracted from websites are separated by an Enter symbol (a small square),
which you can see in the CSV file.

Other User
Resources:

Compare Command
Use this command to compare strings by specifying the strings. You can refine your search by selecting the 'Match Case' option. A
value of True or False is returned. You can assign the values that are returned to a variable.

Find Command
Use this command to locate a sub-string that exists within the source string by specifying the Start parameter.
If the specified string is a regular expression, select the check box that is provided. Insert the regular expression in the Find String field.
Also, refine your search parameters by specifying the character number in 'Start From', selecting 'Match Case' and/or Regular Expression.

For example, to find all email addresses in the source, specify the following as a regular expression: \b[A-Z0-9._%-]+@[A-Z0-9.-]
+\.[A-Z]{2,4}\b

Other User
Resources:

Join Command
Use this command to join all separate elements of list variables by defining the source string and a delimiter.

Length Command
Use this command to obtain the length of a string by specifying the source string.

Other User
Resources:

Lower Case Command
Use this command to convert a source string to lower case .

Replace Command
Use this command to replace a portion of a source string with a specified replacement string. Optionally specify the character position
from which to begin in 'Start' and the number of times it is to be replaced in 'Count'. If the Find String field contains a regular expression,
select the Regular Expression check box.

Other User
Resources:

Reverse Command
Use this command to reverse a specified source string.

Split Command
Use this command to split a source string. Specify a 'Delimiter' and optionally number of delimiters to be considered in 'Limit'. Refine
the scope by selecting 'Match Case'. The resulting elements are stored in a list variable.

Other User
Resources:

Sub String Command
Use this command to retrieve a sub-string. Specify the source string and parameters such as 'Start From' and optionally 'Length'.

Trim Command
Use this command to trim blanks and spaces from a specified source string.

Other User
Resources:

Upper Case Command
Use this command to convert a source string to upper case.

Also See...
l

String Operation Command - Examples

l

Variable Operation Command

Other User
Resources:

System Command
Use this command to automate repetitive tasks pertaining to your computer system.

Overview
Certain repetitive and routine tasks pertaining to your computer system can be automated to save on time and consequently be conserve energy. This topic describes how to use such commands in Automation Anywhere.

Sub-Commands
l

Lock the computer

l

Log off

l

Shutdown the computer

l

Restart the computer

Using the Sub-Commands
To insert a System command in your task, follow these steps:
1. Double-click or drag one of the System commands to the Task Actions List pane. The System window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Lock the Computer Command
Use this command to automatically lock the computer. This command is commonly used at the end of a task, to ensure security if no
one is at the system.

Logoff Command
Use this command to automatically log off the computer. This command is commonly used at the end of a task, to ensure security if no
one is at the system.

Shutdown Command
Use this command to turn off your computer, for example, at the end of the workday.
l

The Shutdown command provides the added benefit of energy savings.

l

To increase environmental awareness, Automation Anywhere highlights energy-saving actions with a green leaf icon, as shown in
the System window next to the Shutdown command.

Note: The Shutdown command should only be inserted at the end of an automation task. Otherwise,
other commands in the task cannot be run.

Other User
Resources:

Restart Command
Use this command to automatically restart the computer.
Note: The Restart command should only be inserted at the end of an automation task. Otherwise, other
commands in the task cannot be run.

Also See...
l

System Command - Examples

l

File and Folder Commands

l

Log-to-File Command

l

Manage Windows Controls Command

l

Open Program/File Command

l

Windows Actions Command

Other User
Resources:

Terminal Emulator Command
Available in Enterprise and Small Business editions only.
Use the Terminal Emulator (TE) command to access and control default, DOS-based actions of remote terminals

Overview
Access and control default, DOS-based actions of remote terminals with Terminal Emulator command. Issue DOS commands - dir,
ipconfig, copy, and recover etc. Also, transfer the exact state of an application between tasks to optimize your automation logic.

Sub-Commands
The Terminal Emulator command provides the following sub-commands:
l

Connect

l

Disconnect

l

Send Text

l

Get Text

l

Set Field

l

Get Field

l

Get All Fields

l

Wait

l

Control

Using the Sub-Commands
To insert a Terminal Emulator command in your task, follow these steps:
1. Double-click or drag one of the Terminal Emulator commands to the Task Actions List pane.
2. Specify required parameters in the fields - Session Name, Host Name, Port, Terminal Type and Terminal Prompt.
Tip: For enhanced security, you can opt to insert Credential Variables in 'Host Name'. Learn
More
* Available in Enterprise edition from version 10.2.1
3. Click Save.

Connect Command
Use this command to remotely connect to a terminal. Specify the connection details of the terminal. You can connect to the following
types of terminals:
l

ANSI

l

VT100

l

TN3270

l

TN5250
Note: The default terminal selected is ANSI.

Other User
Resources:

(Image as seen in Enterprise Edition 8.0)

Share Session*
* Available from version 7.5.2 onward
Enable the 'Share Session' option to optimize your automation logic. With it you can trim your bulky tasks as it provides
the required flexibility to transfer the "exact state of the application to another task". You can use the Run Task command
to achieve this.
Note: Only Terminal Emulator command session state can be shared between tasks. The
existing state is passed on to all Terminal Emulator sub-commands in the subsequent tasks
(sub-tasks).
Reference Share Session between Tasks to understand how this option helps you achieve more.

TN Terminal - Options
Enabling Secure Connection
Enabling/Selecting 'SSL' ensures a secure connection for the Terminal Types 'TN3270' and 'TN5250'; the default 'Port'
for the same being '992'.
l

Terminal Type TN3270: Selecting 'Enable TN3270 Support' allows you to choose a 'Connection Method', which
could be either 'Generic' or 'Specific'. You can hence:
a. Input the 'Device Name' when you select a 'Generic' connection method.
b. Input the 'Device Name' and 'Resource (LU) Name' when you select a 'Specific' connection method.

Other User
Resources:

Note: On enabling TN5250 Support, only the 'Device Name' and 'Resource (LU)
Name' can be input.

Advanced View
Advanced view is available on selection of terminal types ANSI and VT100. Specify either of the three protocols viz. Telnet, SSH1, and SSH2 .

(Image as seen in Enterprise Edition 8.2.2)
Note: The default connection type is Telnet.

Other User
Resources:

For SSH1 and SSH2, provide an authentication type to connect to the terminal.
Authentication modes available:
l

User Authentication: Specify a user name and password.

l

Key file Authentication: Select a location for the key file.*

* Only SSH.COM file format supported.
Note: If using SSH2 connection type, it is mandatory to input 'User Name'. Here,
you can opt to insert a Credential Variable for User Name and Password fields.

(Image as seen in Enterprise Edition)

Disconnect Command
Use this command to disconnect from an existing terminal connection.

Send Text Command
Use this command to specify text and send that text to the terminal. You can also send encrypted text by selecting the Encrypt Text
check box.
To send a key after sending the encrypted text, select the required key from the drop-down list.

Other User
Resources:

Get Text Command
Use this command to receive text from the terminal. You can select from the following options:
l

Last Line

l

All Lines

l

Line From-To

l

Lines With Column Range

Other User
Resources:

Set Field
Use this command to set field either by Index or Name for the terminal types TN3270 and TN5250. Setting data through field for such
type of terminals enhances automation for them.

Get Field
Use this command to get a field value by Index or Name and assign it to a variable for the terminal types TN3270 and TN5250.

Other User
Resources:

Get All Fields
Use this command to get value of all fields and assign them to array variables for the terminal types TN3270 and TN5250.

Wait Command
Use this command to insert a Wait command. Inserting a Wait command helps you to automate and trigger another action in your automated task based on the terminal status.

The following options are provided:
l

Wait till text appears

l

Wait till text disappears

l

Wait till cursor moves to position

l

Wait till cursor moves out of position

l

Wait till screen gets blank

l

Wait till screen contain text

Other User
Resources:

l

Wait till terminal prompt appears

l

Wait till terminal Ready State

Control Command
Use this command to control how the terminal is viewed.

The following options are provided:
l

Show Terminal

l

Hide Terminal

l

Clear Terminal

l

Set Cursor Position

Also See...
l

Terminal Emulator Command - Examples

l

App Integration Command

l

Database Command

l

Email Automation Command

l

Excel Command

l

OCR Command

l

PDF Integration Command

l

Read from CSV and Text Files Command

l

XML Command

Other User
Resources:

Share Session Between Tasks
Available in Enterprise and Small Business editions only.
Imagine having to run hundreds of tasks concurrently, which use commands that are repetitive. For instance, having to connect to the
same application, time and again, from different tasks can be cumbersome. An option that gives you the freedom to achieve this using
a single task would help you optimize your automation logic to a greater extent, in the long run.
The 'Share Session' option is designed to achieve this, precisely. You can use the option 'Share Session' in Terminal Emulator command when you want to pass on the exact state of the application to the concurrently occurring tasks and back.

How to 'Share Session'?
You can create a hierarchy of tasks connected by a common thread - 'Share Session':
l

Simply create a 'Main Task' that would connect you to the application with 'Share Session' option enabled/selected, using the Run
Task command

l

Call in other 'Sub Tasks' that obtain the necessary data/information.

In fact, you do not disconnect from the application (terminal in this case) in the Sub Tasks; you simply pass on the exact state of the
application from Main Task to the Sub Tasks and back. This will ensure,
l

Your bulky tasks are trimmed off of repetitive commands for connecting and disconnecting.

l

Which in turn results in you achieving the same results, faster.

Example: Share session to access and fetch data from applications installed on a mainframe terminal
Here, we cite a hypothetical example to guide you through the workings of 'Share Session':
The assumption is that you have access to a mainframe terminal with various applications installed. Usually you would access each
application using separate sessions to connect to the terminal. Hence, each task comprises of repetitive commands such as connect
and disconnect (to clear the earlier data session).
Now that you are armed with the powerful option 'Share Session' you can literally share your existing session state between tasks.

Ideally you could create a Main Task - TE_Share_Main for instance, that calls the other Sub Tasks - TE_BMIS and TE_CMIS. These
Sub Tasks obtain required data/information from various applications.
1. In the Main Task - TE_Share_Main, connect to the mainframe terminal using the 'Connect' sub-command in Terminal Emulator.
Enable 'Share Session'.

2. Include a 'Run Task' command to call in the first Sub Task - TE_BMIS. Ensure that this task has used some set of sub-commands
such as 'Send Text' and 'Set Fields'.

Other User
Resources:

Note: Since share session is enabled, the application BMIS starts in the same terminal that is
connected in the Main Task - TE_Share_Main.

3. Use the 'Get Text' and 'Get Field' command to obtain the required information.

4. To restore the original terminal state, use the 'Send Text' command.

5. The Sub Task ends here and the control is passed on to the Main Task.

Other User
Resources:

l

For the next Sub Task, TE_CMIS, use similar steps - Connect with 'Share Session' option, then use 'Send Text' and 'Set Field' sets
of sub-commands and acquire information using 'Get Text' and 'Get Field' set of sub-commands. Use the 'Send Text' command to
return to Main Task and restore the terminal to it's original state.

6. Create as many Sub Tasks as required and return to the Main Task using Share Session!
7. End the session in the Main Task by adding a 'Disconnect' sub-command.

Other User
Resources:

Variable Operation Command
Use this command to assign variables to a task.

Overview
The Variable Operation command has been designed for allowing you to assign or reinitialize user specified variables (user variables)
The type and source of variables used dictate the assignment and reinitializing. These are applicable during task execution thus allowing the user to reuse the user variables.

Using the Variable Operation Command
To use the Variable Operation command, follow these steps:
1. Select either User Variables or System Variables.
l

For User Variables:
a. Select a user variable to specify a value to an existing user variable that you have defined.
b. Assign a value. You can assign a value to the variable. The right side of the 'equal to' operator can be a regular operation;
for example, you can specify: $var1$ = ($var2$ + $var5$ - 10) / 5.
Note: The operators (, ), /, *, + and - are supported. The left and right parentheses
take precedence, and the operation within them is evaluated from left to right.
Example: In the expression ($Var1$ + 5) * ($Var2$ -10), the first calculation ($Var1$ + 5) will be evaluated
first, then ($Var2$ -10), and the result of both will be multiplied and assigned to the variable specified on the left side
of the equals sign.

l

For System Variables: This option enables you to reset one of the following system variables:
a. Error Description
b. Error Line Number
c. Email From
d. Email To
e. Email Cc

Other User
Resources:

f. Email Subject
g. Email Message

Also See...
l

Variable Operation Command - Examples

l

Using the Variable Manager

l

Using Variables

l

User (Local) Variables

l

System Variables

l

Comment Command

l

Error Handling Command

l

Image Recognition Command

l

Play Sound Command

l

Screen Capture Command

l

String Operation Command

Other User
Resources:

Web Recorder Command
Use this command to edit and enhance an automation task that you build using the Web Recorder.

Overview
The Web Recorder helps you to automate Internet-related task actions. Using the Web Recorder command, you can record tasks to
extract data from the web, download data, test web sites, extract source code, and more.

Sub-Commands
The Web Recorder command provides the following sub-commands:
l

Open and close websites in browser sessions

l

Manage web controls

l

Download data

l

Extract additional data from the web

l

Test websites and locate broken links

l

Navigate URLs

l

Extract Website source code

l

Search by captions

l

Navigate back

l

Execute a Java Script

Using the Sub-Commands
To insert a Web Recorder command in your task, follow these steps:
1. Double-click or drag one of the Web Recorder commands to the Task Actions List pane. The Web Recorder window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.
For more information on using the specific sub-commands, see Editing a Web-only Task with Web Recorder Commands.

Other User
Resources:

Note: It is recommended that you first search in the following sequence: By Caption, By Attributes
and By Index.

Also See...
l

Editing a Task with Web Recorder Command

l

FTP-SFTP Command

l

Internet Connection Command

l

Launch Website Command

l

Send Email Command

l

Web Service Command

Other User
Resources:

Web Service Command
Available in Enterprise and Small Business editions only.
Use the Web Service command to implement SOA (Service Oriented Architecture) over the internet, so that multiple clients can consume web services through the Web, irrespective of the type of applications or platforms.

Overview
The Web Service command is used to access and exchange information over the internet. By using this command, you can:
l

Consume reusable application components as services. Examples are currency conversion, weather reports, and language translation.

l

Connect to different existing applications and different platforms, irrespective of any underlying infrastructure requirements.

The Automation Anywhere Web Service establishes complete inter-polarity between clients/applications and the Web, supporting
XML-based open standards, such as WSDL (Web Services Description Language), SOAP (Simple Object Access Protocol), and UDDI
(Universal Description Discovery and Integration).

Using the Web Service Command
Follow these steps to create a new Web service:
1. Open the task in the Task Editor.

Other User
Resources:

2. Double-click on or drag the Web Service command to the Task Actions List.

3. Enter complete URI: Enter a complete URI (Uniform Resource Identifier) that you want to use for the Web Service.
4. Authentication Details: If you need to use secure Web Services, enter the authentication details, including user name, password,
domain name, and client certificate.
Tip: You can opt to use Credential Variables* using function key 'F2' in Username and Password
fields for enhanced security. Learn More
*Available in Enterprise edition from version 10.2.1
5. Enter Header Parameter(s):*To automate a Web Service using 2 stage authentication, specify the http header parameter. Assign a
variable (local or credential) to the parameter to support dynamic correlation of different web services. i.e. allowing the token
assigned to a variable from header of one service to be passed to the header of another. Also, update or delete existing parameters.
* Available from version 8.1 onward
6. Build Web Service URI: Optionally, to build a customized WSDL URI, click the Build URI button. In the Build Web Service URI window, specify input for services, operations, and parameters.

Other User
Resources:

l

Select Service, Operations and Parameter Details:Once the connection is established, Services and Operations fields will
be auto-populated. If the selected Operation has parameters, the parameters will be populated in the table with its Name,
Type and Value.
You can Add, Update or Delete the parameters for a particular operation.

(Image as seen in Enterprise edition version 8.1)
l

Other User
Resources:

Raw Data Parameter(s):*Enable this option to specify the input in XML format.
* Available from version 8.1 onward

(Image as seen in Enterprise edition version 8.1)
7. Test Output: Test the output data by clicking the Test Output button. You can test the output data from the specified URI.

(Image as seen in Enterprise edition version 8.1)
8. Provide Output details: Specify the file to which you want to save the output data.
The output can be extracted as a whole output or as a partially extracted value. To aid this below two options are provided.
a. Whole Response: When this options is selected the whole response is captured and can be stored in the selected variable.

Other User
Resources:

b. Selected Response: When this option is selected, only the partial response can be captured from the web service in the
form of XPath and this value can then be stored to a variable.
l

Select/View Response: To open an XML Viewer click on this link. Select the appropriate node from the response
body and the XML Path will be automatically created. Store this output into a variable, which can now be passed into
the header parameter of another request. This is particularly useful for correlating two Web Services.

Also See...
l

Web Service Command - Examples

l

Using Advanced Settings

l

FTP-SFTP Command

l

Internet Connection Command

l

Launch Website Command

l

Send Email Command

l

Web Recorder Command

Other User
Resources:

Windows Actions Command
Use this command to automate a Windows-based action, such as minimizing, maximizing, or closing an application window.

Activate Window
Use this command when you need to activate an application that is already running. Specify the window to be activated from the
'Select Window' drop-down.
Tip: Click Refresh to invoke the application you require if unavailable, yet running.

Close Window
Use this command to close an active window when running a task.

Maximize Window
Use this command to maximize an active window when running a task.

Minimize Window
Use this command to minimize an active window when running a task.

Re-size Window
Use this command to re-size an active window when running a task. Click the 'Capture' button to specify the dimensions to which the
window is to be re-sized.

Other User
Resources:

Get Active Window Title
Use this command to assign the active window title to a variable when running a task.

Other User
Resources:

Common Errors
You may encounter the following error while using the Window Actions Command > Activate Window:
Cannot Find Window or Application titled <window title> that was open during recording.

Possible Reason(s)
The Window/Application that was open when recording the task, could be closed.
The Window/Application does not exist anymore.

Possible Solution(s)
Launch/Open Window/Application and run the task.
Check whether the Window/Application exists or not in it's destination folder/path.

Also See...
l

Window Actions Command - Examples

l

File and Folder Commands

l

Log-to-File Command

l

Manage Windows Controls Command

l

Open Program/File Command

l

System Command

Other User
Resources:

XML Command
Feature also available in Standard edition version 8.1.2 or higher.
Use this command to process XML information that is generated from web services and cloud computing applications.

Overview
The XML command supports sessions, node editing, and Xpath expression execution, based on a tree structure of an XML document.
The command enables the automated task to navigate the tree and make selections based on various criteria.
The XML command enables you to capture data that has XML formatting and saves it to a specified location.

Sub-Commands
The XML command provides the following sub-commands:
l

Start XML Session

l

End XML Session

l

Insert Node

l

Delete Node/Attribute

l

Update Nodes

l

Validate XML Document

l

Get Node(s)

l

Save Session Data

l

Execute XPath Function

Using the Sub-Commands
To insert an XML command in your task, follow these steps:
1. Double-click or drag one of the XML commands to the Task Actions List pane. The XML window is displayed.
2. Specify the required parameters in the fields.
3. Click Save to save the command to your automation task.

Other User
Resources:

Start XML Session Command
Use this command to specify the session name and data source (a file or text).

End XML Session Command
Use this command to complement the Start XML Session command and close an open XML session.

Other User
Resources:

Insert Node Command
Use this command to insert a node with attributes and name spaces you specify. The location of the node is based on the position of
the XPath expression.

Delete Node/Attribute Command
Use this command to delete a node or attribute from the XML file, as a result of specifying the XPath value.

Other User
Resources:

Update Nodes Command
Use this command to update nodes in a session at the position that is specified for the XPath expression.

Validate XML Document Command
Use this command to validate session data using XML schema files (.xsd) or internal Document Type Definitions (DTDs). You can also
validate whether the session data is well-formed.

Other User
Resources:

You can store the output of the validation step (VALID/INVALID) in a variable. If an error occurs during validation, it is stored in the system variables named: $Error Line Number$ and $Error Description$.

Get Node(s) Command
Use these commands to retrieve the values of nodes or attributes in the session data.

l

Get Single Node: Retrieves the value of a single node or attribute from the session data, at the position specified in the XPath
expression. The value is assigned to a variable.

l

Get Multiple Nodes: Retrieves values from multiple nodes in the session data, using Text value/XPath expression/Specified attribute name, based on the specified XPath expression.

The value is assigned to a system variable named $XML Data Node (Node name)$, which you can use in conjunction with a LOOP
command. For example, you can insert a loop to search each node in an XML data set.

Save Session Data Command
Use this command to save the session data to a variable. You can also save it to a location you specify.

Other User
Resources:

Execute XPath Function Command
Use this command to execute an XPath function and store the results in a variable.

Also See...
l

XML Command - Examples

l

App Integration Command

l

Database Command

l

Email Automation Command

l

Excel Command

l

Loop Command

l

OCR Command

l

PDF Integration Command

l

Read from CSV-Text Command

l

Terminal Emulator Command

Other User
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Active Directory Command - Examples
Available in Enterprise edition only.
Use Case Scenario
Create a new Organizational Unit and User. Add the User to a Group in Active Directory
1. Open the Task Editor.
2. Double-click/drag and drop the 'Create User' command under the Active Directory tree from the commands list.

3. Enter details in the LDAP Path section by clicking the browse button:

Note: Ensure that the AD connection details are provided correctly for establishing a
valid LDAP path.
4. Follow the steps for the example.
Note: Comments explain the command steps for Active Directory.

Other User
Resources:

Ensure that the Organizational Unit of Sales Department does not exist in the Active Directory structure.
l

Comment: Add a New Organizational Unit under TESTING Domain. i.e. 'SalesOU'

a. Active Directory: Create Object 'SalesOU' of type 'Organizational Unit'at"LDAP://sharepoint/DC=TESTING,DC=COM"

l

Other User
Resources:

Comment: Rename the newly added Object. i.e. Change the name from 'SalesOU' to 'Sales Department'

b. Active Directory: Rename Object 'SalesOU' To 'Sales Department' at "LDAP://sharepoint/DC=TESTING,DC=COM"

l

Other User
Resources:

Comment: Add a Group under Sales OU. i.e. Tier1 Customer

c. Active Directory: Create Group 'Tier1 Customer' at "LDAP://sharepoint/OU= SalesDepartment,DC=TESTING,DC=COM"

l

Other User
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Comment: Add a new User into the Group. i.e. John Smith with logon name as 'S001'

d. ActiveDirectory: Create User 'S001' at "LDAP://sharepoint/OU= SalesDepartment,DC=TESTING,DC=COM"

l

Comment: Add the newly created User (S001/John Smith) under Group named 'Tier1 Customer'

e. Active Directory: Add User(s) to Group 'Tier1 Customer' at "LDAP://sharepoint/OU= SalesDepartment,DC=TESTING,DC=COM"
Tip: You can use the 'Disable' option for other commands, if you wish to test a specific command.

Also See...
l

Active Directory Command

Other User
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App Integration Command - Examples
Available in Enterprise and Small Business editions only.
Capture the text from any control in an application and set the status of a check box depending on the captured text.

Use - Case Scenario
For instance, you want to select the check box 'Send me information on product updates' on the 'Ask the Experts' page of the Automation Anywhere website, you can do the following:
1. Open the application (in this case Browser) from which you want to capture text data.
2. Open the Task Editor in Automation Anywhere Client.
3. Double-click the App Integration command.
4. Drag and drop the Window Application option
l

5.

The App Integration window is invoked.
Select the application type and options through steps 1 and 2:

6. Select the required application window from the drop-down list.

7. Click View Captured Text. This will generate the image preview on the right side, together with the captured text.

Other User
Resources:

l

The program provides a preview of the captured image and text (in this case the window title) in an extended panel:

8. If you need to filter the captured text, check the 'Filter the captured text' check-box and/or optionally specify 'Before' and 'After'
keywords in step 4.

9. Assign the value to a variable from the list.
10. Click Save.
Note: The next step involves assigning a value to the variable and then setting the status of the
check - box to '√ (Checked)'. For this to work, you need to use the 'If-Else' and 'Manage Windows Controls'
commands.

Other User
Resources:

1. Double-click the If/Else command, and drag-drop the option 'Variable'.

2. Click Edit and select the variable you specified in Step 6.
3. Select Equal To(= ), select Fix, and specify the value you want to check as shown:

4. Double-click the Manage Windows Controls command, and double-click Check Box.
5. Select the application window from the drop-down list. Click Capture and hold and drag the mouse to the control you wish to capture (here it is 'Control Box'). The 'Manage Windows Controls' windows displays the details as follows:

Other User
Resources:

6. Set the 'Check Box Status' and Click Save.
7. Save the task.
Note: Your task should resemble the following image:

Using Wild Cards
You can specify wild cards (*) in a window title.
l

For example, use this command to perform an operation in any window that has the word "Untitled" anywhere in its title.

l

To tell Automation Anywhere Client to perform the operation in a window with any text string before or after the word "Untitled" in
the window title, simply specify *Untitled* for the window title.

l

Automation Anywhere Client will first search for the exact window ("Untitled"), and if it doesn't find it, it will look for windows with the
word "Untitled" anywhere in the title.

l

You can put the wild card character (*) at the beginning or end of the window title.

Also See...
l

App Integration Command

Other User
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Bulk Edit Command - Examples
Use Case Scenario 1
Set a common delay of 5 seconds to multiple delay actions having varying delay criteria.
1. Open the Task Editor.
2. Select multiple 'Delay' actions or use the Filters to view all Delay actions in the Task.

3. Select all 'Delay' commands
4. Select 'Bulk Edit' from Actions drop-down or right click and select 'Bulk Edit'.

Other User
Resources:

l

The Delay/Wait Command window is invoked.

5. Type 5 in the Delay text box.
6. Select Delay in Seconds.
7. Click Save.

Use Case Scenario 2
Set a common random delay to multiple 'Delay' actions having varying delay criteria.
1. Open the Task Editor.
2. Select multiple 'Delay' actions in the task.
3. Select Bulk Edit from Actions.

l

The Delay/Wait Command window is invoked.

4. Select Random Delay.
5. Type 5 in the 'From' text box.

Other User
Resources:

6. Type 500 in the 'To' text box.

7. Select Delay in Seconds.
8. Click Save.

Other User
Resources:

Change Window Title Command - Examples
Set a common Window title to multiple Window actions.
1. Open the Task Editor.
2. Select from drop down of Windows filter to select a particular Window.

3. Select the specific commands which contain windows to edit their Window Titles.
4. Select 'Change Window Title' from Actions.

5. In the ensuing Window, type a Window title with which you wish to replace selected Window titles.

6. Use 'Find' and 'Replace' or 'Replace All' to browse and replace the selected Window title.
7. Click Save.

Other User
Resources:

Clipboard Command - Examples
Available in Enterprise and Small Business editions only.
This command is useful when you are transferring data using Ctrl + C (copying) from one application and Ctrl + V (pasting) into another
application; or when you are performing these operations within a loop. Sometimes there is empty data in an application (e.g., Excel
cells), and the copied data needs to be cleared after the previous iteration.
Tip:
1. During a data transfer task, use the Clear Clipboard command before each iteration.
2. Before the End Loop command, insert a Clear Clipboard command.

Use Case Scenario 1
Assign the value of a variable to the Clipboard so that the value can be directly pasted using Ctrl + V after the task completes.
1. Open the Task Editor.
2. Double-click the Clipboard command.
3. Double-click 'Assign To Clipboard.'
4. Select the variable from the drop-down list whose value you want to assign to the Clipboard.
5. Click Save.
At the end of the task, if you want to move some data into the Clipboard, you can use this command so that as soon as the task finishes
you can simply use Ctrl + V to paste the data into the desired application (e.g., an email client).

Use Case Scenario 2
Compare two cells of an Excel document by assigning the value of the Clipboard to a variable.
1. Open the Task Editor.
2. Double-click the Clipboard command.
3. Double-click Assign From Clipboard.
4. Select the variable Cell1 from the drop-down list.
5. You can assign values from the Clipboard only to Value type variables, not to List or Random type variables.
6. Click Save.
Similarly, assign the value of the Clipboard (after performing a Ctrl + C operation) to another variable, Cell2.
Perform the comparison operations on variables Cell1 and Cell2 as needed.

Also See...
l

Clipboard Command

Other User
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Clipboard Command - Examples
Available in Enterprise and Small Business editions only.
This command is useful when you are transferring data using Ctrl + C (copying) from one application and Ctrl + V (pasting) into another
application; or when you are performing these operations within a loop. Sometimes there is empty data in an application (e.g., Excel
cells), and the copied data needs to be cleared after the previous iteration.
Tip:
1. During a data transfer task, use the Clear Clipboard command before each iteration.
2. Before the End Loop command, insert a Clear Clipboard command.

Use Case Scenario 1
Assign the value of a variable to the Clipboard so that the value can be directly pasted using Ctrl + V after the task completes.
1. Open the Task Editor.
2. Double-click the Clipboard command.
3. Double-click 'Assign To Clipboard.'
4. Select the variable from the drop-down list whose value you want to assign to the Clipboard.
5. Click Save.
At the end of the task, if you want to move some data into the Clipboard, you can use this command so that as soon as the task finishes
you can simply use Ctrl + V to paste the data into the desired application (e.g., an email client).

Use Case Scenario 2
Compare two cells of an Excel document by assigning the value of the Clipboard to a variable.
1. Open the Task Editor.
2. Double-click the Clipboard command.
3. Double-click Assign From Clipboard.
4. Select the variable Cell1 from the drop-down list.
5. You can assign values from the Clipboard only to Value type variables, not to List or Random type variables.
6. Click Save.
Similarly, assign the value of the Clipboard (after performing a Ctrl + C operation) to another variable, Cell2.
Perform the comparison operations on variables Cell1 and Cell2 as needed.

Also See...
l

Clipboard Command
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Database Command - Examples
Available in Enterprise and Small Business editions only.
Use Case Scenario 1
Connect to a database and update the records based on user input.
1. Open the Task Editor.
2. Double-click the Database command.
3. Select Connect.
4. Specify the database you want to connect to.
5. Test the connection before you save the command.
6. Similarly, insert a Database -> Insert/Update/Delete command with the appropriate SQL statement.
7. Insert a Database -> Disconnect command.
Tip: The Insert/Update/Delete statement can include variables, and the values of the variables can
be taken from the user with the Prompt command.

Use Case Scenario 2
Query all accounts with revenue over $1 million and print the account names to an Excel file.
1. Open the Task Editor.
2. Double-click the Database command.
3. Select Connect.
4. Specify the database you want to connect to.
5. Test the connection before you save the command.
6. Similarly, insert a Database -> Select Query command with the appropriate SQL statement to get all required accounts.
7. Insert a Database -> Disconnect command.
8. To access the result returned by the SQL Query, use the $Dataset Column$ system variable. Use 'Loop for Each row in a SQL
query dataset' to loop through the rows of the SQL Query result. To access each column, use $Dataset Column(index)$; for
example, to get the first column, use $Dataset Column(1)$.

Use Case Scenario 3
Connect to a database and create tables, drop tables, or alter tables.
1. Open the Task Editor.
2. Double-click the Database command.
3. Select Connect.
4. Specify the database you want to connect to.
5. Test the connection before you save the command.
6. Similarly, insert a Database -> Insert/Update/Delete command with the appropriate SQL statement to create, drop, or alter tables,
etc.
7. Insert a Database -> Disconnect command.
8. Example 4: Connect to a database and call a procedure stored in the database to update records based on user input.
9. Open the Task Editor.
10. Double-click the Database command.
11. Select Connect.
12. Specify the database you want to connect to.
13. Test the connection before you save the command.

Other User
Resources:

14. Similarly, insert a Database -> Run Stored Procedure command with the procedure name and parameters, if any. The procedure
you specify should have already been created in the database.
15. Insert a Database -> Disconnect command.
Tip: The procedure name and parameters can have variables, and the values of the variables can be
taken from the user with the Prompt command.

Samples SQL Queries
l

To query all columns from a table called Table1, use the query Select * From Table1.

l

To query FirstName and LastName from a table called Names, use the query Select FirstName, LastName from Names.

l

To query FirstName and LastName from a table called Names, where FirstName is John, use the query Select FirstName,
LastName from Names WHERE FirstName=John.

Also See...
l
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Delay Command - Examples
Use Case Scenario 1
Insert a delay of 5 seconds.
1. Open the Task Editor.
2. Double-click Delay.
3. Select Delay from the invoked window

4. Type '5' in the Delay text box for the 'Regular Delay' option
5. Select 'Delay in Seconds.
6. Click Save.

Use Case Scenario 2
Generate random delays to simulate user behavior in a testing scenario.
1. Open the Task Editor.
2. Double-click the Delay command.
3. Select Delay.
4. Select the 'Random Delay' option.

Other User
Resources:

5. Type 5 in the 'From' text box and '500' in the 'To' text box.

6. Select 'Delay in Seconds'.
7. Click Save.
Tip: When the task runs and Automation Anywhere Client comes to the random delay command, it generates a random number in the range you specified.

Also See...
l

Delay/Wait Command
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Email Automation Command - Examples
Available in Enterprise and Small Business editions only.
Example 1: Get All Messages from your mail server.
1. Open the Task Editor.
2. Double-click the Email Automation command. Select the Get All Messages option.
3. Specify the Host Name. ie., your mail server ID.
4. Specify your User Name and Password.
5. Select server type. i.e., IMAP or POP3.
6. Specify the Port Number.
7. Specify the mail status if IMAP server type is selected. ie., All, Read or Unread.
8. Specify the message format. It is HTML by default.
9. Optionally, specify the folder where attachments to be saved. If not specified, attachments will not be downloaded.
10. Save the command. An Email Automation loop will be generated and you can access Email Automation variables in it.

Also See...
l

Email Automation Command

Other User
Resources:

Error Handling Command - Examples
Example 1: To continue extraction of all tables from a website after a table is not found.
1. Open the Task Editor.
2. Double-click the Web Recorder command.
3. Double-click the Extract Table command.
4. Type the website URL and click Launch.
5. Once the site is open, you will be redirected to the Extract Table command dialog box. Click Capture.
6. The mouse will appear as a yellow background text indicating 'Please click on the table you want to extract.'
7. Move the mouse over the table you want to extract and click anywhere in the table. (If the text background of the mouse changes to
red, it means the table cannot be extracted.)
8. Specify the local file path for the CSV file where you want to store the results of the command.
9. Click Save.
10. Double-click the Loop command.
11. Double-click Times.
12. For example, if you want to extract all tables with table number between 1 and 50, specify the loop to run 50 times.
13. Click Save.
14. You need to place the Extract Table command within the above loop.
15. Double-click the Error Handling command.
16. Double-click the Begin Error Handling command.
17. Select the Continue option.
18. Select the Log Data into File check box.
19. Type the local file path for the log file, and the text you want to log.
20. Click Save.
21. The Extract Table command should be within the Begin Error Handling and End Error Handling commands.
22. When you run this command, it extracts all tables with table number from 1 to 50 in the Web page you specified, and stores the results in the CSV file you specified. If a table is not found, the error is logged in the specified log file but the task continues to extract
the next table.

Also See...
l

Error Handling Command
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Excel Command - Examples
Example 1: Copy the values in a column in an Excel sheet to another sheet.
1. Open the Task Editor.
2. Double-click the Open Spreadsheet command.
3. Specify a session name, e.g., 'copy cells.'
4. Click

and select the Excel spreadsheet from which you want to copy.

5. Click Save.
6. Double-click the Open Spreadsheet command.
7. Specify a session name, e.g., 'paste cells.'
8. Click '...' and select the Excel spreadsheet where you want to paste.
9. Click Save.
10. Double-click the Get Cells command.
11. Specify a session name, e.g., 'copy cells.'
12. Select Get Multiple Cells and insert the range, e.g., if the range is from cell C6 to C18, insert C6 in From Specific Cell and C18 in To
Specific Cell.
13. Choose Loop for Each row in an Excel Dataset and set the session name as 'copy cells.'
14. Double-click the Set Cells command.
15. Set the session name as 'paste cells.'
16. In the cell value, select the variable Excel Column and select the column number as 1, since you are retrieving values for one
column.
17. Click Save.
18. Double-click the Go to Cells command.
19. Set the session name as 'paste cells.'
20. Select one cell below.
21. Click Save.

Example 2: To copy from Excel into Notepad.
1. Open the Task Editor.
2. Double-click the Open Spreadsheet command.
3. Click

and select the Excel spreadsheet that you want to copy from.

4. Click Save.
5. Click Get Cells.
6. Select Get Multiple Cells and insert the range, e.g., if your range is from cell C6 to C18, insert C6 in From Specific Cell and C18 in
To Specific Cell.
7. Start a Loop for Each row in an Excel Dataset.
8. Make sure Notepad is open.
9. Double-click the Insert Keystrokes command.
10. Select the Notepad window title from the drop-down list.
11. Select the variable Excel Column from the list on the right, and insert the column number as 1, since you are retrieving values for
one column.
12. Insert a special keystroke of [ENTER] after the $ExcelColumn(1)$ variable.
13. Click Save.

Other User
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Example 3: Run an Excel macro in an Excel spreadsheet.
1. Open the Task Editor.
2. Double-click the Open Spreadsheet command.
3. Click

and select the Excel spreadsheet that contains the macro.

4. Click Save.
5. Double-click the Run Excel Macro command.
6. Type the macro name, e.g., Macro1.
7. Click Save.

Example 4: Delete an entire row in an Excel spreadsheet.
1. Open the Task Editor.
2. Double-click the Open Spreadsheet command.
3. Click

and select the Excel spreadsheet.

4. Click Save.
5. Double-click the Delete Cells command.
6. Specify a cell in the row you want to delete.
7. Select Entire Row from the Delete options.
8. Click Save.

Example 5: Getting values under a specified Column Title.
1. In the Task Editor double click 'Open Spreadsheet' sub-command.
2. Click
image):

and select the Excel spreadsheet that hypothetically contains table with the heading titles in the first row (refer

3. Click Save.
4. Select Get Cells > Get All Cells option.
5. Enable 'Contains Header' check-box to enable the task to fetch required data from the specified column.
6. Save the command.
7. Select Loop > Each Row in an Excel dataset and save. This should then populate the Task Editor with the Start Loop, Comment
and End Loop lines.
8. Insert a Message Box command within this loop.
9. Press F2 and select the $Excel Column$ variable
l

A dialog box will pop-up prompting you to enter the Column Header

10. Enter Name in that text-box and click OK
l

You will notice that the Message Box Command will display $Excel Column(Name)$

11. Save the Command.
12. Save and Run the task
l

You will get the values under the Name Column one by one.

Other User
Resources:

Files/Folders Command - Examples
Example 1: Copy files from one folder to another that were created within the last 180 days, and that are 50 Kb
or larger.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Files/Folders. A list of Files/Folders actions appears.
3. Double-click Copy Files. The Files/Folders dialog appears, with the Copy Files option selected.
4. In the Source Files text box, type the path and name of a source file to copy; or click Browse and select a file.
5. In the Destination Folder text box, type the name of a destination folder where you want to copy the file.
6. Click Advanced View. The Command Options appear on the right side of the Files/Folder dialog.
7. In the Select Size drop-down, select 'atleast', and in the KB text box type 50.
8. In the Date drop-down, select 'created date'.
9. Select 'in last' and type 180 in the 'days' text box.
10. Click Save.

Example 2: Rename all .dat files to .bak
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Files/Folders. A list of Files/Folders actions appears.
3. Double-click Rename Files. The Files/Folders dialog appears, with the Rename Files option selected.
4. In the File(s) text box, type the path to the folder that contains the .dat files you want to rename, and specify all .dat files by inserting
the '*' wildcard character. For example: C:\MyFolder\*.dat. Or click Browse and select a folder, and add '*.dat' to the folder path.
5. In the New File Name text box, type the filename extension for the renamed files; for example: *.bak.
6. Click Save.

Example 3: Back up your work at the end of the day in a Zip file.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Files/Folders. A list of Files/Folders actions appears.
3. Double-click Zip Files. The Files/Folders dialog appears, with the Zip Files option selected.
4. In the Specify File(s) to Compress text box, type the path to the folder that contains the files you want to compress. For example:
C:\MyWork\. Or click Browse and choose a folder.
5. Optionally, in the File Type text box, type the filename extensions for the file types you want Automation Anywhere Client to compress. Separate the filespecs with commas; for example: *.doc, *.txt, *.rtf.
6. In the Specify Destination Zip File text box, type a name for the Zip file that will hold the compressed files.
7. To choose advanced options, click Advanced View. The advanced options appear on the right side of the Files/Folder dialog. Here
you can tell Automation Anywhere Client whether to overwrite or move existing files; specify a compression speed; and/or password-protect the resulting Zip file, etc.
8. Click Save.

Example 4: Delete all *.tmp files at the end of the day.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Files/Folders. A list of Files/Folders actions appears.
3. Double-click Delete Files. The Files/Folders dialog appears, with the Delete Files option selected.
4. In the File(s) Name text box, type the path to the file(s) you want Automation Anywhere Client to delete. For example, to delete all
temporary files with a .tmp filename extension in the C:\Temp folder, type: C:\Temp\*.tmp
5. Click Save.

Other User
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Example 5: Print all of the Microsoft Word documents in the folder C:\My Documents\.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Files/Folders. A list of Files/Folders actions appears.
3. Double-click Print Multiple Files. The Files/Folders dialog appears, with the Print Files in a Folder option selected.
4. In the Folder Name text box, type the path to the folder; for example: C:\My Documents\.
5. Optionally, in the File Type text box, type the filename extensions for the file types you want Automation Anywhere Client to compress. Separate the filespecs with commas; for example: *.doc, *.txt, *.rtf.
6. Click Save.

Example 6: Create a shortcut to open a file by clicking an icon on the desktop.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Files/Folders. A list of Files/Folders actions appears.
3. Select the Create File Shortcut option.
4. Specify the location of the file for which you want to create a shortcut. e.g. C:\Temp\DailyPlan.xls.
5. Specify the destination folder where you want to create the shortcut, e.g., C:\Documents and Settings\Administrator\Desktop\.
6. Click Save.

Also See...
l

Files/Folders Command
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FTP (File Transfer Protocol)/SFTP (Secure FTP) Command - Examples
Example 1: Download a file routinely from an FTP/SFTP server
1. Open the Task Editor.
2. Double-click the FTP/SFTP command. Select the Connect option.
3. Specify the server address, e.g., ftp://yourserver.com, and the username/password, and click Save.
4. To use the SFTP feature, check the Secure FTP box.
5. Double-click the FTP/SFTP command and select the Get File option.
6. In Remote File specify the name of the file on the FTP/SFTP server that you want to download, e.g., Folder1/Folder2/myfile.doc.
7. In Local file, select the folder name by clicking the '...' button.
8. If your document is HTML, plain text, or any other ASCII format, select ASCII format, otherwise select binary.
9. Click Save.
10. Double-click the FTP/SFTP command and select Disconnect.

Example 2: Download your Website.
1. Insert an FTP/SFTP > Connect command.
2. Insert an FTP/SFTP > Get Folder command. Specify the folder you want to download from your Web server.
3. Specify the Local Folder where you want to download the FTP/SFTP folder.
4. Optionally, specify *.htm File Type to download only .htm files.
5. Insert an FTP/SFTP > Disconnect command.

Example 3: Upload your Website.
1. Insert an FTP/SFTP > Connect command.
2. Insert an FTP/SFTP > Put Folder command. Specify the folder you want to upload to your Web server.
3. Specify the File Type that you want to upload, e.g., *.htm.
4. Insert an FTP/SFTP > Disconnect command.

Example 4: Periodically clean your FTP/SFTP folder.
1. Insert an FTP/SFTP > Connect command.
2. Insert an FTP/SFTP > Delete File(s) command.
3. Specify the File Types you want to delete, e.g., abc.htm, or *.htm, or abc*.atmx, or *.*, etc.
4. Insert an FTP/SFTP > Disconnect command.

Example 5: Rename files in your FTP/SFTP folder before you upload the new ones.
1. Insert an FTP/SFTP > Connect command.
2. Insert an FTP/SFTP > Rename File(s) command.
3. Specify the file names you want to rename, e.g., abc.htm, or *.htm, or abc*.atmx, or *.*, etc.
4. Specify the filename that you want to give to the files, e.g., OLD*.htm or OLD*.*, etc.
5. Insert an FTP/SFTP > Disconnect command.

Also See...
l
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If-Else Command - Examples
Example 1:

Close the Windows Notepad window (if open).

1. Open Windows Notepad. A new file opens automatically, titled 'Untitled Notepad.'
2. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
3. In the Task Editor, in the Commands list, double-click If/Else. A sub-menu appears.
4. Double-click Window Exists. The If dialog appears, with Window exists selected.
5. In the Select Title drop-down, select 'Untitled Notepad'.
6. Click Save.
Note: You should insert the Close Window command between If and End if statements in the task.
Example 2:

Search for a record. If found, then perform a different set of actions.

1. Automation Anywhere Client can search for an item, a word, or a record in an application, and if found, perform a set of actions that
you specify; and if not found, perform a different set of actions.
2. The following example shows how to search for an item, word, or record that doesn't exist, so that you see the standard application
window that says 'Not Found' (or equivalent wording).
3. Open the application, and display a 'Not Found' (or equivalent) page by searching for nonexistent data.
4. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
5. In the Task Editor, in the Commands list, double-click If/Else. A sub-menu appears.
6. Double-click Window Exists. The If dialog appears.
7. In the Select Title drop-down, select the 'Not Found' window in the application.
8. Click Save.
Note: You would perform steps 1 to 6 to create a new condition within If and End If statements
Example 3:

Make a copy of the log file named mylog.txt, if it exists.

1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click If/Else. A sub-menu appears.
3. Double-click File Exists. If dialog appears with Window exists selected.
4. In the Select File text box, type (or click Browse to browse to) the path and filename of the mylog.txt file.
5. Click Save. Automation Anywhere Client inserts If File Exists and End if commands in the task.
6. In the Task Editor, in the Task Actions List, click the last action before the End If statement.
7. In the Commands list, double-click Files/Folders. A sub-menu appears.
8. Double-click Copy Files. The Files/Folders dialog appears.
9. In the Source File(s) and Destination Folder text boxes, type or browse to the path and filename of the file you want to copy, and the
folder that you want to copy it to.
10. Click Save.
Note: Automation Anywhere Client has inserted the Copy Files action immediately above the End If
statement. When you run the task, Automation Anywhere Client will check if the file exists, and if it
does, it will copy the file to the folder you specified.
Example 4:

Create a task that prompts the user for a value, and if the user types 'STOP' the task stops.

1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Prompt. A sub-menu appears.
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3. Double-click Prompt For Value. The Prompt dialog appears.
4. Click 'Assign the value to an existing variable.'
5. Click Save. Automation Anywhere Client inserts If File Exists and End if commands in the task.
Note: This example uses variables for illustration purposes only.
6. In the Select Variable pull-down, select a variable that you previously created (for example, $User-Input$).
7. Insert an IF condition that compares the value of the $User-Input$ variable with the text 'Stop.' In the IF command, select the option
'Variable'. Click Edit. Specify the variable $User-Input$ in the first text box, select Includes, and under Fix, type 'STOP'.
8. Insert a Stop task command within the IF-End if commands.
9. Set the Repeat property of the task to 'Repeat Until I Stop.'
10. This task will continue to repeat until the user enters 'STOP' when prompted.
Example 5:

To open a downloaded file, if it exists (if not, prompt for another file before proceeding).

1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Prompt. A sub-menu appears.
3. Double-click Prompt For Value. The Prompt dialog appears.
4. Select 'If-File Exists' and type the path to the file in the Select File text box, e.g., C:\Documents and Settings\...\Desktop\Downloadfile.txt.
5. Click Save.
6. In the Commands list, double-click Open Program/File.
7. Type the program/file path.
8. Click Save.
9. In the Commands list, double-click If-Else, then click End if in the sub-menu.
10. Select Else and click Save.
11. Double-click Prompt for File/Folder.
12. Type a custom caption and message.
13. Under Select File/Folder, select File.
14. Assign it to a list variable from the list.
15. Click Save.
16. Double-click Open Program/File again.
17. In the program/file path, press F2 and insert the list variable that was used in Prompt for File/Folder.
18. Click Save.
Example 6:Create a task that checks if a specific Web server in a cluster is up and running.
1. Open the Task Editor.
2. Double-click If-Else, then EndIf in the sub-menu.
3. Select If-Ping-Successful and type the IP address or the hostname of the first Web server in the cluster.
4. Click Save.
5. Select Else If from the If/Else menu. Then select If-Ping-Successful and type the IP address or the hostname of the next Web server
in the cluster.
6. Click Save.
7. Repeat steps 5 and 6 for all Web servers in the cluster.
8. Select Else from the If/Else menu.
9. Double-click Run Task and select a task that you want to run if all Web servers are down.
10. Click Save.
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Example 7: Create a task that sends notifications to Automation Anywhere trial evaluators to opt for a purchase license.
1.

In Automation Anywhere client, launch the Task Editor to create a new task.

2.

Create variables 'Trial_Period', 'Trial_Run' and 'Trial_Saves'. These shall be used in the task for If conditional commands.
Now, you need to tap into customer details to find out when their evaluation package is about to expire. Use the 'Read from
CSV/Text' command to achieve this.

Note: Here we assume that a CSV file is saved to your machine that contains the required data.
Also, each column in the file should contain headers/titles that match the ones specified as variables (see image)
3.

4.

Insert a 'Loop' command to read through each column and fetch the data to make the condition given in the next step true.

5.

Insert an 'If Variable' with 'Match Any' selected in the conditions window, which is invoked on clicking 'Add more conditions'.

6.

Key in the parameters such as 'Trial_Period' Equal to (= )'14' OR 'Trial_Run' Equal To (=) '50 OR 'Trial_Saves' Equal to (=) '50'
for the OR condition 'Match Any'. If any one of the conditions is satisfied for a user, s/he will be notified about the pending
upgrade.

l

Use the 'Add' button to add as many conditions as required.
Note: You can use only a single condition type and cannot use both i.e. Match Any + Match All.
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l

The 'event data' is populated in the IF command window:

9. You will have to send notifications to your evaluation customers to opt for the purchased product version, for which you can use the
'Send Email' command.
l

Insert the command between the If and End If commands.

10. Insert the End Loop at this juncture i.e. at the very end.

Example 8: Search for books by a specific author on an e-com site using the 'AND' condition
1. In Automation Anywhere client, launch the Task Editor to create a new task.
2. Create value type variables 'Books' and 'Author' to be used later into the task.
3. From the commands pane, double click/drag and drop the 'Web Recorder' command and specify url for the e-commerce site you
wish to navigate to.
l

You can now record the steps that lead to searching books by a specific author available on the website with the help of the 'Manage Web Controls' commands.

Tip: Since you will be using 'Manage Web Controls' command a lot in this task, you can copy
and paste where required. simply change the parameters where required!
3. Launch the e-com website with the help of 'Manage Web Control' command and in the 'Advanced View' choose 'Select Item By
Text' and enter item name 'Books'. This action will enable you to select 'Books' from the drop-down list provided in the website.
4. Now you need to assign the same to a variable 'Books' which we did in the beginning. Select the 'Manage Web Controls' command
and in the 'Advanced View' choose 'Get Selected Item' and 'Assign to Variable' 'Books'.
5. Next, time to key in the name of your favorite author! Use the 'Set Text' action in the 'Advanced View' of the 'Manage Web Controls'
command. Key in the author name in the text box 'Text to Set'.
6. The selected author should be assigned to a variable in the next step. Use the 'Get Text' action to do this from the Manage Web
Controls' command.
7. You can now use conditions to scroll through the results on different pages. Insert an 'IF variable' condition. Use the 'Match All'
option in the 'If Variable' window.
8. Set parameters as shown:
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l

The 'event data' is populated in the IF command window:

l

You can edit the parameters if you want to change those.

10. Use the 'Manage Web Controls' command to click on the 'Search' button/control. Choose 'Perform on Click' in Select action in the
Advanced View.
11. You can choose to specify the number of pages to be searched on the website for which you can include a 'Loop' command. Here,
let's specify '5 Times' as the loop.
12. Insert another 'Perform on Click' action here so that the task moves to the next page automatically till 5 have been reached.
Note: Here, insert a delay of 5 or 10 seconds for the page to load completely before moving to
the next one.
13. End loop.
14. Save the task.

Using Wildcards (*)
l

For the options Window Exists, Window Does Not Exist, and Image Recognition, you can specify wildcards (*) in the beginning,
middle and end.

l

For example, if you want to perform an operation if any window has the word 'Microsoft' in the title, you can use wildcards to indicate any string before or after 'Microsoft'.

l

For example, you can specify: IF Window Exists *Microsoft*.

l

Automation Anywhere Client will first search for the exact window title ('Microsoft'), and if it does not find it, it will look for windows
with the word Microsoft anywhere in the title.

Also See...
l

If Else Command
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Image Recognition Command - Examples
Feature also available in Standard edition version 8.1.2 or higher.

Example 1: Search for an image in a website and click it if found.
1. Open the Task Editor.
2. Double-click the Launch Website command.
3. Specify the URL of the website where you want to search for the image.
4. Click Launch.
5. Click Refresh.
6. Select the window where the website has been launched.
7. Click Save.
8. Assign the value to a variable from the list.
9. Double-click the Image Recognition command.
10. Click Save.
When you run the task, it will launch the website and click Image 2 if it is found within Image 1.

Using Wildcards (*)
l

For the options Window Exists, Window Does Not Exist, and Image Recognition, you can specify wildcards (*) in the beginning,
middle and end.

l

For example, if you want to perform an operation if any window has the word 'Microsoft' in the title, you can use wildcards to indicate any string before or after 'Microsoft'.

l

For example, you can specify: IF Window Exists *Microsoft*.

l

Automation Anywhere Client will first search for the exact window title ('Microsoft'), and if it does not find it, it will look for windows
with the word Microsoft anywhere in the title.

Also See...
l

Image Recognition Command
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Insert Keystrokes Command - Examples
Example 1: Insert keystrokes in a Microsoft Word document titled news.doc.
1. Open a document named news.doc in Microsoft Word.
2. In Automation Anywhere Client, click New, and in the Create New Task dialog, click Task Editor.
3. In the Commands list, double-click Insert Keystrokes or drag and drop from the command panel.
4. Click the downward-pointing arrow to the right of the Select Window text box, and in the drop-down list select news.doc - Microsoft
Word.
5. Insert the required keystrokes. For example, type 'Today's tasks are complete" and under Special Keystrokes choose Enter.
6. Click Save.

Example 2: Copy a cell from an Excel document titled data.xls.
1. Open a document named data.xls in Microsoft Excel.
2. In Automation Anywhere Client, click New, and in the Create New Task dialog, click Task Editor.
3. In the Commands list, double-click Insert Keystrokes.
4. Click the downward-pointing arrow at the right of the Select Window text box, and in the drop-down list click Microsoft Excel data.xls.
5. Follow these steps to perform a copy operation by inserting a Ctrl+C command in the Keystrokes window:
a. In the Special Keystrokes section, click Ctrl Down, then type 'c' in the Keystrokes window, and under Special Keystrokes click Ctrl
Up. The Keystrokes window now displays: [CTRL DOWN]c[CTRL UP].
b. Click Save.

Example 3: Insert the current date and time.
For example, to include the date and time in filenames, so that you can identify the files that were created when you ran the task.
Automation Anywhere Client provides system variables that you can use to insert the current date and time and other useful data. The
date system variables are: $Date$, $Year$, $Month$, $Day$, $Hour$, $Minute$, and $Second$. You can configure the $Date$ variable to print the date in your preferred format.
1. In the Task Editor, choose Tools > Variable Manager > System Variables > Date. Click the '...' button to the right of the Date variable, and in the Date format text box, edit the format, or click the down-arrow to the right of the Date format text box and select a
standard format from the drop-down list.
2. For example, to name an Excel file MyExcelResults plus the current date and time, open the File Save dialog in Excel, then follow
steps 1 and 2 above to insert the following in the Keystrokes text box: MyExcelResults-$Year$-$Month$-$Day$-$Hour$-$Minute$$Second$.xls.
3. To configure your own date and time format, using the System variables $Year$, $Month$, $Day$, $Hour$, $Minute$, $Second$,
follow these steps:
4. In the Task Editor, double-click Insert Keystrokes in the Commands list.
5. Click the down-arrow to the right of the Select Window text box, and from the drop-down list select the window where you want to
insert the date and time.
6. From the Insert Variable list, select a system variable (e.g., Date) and click Insert. The variable appears in the Keystrokes text box.

Example 4: Insert keystrokes in any currently active window.
1. Open the window of the application where you want to enter keystrokes.
2. In the Task Editor, double-click Insert Keystrokes in the Commands list.
3. From the Select Window drop-down list, select Currently Active Window.
4. Enter keystrokes and commands in the Keystrokes text box, as described in Example 1 above.
5. Click Save. When you run the task, Automation Anywhere Client will insert your keystrokes.
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Also See...
l

Insert Keystrokes Command
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Insert Mouse Click Command - Examples
Example 1: Perform a mouse click at the Yahoo! sign-in dialog.
1. Open mail.yahoo.com in your Web browser.
2. In Automation Anywhere Client, click New > Task Editor, or Tools > Task Editor.
3. In the Commands list, double-click the Insert Mouse Click command.
4. Click Refresh.
5. From the Select the Window... drop-down, select 'Sign in to Yahoo! - Microsoft Internet Explorer'.
6. Click Capture and hold the left mouse button. Automation Anywhere Client activates the 'Sign in to Yahoo! - Microsoft Internet
Explorer' window.
7. Click the Yahoo! 'Sign In' button, and release the mouse button.
8. In the Insert Mouse Click dialog, click Save.
Note: To insert other types of clicks (double-click, right-click, etc.), click Advanced View and
select the appropriate options.

Also See...
l

Insert Mouse Click Command
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Insert Mouse Move Command - Examples
Example 1: Insert a mouse move command that moves the mouse cursor from position (200,300) to (400,500)
in the active application window.
1. In Automation Anywhere Client, click New Task, Task Editor, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Insert Mouse Move.
3. Select Mouse Position (From).
4. Click Capture. Automation Anywhere Client switches to the active application window.
5. Left-click and drag the mouse to location (200,300) and release the mouse button.
6. In the Insert Mouse Move dialog, select Mouse Position (To).
7. Click Capture. Automation Anywhere Client switches to the active application window.
8. Left-click and drag the mouse to location (400,500) and release the mouse button.
9. In the Insert Mouse Move dialog, click Save.

Also See...
l

Insert Mouse Move Command
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Insert Mouse Move Command - Examples
Example 1: Insert a mouse move command that moves the mouse cursor from position (200,300) to (400,500)
in the active application window.
1. In Automation Anywhere Client, click New Task, Task Editor, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Insert Mouse Move.
3. Select Mouse Position (From).
4. Click Capture. Automation Anywhere Client switches to the active application window.
5. Left-click and drag the mouse to location (200,300) and release the mouse button.
6. In the Insert Mouse Move dialog, select Mouse Position (To).
7. Click Capture. Automation Anywhere Client switches to the active application window.
8. Left-click and drag the mouse to location (400,500) and release the mouse button.
9. In the Insert Mouse Move dialog, click Save.

Also See...
l

Insert Mouse Move Command
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Internet Connection Command - Examples
Example 1: Connect to 'myDialUp'.
1. Open the Task Editor.
2. Double-click the Internet Connection command.
3. Select the Connect option in the 'Internet Connection' category.
4. Select your dial-up connection from the drop-down list.
5. Click Save.

Also See...
l

Internet Connection Command
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Launch Website Command - Examples
Example 1: Open the website www.cnn.com.
1. Open the Task Editor.
2. Double-click the Launch Website command.
3. Type 'www.cnn.com' in the 'Enter a URL and click Launch' text box.
4. Click Launch.
5. Click Refresh.
6. Select the title 'CNN.com - Microsoft Internet Explorer' in the drop-down.
7. Click Save.

Also See...
l

Launch Website Command
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Log to File Command - Examples
Example 1: Monitor the performance of a task by inserting a Log to File command in the task. When task playback reaches the Log to File command, Automation Anywhere Client creates a time-stamp in a log file.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools -> Task Editor.
2. In the Task Editor, in the Commands list, double-click Log to File. The Log to File dialog appears.
3. In the Log File text box, type a path and name for the log file, or click Browse to choose an existing file.
4. Optionally, in the text box, type any text that Automation Anywhere Client should add to the log file each time it creates an entry in
the file.
5. Optionally, select Add Timestamp. Each time the task runs, Automation Anywhere Client will insert the current date and time.
6. After the task runs, you can open the log file (a simple text file) and check the actions that Automation Anywhere Client has played
back. Log files can help you measure the performance and accuracy of your tasks.

Example 2: Log the clipboard contents to help debug a task that copies data.
Let's say you are using loops within your tasks, and you want to check the text in the clipboard variable during each pass of the loop.
Automation Anywhere Client provides system variables called $Counter$ and $Clipboard$. You can log these variables, for example,
by including a $Counter$-$Clipboard$ variables in a Log to File command. For complete information on using variables, see the Using
Variables help section.

Also See...
l

Log to File Command
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Loop Command - Examples
Example 1: Open five Internet Explorer windows with one click.
1. Open the Task Editor.
2. Double-click the Loop command and select the option Times, then type 5 in the text box.
3. Save the command. It automatically inserts an End Loop command.
4. Insert an Open Progam/File command to open IEXPLORE.exe within the Start and End Loop commands.

Example 2: Loop through a list and insert one value at a time in an already-open Excel document.
1. Create a list variable from Tools > Variable Manager (we'll call it $my-list$).
2. Specify an option to have the variable read from a text file.
3. Let's say you have filled the values of the list variable.
4. Double-click the Loop command.
5. Select List and select $my-list$ from the drop-down list.
6. This inserts Start and End Loop commands in the editor.
7. Insert a Keystroke action $my-list$[ENTER in the Excel window. It will type the next value of the list variable each time it loops.

Example 3: Monitor an application and send email to the administrator if the application shuts down.
1. Double-click the Loop command.
2. Select Condition.
3. Select Application Running and specify the path of the application that you want to monitor for (e.g., C:\My-Application.exe).
4. Save the command. It inserts Loop and End Loop commands.
5. Insert a Send Email command after the End Loop command.
6. When you run the task, it loops as long as the application is running. As soon as the application crashes or shuts down, it leaves
the loop and sends an email alert.

Example 4: Query for all contacts in the database that have last name beginning with 'R' and print the names in
an Excel document.
1. Using database commands, connect to a database and issue an SQL query to fetch your records. Insert a Connect command first,
then an SQL Query command.
2. Double-click the Loop command.
3. Select "Each row in a SQL Query dataset."
4. To access the result returned by the SQL query, use the $Dataset Column$ system variable provided by Automation Anywhere Client. Use the 'Loop for Each row in a SQL query dataset' option to loop through all rows of the SQL query result. To access each
column, use $Dataset Column(index)$; for example, to get the first column use $Dataset Column(1)$, and so on.
5. You can use the Insert Keystrokes commands with the $Dataset Column$ variable to type the results in the Excel document.
6. Disconnect from the database.

Example 5: Print prices extracted from a pricing table on a Web page.
1. Use the Web Recorder 'Extract Table' command to extract the tabular data from the Web page.
2. After you call the Extract Table command, Automation Anywhere Client stores all of the tabular data in a system variable called
$Table Column(index)$. You can use this variable to get all the rows and columns of the table you extracted.
3. Double-click the Loop command.
4. Select 'Each row in an Internet Explorer Table.'
5. To access each row and column in the $Table Column$ system variable, use the 'Loop for Each row in an Internet Explorer table'
option to loop through the rows of the table. To access each column, use $Table Column(index)$; for example, to get the first
column, use $Dataset Column(1)$, and so on.
6. You can use the Insert Keystrokes command with the $Table Column$ variable to type the results in the Excel document.

Example 6: Insert an Exit Loop command to break out of the loop.
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1. Open the Task Editor.
2. Double-click the Loop command and select Exit Loop, and move it to the appropriate location between the Start and End Loop commands.
3. The Exit Loop command can appear only between Start Loop and End Loop statements.

Example 7: Insert a Loop for each mail message in your mail server.
1. Click Each Message in Server option.
2. Edit and fill up required details like Hostname, Username, Password, Port number and specify a folder to Save attachemnt in.
3. Save the form.
4. Edit the task. Insert variables to dowload email attributes like Subject, Message, To, Cc, Attachment.
l

This loop extracts and downloads all mail details as specified.

Using Nested Loop
Let's say you are using a nested loop as follows:
1. Start Loop "List Variable my-list-variable"
2. Variable Operation: $my-list-variable$ To $Income$
3. Start Loop "5" Times
4. Keystrokes: $Income$[ENTER] in "Untitled - Notepad"
5. End Loop
6. End Loop
l

You should assign the value of the list variable to a value type variable before the nested loop starts, and use the value type variable inside the nested loop.

l

You can apply the same tip when you are using Loop for each row in an Internet Explorer Table, Loop for each row in a SQL Table,
or Loop for each row in an Excel dataset.
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Loop While Command - Examples
Example 1: Loop While for Object Property of button
1. Open the Test Editor.
2. Double-click the Loop command and select the option Times, then type 5 in the text box.
3. Save the command. It automatically inserts an End Loop command.
4. Insert an Open Progam/File command to open IEXPLORE.exe within the Start and End Loop commands.

Example 2: Loop through a list and insert one value at a time in an already-open Excel document.
1. Create a list variable from Tools > Variable Manager (we'll call it $my-list$).
2. Specify an option to have the variable read from a text file.
3. Let's say you have filled the values of the list variable.
4. Double-click the Loop command.
5. Select List and select $my-list$ from the drop-down list.
6. This inserts Start and End Loop commands in the editor.
7. Insert a Keystroke action $my-list$[ENTER] in the Excel window. It will type the next value of the list variable each time it loops.

Example 3: Monitor an application and send email to the administrator if the application shuts down.
1. Double-click the Loop command.
2. Select Condition.
3. Select Application Running and specify the path of the application that you want to monitor for (e.g., C:\My-Application.exe).
4. Save the command. It inserts Loop and End Loop commands.
5. Insert a Send Email command after the End Loop command.
6. When you run the test, it loops as long as the application is running. As soon as the application crashes or shuts down, it leaves the
loop and sends an email alert.

Example 4: Query for all contacts in the database that have last name beginning with 'R' and print the names in
an Excel document.
1. Using database commands, connect to a database and issue an SQL query to fetch your records. Insert a Connect command first,
then an SQL Query command.
2. Double-click the Loop command.
3. Select "Each row in a SQL Query dataset."
4. To access the result returned by the SQL query, use the $Dataset Column$ system variable provided by Testing Anywhere Client.
Use the 'Loop for Each row in a SQL query dataset' option to loop through all rows of the SQL query result. To access each column,
use $Dataset Column(index)$; for example, to get the first column use $Dataset Column(1)$, and so on.
5. You can use the Insert Keystrokes commands with the $Dataset Column$ variable to type the results in the Excel document.
6. Disconnect from the database.

Example 5: Print prices extracted from a pricing table on a Web page.
1. Use the Web Recorder 'Extract Table' command to extract the tabular data from the Web page.
2. After you call the Extract Table command, Testing Anywhere Client stores all of the tabular data in a system variable called $Table
Column(index)$. You can use this variable to get all the rows and columns of the table you extracted.
3. Double-click the Loop command.
4. Select 'Each row in an Internet Explorer Table.'
5. To access each row and column in the $Table Column$ system variable, use the 'Loop for Each row in an Internet Explorer table'
option to loop through the rows of the table. To access each column, use $Table Column(index)$; for example, to get the first
column, use $Dataset Column(1)$, and so on.
6. You can use the Insert Keystrokes command with the $Table Column$ variable to type the results in the Excel document.
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Example 6: Insert an Exit Loop command to break out of the loop.
1. Open the Test Editor.
2. Double-click the Loop command and select Exit Loop, and move it to the appropriate location between the Start and End Loop commands.
3. The Exit Loop command can appear only between Start Loop and End Loop statements.

Example 7: Insert a Loop for each mail message in your mail server.
1. Click Each Message in Server option.
2. Edit and fill up required details like Hostname, Username, Password, Port number and specify a folder to Save attachment in.
3. Save the form.
4. Edit the test. Insert variables to download email attributes like Subject, Message, To, Cc, Attachment.
5. This loop extracts and downloads all mail details as specified.
6. Using Nested Loop
7. Let's say you are using a nested loop as follows:
8. Start Loop "List Variable my-list-variable"
9. Variable Operation: $my-list-variable$ To $Income$
10. Start Loop "5" Times
11. Keystrokes: $Income$[ENTER] in "Untitled - Notepad"
12. End Loop (for "5" times)
13. End Loop (for my-list variable)
14. You should assign the value of the list variable to a value type variable before the nested loop starts, and use the value type variable inside the nested loop.
15. You can apply the same tip when you are using Loop for each row in an Internet Explorer Table, Loop for each row in a SQL Table,
or Loop for each row in an Excel dataset.
Example 8: Insert Loop While command with 'Wait' time for a 'File to Exist' when downloading data.
1. From the commands list, double click/drag and drop the 'Open File/Folder' command.
2. Insert an 'If file exists' condition.
3. Add delay of 50 milliseconds.
4. Insert 'Delete Files' command and specify the file that should be deleted. This is useful as it deletes files with same name downloaded earlier and allows it to be saved to the same location.
5. End the 'If' command.
6. Insert a 'Web Recorder' command with 'Manage Web Controls' selected.
7. Specify the URL. The website is launched.
8. Capture the required actions - in this case, clicking the download link to save an offline copy of the data to a csv file.
9. The required parameters are populated in the 'Web Recorder' command window.
10. Insert an 'Activate Window' command to activate the website window.
11. Insert a 'Loop While' for 'File does not exists'. This ensures that the program will keep looping till the file does not exists and will
loop out as soon as it finds the required file.
12. Add 'Wait time for the condition to be true'. The time set could be 5 seconds if you feel the file can be downloaded within this time
frame.
13. End the loop.
14. Open the csv file and verify your data.
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Example 9: Insert Loop While command with 'Wait' time for 'Ping Unsuccessful' when uploading files to a server.
1. From the commands list drag and drop/double click the 'Loop While' command for 'Ping Unsuccessful' with 'Wait for condition to be
true' enabled. This ensures that the loop will be executed till the ping is unsuccessful. The task exits the loop as soon as it validates
a ping.
2. Insert 5 seconds as the time and 'End' the loop.
3. Connect to a server using the 'Connect' sub-command in 'FTP/SFTP'.
4. Use 'Start Loop' with 'Each file in Folder' option selected. Here, loop command is used to ensure that all files in the folder are selected for upload to a path specified in the next step.
5. In the 'FTP/SFTP' command select the option 'Put Files' and specify the path.
6. Transfer the data to a csv file using the 'Log to File' command.
7. End the loop.
8. Use the 'Disconnect' sub command of FTP/SFTP.
9. Now mail the data file to the user specified in the 'Send Email' command.
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Manage Windows Controls Command - Examples
Available in Enterprise, Small Business and Premier editions only.
Example 1: Extract a PC's event log.
1. Open the event log whose contents you want Automation Anywhere Client to extract.
2. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
3. In the Task Editor, in the Commands list, double-click Manage Windows Controls. The Manage Windows Controls dialog appears.
4. From the Select Window drop-down list, select the window that contains the log file data you want to capture.
5. Click and hold Capture and select the text in the log file.
6. In the Manage Windows Controls dialog, select Get Text in the right pane under Select Action.
7. In the Assign to variable drop-down, select the variable to which you want to assign the log file. (To learn more about variables, see
Using Variables.)
8. Click Save.

Example 2: Get (or set) the status of a check box.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Manage Windows Control. The Manage Windows Controls dialog appears.
3. Click and hold Capture and drag the mouse to the checkbox whose status you want to capture.
4. From the Select Window drop-down, select the title of the window that contains the checkbox whose status you want to get or set.
5. To get the status of the checkbox:
l

In the Manage Windows Controls dialog, select Get Check Box Status in the right pane.

l

In the Assign to variable drop-down, choose a variable to assign the checkbox status to. (For detailed information on variables, see
Using Variables.)

6. To set the status of the checkbox:
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l

In the Manage Windows Controls dialog, select Set Check Box Status in the right pane.

l

In the Select Check Box Status select Check, Uncheck or Toggle for the appropriate action you want to perform.

7. Click Save.

Example 3: Enter data from a comma-separated (CSV) data file into an application.
1. Open the application where you want to enter data.
2. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
3. In the Task Editor, in the Commands list, double-click Excel. A submenu appears.
4. Double-click the Open Spreadsheet command. The Excel dialog appears.
5. In the Excel dialog, fill in the Spreadsheet Path and Specific Sheet Name text boxes, then click Save.
6. In the Task Editor, in the Commands list, double-click Excel > Get Cells. The Excel dialog appears.
7. In the Excel dialog, select Get Multiple Cells.
8. Fill in the From Specific Cell and To Specific Cell text boxes: type the coordinates of the first and last cells of the data you want to
capture.
9. Click Save.
10. In the Task Editor, double-click Loop. A submenu appears.
11. Double-click Each Row In An Excel Dataset. The Loop dialog appears.
12. Type a session name, and click Save.
13. In the Task Editor, in the Commands list, double-click Manage Windows Controls. The Manage Windows Controls dialog appears.
14. From the Select Window drop-down, select the application window where you want to insert the captured CSV data.
15. Click and hold the Capture button and drag the mouse onto the control you want to select. Then select the required action to set the
value of the control to that from the Excel dataset.
16. Click Save.
17. In the Task Editor, in the Commands list, double-click Loop. A submenu appears.
18. Double-click 'Each Row In An Excel Dataset.' The Loop dialog appears.
19. Select End Loop.
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20. Click Save.
21. In the commands list, double-click Excel. A submenu appears.
22. Double-click Close Spreadsheet. The Excel dialog appears.
23. Click Save.

Example 4: Select options to generate a report with an application.
1. Open the application from which you want to generate the report, and open the application's report-generation options window.
2. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
3. In the Task Editor, in the Commands list, double-click Manage Windows Controls. The Manage Windows Controls dialog appears.
4. In the Select Window drop-down, select the report generation options window.
5. Click and hold Capture and drag the mouse onto the control you want to select.
6. In the Manage Windows Controls dialog, in the right pane under Select Action, select the action to set the value of the control.
7. Click Save.
8. Repeat steps 5 to 7 for each of the options required to generate the report.
9. In the Manage Windows Controls dialog, click and hold Capture and drag the mouse in the application onto the button to be clicked
to save the options you entered and begin processing the report.
10. In the Manage Windows Controls dialog, click Save.

Example 5: Extract a table from a Web page.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Web Recorder and double-click Open Browser. The Web Recorder dialog
appears.
3. In the URL to Open text box, type the URL of the page you want Automation Anywhere Client to open.
4. Click Save.
5. In the Commands list, double-click Manage Windows Controls. The Manage Windows Controls dialog appears.
6. In Internet Explorer, open the page that contains the table you want to extract.
7. In the Manage Windows Controls dialog, in the select Window drop-down, select the Internet Explorer window.
8. Click and hold Capture and drag the mouse onto the Internet Explorer status bar.
9. In the right pane of the Manage Windows Controls dialog, in the Select Action list, select the variable to which you want to assign
the value of the status bar.
10. Click Save.
11. In the Commands list, double-click If/Else. A submenu appears.
12. Double-click Variable. The If dialog appears.
13. Click Edit. The If Variable dialog appears.
14. In the Variable text box, type the name of the variable you specified above.
15. In the Operator drop-down, select Equal To (=).
16. Select Fix, and in the Fix text box, type a value.
17. Click Save.
18. In the Commands list, double-click Web Recorder. A submenu appears.
19. Double-click Extract Table. The Web Recorder dialog appears.
20. In the Step 1 text box, type the URL of the Web page where you want to capture the table.
21. In the Step 3 text box, type the name of a CSV file where you want to save the table data.
Note: The Extract Table command above should be within the If and End If actions.
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22. Click Save.
23. In the Commands list, double-click Web Recorder, and in the submenu double-click Close Browser. The Web Recorder dialog
appears, with Close Browser selected.
24. Click Save.

Using Wildcards (*)
l

You can use wildcards (*) when you specify a window title in any Manage Windows Controls dialog.

l

For example, if you want to perform any operation in any window that contains the word Untitled,' insert the '*' wildcard character to
indicate any number of characters before and/or after 'Untitled': '*Untitled*'.

l

Automation Anywhere Client will first search for a window titled 'Untitled,' and if it does not find it, it will look for other windows
whose names include the word 'Untitled.'

l

You can insert the wildcard character (*) at the beginning or end of the window title.

Also See...
l

Manage Window Controls Command
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Message Box Command - Examples
Example 1: Insert Message Box commands to instruct the user how to change the screensaver on a PC.
1. Insert a Message Box command that says 'Click on Start button and then click on Control Panel.'
2. Insert a Delay of 2 seconds.
3. Insert another Message Box command that says 'Double-click on the Display.'
4. Insert another Message Box command that says 'Select the Screen Saver Tab.'
5. Insert another Message Box command that says 'Select your Screen Saver and click on Apply, then click OK.'

Example 2: Create an automated interactive task that tells the user how to perform the next action.
1. Open the Task Editor.
2. Create a task and insert a Message Box command at appropriate locations to tell the user which actions to take.
3. Insert a Pause command after the Message Box command. Sometimes users may hit OK without reading the complete message.
This ensures that the task does not proceed but pauses until the user manually resumes it.

Also See...
l

Message Box Command
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Object Cloning Command - Examples
Available with Enterprise edition only
Use Case Scenario: To search a topic, say "Introduction to Automation Anywhere" on the Automation Anywhere support site, you can
utilize the 'Object Cloning' command to perform this task.
1. Click on 'New' button in the client to invoke the 'Create New Task' window.
2. Select 'Task Editor' to launch it.
3. From the Commands section, either double click or drag and drop the 'Object Cloning' command.
4. In the 'Select Window' section, from the drop down, select appropriate window; 'Help Desk of Automation Anywhere - Internet
Explorer' in this case.
Note: The window has to be open so as to be visible in the list. If open, yet unavailable,
click 'Refresh'.
5. Click and hold 'Capture', and navigate the mouse to the search box in the support site that launches.
Note: The selected object borders will be highlighted in red.
l

The object properties are populated in the 'Object' tab of the 'Object Cloning' window.

6. From the 'Select Action To Perform' drop down list, choose 'Set Text' option.
7. Key in the search keywords; for instance "Introduction to Automation Anywhere" in the 'Text to Set' option.
8. Save the Command.

l

The next step involves clicking the search button to navigate to appropriate pages.

9. Follow steps 3 and 4. Click and hold the capture button. Navigate your mouse towards 'Search' button.
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l

The 'Search' button properties are populated in the 'Object' tab.

10. In the 'Select Action' section choose 'Left Click' from the list.
11. Save the command.

l

Now you need to navigate to the appropriate topic.

12. Follow Steps 3 and 4. Click and hold the capture button. Navigate the mouse to the listed topics:
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13. Select the topic that meets your parameters.
l

The selected Object properties are populated in the 'Object' tab.

14. Go to 'Select Action' and choose 'Left Click' from the list.
15. Save the command.

16. Save the task.
You are now ready to launch your search for topics on the Automation Anywhere Support site!

Tip: Change the search parameters as and when required by editing the task.

Also See...
l

Object Cloning Command
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Object Recorder Command - Example
Example : To record the setup process of Launch-n-Go setup.
Open the Launch-n-Go setup file.
Click on New > Object Recorder.
Select the Launch-n-Go setup file from the Select Window option. Check the Use Intermediate delay box.
Click Record.
Follow the instructions of the Launch-n-Go setup by using the appropriate control property options that the Object Recorder provides
during each step.
When you finish with the setup file, select Save in the Object Recorder dialog box.
Type in a name for the Task and click Save in the Save Task window.
When you run this task, it will automatically execute the Launch-n-Go setup in the background.
You can also set the SnapPoints to view your actions, step by step, using the Visualize feature.

Also See...
l

Using the Object Recorder
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Open Program/File Command - Examples
Example 1: Open Notepad.exe.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Open Program/File. The Open Program/File dialog appears.
3. In the Program/File Path text box, type 'notepad.exe'.
4. Click Save.
5. Optionally, if you want to open a file in Notepad called mynotes.txt, then type the path and filename in the Parameters text box, for
example, C:\words\correspondence\mynotes.txt.

Example 2: Run a batch file from Automation Anywhere Client.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Open Program/File. Automation Anywhere Client opens the Open Program/File dialog.
3. In the Program/File Path text box, type the path and name of the batch file; e.g., C:\My-Batch-File.bat.
4. Click Save.

Example 3: Open a Microsoft Word document.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click Open Program/File. Automation Anywhere Client opens the Open Program/File dialog.
3. In the Program/File Path text box, type the path and name of the batch file; e.g., C:\My Documents\smithletter.doc.
4. Click Save.
Tip: If you use the Record feature in Automation Anywhere Client to create a task that opens an
application or a file, you can make the task run faster by opening the task in the Task Editor and
replacing the multiple keystrokes that you recorded with single Open Program/File commands, as
described in the examples above.

Also See...
l

Open Program/File Command
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PDF Integration Command - Examples
Available in Enterprise edition only

Example 1: Extract form fields from a downloaded and pre filled PDFs and split them, then merger and encrypt
them.
Open the Task Editor.
See the below example with detailed steps and Comments explain the task steps.
1. Download file '$FolderPath$fw4.pdf' from 'http://www.irs.gov/pub/irs-pdf/fw4.pdf'
Comment: After download, fill in details of the forms. In this example two pre-filled forms are taken.
Comment: Below loop creates folders for the output files
2. If Folder Does Not Exist ("$OutPutFolderPath$") Then
Create Folder "$OutPutFolderPath$"
Create Folder "$OutPutFolderPath$$EmployeeData$"
Create Folder "$OutPutFolderPath$$DeductionSheets$"
End If
Comment: Below Loop will save images into $OutPutFolderPath$
3. Start Loop "Each File In Folder $FolderPath$"
4. PDF Integration: Convert "$FolderPath$$FileName$.pdf" to images as "$PDFFileName$_$PDFTitle$" under folder "$OutPutFolderPath$$EmployeeData$"
5. PDF Integration: Convert "$FolderPath$$FileName$.pdf" to images as "$PDFFileName$_$PDFTitle$" under folder "$OutPutFolderPath$$DeductionSheets$"
6. End Loop
Comment: Creation of one csv file as below to store the extract form fields.
7. Log to File: "First Name","Last Name","Home Address","City,State,Zip","Security Number","Employer","Section 10" in "$OutPutFolderPath$$CsvFilePath$"
Comment: Below loop will process each file from from $FolderPath$ and extract form fields to $OutPutFolderPath$\PDFOutput.csv
8. Start Loop "Each File In Folder $FolderPath$"
9. PDF Integration: Extract Form Fields from "C:\Sample PDF\fw41.pdf"
10. Log to File: "$FirstName$","$LastName$","$HomeAddress$","$CityStateZip$","$SecurityNo$","$EmployerName$","$AmountForSection10$" in "$OutPutFolderPath$$CsvFilePath$"
11. End Loop
Comment: Below loop will process each file from $FolderPath$ and will split into two parts that is employee data and deduction
sheet.
12. Start Loop "Each File In Folder $FolderPath$"
13. PDF Integration: Split "$FolderPath$$FileName$.pdf" into files as "$FileName$" under folder "$OutPutFolderPath$\$EmployeeData$"
14. PDF Integration: Split "$FolderPath$$FileName$.pdf" into files as "$FileName$" under folder
"$OutPutFolderPath$\$DeductionSheets$"
15. End Loop
Comment: Merge all the documents into single file and save under $OutPutFolderPath$
16. PDF Integration: Merge Documents into "$OutPutFolderPath$\AllFormsDetail.pdf"
Comment: Encrypt document and save under $OutPutFolderPath$
17. PDF Integration: Encrypt Document "$OutPutFolderPath$\AllFormsDetail.pdf"; Save it as "$OutPutFolderPath$\EncryptedAllFormsDetail.pdf"

Also See...
l

PDF Integration Command
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PGP Command - Examples
Available in Enterprise edition only.
Example 1: Create folders and encrypt and decrypt file using Passphrase.
1. Open the Task Editor.
2. See the below example with detailed steps and Comments explain the task steps.
3. If Folder Does Not Exist ("c:\pgp") Then
2
Comment: Please enter the conditional commands here.
3
Create Folder "c:\pgp"
4 End If
5 If File Does Not Exist ("c:\pgp\pgp.txt") Then
6
Comment: Please enter the conditional commands here.
7
Create File "c:\pgp\pgp.txt"
8 End If
9 Open File "C:\pgp\pgp.txt"
10 Keystrokes: [SHIFT DOWN]welcome to security[SHIFT UP]command "pgp.txt - Notepad" with delay: 5 ms
11 Keystrokes: [CTRL DOWN]s[CTRL UP] in "pgp.txt - Notepad" with delay: 5 ms
12 Close Window: "pgp.txt - Notepad"
13 If Folder Does Not Exist ("c:\pgp\encrypt") Then
14
Comment: Please enter the conditional commands here.
15
Create Folder "c:\pgp\encrypt"
16 End If
17 PGP: Encrypt Files using Passphrase; Source: "C:\pgp\pgp.txt"; Destination: "C:\pgp\encrypt"
18 If Folder Does Not Exist ("c:\pgp\decrypt") Then
19
Comment: Please enter the conditional commands here.
20
Create Folder "C:\pgp\decrypt"
21 End If
22 PGP: Decrypt Files using Passphrase; Source: "C:\pgp\encrypt\"; Destination: "C:\pgp\decrypt\"

Example 2: Create folders and encrypt and decrypt file using Keys after creating the key files first.
1. Open the Task Editor.
2. See the below example with detailed steps and Comments explain the task steps.
1 If Folder Does Not Exist ("c:\pgp") Then
2
Comment: Please enter the conditional commands here.
3
Create Folder "c:\pgp"
4 End If
5 If File Does Not Exist ("c:\pgp\pgp.txt") Then
6
Comment: Please enter the conditional commands here.
7
Create File "c:\pgp\pgp.txt"
8 End If
9 Open File "C:\pgp\pgp.txt"
10 Keystrokes: [SHIFT DOWN]welcome to creation of key files [SHIFT UP]bc in "pgp.txt - Notepad" with delay: 5 ms
11 Keystrokes: [CTRL DOWN]s[CTRL UP] in "pgp.txt - Notepad" with delay: 5 ms
12 PGP: Create Keys; Public key: "C:\pgp\public.pkr"; Private key: "C:\pgp\private.skr"
13 Close Window: "pgp.txt - Notepad"
14 If Folder Does Not Exist ("c:\pgp\encrypt") Then
15
Comment: Please enter the conditional commands here.
16
Create Folder "c:\pgp\encrypt"
17 End If
18 PGP: Encrypt Files using Public Key; Source: "C:\pgp\pgp.txt"; Destination: "C:\pgp\encrypt"
19 If Folder Does Not Exist ("c:\pgp\decrypt") Then
20
Comment: Please enter the conditional commands here.
21
Create Folder "C:\pgp\decrypt"
22 End If
23 PGP: Decrypt Files using Public Key; Source: "C:\pgp\encrypt\"; Destination: "C:\pgp\decrypt\"
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Play Sound Command - Examples
Example 1: Insert a Play Sound command to beep when the task finishes.
1. Open the task in the Task Editor.
2. Double-click the Play Sound command and select Play Beep option.
3. Click Save.
4. Move the Play Beep action to the last position in the task.

Example 2: Play a recorded file.
1. Open the task in the Task Editor.
2. Double-click the Play Sound command, select Play Media File option and specify a file to play.
3. Select the media file to play, and click Save.

Also See...
l
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Printers Command - Examples
Example 1: Change the default printer.
1. Open the Task Editor.
2. Double-click the Set Default Printer command.
3. Select a printer from the list of installed printers.
4. Click Save.

Example 2: Remove a printer.
1. Open the Task Editor.
2. Double-click the Remove Printer command.
3. Select a printer from the list of installed printers.
4. Click Run script command.
5. Click Save.

Also See...
l
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Prompt Command - Examples
Example 1: Prompt the user for Start and End dates and generate a sales report for the date range.
1. Open the Task Editor.
2. Double-click the Prompt command and double-click Prompt For Value.
3. Select Don't Write In Any Window from the drop-down list.
4. Type a message to prompt the user for the Start date.
5. Assign the value the user enters to a variable, by selecting the variable from the variable list.
6. Similarly, assign the End date entered by the user to a variable.
7. You can use the two variables in place of start and end dates in the task that generates the sales report.
8. When the task runs, the two variables will be assigned the values entered by the user.

Example 2: Create a task that prompts the user for data and automates the installation of an application.
1. Click Record in Automation Anywhere Client.
2. Perform the steps to install the application.
3. If you plan to run the task on different computers with different resolutions, we suggest using the keyboard instead of the mouse
while recording the installation process.
4. After you finish recording and save the task, select it in the Task List and click Edit.
5. Review your keystroke actions, such as the actions where you specified an installation folder, etc.
6. Right-click an action and select Convert to Prompt (or select it and click the Actions button).
7. This converts your recorded keystrokes to a Prompt command that prompts the user when the task runs.
In this manner, you can create a generic task to automate the application and not depend on the values you entered while recording.

Example 3: Prompt for a file that will be used in a loop to enter data.
1. Open the Task Editor.
2. Double-click the Prompt command and double-click Prompt for File.
3. Type the caption text.
4. Enter a custom message for the user to specify the file.
5. Assign the value to a list variable from the list.
6. Expand the Loop command and double-click the list.
7. Select the list variable you assigned to the file.
8. Double-click the Insert Keystrokes command.
9. Select the window title from the list of files where the data will be entered.
10. Type the data you want to insert into the file.
11. Click Save.
Note: This is a procedure for a single file. You can do the same for multiple files; you will have
to check 'Enable this task to run with similar window titles/files' under the General Tab, in the Properties menu.

Example 4: Prompt for the folder that contains a setup file (setup.exe).
1. Open the Task Editor.
2. Double click the Prompt command and double-click Prompt for Folder.
3. Type a caption.
4. Type a message for the user to select the folder.
5. Assign the value to a value variable from the list.
6. Click Save.
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7. Double-click the Open Program/File command.
8. In the Program/File path, type the variable to which you assigned the value of the folder, followed by '\setup.exe'.
9. Click Save.

Example 5: Prompt the user for confirmation before deleting a record from a database.
1. Open the Task Editor.
2. Insert the command to connect to a database.
3. Double-click the Prompt command and double-click Prompt For Yes/No.
4. Type a message for the user to select the folder.
5. Type a caption.
6. Type a custom message asking the user to select the desired option (Yes/No).
7. Assign the value to a value variable from the list.
8. Click Save.
9. Double-click the Loop command and double-click Condition.
10. In the If dialog, choose File exists.
11. Insert an If - Variable condition to check whether the variable to which the value assigned has the value Yes.
12. Click Save.
13. Double-click the Database command and double-click Insert/Update/Delete.
14. In the Database dialog, in the Enter Insert/Update/Delete Statement text box, type the delete statement to delete a record from a particular table.
15. Click Save.
16. In the Program/File path, type the variable to which the value of the folder was assigned, followed by \setup.exe.
Double-click the Database command and double-click Disconnect.
17. Click Save.

Also See...
l
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Read From CSV/Text Command - Examples
Example 1: Read values from a tab-delimited CSV file and transfer the values to another application.
1. Open the Task Editor.
2. Double-click the Read from CSV/Text command.
3. Specify the name of the CSV file you want to read.
4. Select Tab as the delimiter, and check the Header check box if your CSV file has headers.
5. Click Save.
6. To access the values returned by the command, use the $Filedata Column$ system variable. Use the 'Loop for Each row in a
CSV/Text file' option to loop through the rows of the result. To access each column, use $Filedata Column(index)$; for example, to
get the first column, use $Filedata Column(1)$.
7. Within the loop, insert Manage Windows Controls commands to set the value of the controls in the target application.

Example 2: Getting values under a specified Column Title.
1. In the Task Editor double click 'Read from CSV/Text' command.
2. Click

and select the CSV File that hypothetically contains table with the heading titles in the first row (refer image):

3. Tick the Contains Header check-box.
4. Save the command.
5. Double click on Loop > Each Row in A CSV/Text File Command.
6. Save the command; it should then populate the Task Editor with the Start Loop, Comment and End Loop lines.
7. Inside the loop, double click the Message Box Command
8. Press F2 and select the $Filedata Column$ variable
l

A dialog box will pop-up prompting you to enter the Column Header

9. Enter Name in that text-box and click OK
l

You will notice that the Message Box Command will display $Filedata Column(Name)$

10. Save the Command.Save and Run the task; you will get the values under the Name Column one by one.
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Registry Command - Examples
Example 1: Create a new registry key, before creating a key check out whether it is already created or not.
1. Open the Test Editor.
2. Insert Checkpoint - Registry, select "Registry key exists" option and provide a registry key to check if the registry key exists or not.
3. Double-click the Registry command.
4. Enter the registry key to be created.
5. Enter a value name of the key to be created.
6. Select a type of a value.
7. Enter appropriate data for the value according to the selected value data base.
8. Click Save.
9. Save the test.

Example 2: Get data of a value from registry
1. Open the Test Editor.
2. Double-click the Get Value Data command.
3. Specify the registry key for which data needs to be fetched.
4. Assign the value to a variable from the list.
5. Click Save.
6. Save the test.

Example 3: Export the registry
1. Open the Test Editor.
2. Double-click the Export command.
3. Select the export range.
4. Provide the path where you want to save the exported registry file.
5. Click Save.
6. Save the test.
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REST Web Service Command - Examples
Available in Enterprise and Small Business editions 8.2.1 onward.
Change parameters of country for a REST Web Service and verify.
1. Open REST Web Service command.
2. Enter complete URI for any web service which is up and running and you want to test.
3. Using different methods for REST service, like GET and PUT perform the necessary actions.
4. Save the response to different variables where necessary and save each command.
To enhance the test, as shown below, we have also included checkpoints wherever necessary to verify the actions that are performed.
a. REST Web Service: Method: "PUT"; Request: "http://192.168.2.23:9090/RestOrderService/OrderService.svc/UpdateOrder"; Save Response To: "$Prompt-Assignment$"
b. REST Web Service: Method: "GET"; Request: "10248"; Save Response To: "$Prompt-Assignment$"
c. Message Box: "$Prompt-Assignment$"
d. CheckPoint: $Prompt-Assignment$ Includes "US"
e. REST Web Service: Method: "PUT"; Request: "http://192.168.2.23:9090/RestOrderService/OrderService.svc/UpdateOrder"; Save Response To: "$Prompt-Assignment$"
f. REST Web Service: Method: "GET"; Request: "10248"; Save Response To: "$Prompt-Assignment$"
g. Message Box: "$Prompt-Assignment$"
h. CheckPoint: $Prompt-Assignment$ Includes "India"
i. REST Web Service: Method: "POST"; Request: "http://192.168.2.23:9090/RestOrderService/OrderService.svc/PlaceOrder"; Save Response To: "$Prompt-Assignment$"
j. Message Box: "$Prompt-Assignment$"
k. CheckPoint: $Prompt-Assignment$ Includes "true"
l. REST Web Service: Method: "GET"; Request: "http://192.168.2.23:9090/RestOrderService/OrderService.svc/GetOrderDetails/1010"; Save Response To: "$check$"
m. Message Box: "$check$"
n. CheckPoint: $check$ Includes "India"
o. REST Web Service: Method: "PUT"; Request: "http://192.168.2.23:9090/RestOrderService/OrderService.svc/UpdateOrder"; Save Response To: "$Prompt-Assignment$"
p. REST Web Service: Method: "GET"; Request: "10248"; Save Response To: "$Prompt-Assignment$"
q. Message Box: "$Prompt-Assignment$"
r. CheckPoint: $Prompt-Assignment$ Includes "US"

Also See...
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Run Script Command - Examples
Example 1: Summation of all Variables using Java script.
1. Create and save a Java Script to sum all variables.
2. Create user defined variables using variable manager. For example:
Variable as 0 and variable1, variable2, variable3, variable4, variable5 as NULL.
3. Now Using Variable operation command
Assign Variable1 = Variable + 1
Variable2 = Variable1 + 1
Variable3 = Variable2 + 1
Variable4 = Variable3 + 1
Variable5 = Variable4 + 1
4. Click Run script command.
5. Specify the saved Java Script in Insert Script.
6. Insert assigned variables in parameters field. Insert a variable Return value field.
7. Drag and Drop a message box command, Using F2 support insert the variable which will return the sum.
8. Save the task.
9. Result: When you run this task, it will run the script and return a message box with summation of all variables.

Example 2: Loop through all files in a folder, and pass each filename as a parameter to a VBScript that checks
the size of the file and prompts the user.
1. Double-click the Loop command.
2. Select 'Loop for each file in a folder.'
3. Specify the path of the folder from which you want to pass all the files as a parameter to the VBScript.
4. Call the VBScript within the loop and pass the following system variables as a parameter to the script: $CurrentDirectory$,
$FileName$.$Extension$.
5. Save the task.

Example 3: Create Run time database to insert records into database (.mdb) file from an Excel operation or a
Database task.
1. Create and save a script in VBScript to create a database (.mdb) file.
2. Edit the required Excel operation or Database task.
3. Select the task action where you wish to create a database(.mdb) file.
4. Click Run script command.
5. Specify the saved VBscript in Select Script. Click Save.
6. You can then specify Loop and Database operations to read required Excel data and insert the data into the database file(.mdb)
7. Save the task.
l

When you run this task, it will run the script and create a database file(.mdb) after which data will be inserted from Excel into the
database(.mdb) file.
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Example 4: Add data into an XML file from an Excel operation.
1. Create and save a script in VBScript to add data into XML file.
2. Edit the required Excel operation.
3. Specify Loop and Database operations to get required Excel data.
4. Select the task action where you wish to add Excel data into XML file.
5. Click Run script command.
6. Specify the saved VBscript in Select Script.
7. Insert variables in Parameters.
8. Click Save.
9. Save the task.
l

When you run this task, it will run the script and add Excel data into the specified XML file.

Also See...
l
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Run Task Command - Examples
Example 1: Create a process (Task Chain) that calls several smaller tasks.
1. Open the Task Editor.
2. Double-click the Run Task command.
3. Click Browse, and select the path to notepad.atmx.
4. You can select repeat and speed properties for the task.
5. Click Save.
6. Insert Run Task commands to call the remaining tasks.

Note: You can run as many tasks as you want from a single task. You can also chain tasks, e.g. call
Task2 from Task1, and call Task3 from Task2, etc. You can even call tasks conditionally; for example
you can call the Run Task command within an IF condition.

Also See...
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Screen Capture Command - Examples
Example 1: Capture a screen of an active application.
1. Open the application that you wish to capture.
2. Open the Task Editor in Automation Anywhere Client.
3. Double-click the Screen Capture command.
4. Choose 'Capture Window' option.
5. Select the application window from the drop-down list.
6. Provide the path where you want to save the captured image of the application screen.
7. Click on 'Overwrite File' to overwrite the output if desired.
8. Click on Save.
9. Save the task.

Also See...
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Send Email Command - Examples
Example 1: Send an email to a list of contacts, and attach a document with details about a new product.
1. Create a List variable for your list of contacts. You can enter all of the list values in the Variable Manager, or you can read the data
from a text file.
2. Open the Task Editor.
3. Insert a Loop for List variable action from the Loop command. Select the list variable that you created in step 1.
4. Double-click the Send Email command.
5. Specify the appropriate From address.
6. In the To text box, type the list variable you created in step 1.
7. Specify the path and name of the document you want to attach.
8. Type the email message you want to send.
9. You can use the following keywords to send specific information about the task: <taskname>, <desc>, <repeat>, <status>,
<lastruntime>.
10. Save the command.
11. Place the Send Email command within the Start and End loop.
12. When you run the task, it loops through the list and sends an individual email to each contact, with the attached document.

Also See...
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Services Command - Examples
Example 1: Start a user-defined or Windows service, if it is not already running, before running an application
that requires the service to be running.
1. Open the Task Editor.
2. Double-click the Get Service Status command.
3. Select the service from the list of available installed services.
4. Select the variable from the list to assign the value to.
5. Click Save.
6. Insert an IF condition that checks whether the value of the variable selected in step 4 is not equal to Started. In the IF command,
select the option Variable. Click Edit. Type the variable in the first text box, select the operator Not equal To (<>), and in the Fix
option, type Started.
7. Double-click the Start Service command and insert the same actions within the If-Endif commands.
8. Select the service from the list of available installed services.
9. Click Save.
10. Double-click the Open Program/File command.
11. Specify the name of the application you want to run.
12. Click Save.

Example 2: Pause a service before performing an action, then resume it.
1. Open the Task Editor.
2. Double-click the Pause Service command.
3. Select the service from the list of available installed services.
4. Click Save.
5. Insert the commands for the actions you want to perform.
6. Double-click the Resume Service command.
7. Select the service from the list of available installed services.
8. Click Save.

Also See...
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Simple Network Management Protocol (SNMP) Command - Examples
Example 1: Send a SNMP Get message to agent to access its computer information.
1. Open the Task Editor.
2. Double-click the SNMP Get command.
3. Specify the name or IP address of Agent ie., newpc or 132.18.4.12
4. Specify the Community that the Agent belongs to.
5. Specify Object ID.
6. Select the required Data Type format options, ie., Ascii or Hex.
7. Specify a path for the log file.
8. You can assign the result value to a variable.
9. In Advanced View, specify the SNMP version V1 or V2C.
10. Specify the Timeout required in milliseconds ie., 1000
11. Specify the Remote port.
12. Specify the number of retry times for the message.
13. Click Save.

Example 2: Send Trap message to SNMP Manager.
1. Open the Task Editor.
2. Double-click the Send Trap command.
3. Specify the name or IP address of Agent ie., newpc or 132.18.4.12
4. Specify the Community that the Agent belongs to.
5. Specify Object ID.
6. Select required Trap Type from the list options.
7. In Advanced View, specify the SNMP version V1 or V2C.
8. Specify the Timeout required in milliseconds .ie.,1000
9. Specify the Remote port.
10. Specify the number of retry times for the message.
11. Click Save.

Also See...
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Web Service Command - Examples
Available in Enterprise and Small Business editions only.

Example 1: Creating a Web service.
1. Open Web Service command.
2. Enter complete URI for any web service which is up and running.
l

Example:http://www.xignite.com/xGlobalQuotes.asmx?WSDL

3. Click the Test Output button to view the Web Service Output data.
4. Save the data as an XML file or assign it to a variable.
5. Save and exit the Web Service command.

Also See...
l

Web Service Command

Other User
Resources:

System Command - Examples
Example 1: Lock the computer.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click System. A submenu appears.
3. Double-click Lock Computer. The System dialog appears. Note the green symbol indicating that the Shutdown command can help
save energy and spare the environment.
4. Click Save.

Example 2: Shut down the computer.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click System. A submenu appears.
3. Double-click Shutdown. The System dialog appears. Note the green symbol, indicating that the Shutdown command can help save
energy and spare the environment.
4. Click Save.

Example 3: Restart the computer.
1. In Automation Anywhere Client, open the Task Editor. To open an existing task, select the task in the Task List, and click Edit. To
create a new task, click New, or choose Tools > Task Editor.
2. In the Task Editor, in the Commands list, double-click System. A submenu appears.
3. Double-click Restart.
4. Click Save.
Note: Always put System commands last in tasks, since actions entered after the System command will
not be executed.
Tip : You can have Automation Anywhere Client perform an auto-login, so that when your computer
restarts, Automation Anywhere Client will enter your username and password. Learn more about auto-login .

Also See:
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Terminal Emulator Command - Examples
Available in Enterprise and Small Business editions only.
Example 1: Obtain ipconfig of remote terminal using default prompt actions.
1. Open the Task Editor.
2. Double-click the Terminal Emulator command. Select the Connect option.
3. Specify the Connection Type, e.g., TCP/IP
4. Specify Host Name of the remote terminal.ie., Admin.
5. Select the Terminal Type from the drop down list.
6. The Port is set to 23.
7. Insert the Default Prompt command of the terminal ie.,C:\Documents and Settings\Admin> cannot be extracted.)
8. Check Wait For Default Prompt if you to issue a delay. Specify the Wait Time in milliseconds.
9. Check the Show Terminal Window if you want to view the action as it happens.
10. Click Save.
11. Select the Send Text feature.
12. In the Send Text type ipconfig.You can also press F2 to insert a variable. If you wish to encrypt the text, select the Encrypt Text
check box.
13. Select an option if Wait for Default is desired.
14. Click Save.
15. Select the Get Text feature.
16. Select All lines form Get Text option.
17. Insert a variable in Assign Text To Variable text box i.e., $Clipboard$. You can also press F2 to insert a variable.
18. Click Save.
19. Select Message Box from the Commands list..
20. Enter a caption title for the Message box. You can also press F2 to insert a variable.
21. Insert variable $Clipboard$ in Please enter message to show the user text box. Specify scrollbar options for message box if
desired.
22. Click Save.
23. Insert a disconnect command from the terminal selecting the Disconnect feature .
24. When you run this task the ipconfig of the Admin terminal will be viewed as a message on your computer screen.

Also See...
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Variable Operation Command - Examples
Example 1: Use Variable Operation for an array variable for assignment and reinitialize operations.
1. Open the Task Editor.
2. See below task with all details mentioned as comments for execution of task.
1 Comment: We use an array variable to read from existing excel file and then resue it using data from another csv file extracted from
website and then insert to database.
2 Connect to "$ConnectStr$" Session:'Default'
3 Comment: ArrayRows is a system defined variable used to retrieve total rows in the user defined array.
4 Comment: ArrayExl - is a user defined array varaible with source as Read from Excel file . Here in our example we use the list of the
books and games of the kids having title and cost, which is initalized in Variable Manager.
5 Variable Operation: $ArrayRows($ArrayExl$)$ To $Row$
6 Start Loop "$Row$" Times
7
Comment: To skip the header title of the csv extracted from the website use below If condition
8
If $Counter$ Equal To (=) "1" Then
9
Continue
10
End If
11
Execute SQL Statement: 'Insert into Ebaykids (BookTitle,cost) values ("$ArrayExl($Counter$,1)$",'$ArrayExl($Counter$,2)$')' Session: 'Default'
12 End Loop
13 Open "http://www.ebay.com/"
14 Comment: Extracting the books on the philosophy into a csv file using Web Recorder
15 Set text 'philosophy books' into _nkw in the webpage 'Electronics, Cars, Fashion, Collectibles, Coupons and More Online Shopping
| eBay'
16 Click on 'Search' Command Button in the webpage 'Electronics, Cars, Fashion, Collectibles, Coupons and More Online Shopping |
eBay'
17 Loop While Web Control Exists (Other HTML Control : Next ) in the webpage 'philosophy books | eBay'
18
Extract Multiple Data from Webpage to $filePath$ from the web page: philosophy books | eBay
19
Click on 'Next' Other HTML Control in the webpage 'philosophy books | eBay'
20 End Loop
21 Extract Multiple Data from Webpage to $filePath$ from the web page: philosophy books | eBay
22 Comment: Reinitialising the Array-read from excel file (ArrayExl) with the csv file extracted from the website.
23 Variable Operation: Reinitialize $ArrayExl$
24 Variable Operation: $ArrayRows($ArrayExl$)$ To $Row$
25 Start Loop "$Row$" Times
26
If $Counter$ Equal To (=) "1" Then
27
Comment: To skip the header title of the csv extracted from the website
28
Continue
29
End If
30
Execute SQL Statement: 'Insert into Ebayphilosophy (BookTitle,cost) values ("$ArrayExl($Counter$,1)$",'$ArrayExl($Counter$,2)
$')' Session: 'Default'
31 End Loop

Example 2: Use different list type of variable and perform Assign and Reinitialize Operations on them. Here we
are using list variable to then send emails.
1. Open the Task Editor.
2. See below task with all details mentioned as comments for execution of task.
1 Comment: This Loop will execute for 5 times as List read from text file variable has 5 entries.
2 Comment: Create Variable List Type : Source = Read from text file having this RDlsttxt = 11, 21,31,41,51
3 Start Loop "List Variable $RDlsttxt$"
4
Comment: Message box will show the addition of list variable value with other variable value.Here $row$=10
5
Variable Operation: $RDlsttxt$ + $row$ To $Prompt-Assignment$
6
Message Box: "$Prompt-Assignment$"
7 End Loop
8 Comment: Reinitialize Variable List Type : Source = Read from text file having this RDlsttxt support@automationanywhere.com, testing@gmail.com, sales@automationanywhere.com, buynow@automationanywhere.com
9 Variable Operation: Reinitialize $RDlsttxt$
10 Start Loop "List Variable $RDlsttxt$"
11
Comment: This Loop will execute for 4 times as 'List read from text file variable has 4 entries.
12
Comment: Below command will the send emails to the address ids mentioned in the above Read from text file -List variable.
13
Send Email: Subject "Automation Anywhere finished executing the task." with Attachment(s).
Other User
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14
Message Box: "Email to '$RDlsttxt$' has been sent sucessfully."
15 End Loop
16 Comment: Create Variable List Type: Source is Value.
17 Comment: In the below Prompt command select more than one file
18 Prompt For File: "Please browse and select multiple files:" for File Assign to variable "$list_val$"
19 Variable Operation: sales@testinganywhere.com To $list_val(2)$
20 Start Loop "List Variable $list_val$"
21
Comment: This loop will execute no. of files selected in Prompt command.
22
Message Box: "$list_val$"
23 End Loop

Example 3: Use yesterday’s date as a variable.
1. Open the Variable Manager from Tools > Variable Manager.
2. Click Add new variable.
3. Set the variable type as Value, type a name for the variable (e.g., yesterday), and enter 1 as a value. (This will be the temporary
value.)
4. Open the Task Editor.
5. Double-click Variable Operations.
6. On the left side of the = sign, select the variable you created from the drop down list.
7. On the right side of the = sign, press F2 and select the system variable date and click insert.
8. Type -1 after $Date$.
9. Click Save.

Example 4: Convert the value of a variable to thousands.
1. Open the Task Editor.
2. Double-click Variable Operations.
3. For select variable, select the variable whose variable whose value you want to convert into thousands.
4. On the right side of the = sign, press F2 and insert the variable whose value you want to convert into thousands.
5. Type / 1000 after the variable.
6. Click Save.

Example 5: Increment the value of a variable by 1 without using $Counter$.
1. Open the Task Editor.
2. Double-click Variable Operations.
3. For select variable, select the variable whose value you want to increment by 1.
4. On the right side of the = sign, press F2 and insert the variable whose value you want to increment by 1.
5. Type +1 after the variable.
6. Click Save.

Also See...
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Using Web Recorder Command - Examples
Example 1: Extract data from Website using pattern based data extraction.
1. Click New > Web Recorder in the main window.
2. Enter website URL for the website that you wish to extract data based on pattern . eg., an URL of a book listing site.
3. Click Start to begin recording. Please wait until Internet Explorer launches the URL completely.
4. Maximize window.
5. Click Extract Data > Pattern based data
6. Click Add to add the fields that you wish to capture from the selected web page eg., titles of books, author names, publisher, book
icons, etc.
7. Click Next.
8. Check The data spans across multiple pages box to select similar data from subsequent pages.
9. Click Capture button to select the link that takes you to the next page.
10. Click Next.
11. Click Preview data to preview the data captured.
12. Specify the folder to save images into and specify a file ie., csv to save the extracted data into.
13. Images extracted from multiple pages will be saved in different folders.

Example 2: Extract tabular data from a Web page.
1. Click New > Web Recorder in the main window.
2. Enter website URL http://www.automationanywhere.com. You can add the URL to Favourites for easy access again.
3. Click Start to begin recording. Please wait until Internet Explorer launches the URL completely.
4. Maximize window.
5. Click on Purchase > Volume Pricing in the webpage.
6. Select the web control you require in the Web recorder window that opens. Click Save.
7. Click on Extract Table button in the Web Recorder toolbar.
8. Move the yellow prompt bar provided to the table you wish to select, i.e, Feature table.
Note: The yellow prompt bar will change to red if the content you click on is not a table.
9. A preview of the extracted table will open for your immediate viewing. Save the file as a .csv file.
10. Use the Append to an already existing csv file option, if a CSV file has already been defined .
11. Click OK.
12. Stop recording the task.
13. Save the task.
Note: When you run this task, it will extract the table and append it into the csv.file if specified.
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Wait Command - Examples
Example 1: Wait for a window titled 'Untitled - Notepad' to open.
Open the Task Editor.
1. Double-click the Delay/Wait command.
2. Select Wait For.
3. Select Wait For Window To Open, and type the window title: 'Untitled - Notepad'.
4. Type how long you want Automation Anywhere Client to wait for the condition to be true, i.e., for Notepad to open.
5. You can specify the task to continue or stop if the Notepad window doesn't open with the specified time.

Using Wildcards (*)
1. You can use wildcards (*) in the following options: Wait For Window To Open, Wait For Window To Close, and Wait for Screen
Change (relative to Window).
l

For example, if you want to perform an operation in any window with the word 'Untitled' anywhere in the title, you can insert a * wildcard character before and after 'Untitled'. In this case, you can specify Wait For Window To Open *Untitled*.

2. Automation Anywhere Client will first search for the exact window named 'Untitled,' and if it does not find it, it will look for windows
with 'Untitled' anywhere in the title.
3. You can insert the wildcard character (*) at the beginning or end of the window title.

Example 2: Wait for a submitted query to return successfully on the Web.
1. Open the Task Editor.
2. Click the Delay/Wait command.
3. Double-click Wait For Screen Change.
4. Keep the Web page open to the page where the result of the query will be displayed.
5. Select the relevant option based on whether you want to capture the image relative to the screen, or a particular window. If you
select Window, you will be required to select a window from the list.
6. Click Capture and capture a rectangular selection around the area that will change when the query returns.
7. Specify 1 second in the box titled 'How long you want to wait before comparing the screen.'
8. Specify the maximum number of seconds you want the task to wait, and whether you want Automation Anywhere Client to stop the
task or proceed to next command.
9. Save the command.

Also See...
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Web Recorder Command - Examples
Example 1: Extract tabular data from a Web page.
1. Open the Task Editor.
2. Double-click the Web Recorder command and select Extract Table.
3. Specify a URL, e.g., http://www.yourserver.com.
4. Launch the URL.
5. Click Capture and click the table you want to extract.
6. Specify the path of the CSV file where you want the table data to be saved when the task runs.
7. Save the command.
8. After you call the Extract Table command, Automation Anywhere Client stores all the tabular data in a system variable called
$Table Column(index)$. You can use this variable to get the rows and columns of the table that you extracted.
9. Double-click the Loop command.
10. Select 'Each row in an Internet Explorer Table'.
11. To access each row and column in the $Table Column$ system variable provided by Automation Anywhere Client, use 'Loop for
Each row in an Internet Explorer table' to loop through all the rows of the table. To access each column, use $Table Column(index)
$; for example, to get the first column, use $Dataset Column(1)$, and so on.
12. You can use Insert Keystrokes commands with the $Table Column$ variable to type the results into the Excel document.

Example 2: Click a link that changes its location in Internet Explorer.
1. Open the Task Editor.
2. Double-click the Web Recorder command, and select Open Browser.
3. Specify the URL (e.g., http://www.yourserver.com).
4. Save the command.
5. Double-click the Web Recorder command again and select Manage Controls.
6. Specify the URL where the link is present; in this case, the same page you specified in Open Browser.
7. Click Launch. Click Capture and leave the mouse on the link you want to click.
8. The link information will be captured.
9. Save the command.
10. Save the task.
11. When you run the task, it will open the URL and click the link you specified.

Example 3: Download an http file.
1. Open the Task Editor.
2. Double-click the Web Recorder, and select Download File.
3. Specify the download file URL (e.g., http://www.yourserver.com/myfile.exe).
4. Save the command.
5. Specify a local filename to store on your machine.
6. Save the command.

Example 4: Check all links in a Web page.
1. Open the Task Editor.
2. Double-click the Web Recorder command and select Find Broken Links.
3. Specify the URL (e.g., http://www.yourwebpage.com).
4. Select Test Specified Webpage Only.
5. Specify the local path for the CSV file to store the results of the command.
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6. Save the command.
7. When you run the command, it will test all links in the Web page you specified, and store the results in the CSV file you named.

Example 5: Check all links in a website.
1. Open the Task Editor.
2. Double-click the Web Recorder command, and select Find Broken Links.
3. Specify the website address (e.g, http://www.yourwebsite.com).
4. Select Test Entire Website.
5. Specify a local file path for the CSV file to store the results of the command.
6. Save the command.
7. When you run the command, it will test all the links in the website you specified, and the results will be stored in the CSV file you
named.

Example 6: Always click the third link in the CNN Headlines.
1. Click Tools > Web Recorder.
2. Type http://www.cnn.com and click Start
3. Click the third link, then click Stop recording.
4. Open the task in the Task Editor.
5. Edit the Click command.
6. Un-check the Name check box, and check the Index check box. Now, every time Automation Anywhere Client reaches this command it will search the link by its index (and not the name or URL it points to). Thus, even if the name of the link changes, it will click
the third link.

Example 7: Extract data from a website and paste it into a blank Word document.
1. Open the Task Editor.
2. Double-click the Web Recorder command.
3. Double-click Extract Data.
4. Type a website URL and click Launch (e.g., http://www.automationanywhere.com/products/automation-software.htm).
5. Once the site is open, you are redirected to the Extract Data dialog box.
6. Click Capture.
7. The mouse appears as yellow background text indicating Please click on the data you want to extract.'
8. Move the mouse over the text you want to copy, and click anywhere in the text. (If the text background of the mouse changes to red,
it means the text is not available for copying.)
9. Assign the copied text value to a variable from the list; e.g., $my-variable$.
10. Click Save.
11. Make sure a blank Word document is open.
12. Double-click Insert Keystrokes.
13. Select the window title from the list.
14. Insert the variable from the list on the right side of the dialog box, i.e., $my-variable$.
15. Click Save.
Tip : You can specify keywords that determine the range of your text. For example, from the text
'Your reference no. is 245698 for today,' if you want to copy only the number and avoid the extra text,
you can specify 'is' as the 'Before Keyword' and 'for' as the 'After Keyword.'

Also See
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Window Actions Command - Examples
Use Case Scenario 1
Close the window 'Untitled - Notepad' in Microsoft Windows Notepad.
1. Start Microsoft Notepad. Notice that the title bar says 'Untitled - Notepad.'
2. In Automation Anywhere Client, open the Task Editor.
3. In the Task Editor, in the Commands list, double-click Window Actions. A sub-menu appears.
4. Double-click Close Window. The Window Actions dialog appears.

5. In the Select Window drop-down, select 'Untitled - Notepad.'

6. Click Save.

Use Case Scenario 2
Close all open windows.
1. In Automation Anywhere Client, open the Task Editor.
2. In the Task Editor, in the Commands list, double-click Window Actions. A sub-menu appears.
3. Double-click Close Window. The Window Actions dialog appears.
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4. From the Select Window drop-down, select 'Close All Open Windows.'

5. Click Save.

Use Case Scenario 3
Re-size a browser window
1. Open a Web page in a browser.
2. In Automation Anywhere Client, open the Task Editor.
3. In the Task Editor, in the Commands list, double-click Window Actions. A sub-menu appears.
4. Double-click Re-size Window. The Window Actions dialog appears.

5. From the Select Window drop-down, select the browser window title that you want to re-size.
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6. Click Capture, and draw a rectangle of the desired size.

7. This will retrieve the coordinates for the re-sized window.

8. Click Save.

Use Case Scenario 4
Maximize a Microsoft Excel file named 'Microsoft Excel-Book1.'
1. Open the file Book1.xls in Microsoft Excel.
2. In Automation Anywhere Client, open the Task Editor.
3. In the Task Editor, in the Commands list, double-click Window Actions. A sub-menu appears.
4. Double-click Maximize Window. The Window Actions dialog appears.
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5. From the Select Window drop-down, select the window titled 'Microsoft Excel-Book1.xls.'

6. Click Save.

Use Case Scenario 5
Activate a Microsoft Word document titled 'Document1.'
1. In Microsoft Word, open a new document - Word automatically names it Document 1.
2. In Automation Anywhere Client, open the Task Editor.
3. In the Task Editor, in the Commands list, double-click Window Actions. A sub-menu appears.
4. Double-click Activate Window. The Window Actions dialog appears.
5. From the Select Window drop-down, select 'Document1-Microsoft Word.'

6. Click Save.

Also See...
l

Web Actions Command
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XML Command - Examples
Feature also available in Standard edition version 8.2 or higher.

Example 1: Get XML data by defining nodes and saving the XML data at the required location.
1. Start XML Session using an existing file, for eg.,"C:\XML\Bookstore.xml". Keep the Session as Default.
2. Update the Node value to "2010" for a XPath location "//book[3]/year".
3. Insert Node name and Node value as "newNode" and "newVal" respectively for XPath location "//book[3]/year".
4. You can execute a XPath Function "sum(//book/price)" and assign the returned value to a variable.
5. To get text value from multiple nodes given XPath expression "//book/title", go to Get Node(s) > Multiple Nodes.
6. Start Loop for 'Each node in an XML datasheet'
7. Insert a comment and prompt a message box at this juncture.
8. End Loop
9. Save the session data assigned to the variable and write the Session Data into a new file at the required location. Overwrite the file
if it exists.
10. End the session by selecting End XML session

Also See...
l

XML Command
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Using Variables
Why Use Variables?
Variables are storage locations for known or unknown information.
When building automated tasks, variables play an important role in maintaining or calculating information.
Variables can help you in a number of ways, from fetching online data to transferring data between applications, such as Microsoft
Excel.
Automation Anywhere is designed with various types of variables which can be defined for each task.
These are known as local variables. It has pre-defined system variables available for all tasks.
The topics in this section will help you to understand the types of variables, how to use them, and when to use them.

When to Use Variable?
As you build automation tasks, the scripts that are generated can lend themselves to using variables to track or modify the value of a
field or data point. For example, if you want to loop through a set of data in a CSV file, you can use a variable to copy the first row, paste
it to another application, move to the second row, and so on.
All actions that you take in a task can support the use of variables. These actions can include:
l

Selecting windows

l

Opening programs

l

Working with files, folders, keystrokes, spreadsheets, loops, and more.

In This Section
l

Types of Variables

l

Working with Variables
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Knowing When to Use Variables
This topic explains when you might want to use variables in your automation tasks.
As you build automation tasks, the scripts that are generated can lend themselves to using variables to track or modify the value of a
field or data point. For example, if you want to loop through a set of data in a CSV file, you can use a variable to copy the first row, paste
it to another application, move to the second row, and so on.
All actions that you take in a task can support the use of variables. These actions can include:
l

Selecting windows

l

Opening programs

l

Working with files, folders, keystrokes, spreadsheets, loops, and more.

Two special cases of using variables include:
l

Passing a variable between Running Tasks

l

Using variables with IF/Else and LOOP commands

Also See...
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Assigning Variables to a Task
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Reinitializing Variables

l

Resetting System Variables
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Reading Variables from a Text File
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Watching Variables

Other User
Resources:

Passing a Variable between Running Tasks
You can pass an individual variable value from one task to another by using this option. The value of the variable in the first running
task becomes the input for the variable in a second task. This feature is important when tasks are run in nested manner.
Tip: The same type of variable should be defined in both tasks.
To pass a variable between running tasks, follow these steps:
1. Select the Run Task command and select the Variable option.
2. In the "Create variable association" field, select the variable from list in Main Task that has to be passed on to the consequent 'Run
Task' variable.

Also See...
l

Using Variables with IF-Else and LOOP Commands
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Using Variables with IF-Else and LOOP Commands
The IF/Else and LOOP commands enable you to use variables, allowing you to run a loop until a particular condition is met for the variable.

Using IF/Else Commands with Variables
While inserting an If/Else condition, select a variable you want to use (see example).

Using Loop Commands with Variables
While inserting a Loop condition, select a variable you want to use within the loop until the condition is met (see example).

Also See...
l
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Types of Variables
This topic describes the types of variables you can define and use when building automated tasks.
Essentially three variable types exist in Automation Anywhere tasks: User (local) Variables, System Variables and Credential Variables.
For all Automation Anywhere commands, variables are supported in fields that have the light bulb

symbol present.

Use F2 function key and the list of variables will appear for selection.

User (Local) Variables
User variables are typically defined by an automation user, and used for a particular task or set of tasks. The purpose of a user variable
can range from simply holding a single value to holding multiple values, as would be used in an Excel spreadsheet.
For new automation tasks, two variables are pre-defined for your use:
l

my-list-variable (type: List)

l

Prompt-Assignment (type: Value)

After you create a user (local) variable, you can reinitialize it or assign it when a task runs.

System Variables
System variables are pre-defined variables that are provided by Automation Anywhere. System variables are available for use in all
automation tasks.

Credential Variables
Available in Enterprise edition only from version 10.2.1
Credential Variables are a special category of variables that can be used by the BotCreator - a Client user who creates tasks, in Commands that require credential input.
Note: Credential variables can be used optionally in select commands only.
These credentials are defined by the Control Room administrator in the form of 'Credential Keys' that comprise a set of 'Attribute Values' and are securely stored in a centralized location - the Credential Vault.
Learn More
Unlike User and System variables, you cannot view 'Credential' variables in the Variable Manager. They are visible in the Insert Variable window while creating a task with commands that support Credential Variables. Refer list of Commands that support Credential
variables in Assigning Credential Variables.

Also See...
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Local (User) Variables
User Variables, also known as local variables, are those variables that are defined by an Automation Anywhere user for a particular
task. All user variables are displayed in the Variable Manager for the respective tasks under 'Local Variables'.
Each user variable has a source . This source varies from direct assignment to reading values from files, such as text files, Excel or
CSV files, or a database.
Types of user (local) variables:
l

Value - Holds a single value.

l

List - Holds multiple values in a single dimension (1 X n).

l

Array - Holds multiple values in two dimensions (n X n).

l

Random- Holds a string or numeric value that is determined by the system while running the task.
Note: Local Variables can be created only if you have a developer license.
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Value Type Variables
When/Why To Use a Value Type Variable
You can use a value type variable when you need to hold a single data point and use it in multiple places. This "placeholder" value
can represent either text or numeric data.
After you create the variable, you can use it by inserting the variable in several of the Task Editor commands. When the value of the
variable is modified, this value is reflected in any subsequent commands that are run by the task.
You can also mark a value type variable as 'Regular Expression' . These, you can use when creating tasks that require pattern based
searches in files, folders and window title commands.
Note:
l

You can input only the first line of text in the 'Value' text box.

l

Regular Expression in variables can be used in commands that support wild-cards. For instance, you
can use regular expressions in certain sub-commands of Files/Folders; namely Copy, Delete, Zip and
Print Multiple Files/Folders.

For a list of commands that support variables with regular expression, refer the section 'Commands that support Regular Expression'.

How to Create a Value Type Variable
You can create value type variables in two ways: using direct assignment or using a file.

Direct Assignment
Create a value type variable using direct assignment. This is used when values are generally known and needs to be retrieved repetitively for different commands in the task. This makes the task flexible and easy to use.
To create a value type variable using direct assignment, follow these steps:
1. In the Task Editor, click on the Variable Manager icon at the top or on the tab on the right side.
2. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.
3. Select type "Value". Generally, this is the default selection.
4. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.
5. Select the "Value" radio button. This is the default.
6. Specify an initial value. This value can be character or numeric.
7. Click Save.
After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.
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Examples of Value Type Variables:
l

Name: ValueDB, Value: Oracle

l

Name: email, Value: contact@automationanywhere.com

l

Name: Pathname, Value: C:\Automationanywhere\
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l

Name: RegExDt, Value: ^(19|20)\d\d[- /.](0[1-9]|1[012])[- /.](0[1-9]|[12][0-9]|3[01])$

Common examples of names you can use for value type variables include:
Pathname, CounterValue, DatabaseName, email, etc.

File Assignment
Create a value type variable using file assignment when the value of the variable needs to be retrieved from a text file while a task is
running.
Your task can read the file and change the value of the variable, reassigning the value at each data point in the file.
To create a value type variable using file assignment, follow these steps:
1. Determine the text file you will use for assigning values. In the text file, ensure that the variable name exists, followed by an '=' operator. This ensures correct assignment of values. Example: Variable Name: Website Text file content: website = automationanywhere.com
2. In the Task Editor, click on the Variable Manager icon at the top or on the tab on the right side.
3. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.
4. Select type "Value". Generally, this is the default selection.
5. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.
6. Select the "Read from text file" radio button.
7. In the Select File field, browse to the file or type the file path for the required text file. Use the Open File button to view the selected
text file.
8. Click Save.
After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.
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Commands that support regular expression
l

App Integration

l

Delay/Wait

l

File/Folder

l

Image Recognition

l

Insert Keystrokes

l

Insert Mouse Click

l

Manage Window Controls

l

OCR

l

Screen Capture

l

Window Actions

Also See...
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Random Variables

l

Pre-defined variables
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List Type Variables
When/Why To Use a List Type Variable
You can use a list type variable when you need to retrieve multiple values, one by one. It is basically one dimensional placeholder for
data.
Common uses of list variables include:
l

Sending email to multiple recipients

l

Passing different values inside of a loop

l

Searching multiple web addresses

The values can represent either text or numeric data.
After you create the variable, you can use it by inserting the variable in several of the Task Editor commands. When the value of the
variable is modified, this value is reflected in any subsequent commands that are run by the task.

How to Create a List Type Variable
You can create list type variables in two ways: using direct assignment or using file assignment.

Direct Assignment
Create a list type variable using direct assignment when the values of the variable are fixed and need to be retrieved one-by-one as
the task runs.
To create a list type variable using direct assignment, follow these steps:
1. In the Task Editor, click on the Variable Manager icon at the top or on the tab on the right side.
2. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.
3. Select type "List".
4. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.
5. Select the "Value" radio button. This is the default.
6. Specify list values in the field provided. The values can be character or numeric.
7. Click the "Add to List" button.
8. Repeat steps 5 and 6 to complete the list.
9. Click Save.
You can use the "Make Random" checkbox to call the values randomly when the task runs.
If you leave the option unchecked, the values will be retrieved in the order you have entered them.
After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.
Example of List Type Variable:
Name:Email Address
Values: products@automationanywhere.com, support@automationanywhere.com, john.smith@automationanywhere.com
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File Assignment
Create a list type variable using file assignment when the values for the variable need to be retrieved from a text file while a task is running.
The text file is used to define the list variable. Loop commands make it easy to process the list of values.
Common Use Case: Extract data to a text file
To create a list type variable using file assignment, follow these steps:
1.

Determine the text file you will use for assigning values.
In the text file, ensure that the variable name exists, followed by an '=' operator, and a list of comma-separated values.
Example text file with list of values: Variable Name: products
The products.txt file contains:
products = automation, testing, PI, SAP-automation, ERP-automation

2. In the Task Editor, click on the Variable Manager icon at the top or on the tab on the right side.
3. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.
4. Select type "List".
5. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.
6. Select the "Read from text file" radio button.
7. In the Select File field, browse to the file or type the file path for the required text file. Use the Open File button to view the selected
text file.
8. Click Save.
After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.
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Array Type Variables
When/Why To Use an Array Type Variable
An array variable is a two-dimensional variable that holds multiple values in a table of rows and columns. Arrays are very powerful for
creating staging areas for data that need to be retrieved by your process as it runs.
Common uses of array variables include:
l

Extracting data from web pages

l

Extracting many rows of data from an Excel spreadsheet or a database

l

Read or write data from/to a legacy system, an ERP system, or another application

l

Filling out order forms with different fields from Excel to Database

The values can represent either text or numeric data.
After you create the variable, you can use it by inserting the variable in several of the Task Editor commands.
Tip: Loop command makes it very easy to process arrays variables. Refer How to Use Array Type Variable in
Loop Command for details on how.
When the value of the variable is modified, this value is reflected in any subsequent commands that are run by the task.

How to Create an Array Type Variable
You can create an array type variable in four ways:
l

Using direct assignment

l

Using a text file

l

Using an Excel or CSV file

l

Using a database

Direct Assignment
Create an array type variable using direct assignment when you want the values of the variable to be defined directly to the variable.
To create an array type variable using direct assignment, follow these steps:
1. In the Task Editor, click on the Variable Manager tab on the right side.

2. Click on the Add button. The 'Add Variable' window is displayed, with the 'Create New Variable' option selected.
3. Select type 'Array'.
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4. Enter a name for the variable. The name must begin with an alphabet and should not contain spaces.
5. Select how you want the array to be created. Default selection is 'Value' which indicates that you will define the values of this variable directly in it.
6. Specify the number of rows and columns in the field provided. Default values are 1 X 1.

7. Click the Initialize Values button. The Array Value Details window is displayed based on the rows and columns provided in step 6.

8. Enter the values for each cell.
9. Click the Save button to save the values.
10. Click the Save button again to save the array variable.
You can modify the array dimensions using the Add Row, Add Column, Delete Row, and Delete Column buttons.
After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.

Text File Assignment
Create an array type variable using text file assignment when you want to read values from a specified text file into the array variable
while the task is running. The text file is used to define the array variable.
To create an array type variable using text file assignment, follow these steps:
1. Determine the text file that you will use for assigning values.
l

For Rows enter the data in a new line.

l

For Columns use comma separated values.
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l

Example: sports_team.txt

2. In the Task Editor, click on the Variable Manager tab on the right side.
3. Click on the Add button. The 'Add Variable' window is displayed, with the 'Create New Variable' option selected.
4. Select type 'Array'.
5. Enter a name for the variable. The name must begin with an alphabet character and should not contain spaces.
6. Select 'Read from text file' from the dropdown.
7. In the Select File field, browse to the file or type the file path for the required text file. Use the Open File button to view the selected
text file or to modify it.
8. Click Save.
After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.

Excel or CSV File Assignment
The Automation Anywhere Web Recorder and Excel commands extract data to Excel and CSV formats. You can use these files to create an array variable that might be used for entering or manipulating data for computing or analysis.
Automation Anywhere provides a range of options for retrieving subsets or partial sections of the data.
Create an array type variable using an Excel or CSV file assignment when you want the values of the variable to be retrieved from an
Excel or CSV file.
To create an array type variable using Excel or CSV file assignment, follow these steps:
1. In the Task Editor, click on the Variable Manager tab on the right side.
2. Click on the Add button. The 'Add Variable' window is displayed, with the 'Create New Variable' option selected.
3. Select type 'Array'.
4. Enter a name for the variable. The name must begin with an alphabet and should not contain spaces.
5. Select 'Read from Excel/CSV file'from the dropdown.
6. Browse and select the required file.
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7. Select the options you want for reading values from specific locations in the file. You can choose from:
l

All cells

l

Entire Row

l

Entire Column

l

Range

Note: If you select Range, specify the From and To. You can use the Open File button to view
the selected text file or to modify it.
8. Click Save.
After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.

Using a Database
You can define an array variable with values derived from the result of a database query. The array variable is created with dimensions
that are determined as a result of running the query.
To create an array type variable using a database query, follow these steps:
1. In the Task Editor, click on the Variable Manager tab on the right side.
2. Click on the Add button. The 'Add Variable' window is displayed, with the 'Create New Variable' option selected.
3. Select type 'Array'.
4. Enter a name for the variable. The name must begin with an alphabet and should not contain spaces.
5. Select the 'Read from database' from the dropdown.
6. Specify the database connection string details using Browse.Clicking on browse opens the Data Link properties dialogue box. Use
it to test and create a valid connection string for the database of your choice.
7. Enter Select Query by typing the entire database query.
8. Click Save.
After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.
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Once you have created array variables by reading data from various sources, use Loop command to easily process them in your automation task.Learn more.
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Random Variables
You can create two types of random variables: string and numerical.
Random variables are useful when you need to generate a random, repetitive string or numerical set. The values are generated when
you run the task.
Common use cases:
l

String: Generating test data as input for fields or forms

l

Numerical: Generating ID numbers in batch

After you create the variable, you can use it by inserting the variable in several of the Task Editor commands.

How to Create a Random Type Variable
Creating a Random String Variable
To create a random string variable, follow these steps:
1. In the Task Editor, click on the Variable Manager icon at the top or on the tab on the right side.
2. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.
3. Select type "Random".
4. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.
5. Select the "Random String" radio button. This is the default.
6. Specify the string length in the field provided. The value cannot exceed 255.
7. Click Save.

Creating a Random Numeric Variable
To create a random numeric variable, follow these steps:
1. In the Task Editor, click on the Variable Manager icon at the top or on the tab on the right side.
2. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.
3. Select type "Random".
4. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.
5. Select the "Random Number - Range" radio button.
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6. Specify the "From" and "To" values for the range.
7. Click Save.
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Pre-Defined User Variables
Automation Anywhere provides two user variables that are pre-defined for your use:

my-list-variable (type: List)
This variable provides a container for a list of values. For more details see List Type Variables

Prompt-Assignment (type: Value)
This variable provides a container for a single value. For more details see Value Type Variables .
These variables can be used quickly by pressing the F2 key.
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Restoring Deleted Variables
If you delete one or both of the pre-defined user variables (listed below), you can restore them. These include:
l

my-list-variable (type: List)

l

Prompt-Assignment (type: Value)

To restore either or both of these variables, follow these steps:
1. Open the Variable Manager.
2. Click on the Add button to display the Add Variable window.
3. Click on the "Select Variable from List" radio button.
4. Check the box next to the pre-defined variable that you want to restore, and click on Save.
Note: You cannot restore user variables that you create and then delete.
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System Variables
Automation Anywhere provides powerful pre-defined system variables that you can use to automate common processes.
System Variable types include:
l

Date/Time: System-related date and time variables.

l

Loop: Useful in conjunction with Loop commands.

l

Excel: Useful for Excel automation.

l

Email: Useful for Email automation.#

l

Trigger: Useful in conjunction with triggers.

l

PDF: Useful for use with PDF command.*

l

System: Variables specific to a particular client machine.

* Available in Enterprise edition only.
# Available in Enterprise and Small Business editions only.
After system variables are used in a task, you can view their progress while running a task. For more information, see Watching Variables.
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Date and Time System Variables
You can use the set of Date and Time system variables to insert or monitor the current date and time of a system as your automation
task runs.

Use Case Scenario
Using Date/Time variables can help you track and log points in time to monitor the success or error of a running process.
To view the system variables and their descriptions, follow these steps:
1. In the Task Editor, click on the Variable Manager icon at the top or on the tab on the right side.
2. Click on the "Show System Variables" link.
To insert a Date/Time system variable, follow these steps:
1. In the Task Editor, drag and drop a Variable Operation command in the task pane.
2. Select the System Variables radio button.
3. In the drop-down menu, select the system variable that you want to insert.
4. Click Save.
Manage your Date/Time variables by using the options listed in the table. The table shows Date/Time system variable names, return
values, and actions.
For the Date variable, you can use the System Variables window to change the format that is returned in the Date variable. Follow
these steps:
1. In the Task Editor, click on the Variable Manager icon at the top or on the tab on the right side.
2. Click on the "Show System Variables" link.
3. Select the Date variable from the Date/Time list of variables and click the ... button.
4. Select the date format in the Select Date Format pop-up window.
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Examples:
A. The following command stores the current DATE, DAY, and YEAR path in a log file. This is important while logging of errors or certain important information on files to include the date stamp.
1. Drag and drop the Log To File command.
2. Use the F2 function key to insert variables for $Date$, $Day$ and $Year$.
Command: Log to File: Date:$Date$Day:$Day$Year:$Year$ in "C:\Variable Operation.txt"
B. The following command stores the current HOUR, MINUTE, and SECONDS in a log file. This adds the timestamp to the log for analysis.
2. Drag and drop the Log To File command.
3. Use the F2 function key to insert variables for $Hour$, $Minute$, and $Seconds$.
Command: Log to File: Hour:$Hour$Minute:$Minute$Seconds:$Second$ in "C:\Variable Operation.txt"

Also See...
l

System Variables

l

User (Local) Variables

l

Log to File Command

Other User
Resources:

System Variables - Loop
A Loop system variable complements the Loop command and works within the scope of a defined loop. Most loop variables have no
value when used outside of loops. You can manage your Loop command using the variable options in the following table.

Example 1:
Start Loop "Each File In Folder D:\My Desktop\JAVA"
Comment: Please enter your commands to loop. Use $filename$.$extension$ variable for each file name in
the Loop.
End Loop
Start Loop "Each row in an Internet Explorer Table of Session: Default"
Comment: Please enter your commands to loop. Use $TableColumn$ variable for each row in Table.
End Loop
Example 2:
1. Comment: -------------------------------------- Start XML Session------------------------------2. XML : Start XML Session using existing file "D:\My Desktop\XML Files\Bookstore - 1.xml"Session:Session1
3. Comment: -------Get Multiple Nodes, I have set Xpath Xpression as Book [1], means only First Occurance ------4. XML : Get Multiple Nodes text value from XPath expression "//book[1]/author". Session:Session1
5. Comment: -------------- Use Loop for "Each Node in XML Dataset" ----------------------6. Start Loop "Each Node In a XML Dataset Session: Session1"
7. Comment: --------- Pring Node Value to Message box using SYSTEM Variable "XML Data Node (Node Name)"
--------8. Message Box: "$XML Data Node(author)$"
9. End Loop
10. Comment: ------------ Get Multiple Nodes, I have set Xpath Xpression as "Lang", means only All Occurance -------11. XML : Get Multiple Nodes attributes name "lang" from XPath expression "//book/title ". Session:Session1
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12. Comment: -------------- Use Loop for "Each Node in XML Dataset" ----------------------13. Start Loop "Each Node In a XML Dataset Session: Session1"
14. Comment: ---------Pring Node Value to Message box using SYSTEM Variable "XML Data Node (Node Name)" ------15. Message Box: "$XML Data Node(lang)$"
16. End Loop

Also See...
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Excel System Variables
You can use Excel System Variables to manage Excel automation processes. These variables are specific to the scope of the Excel
command.

Excel relevant system variables
1. Excel Cell - This will indicate the column name and position of the cell from the header, when 'Contains Header' is enabled for a
session in Open Spreadsheet of the Excel Command. It is applicable to Excel operations like Get Cells, Set Cells, Go to Cell,
Delete Cells and Find/Replace.
2. Excel Cell Column - This will return the column of the Excel on which the operation has been performed.
3. Excel Cell Row - This will return the cell of the Excel on which the operation has been performed.
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Email System Variables
You can use Email system variables within an Email automation task to manage your email automation loop. These variables are specific to the scope of the loop that processes each email message for the server.

Manage your email automation using the e-mail variable options in the table below.
Note: Applicable only for the Loop command: Each Email Message on Mail Server.
When you use the Loop/Email automation command (see example below), a comment in the task explains how you can use these system-defined variables.
Example 1:
1. Start Loop "Each message on server: mail.automationanywhere.com,User Name: support@automationanywhere.com, ServerType:
IMAP, Message Format: HTML"
2. Comment: Please enter your commands to loop. Use Email Automation variables for each email on Server (e.g. $Email From$,
$Email To$, etc.)
3. End Loop
Example 2:
In below example we extract emails from inbox and store them in text files. This type of task can be scheduled and emails can be
retrieved offline.
1. Start Loop "5" Times
2. Comment: Please enter your commands to loop.
3. Start Loop "Each message on server: imap.gmail.com, User Name: admin1, SSL, ServerType: IMAP, Message Format: HTML"
4. Comment: Please enter your commands to loop. use sys variables for each email on Server.(e.g. $Email From$, $Email To$, etc.)
5. Log to File: $Email From$ John in "D:\Desktop\1.txt"
6. Message Box: "$Email Subject$ $Email From$"
7. Variable Operation: Reset: $Email From$
8. Message Box: "$Email Subject$"
9. Variable Operation: Reset: $Email Subject$
10. End Loop
11. End Loop
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The variables in this example can be reset using the Variable Operation (System Variable) command. The drop-down menu offers all
of the options for resetting.
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Trigger Variables
You can use a trigger system variable anytime you work with an automation task that is launched with a trigger. The trigger value is
determined based on the type of trigger event.

Using trigger variables is particularly helpful when multiple trigger events are used with an automation task. The variable provides
information about the name of the file, folder, window, or service name for the trigger event.
For other uses, this system variable does not contain a value.
The following table provides the return values and description for the trigger variable.
Name

Return Value

Trigger Value

String
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Description
Returns the name of File/Folder/Window/Service for which a trigger is fired, depending on the
trigger type that was executed.

PDF System Variables
You can use the PDF system variables with the PDF Integration command.

The following table provides the names, return values, and descriptions for the PDF system variables.
Name
PDFFileName
PDFTitle
PDFAuthor
PDFSubject

Return Value
String
String
String
String

Description
Returns PDF file name for given file without .pdf extension.
Returns PDF title for given file.
Returns PDF author name for given file.
Returns PDF subject for given file.

Example:
PDF Integration:
Convert "D:\PDF\fw4.pdf" to images as "$PDFTitle$" under folder "D:\PDFImages\"
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System Variables - Specific to System Settings/Parameters
You can use system-related system variables to include parameters in your automation task that are related to a particular computer.
The variables return actual system settings and parameters, such as RAM, CPU/RAM usage, and total RAM.

Image as seen in Enterprise Edition 9.0.2
Common Use Case: These variables are useful when the performance of a system needs to be tracked during an activity; for instance
load testing.
The following table provides names, return values, and descriptions for the system-related system variables.
*When you select the System variable, a menu is displayed from which you can select the specific system variable (see steps below).

Steps to select System Related Variables:
1. Click F2 and you will see Insert Variable window.
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2. Select the required variable and click Insert.

Note: Don't confuse System Related Variables with System Variables. To select System from System
Related Variables, refer the following section.

Steps to select System from System Related Variables:
1. Click F2 and you will see Insert Variable window.

2. Select System and click Insert, a pop up window for System Variable Option appears.

3. Click OK and insert the system variable.
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Troubleshooting an error
Error: If you use the $CPUUsage$ variable in a message box and an error message is issued, you need to reset the counter for the system by performing the following action:
Open a command prompt and enter the following two commands:
cd\windows\system32 [enter]
lodctr /R [enter]
Examples
When creating an executable file (EXE) for a task, you might want to use the path of the EXE to log a file or refer to a file located in a
folder. In this case, use the AAApplicationPath variable to select the path of the EXE from any location in which it is stored. This eliminates the need to use static paths for EXEs.
1.

The following command stores the current application path in a log file. Drag and drop a Log To File command to your task, and
press the F2 key to insert $AAApplicationPath$ variable:
Log to File:Automation Anywhere Application Path:$AAApplicationPath$ in "C:\Variable Operation.txt"

2.

The following command stores the current RAM usage and CPU usage in a log file. Drag and drop a Log To File command to
your task, and press the F2 key to insert $RAMUsage$ and $CPUUsage$ variables.
Log to File: CPU Usage:$CPUUsage$RAM Usage:$RAMUsage$ in "C:\Variable Operation.txt"

3.

The following command stores the current Task path in a log file. Drag and drop a Log To File command to your task, and press
the F2 key to insert $AATaskName$ variable.
Log to File:Automation Anywhere Application Path:$AATaskName$ in "C:\Variable Operation.txt"
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Working with Variables
These topics describe how you can create and modify variables, as well as take other actions on variables with your automation tasks.

In This Section
l

Using the Variable Manager

l

Creating a New User Variable

l

Adding Variables to a Task
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Editing a Variable
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Copying a Variable
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Deleting a Variable
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Variable Operation: Assign
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Variable Operation: Reinitialize
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Resetting System Variables
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Reading Variables from an External File
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Watching Variables
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Using Variables to Create Timestamps for Your Files

l

Passing a Variable to a VB Script

l

Workflow Variables through Run Task
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Using the Variable Manager
The Variable Manager displays the local variables that are defined for a particular task. You can use the Variable Manager to add,
modify, and copy variables within automation tasks.
In the Task Editor, click the Variable Manager link* on the top menu, or click the Variable Manager tab on the side.

* Available in version 8.2 or less

Use the Variable Manager to perform any of the following actions with variables:
l

Copy

l

Copy All

l

Paste

l

Add a new variable

l

Edit a variable

l

Delete a variable

When you click on the "Show System Variables" link, the Variable Manager displays details about all system variables that are available for each task.
When you use the Variable Manager for the first time, you will see that Automation Anywhere provides two pre-defined user variables
for your use:
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my-list-variable (type: List)
This variable provides a container for a list of values.

Prompt-Assignment (type: Value)
This variable provides a container for a single value.
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Creating a New Local Variable
Creating a new local variable and inserting it within your automation task is easy.
To create a new user variable, follow these steps:
1. In the Variable Manager, click the Add button at bottom or right-click on an existing variable and select Add.

2. In the Add Variable window, the Create New Variable option is selected by default.
3. Select the variable type. See more details.

4. Enter a name, and select the method for determining the value of the variable.
Several important facts about using variables include:
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l

The $ signs that surround the variable name indicate that the text inside should be treated as a variable.

l

When the task runs, Automation Anywhere replaces the variable name with the actual value of the variable.

l

All command fields with the light bulb icon support variables. When you want to insert a variable, use the F2 function key to list all
user and system variables that are available for selection.

l

Variable values can be verified in debug mode by using the Variable Watch feature, which displays the run-time values for the
selected variables.

After creating a variable, you can use it within your tasks using most Automation Anywhere commands. Below example illustrates how
to insert a variable that will set a cell value in Excel command.
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Editing a Variable
You can edit and modify any local variable that you have created. In addition, you can edit the pre-defined variables.
To edit a variable, follow these steps:
1. Select the variable you want to edit.
2. Click the Edit button or right-click on the variable and select Edit. The Edit Variable window is displayed.
3. Modify the variable fields as necessary. You can change the variable type, the name, or the method of determining value.
4. Click Save.
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Copying a Variable
When you need to use a variable from one task in another task, use Copy/Copy All, which are provided in the Variable Manager.
When you select Copy All, you are asked to confirm that you want to overwrite the default variables Prompt-Assignment and my-list-variable.
To copy a variable, follow these steps:
1. Select the variable you want to copy.
2. Click the Copy button or right-click on the variable and select Copy. You can alternatively click on the Copy All button or right-click
and select Copy All. The Copy button is enabled only if a particular variable is selected.
3. Select or open another task in which you want to insert the variables.
4. Click Paste.
The Paste button for a new task is enabled only if variables are first copied.
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Deleting a Variable
If a variable becomes obsolete and you want to delete it, you can use the Variable Manager to do so.
When using Copy All to copy all variables to another task, you might need to delete several variables that are redundant or useless in
the new task.
To delete a variable, follow these steps:
1. Select the variable you want to delete.
2. Click the Delete button or right-click on the variable and select Delete.
3. When the confirmation message is displayed, click yes.
Note: Only single variables can be deleted at one time.
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Adding Variables to a Task
Many of the commands that are available in the Task Editor allow you to insert variables in your tasks. Some commands, like Insert Keystrokes, provide a navigation for you to select and insert variables in your task.
For other command fields that allow you to insert variables, use the F2 function key. It will list all user and system variables that are
available for insertion.
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Variable Operation: Assign
After you define variables, you can perform operations on them within your automation tasks. Variable Operation command enables
you to assign and reinitialize user variables. Assignment means that a single value is attached to a variable. This operation enables
the user to reuse the defined variables as the task runs.
Assignment can be performed on three types of variables: Value, List, and Array. For lists and arrays, the assignment is applied by specific positions within the list or array.
The following table shows the types and source (subtypes) of the user variables and if it supports the assignment operations on them.

Assigning Value Variables
To assign a value to a Value type variable, follow these steps:
1. In the Task Editor, drag and drop a Variable Operation command into the task.
2. Select the User Variables option.
3. Under "Specify Variable," select the variable from the list of all user variables that are defined for the task. The variable type and
source is displayed.
4. Select the Assign operation radio button.
5. In the "Specify value" field, enter a value or insert another variable by pressing the F2 function key.
The right side of the assignment can include any regular operation.
Example:singleval1 = ($var2$ + $var5$ - 10) / 5
Operators supported: (, ), /, *, +, Order of Operations: Parentheses take first precedence in order, with the operation inside them being evaluated from left to right.

Assigning List Variables
When assigning values to a List type variable, you need to specify the position for that value. Any previous value for that position will
be overwritten.
To assign a value to a List type variable, follow these steps:
1. In the Task Editor, drag and drop a Variable Operation command into the task.
2. Select the User Variables option.
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3. Under "Specify Variable," select the variable from the list of all user variables that are defined for the task. The variable type and
source is displayed.
4. Select the Assign operation radio button.
5. For the list variable, the "Select Position" is displayed. Specify the position for this value. For example, $Counter$
6. You can also specify another variable to be inserted here by pressing the F2 function key and selecting the variable.
7. In the "Specify value" field, enter a value or insert another variable by pressing the F2 function key.

Assigning Array Variables
When assigning values to an Array type variable, you need to specify the positions for the values. Any previous values for these positions will be overwritten.
The source of the array variable can be Excel or CSV files, a database, or a text file, depending on the type of variable you select from
the list.
To assign values to an Array type variable, follow these steps:
In the below example we are assigning an array variable for position (2,2) from another variable defined in the task.
1. In the Task Editor, drag and drop a Variable Operation command into the task.
2. Select the User Variables option.
3. Under "Specify Variable," select the variable from the list of all user variables that are defined for the task. The variable type and
source is displayed.
4. Select the Assign operation radio button.
5. For the array variable, the "Select Position" fields for Row and Column are displayed. Specify the position for these values. For
example, "Row 2 and Column 2".
6. You can also specify other variables to be inserted here by pressing the F2 function key and selecting the variable.
7. In the "Specify value" field, enter values or insert another variable by pressing the F2 function key.
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Variable Operation: Rounding Values
When using the Variable Operation command in the Task Editor, be aware that values are rounded.
For example, we use a Variable Operation command to assign the value '01.20' to a variable named Temp. The returning value in the
message box will be 1.2, as the extra zeros before and after the value are removed.
Examples:
Example 1
Type: List, Source: Read from text example.
1. Comment: This Loop will execute for 5 times as List read from text file variable has 5 entries.
2. Comment: Create Variable List Type : Source = Read from text file having this RDlsttxt = 11, 21,31,41,51
3. Start Loop "List Variable $RDlsttxt$"
4. Comment: Message box will show the addition of list variable value with other variable value.Here $row$=10
5. Variable Operation: $RDlsttxt$ + $row$ To $Prompt-Assignment$
6.

Message Box: "$Prompt-Assignment$"

7. End Loop
Example 2
Type: Array Source: Read from Excel
1. Comment: We use an array variable to read from existing excel file
2. Connect to "$ConnectStr$" Session:'Default'
3. Comment: ArrayRows is a system defined variable used to retrieve total rows in the user defined array.
4. Comment: ArrayExl - is a user-defined array variable, using a source that is Read from Excel file. In this example, we use a list of
books and games having title and cost, which is initialized in the Variable Manager.
5. Variable Operation: $ArrayRows($ArrayExl$)$ To $Row$
6. Start Loop "$Row$" Times
7. Comment: To skip the header title of the csv extracted from the website use below If condition
8.

If $Counter$ Equal To (=) "1" Then

9. Continue
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10. End If
11. Execute SQL Statement: 'Insert into Ebaykids (BookTitle,cost) values ("$ArrayExl($Counter$,1)$",'$ArrayExl($Counter$,2)$')' Session: 'Default'
12. End Loop
13. Open "http://www.ebay.com/"
14. Comment: Extracting the books on the philosophy into a CSV file using Web Recorder
15. Set text 'philosophy books' into _nkw in the webpage 'Electronics, Cars, Fashion, Collectibles,
Coupons and More Online Shopping | eBay'
16. Click on 'Search' Command Button in the webpage 'Electronics, Cars, Fashion, Collectibles, Coupons
and More Online Shopping | eBay'
17. Loop While Web Control Exists (Other HTML Control : Next ) in the webpage 'philosophy books | eBay'
18.

Extract Multiple Data from Webpage to $filePath$ from the web page: philosophy books | eBay

19.

Click on 'Next' Other HTML Control in the webpage 'philosophy books | eBay'

20. End Loop
21. Extract Multiple Data from Webpage to $filePath$ from the web page: philosophy books | eBay
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Assigning Credential Variables
Available in Enterprise edition only from version 10.2.1
To securely store sensitive information that is necessary to play automation tasks, the Control Room administrator creates 'Credential
Keys' comprising 'Attribute' values. These Credentials are used by BotCreators (Client users who create tasks), in various commands
that require credential inputs, as 'Credential Variables'.
These special category of variables are centrally stored in a 'Credential Vault' to which the Control Room administrator will have exclusive access privileges. Learn More
A BotCreator, while creating tasks, can assign the Credential variables in command fields that require credential input and support
these. Refer list of commands in this topic.
Note: To access Credential variables during task creation and play, the BotCreator has to be online
i.e. connected to the Control Room.

Using the Credential Variables
The method to input Credential variables in commands that require them is similar to assigning variables. You simply press the function key 'F2'. The credential values are retrieved in the command during play time.
Before you start assigning variables, remember:
l

A BotCreator can only insert the Credential variables in commands; no add or update rights are available to the BotCreator.

l

Credential Variables can be seen and accessed only from the Insert Variables window.

l

Only the name of a Credential Key is visible in the command field and list of Credential variables; Attribute values is not displayed.
Not even while editing or debugging the task.

l

Bulk Edit is allowed only on commands that comprise same Credential variables.

l

A Credential variable is read only; hence you are not allowed to edit its values. Nor can you append another variable (Local or System variable) to it. To insert such variables, you must delete the Credential variable first.

l

To delete a Credential variable, double click or hit 'Backspace' and then 'Delete'.

l

Copying and pasting of the variable converts it to string. Manually inputting the variable name also converts it to string.

Steps to Assign Credential Variables
To assign variables in command fields that support Credential variables, follow the steps given below:
1. To add a Credential Variable, press F2 and select the required Credential 'Key' in the Insert Variable window:
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2. Select the required Attribute

3. The command is assigned the credentials as shown:

l

Here, 'MyFTP' is the Credential Key, while 'HostName' and 'UserName' are its Attributes.
Note: Password fields are displayed encrypted.

Commands that support Credential Variables
The following commands support use of Credential variables:
1. Active Directory
2. Citrix Automation
3. Database
4. Email Automation
5. Excel
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6. FTP/SFTP
7. Insert Keystrokes
8. Manage Windows Controls
9. Object Cloning
10. PDF Integration
11. PGP
12. REST Web Services
13. SAP Integration
14. SOAP Web Services
15. Terminal Emulator
16. Web Recorder
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Reinitializing Variables
When you create user variables and use them within automation tasks, you need to reinitialize them each time you use them.
You can reinitialize any type of user variable, including:
l

Value variables (Only read from txt type)

l

List variables

l

Array variables

l

Random variables

Reinitializing Value Variables
To reinitialize a value type variable, follow these steps:
1. In the Task Editor, drag and drop a Variable Operation command into the task.
2. Select the User Variables option.
3. Under "Specify Variable," select the variable that you want to reinitialize.
4. Select the Reinitialize radio button.
5. In the "Specify value" field, browse to select a new text file for the variable to reinitialize the value.
6. Click Save. Any previous values for this variable will be overwritten.

Reinitializing List Variables
To reinitialize a list type variable, follow these steps:
1. In the Task Editor, drag and drop a Variable Operation command into the task.
2. Select the User Variables option.
3. Under "Specify Variable," select the variable that you want to reinitialize.
4. Select the Reinitialize radio button.
5. In the "Specify value" field, type in new values or browse to locate a new text file.
6. Click Save.
Only the new values that are specified will be assigned. Any previous values for this variable will be overwritten.
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Reinitializing Array Variables
Several options are available for reinitializing array variables.
To reinitialize an array type variable, follow these steps:
1. In the Task Editor, drag and drop a Variable Operation command into the task.
2. Select the User Variables option.
3. Under "Specify Variable," select the array variable from the list of user variables that are defined for the task. The variable type and
source is displayed.
4. Select the Reinitialize radio button.
5. Specify new dimensions. For example, Row 2 and Column 2. You can also specify other variables to be inserted here by pressing
the F2 function key and selecting the variable.
6. In the "Specify value" field, enter values or insert another variable by pressing the F2 function key.
7. Click Save.
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Restrictions and Usage Rules:
l

If the rows and columns are numeric, you can use the Initialize Values button to insert new values. In this case, both the structure
and values for the array are completely redefined.

l

For an array having source type Excel, you can reinitialize the entire row, column, range, or all of the cells.

l

l

For an array having source type of Excel or CSV file, you need to specify a path in order to reinitialize it.

The Open File option is enabled only when you specify a valid file path.
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l

For an array having a Database source type, you can specify connection properties to a new database with its SQL query.

Reinitializing Random Variables
To reinitialize a random variable, follow these steps:
1. In the Task Editor, drag and drop a Variable Operation command into the task.
2. Select the User Variables option.
3. Under "Specify Variable," select the variable that you want to reinitialize.
4. Select the Reinitialize radio button.
5. In the "Specify value" field, specify new values for the number range or string.
6. Click Save. Any previous values for this variable will be overwritten.
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Use Case Scenarios
Example 1:
Type: List Source: Read from text Reinitialize
1. Comment: Reinitialize Variable Type: List, Source: Read from text file having this RDlsttxt =support@automationanywhere.com, testing@gmail.com, sales@automationanywhere.com, buynow@automationanywhere.com
2. Variable Operation: Reinitialize $RDlsttxt$
3. Start Loop "List Variable $RDlsttxt$"
4. Comment: This Loop will run 4 times as 'List read from text file variable has 4 entries.
5.

Comment: The following command will send emails to the address IDs listed in the above Read from
text file -List variable.

6. Send Email: Subject "Automation Anywhere finished executing the task." with Attachment(s).
7. Message Box: "Email to '$RDlsttxt$' has been sent sucessfully."
8. End Loop

Example 2:
Type: Array Source: Read from Excel
1. Comment: Reinitializing the Array Source: read from excel file (ArrayExl) with the CSV file extracted
from the website.
2. Variable Operation: Reinitialize $ArrayExl$
3. Variable Operation: $ArrayRows($ArrayExl$)$ To $Row$
4. Start Loop "$Row$" Times
5. If $Counter$ Equal To (=) "1" Then
6. Comment: To skip the header title of the csv extracted from the website
7. Continue
8. End If
9. Execute SQL Statement: 'Insert into Ebayphilosophy (BookTitle,cost) values ("$ArrayExl($Counter$,1)
$",'$ArrayExl($Counter$,2)$')' Session: 'Default'
10. End Loop
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Resetting System Variables
When using some system variables, you have the option to reset the values while a task is running.
The following system variables can be reset:
l

Error Description

l

Error Line Number

l

Email From

l

Email To

l

Email Cc

l

Email Subject

l

Email Message

To reset a system variable, follow these steps:
1. In the Task Editor, drag and drop a Variable Operation command into the task.
2. Select the System Variables radio button.
3. Select the system variable you want to reset.
4. Click Save.
When the task runs, the value for the system variable will be reset.

Also See...
l

Using the Variable Manager

l

Creating a New User Variable

l

Editing a Variable

l

Copying a Variable

l

Deleting a Variable

l

Assigning Variables to a Task

l

Reinitializing Variables

Other User
Resources:

l

Reading Variables from an External File

l

Watching Variables

Other User
Resources:

Reading Variables from an External File
If you don’t want to specify the value of the variable at the time you create the variable, Automation Anywhere allows you to set the values of variables using an external file such as CSV, Excel, text, and database.
Reading from a Text File
To read variable values from a text file, follow these steps:
1. In the Variable Manager, click the Add button at bottom or right-click on an existing variable and select Add to invoke the Add Variable window.
Note: In the Add Variable window, the Create New Variable option is selected by default.
2. Select the desired variable type, enter a name, and select the 'Read from Text File' option from the dropdown.
To ensure that Automation Anywhere reads text files properly when assigning values for the variables, follow these guidelines:
l

One text file can have multiple<variable> = <value>pairs, on separate lines (line returns using the ENTER key).

l

For value type variables, only one value should be assigned.

l

Example:myvar=value1wheremyvaris the name of the variable.

l

Example:my-list-var= value1,value2,value3

l

Ensure that your text file is specified in the Variable Manager before the task runs.

l

For List type variables, you can define the comma-separated values for the variable.

l

Variable names are not case-sensitive.

Example: Text file with different <variable>=<value> pairs:
Age=12,13,16,21
Games=Football,Soccer,Rugby
username=my-username
Removed the password field.

Reading from an Excel File
When you create an array variable and specify that values should be read from an Excel file, data can be read for the following:
l

For an entire row

l

For an entire column

l

For a range of cells that you specify using the 'From' and 'To' fields
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Reading from a Database
To read values from a database file, you need to specify a connection string and a SELECT query.

Note: Reading variable from database is applicable only for array type variables. Learn More.
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Watching Variables
This topic describes how to use the Automation Anywhere Variable Watch feature to watch your variables, when the automated task is
running.
To track the progress of variables within the task, Automation Anywhere provides a way for you to watch variables as they change.
This makes the progress of variables easier. This can be achieved using "Variable Watch Table" feature which is enabled when you
are using the Debugging mode.
The Variable Watch Table displays current variable values while the task runs, and applies to all types of variables (user and system
variables) that are defined for that task.

Using the Variable Watch Table
To use the Variable Watch Table, click on the Enable Debugging button at the top of the Task Editor. The Variable Watch Table pops
up and displays the actual variable values (or what it contains) as the task runs a particular step.

Initially, the Variable Watch Table is empty. Use the Add button to include variables you want to track.

When the "Add Variables in Watch" window is displayed, select the variables you want to watch and click the Add button.
Any user variables and system variables that are defined for the task can be added to the table.

Other User
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As shown below, the Variable Watch Table contains all of the variables selected for watching. The values get populated and changed
as the task runs.

For an array variable, the Variable Watch Table shows the column/row value. For example, (1,1) is displayed in the left column (Name)
in the table.
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Using Variables to Create Timestamps for Your Files
Timestamps are useful tools to use in your automation tasks to track when particular events occur.
The following system variables are available for you to use to create timestamps for your files:
l

Year

l

Month

l

Day

l

Hour

l

Minute

l

Second

l

Date

You can combine any of these variables to design your own timestamp formats.
To design date/time timestamps, following these steps:
1. Launch the Variable Manager.
2. Click on "Show System Variables".
3. Select the Date/Time variable and use a combination of variables.

Using the Date Variable with File Names
If you use the Date variable to append a date to file names, you cannot use a slash (/) in your date format. Microsoft Windows prohibits
the use of the slash character in file names.
Examples:
1. To create a timestamp for Year, Month, and Day, that is appended to the end of string 'ABC', type: ABC$Year$$Month$$Day$
This example might look like this: ABC2013521
2. To create a complete timestamp for the previous example with the current date and time, type:
ABC$Year$$Month$$Day$$Hour$$Minute$$Second$
This example might look like this: ABC201352107:03:03
3. For clarity, you can insert text characters between the variables.
For example, to display ABC2013-5-21, type: ABC$Year$-$Month$-$Day$
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Passing a Variable to a VB Script
Sometimes, people prefer to run VB (Visual Basic) scripts to accomplish a task or process. In conjunction with Automation Anywhere,
running VB scripts can be very powerful. These scripts can be automated, using the Run Script command.

Sample Use Cases:
l

Obtain data from a file on a website

l

Calculate dates and times

Use the Run Script command to pass values in a variable to the Parameter field. You can then obtain the output from the Return Value
field.
Commands that are required to pass values to a VB script and obtain the results include:
1. Pass values in the VB script: WScript.Arguments.Item(0)
2. Return values in VB script: WScript.StdOut.WriteLine "Variable"
For "Variable", the double quotes are not required for Return values.
Separate the values with a space.
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Customizing an Automation Anywhere Client
After installing your Automation Anywhere client, you can customize it by clicking on Tools > Options.

You can customize the following options for your client:
l

Auto-Login - to automatically unlock and log into a computer while running an automated task.

l

Email Notifications - to notify you about a task's status after it has been executed, by email.

l

Hotkeys - to eliminate keystroke and mouse movement errors.

l

View Options - to customize the run-time view of an automated task.

l

Advanced Settings - to set various options for recording tasks, defining the application locations, editing tasks and enabling system
logging.

l

Run-time Settings - to customize how your automated process runs and performs, and ensure that the process runs as expected.

l

ROI Settings - to calculate the return on investment (ROI) in US dollars.

l

Server Settings - to view or set connection properties for accessing and communicating with the Automation AnywhereSmall Business Server.

l

Plugin Settings - to install/uninstall plugins for IE 11, Flex and Silverlight.

l

Task List View - to customize the columns that you can view in your task list.
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Using the Login Settings
*Applicable for version 9.0 onward.
The Login Settings allows you to save your windows credentials, so that they can be used for running scheduled and/or automated
tasks.
If you are using version 9.0 or less, the Auto Login option will allow you to run tasks on computers
that are unattended. See details.
You can use this setting in conjunction with the following types of activities:
l

Scheduling tasks

l

Running reports

l

Running workflows

l

Triggers

Operating System Support
Windows login settings for Auto Login is supported for the following operating systems:
l

Windows 2000

l

Windows 2003

l

Windows 7

l

Windows 8

How Login Settings Work for Auto Login
Login Settings can be used to set username and password that can help you Auto Login the computers and run an automated task.
The Auto Login works as follows:
l

Auto Login checks whether the computer is locked or the user is logged off.

l

If the computer is locked, hibernating, or in standby mode, Auto Login unlocks the computer or logs into the machine by using the
user name and password provided.

l

The automated process runs.

l

After the task completes (successfully or with errors), the program restores the computer to its original state.

As a task is running, if one of the following actions occur, Automation Anywhere can log off or lock the computer:
l

Stop Task key (Escape key by default) on the keyboard is pressed

l

Pause key on the keyboard is pressed

l

An error occurs while the task runs.

To enable Auto Login option to run an automated task, follow the below mentioned steps:
1. Go to Tools > Options > Login Settings.
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(Image as seen in Enterprise edition 9.0)
2. Input the windows username and password under the 'Windows Login Credentials'.
3. Select the check box for setting Auto Login. This shall enable you to apply Auto Login to all of your tasks.

(Image as seen in Enterprise edition 9.0)

Note: Do not use interactive commands (commands that prompt a user for input) for tasks that use the
Auto Login feature.
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Using Login Settings for Scheduling Tasks
You can save Login credentials for scheduling an automated task. This will ensure that you don't have to input your credentials again
while scheduling a task using Scheduler
1. Go to Tools > Options > Login Settings.
2. Input the windows username and password under the 'Windows Login Credentials'.
3. Select 'Schedule a task' check box if you want to schedule an automated task.

(Image as seen in Enterprise edition 9.0)
4. To enable Auto Login for a scheduled task, make sure you also select the check box for 'Auto Login your computer when the task
runs'.

(Image as seen in Enterprise edition 9.0)
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Tip: It is recommended, you enter the domain name to enable Auto Login to work properly when used in
conjunction with scheduling.

Enabling Bypass Legal Disclaimer *
* Available in Enterprise Edition 7.5 onward. For details contact support@automationanywhere.com

If you operate your tasks in an environment that require stringent security measures, you may not be able to log on automatically to run
certain tasks. Given this scenario, to make your Auto Login option work, you may be required to enable the 'Bypass Legal Disclaimer'
feature.

The feature is available for use, when you select 'Auto Login your computer when the task runs' option. If you wish to bypass the security measures and automatically log on, enable 'Bypass legal disclaimer'.
Caution Note: Please note that this feature should be used with utmost care before enabling the
same. The sole responsibility of using this feature lies with the user and Automation Anywhere shall
not be held liable for its misuse and/or related consequences.
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Using the Auto Login Option
The Auto-Login option allows you to run tasks on computers that are unattended. Auto-Login unlocks the computer, and runs the automated tasks, and returns the computer to the original state.
You can use in conjunction with the following types of activities:
l

Scheduling tasks

l

Running reports

l

Running workflows

l

Triggers

How Auto Login Works
When an automated task runs, Auto Login works as follows:
l

Auto-Login checks whether the computer is locked or the user is logged off.

l

If the computer is locked, hibernating, or in standby mode, Auto Login unlocks the computer or logs into the machine by using the
user name and password provided.

l

The automated process runs.

l

After the task completes (successfully or with errors), the program restores the computer to its original state.
Note: Use the Auto Login Advanced Settings to add security features to Auto Login

As a task is running, if one of the following actions occur, Automation Anywhere can log off or lock the computer:
l

Stop Task key (Escape key by default) on the keyboard is pressed

l

Pause key on the keyboard is pressed

l

An error occurs while the task runs.

Scheduling Tasks to Use Auto-Login
You can enable the Auto-Login option when you schedule a task to run.
1. Go to Tools > Options > Auto Login.
2. Select the check box for setting Auto Login This shall enable you to apply Auto Login to all of your tasks.
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(Image as seen in Enterprise Edition 8.2)
3. Select a task and go to the Schedule tab.
4. Input the required parameters and click save:

5. Input the username and password in the 'Login to Schedule Task' window. Click Save.

Refer Scheduling a Task for details.
l

To turn off Auto-Login, click on the Tools > Options. Under the Auto-Login option, deselect the 'Enable Auto-Login your computer
when the task runs' check box.

l

If an error occurs while a task is running, Automation Anywhere returns the computer to its previous state, regardless of other tasks
waiting to process.

Note: Do not use interactive commands (commands that prompt a user for input) for tasks that use the
Auto-Login feature.
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Enabling Bypass Legal Disclaimer *
* Available in Enterprise Edition 7.5 onward. For details contact support.@automationanywhere.com

If you operate your tasks in an environment that require stringent security measures, you may not be able to log on automatically to run
certain tasks. Given this scenario, to make your Auto Login option work, you may be required to enable the 'Bypass Legal Disclaimer'
feature.

The feature is available for use, when you select 'Auto Login your computer when the task runs' option. If you wish to bypass the security measures and automatically log on, enable 'Bypass legal disclaimer'.
Important: Please note that this feature should be used with utmost care before enabling the same.
The sole responsibility of using this feature lies with the user and Automation Anywhere shall not be
held liable for its misuse and/or related consequences.

Operating System Support
Auto-Login is supported for the following operating systems:
l

Windows 2000

l

Windows 2003

l

Windows 7

l

Windows 8
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Setting up Email Notifications
Automation Anywhere client enables you to notify task status after it has been executed, by email.
To enable email notifications, ensure that you configure your email settings first. For this follow the steps given here:
1. In the main Automation Anywhere window, click on Tools > Options.
Note: You can also configure email notification settings when you click on Properties tab >
Notification
2. Click on Email Settings

3. Now set the following fields given under Outgoing Mail Server (SMTP):
l

Host - The SMTP Host enables you to send email from an Automation Anywhere client over the Internet. You can obtain this information from your Internet email provider, or from the configuration section of your email program.

l

Port - This setting defines the TCP/IP port that Automation Anywhere uses to send email. The default port is 25, the Internet standard for sending SMTP email.

l

Username - If your outgoing mail server requires a user name and password, specify the user name in this field.

l

Password - If your outgoing mail server requires a user name and password, specify the password in this field.
Go Green !

l

Other-Automation Anywhere cares about the environment and wants to help spread the message. As part of our Green Campaign,
a message is included at the end of each email notification. You can deselect this option if you do not want your outgoing emails to
include the Go Green message.

The next step involves setting the email notification options:
1. Click on Email Notification to set notification content. Enter a "From" and "To" email address and one or more email addresses to be
notified.
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2. Also include a subject line and main body content for the email.

Tip:
1. Always try to include the task name with the variable <taskname>.
2. If you plan to notify only one email address with task updates, use the Tools -> Options -> Email
Notification to simply set it one time. However, if you want different tasks to send status emails to
different email addresses, specify the email addresses within each task.
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Defining Client Hotkeys
You can define Hotkeys to save time and eliminate keystroke and mouse errors.

Defining Hotkeys Using Automation Anywhere
You can define hotkeys for the following operations:
l

Start recording

l

Stop recording

l

Stop a running task

These actions have hotkeys defined by default. To select different keys on the keyboard for these actions, simply press the "Hotkey..."
button and select a key combination from the list.
To reset the action to the default, press the "Default" button.
Note: To use hotkeys, ensure that Automation Anywhere is running in the Windows system tray.

Configuring a New Hotkey
Follow these steps to configure a new hotkey:
1. From the main Automation Anywhere window, click on Tools -> Options
2. In the Options window, click on Hotkeys
3. Set the Hotkeys for 'Start Recording', 'Stop recording' and 'Stop Task' by clicking the Hotkey button.

Note: You can modify a hotkey by pressing the Hotkey button. Also set the selected key as
default.

Alternately, you can select Properties tab -> Hotkey ->
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to set hotkeys for the selected task

4. Select an action and a key combination from the list.

5. Click OK.
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Setting View Options
Viewing options provide you the necessary leverage to control the way certain options are displayed. For instance, you can customize
to display the run-time window and keep tab upon the error(s) the task encounters when running.

(Image as seen in Enterprise edition 9.0)
Configure your options from Tools > Options > View:
1. Show Run Time Window: Show or hide the Run Status window that Automation Anywhere displays in the lower right side of your
screen while a task runs.
2. Show Errors: Show or hide any errors that Automation Anywhere issues while running a task.
3. Show Start Page: Show or hide the Automation Anywhere Start Page when starting up the Client.
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Using Advanced Settings
Using advanced settings options enables you to customize the way you control mouse moves/clicks, keystrokes, capture screen-shots
etc when recording a task.
Configure these settings from Tools > Options > Advanced Settings:

For Recording:
1. Record Mouse Moves - To stop recording mouse moves while recording a task, un-check this option. Some mouse moves have
application-specific meaning, such as when recording application menus. In these cases, keep this option enabled.
2. Record Mouse Clicks - To stop recording mouse clicks while recording a task, un-check this option.
4. Record Keystrokes - To stop recording keystrokes while recording a task, un-check this option.
5. Capture Screen-shots While Recording - To capture and display images of the screen-shot while you record tasks use this option.
For more information about this feature, see Using SnapPoint.

For Application Location:
1. Application Path - Check this to specify a different application path. The default application path is the Automation Anywhere Files
folder under My Documents.
When changing this location, all of your tasks will be saved in the new location. The new path will take effect when you restart
the Automation Anywhere client.
Note: After changing the application path, all the triggers, hotkeys, and scheduled tasks will
run as normal.

For Editing and Logging:
1. lEdit Task on double click in Task List - By Default, a double click on a task will run or execute a task. Enable this option to change
the default setting to edit a task on a double click.
2. Enable System Logging - For more information about this feature, see Viewing System Logs.

For Proxy Server:*
Applicable from version 8.1 onward for Small Business and Enterprise editions only
Proxy Server Settings (For Web Service) - These are applicable for Web Service command only. If your environment is using a
proxy server, specify the Host Name/IP Address and the Port Number.
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Using Run-Time Settings
The Automation Anywhere run-time settings enable you to customize how your automated task runs and performs, and helps to ensure
that it runs as expected.
After recording your task, you should check and adjust these settings. The run-time settings take effect, when you initiate a run of your
automated task.

Settings: An Overview

Note: Applicable to Windows 7 or later, in which user account control (UAC) is enabled. For other
operating systems or when UAC is not enabled, turn this setting off. For details refer Setting User Access
Control.

Run Task as an Administrator
Use this setting when running critical tasks for which a Windows prompt is issued asking for authorization to run a process. When this
setting is turned on, the user name and password of the computer administrator is required to be entered before the task can be run.

"Start In" Path of Task
Use this setting when a specific path is not specified in the Log-To-File command or other commands, in which a file or folder path is
required for running a task.
While the task runs, a new folder is created in the location specified in this setting field. After you apply this setting, all newly created
files and folders are located in this path location.

Internet Explorer Timeout
Internet connection speeds can differ widely. Hence adjustments are required to ensure proper running of a task which involves loading web pages.
Use this setting to adjust the timeout value, based on your local internet connection speed or the time taken by the web page to load
completely.
For example, if you use a slow dial-up connection and experience frequent timeout errors while a task is running, adjust this setting to
increase the timeout period.
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Capture Screen-shots while Running a Task
Use this setting to capture visual logs (screen-shots) as a task runs. You can turn this setting off by un-checking the check-box.
Tip: Turning this setting off can enhance performance and free up hard drive memory.
For more information on capturing visual logs, see Using SnapPoint.
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Using ROI Settings
Automation Anywhere calculates the return on investment (ROI) that results from automating tasks.
The ROI is a cumulative savings amount in U.S. dollars that is calculated as you run automated tasks.
Note: The ROI calculation is based on cost of hourly time, run time, debug time, alert assistance
time, documentation time, training time, and knowledge capture.
l

Click on Tools > Options > ROI Settings to change the hourly rate. Changes to this value will be reflected in future ROI calculations.

(Image as seen in Enterprise edition 9.0)
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Using Plugin Settings
Automation Anywhere provides you the option of installing/reinstalling plugins that enable you to access UI objects in technology specific applications.
This functionality can be utilized when you wish to record and run:
Web based tasks in Internet Explorer 11
Applications that use Silverlight/Flex technologies
In order to install these plugins, go to Tools > Options > Plugin Settings.

(Image as seen in Enterprise edition 9.0)
Installing the Internet Explorer 11 Plugin
You will be needing to install the plugin if you wish to record and execute your web recorder tasks in Internet Explorer 11.
1. In order to install the IE 11 plugin, go to Tools > Options > Plugin
2. Click 'Install' in the column corresponding to 'IE 11'.

l

Your installation process is complete when you see the confirmation message for the same.

Note: You can verify if the IE 11 plugin has been installed in the browser from Tools > Manage Addons:
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Pre-requisites for installation
It is recommended that you run Automation Anywhere using the 'Run as Administrator' mode.
Windows Server 2012 users, please note that:
l

The IE Advanced Security should be turned 'OFF'.

l

The Enable Enhanced Protected Mode* in IE should be un-checked. (Go to IE Settings > Internet Options > Advanced tab > Security.)

Installing the Silverlight Plugin
In order to be able to record tasks for applications that use Silverlight and consequently run them, you are required to install related plugins. In your client, switch to 'Administrator Mode' (if not) and follow the given steps:
1. Go to Tools > Options > Plugin Settings
2. Click 'Install' in the column corresponding to 'Silverlight'
l

The installation process begins.

l

Your installation process is complete when you see the confirmation message for the same.
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Installing the Flex Plugin
In order to be able to record tasks for applications that use Flex and consequently run them, you are required to install related plugins.
In your client, switch to 'Administrator Mode' (if not) and follow the given steps:
1. Go to Tools > Options > Plugin Settings
2. Click 'Install' in the column corresponding to 'Flex'
l

The installation process begins.

l

Your installation process is complete when you see the confirmation message for the same.

Installing the Chrome Plugin
In order to capture objects in Google Chrome while using the Object Cloning command, you should have the Chrome Plugin
installed/enabled. You can install the plugin using any of three methods:
1. While installing the Automation Anywhere Enterprise Client. Refer the installation guide for details.
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2. Using the 'Fix' option in the window that appears while recording:

3. Installing from Tools > Options > Plugin Settings menu by clicking install.
l

Chrome Plugin is ready to install:

l

Your installation process is complete when you see the confirmation message for the same.

Tip: To add Automation Anywhere Enterprise extension in Chrome, use the 'Open Folder' option to drag
and drop the extension in the browser or use 'Fix'.
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Reinstalling/Uninstalling Plugins
If, at any given point of time, you wish to reinstall or uninstall the plugin(s), you can simply click the ' Reinstall' or 'Uninstall* ' link in Plugin Settings:

* 'Uninstall' option available for IE 11 Plugin only.

(Image as seen in Enterprise edition version 9.0)
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Configuring Web Recorder Settings
Available from version 9.0 onward.
To automate your web enabled tasks in Automation Anywhere, you can configure the 'Web Recorder' settings from Tools > Options >
Web Recorder Settings.

(Image as seen in Enterprise edition 9.0)

For Recording
1. Record on Mouse Down - Select this option to record a task with the help of Web Recorder using mouse down event i.e. while
scrolling.

For Play Time
1. Internet Explorer Time Out - Define the time (in seconds) within which the Internet Explorer browser should wait till the required
page uploads.The maximum time out allowed is 240 seconds.
2. Parallel Threads to Find Broken Links -Use this to input the number of broken links that can be processed at a time. Default is set
at 10.
3. Find Broken Links Time Out - Use this to allow the web recorder to wait for the 'Broken Link' to exist. Default is set at 10.

General Settings
1. Launch Internet Explorer as a Process - Enable this option while recording in stringent security environment.
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Customizing the Task List View
At times, for ease of use you might want to remove certain columns from being displayed in the Task List.
You can customize your view of the Task List columns by following these steps:
1. From the main Automation Anywhere window, click on View -> Columns Displayed.

2. Add, remove, or reorder columns in the display.

3. Save, cancel or reset your changes to the display.

Adding a Column
Select a column from the list of available columns and click Add.
The newly added column is displayed in the list on the right.

Removing a Column
Select a column from the list on the right depicted below the text 'Show these columns in this order:' and click Remove.
The column is removed from the list and is added back to the list on the left side (Available Columns)
Note: The File Name column is required and cannot be removed from view.

Reorder Columns
Use the Move Up and Move Down buttons to change the left-to-right column position in the view. The columns that are listed from topto-bottom are displayed in the Task List view from left-to-right.

Save Changes
Click Save to save any changes you make to the view and apply them to the Task List.
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Cancel Changes
Click Cancel to abandon any changes you make to the view.

Reset Display to Default
Click Reset to restore the default column settings in the Task List view.
Note: The default column order is: File Name, Type, Repeat, Status, and Last Run Time.
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Setting User Access Control and Data Execution Prevention
In some cases, when using Automation Anywhere on Windows 7 etc User Access Control (UAC) and Data Execution Prevention (DEP)
settings need to be modified.
To ensure smooth operation on machines that run on OS Windows Vista and above, follow these steps:
1. Check to see whether User Access Control (UAC) is turned on for the computer that is running Automation Anywhere:
l

On the Windows desktop, click on Start > Control Panel > User Accounts > Change User Account Control Settings.

l

Drag the slider to the bottom so that the setting is on "Never Notify".

2. Add Automation Anywhere to the list of exceptions under Data Execution Protection (DEP):
l

On the Windows desktop, click on Start > Control Panel > System > Advanced System Settings.

l

On the 'Advanced' tab, click the 'Settings' button in the 'Performance' area.

l

Click on the tab "Data Execution Prevention" and select the option "Turn on DEP for all programs and services except those
I select:"

l

Click on the 'Add' button, and add the Automation Anywhere.exe (Program Files (x86)\Automation Anywhere) folder to the
list.

l

Click on Apply and then OK.

3. Reboot the computer to ensure that the new settings take effect.
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Using the OCR Feature
The OCR Feature command provides the following options:
l

Capture Window: Specify the window title. Automation Anywhere captures the window as an image.

l

Capture Area: Specify a specific area of the window to capture.

l

Capture Image By Path: To extract text that is contained within an image that is stored on your local or network drive, specify the
location of the file. The drive must be accessible when you run the task.

l

Capture Image by URL: Specify a website URL that contains the image you want to capture.

Using Keywords to Identify Captured Text
To make specifying the target text to capture easier, use the Before and After keywords. For example, in the text string "Name: ABC Inc.
Location:", to copy only "ABC Inc.," specify Before = "Location" and After = "Name:". You can also trim the captured text to remove leading and trailing spaces.
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Using Image Recognition
Use the Image Recognition feature to compare many large images and automate application processes using visual elements.
For automated testing, Image Recognition can be used for user interface validation. You can compare a current application screen to
an expected application screen, as well as ensure that all user interface elements are valid.
Using Image Recognition, you can do the following:
l

Locate an image within another image that is saved in a file or captured from a window at run time. The image is captured dynamically at run time in a window that you specify.

l

Specify the minimum percentage match for which you want the command to return true.

l

Left-click, right-click, or double-click the image if it is found within the larger image.

l

Capture images from BMP, JPG, and GIF file formats.

l

Compare images with two modes: Tolerance and Comparison Mode.
Tolerance Mode: Compares images having light and dark colors. It performs the color grading check.

l

Specifying a 0% tolerance compares exact pixel color with the source image. Specifying a tolerance of 10% compares
the 10% (plus/minus) color shade with the source image.
l

Comparison Mode: Provides the following options:
l

Normal mode: Compares the RGB components of the pixels with the source.

l

Gray-scaled mode: Converts the pixel to gray scale and then performs a comparison.

l

Monochrome mode: Converts the pixel to either black or white and performs the comparison.
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Running Tasks in Parallel Using the Multi Task Designer
Automation Anywhere offers an add-on feature - the Multi-Task Designer that you can use to run multiple tasks in parallel.
Using this facility, you can coordinate a set of automation tasks to run in parallel, on the go or setting the timing any way you like. Using
the facility is simple, providing drag-and-drop operations made available in the Multi Task Designer window.

Purchasing a Multi Task Designer License
You can purchase licenses for the Multi Task Designer based on the number of concurrent tasks you want to run. If necessary, you can
obtain a limited-time license key as well.

Enabling the Multi Task Designer
After you install the Multi Task Designer license key, the facility is enabled. A Multi Tasks tab is displayed on the left side of the main
Automation Anywhere window under 'Manage'.

Using the Multi Task Designer
To use the Multi Task Designer, follow these steps:
1. In the main Automation Anywhere window, click on the Multi Task Designer tab.
2. In the Multi Task Designer window, all folders are displayed in the left panel.
3. To view all task files (.atmx files), click on a folder.
4. Create a new list of tasks that you want to run in parallel. Either drag a file or double-click on a file to add tasks to the list.
5. Save the Multi Task list by clicking the Save button. The saved list file has a file extension of .mtlx. Multi Task list files are stored in
the My Lists folder.
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6. Run the Multi Task list file. All tasks run in parallel, depending on the authorized concurrency count.

Removing a Task from the Multi Task List
To remove a task from the Multi Task list, select (highlight) a task from the list and click on the X in the file icon.

Running a Multi Task List File
To run your tasks in parallel, simply run the Multi Task list file that you've created by clicking on the Run button.
The Task Progress window is displayed, showing the first two tasks that are running in parallel. If you are running more than two tasks
in parallel, a scroll bar is provided to view them.

Performing Actions on Multi Task Lists
You can perform the following actions on Multi Task list files (.mtlx) that are stored in the My Lists folder:
l

Run: Runs a Multi Task list file from the My Lists folder.

l

Edit: Enables you to edit a Multi Task list file. You can add or remove tasks from the list using the Multi Task Designer.

l

Delete: Deletes a Multi Task list file.

l

Upload: Uploads a Multi Task list file to the Server Repository, assuming proper privileges exist for the client.
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Restrictions with Running Tasks in Parallel
The following restrictions exist for running tasks in parallel:
l

Tasks can only be run in parallel using the Multi Task Designer.

l

Task performance and completion depends on your available system resources. If system resources are fully consumed, tasks
might stall or fail.

Recommendations when Running Tasks in Parallel
To ensure success, follow these recommendations when running tasks in parallel:
l

Avoid running tasks in parallel that include the following interactive commands:
n

Insert Keystrokes

n

Insert Mouse Clicks

n

Message Boxes

n

Prompts

n

Image Recognition

n

Manage Windows Control

Avoid running two tasks in parallel that both access the same file or application (for applications that do not support multiple threads or
sessions), such as a Microsoft Excel file. Opening, editing, and closing a single file using two parallel tasks can result in unpredictable
results.

Supported Commands
The following commands are supported for running tasks in parallel:
l

Excel commands

l

Web Recorder commands

l

Read from CSV/Text

l

Database commands

l

Log-to-file command

l

String operations
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Using SnapPoint
Use the SnapPoint feature to add screen shots to an automation task or to recapture screen shots when a task is running.

Capturing Images While Recording Tasks
Automation Anywhere provides a state-of-the-art technology for capturing and displaying screen shot images as you create automation
tasks.
To capture screen shots, click on the Tools menu, select Options, and select Advanced Settings. Click on Capture Screenshots While
Recording.
You can re-size and move images inside the Task Editor to place them in a desired location. The captured image is the active window
during recording, and shows you exactly where your mouse cursor is located.
For example, in the following screen shot, line number 24 in the task, Mouse Click: Left Button on 2 in Calculator, and the corresponding image showing the Windows calculator.

Using the Visualize Tab
Use the Visualize tab in the Task Editor to view a complete graphical layout of the current task. The following screen shot shows a task
after having clicked on the Visualize tab. The example shows that you clicked Start, then Run, then OK in the Run window, then number '1' in the calculator.
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Setting SnapPoints to Refresh the Images
When you create a task manually using the Task Editor, or you modify a recorded task, the images that you captured during recording
might not remain the most current. Automation Anywhere provides a convenient way to refresh the images, called SnapPoints.
To set SnapPoints, click the Set SnapPoint button. You can now set SnapPoints in the column to the left of the line numbers, as shown
below. When you run a task after setting SnapPoints, Automation Anywhere recaptures the images for those commands on which you
set SnapPoints.
The images are captured after the task runs.
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Commands that Support SnapPoints
The following commands support SnapPoints:
l

Insert Keystrokes

l

Insert Mouse Click

l

Prompt

l

Excel

l

Web Recorder

l

Window Actions

l

Message Box

l

Manage Windows Controls

l

Screen Capture

Also See...
l

Running Tasks in Parallel Using the MultiTask Designer (Add-On Feature)

l

Using the Report Designer

l

Using the Workflow Designer

l

Using the ROI Calculator

Other User
Resources:

Using the Report Designer
Use the Automation Anywhere Report Designer to run reports for your automation projects. These reports gives a graphical representation of automated tasks over a period of time. It also displays the ROI for an organization using Automation Anywhere products.
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l

Triggering a Report to Run
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Viewing a Report Graphically
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What is a Report?
Reports are important feature to measure the success and calculate the ROI that Automation Anywhere brings to your organization
with respect to time.
Automation Anywhere provides graphical reports that display the status of tasks and workflows, as well as the ROI over time.
You can view the following types of reports:
Task Run: Displays how many times a task has run successfully, and how many times it has failed during the period. You can view this
report for:
l

All Tasks saved in the default location, i.e., My Documents\Automation Anywhere\Automation Anywhere\My Tasks

l

Tasks in a specified folder

l

Selected tasks.

To graphically view your Task Run, see the Visualize Report.
Workflow Run: Displays how many times a workflow has run successfully and how many times it has failed during the period. You can
view this report for:
l

All workflows saved in the default location, i.e., My Documents\Automation Anywhere Files\Automation Anywhere Files\My Workflow

l

Workflows in a specified folder

l

Selected workflows

Task Timeline: Displays task history in a graphical time line. Select a task and time line to view the number of times a task was run or
modified during the period. It also shows whether the task was created or deleted during that time. You can view this report for:
l

All tasks saved in default location, i.e. My Documents\Automation Anywhere Files\Automation Anywhere Files\My Tasks

l

Tasks in a specified folder

l

Selected tasks

Workflow Timeline: Displays workflow history in a graphical time line. You can select a workflow and a time line to see the number of
times the workflow was run or modified during the time period. It also tells you whether the workflow was created or deleted during that
time. You can view this report for:
l

All Workflows saved in default location, i.e. My Documents\Automation Anywhere Files\Automation Anywhere Files\My Workflow

l

Workflows in a specified folder

l

Selected workflows

ROI: Displays how much USD/Dollar Value has been saved by using Automation Anywhereduring the time period.
Visual Logs: Graphically displays tasks that have run by providing step-by-step SnapPoints for each action in a task.
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Running Reports
How do I run a report?
Running a report is simple.
To run a report, simply specify your criteria in the Report Designer and click Run Report.
To run a saved report, double-click the report file in the Task List, or select the report in the Task List and click Run.
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Saving Reports
How do I save a report?
To save a report after specifying the criteria, click Save and Run Report.

Automation Anywhere stores your selections and saves the report as a template for future use.
If you want to save a report as an image, click on the File menu and select Save As Image.
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Sending Email Notifications for Reports
Using the Notification property, you can automatically send an email notification after a report completes.
The email includes the report as an image, as well as other helpful information.
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Scheduling a Report to Run
Using the Automation Anywhere scheduler, you can schedule a report to run at a specific time.
To schedule a report to run, follow these steps:
1. In the Task List, select the report.

2. Select Schedule.
3. Specify the scheduling parameters.
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Triggering a Report to Run
Using the Automation Anywhere trigger feature, you can run a report based on a trigger event.
To trigger a report to run, follow these steps:
1. In the Task List, select the report.

2. Select Trigger.
3. Define your trigger.

You can use the Notification property to send an email notification after the trigger event runs the report. For more information, see
Sending Email Notifications for Reports.
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Viewing a Report Graphically
Automation Anywhere provides a step-by-step graphical view of all tasks run. To turn on the Visualize view, follow these steps:
1. Click on the Tools menu, and select Options.
2. Click on Advanced Settings.
3. Check the 'Capture Screenshots While Recording a Task' check box.
4. Click the Apply and OK buttons.
5. To view your task graphically, simply click on the bar representing the task using the Task Run report view.
If SnapPoints are not supported by the task, a message is displayed to notify you immediately.
Using the Visualize Report, you can:
l

View the number of days that the task has run during a specific date range.

l

View a specific day and the number of times that a task has run during that day.

l

Compare your tasks using all of the saved SnapPoints in the task folders (..My Documents\Automation Anywhere\SnapPoints).
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Using the Workflow Designer
To assist you in designing and improving your business workflows, Automation Anywhere provides a Workflow Designer tool. The
Workflow Designer helps you build Workflow flow diagrams in a graphical environment. You can subsequently use these Workflow to
build and run automated Workflows using Automation Anywhere.

Overview
A Workflow shows a high-level, graphical view of your business or IT Workflow, with a representation of conditional logic and Workflow
flow. Some Workflows might be simple, some more complex.
The Workflow Designer provides an intuitive, drag-and-drop interface to help you quickly design your workflows.

Creating a Workflow?
To create a new Workflow, follow these steps:
1. Click on the Tools menu and select Workflow Designer. The Workflow Designer provides the following design objects:
l

l

Start: The starting point for the Workflow. Each Workflow can have only one Start object.

Run Task: Runs a previously built task (.atmx file). Before proceeding to the next Workflow step, the Workflow stops until the
Run Task command is completely finished.

When you insert a Run Task object, it displays one Successful arrow and one Unsuccessful arrow. Both arrows are required for
a complete Workflow. If you accidentally delete one of these arrows, move the mouse over the Run Task object and pull
another arrow over to connect it with the desired object.
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Note: You can edit a task from the Run Task list by right-clicking the task and viewing the
menu.
l

Conditional (If): Provides an event condition on which the subsequent steps in the Workflow depend. Based on the result of the
condition (True or False), the Workflow moves along the appropriate path to next steps.

When you insert a Conditional object, it displays one True arrow and one False arrow. Both arrows are required. If you accidentally delete one of the arrows, move the mouse over the object and pull another arrow over to connect it with the desired
object.
Use multiple AND or OR conditions*- You can include 'AND' or 'OR' conditions when you wish to include multiple conditions in
the same command.
* Available from version 7.5.2 onward
Refer If Else Command to know how.
l

End: The end of the Workflow. When the Workflow reaches this object, execution is stopped.

l

Arrows: Connects objects and pathways in the Workflow. To insert an arrow from any object, move the mouse over the object until
the mouse icon changes to a hand icon:
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Tip: Prior to running a Workflow or exiting the Workflow Designer, always validate the Workflow. Validation ensures that your Workflow objects are correctly connected and that errors do not occur.

Running a Workflow
To run a Workflow from the Workflow Designer, click on Run or double-click the Workflow file in the Task List.
When you run the Workflow within the Workflow Designer, Automation Anywhere indicates the path followed in the Workflow. For
example, you can easily see whether a True or False condition occurs.

After a Workflow has completed a run, the Workflow Designer highlights the complete path in color.
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Repeating a Workflow
To repeat a Workflow, use the Repeat property. The Workflow will run again.

Sending Email Notification for a Workflow
To send an email notification when a Workflow run is complete, use the Notification property.

Saving a Workflow as an Image
To save a Workflow as an image, click on the File menu and select Save as Image.

Printing a Workflow
To print a Workflow, click on the File menu and select Print.

Scheduling a Workflow to Run
You can schedule a Workflow to run using the Automation Anywhere Scheduler. Refer Scheduling Tasks to Run.

Triggering a Workflow to Run
You can use triggers to schedule a Workflow to run. Refer Scheduling Tasks Using Triggers.

Associating Workflow Variables to Task Variables
Workflow variables can be associated with various tasks. The associated variable is clearly shown in Run Task command.
Only type of variable association should be same, the names of variables can differ.
Steps to associate Workflow variable to task variables:
1. Click the Run Task command.
2. Select Task using Browse.
3. Select Variable option as action.
4. Create variable association section appears.
5. Select Worflow Variables from drop down list and associate them with the drop down of list for the Task Variables.
Use the 'Quick Map' button if you have a large set of variables to associate *.
* Available from version 8.1 onward.
Refer Run Task Command for details.
6. Associate workflow variables to task variables using Run Task > Variable option.
l

Both drop downs will only display Value type of variables defined.
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7. Use Add button to add more variable association of Workflow to Task.
8. Select an association and use Delete button, to remove it.

Note:
1. If there are changes to the task variables type or source, the association will be invalid.
2. If there is change in application path of a task, the association will be updated automatically.
However, one needs to manually Save the workflow.
3. The SAVE button is enabled for these workflows with an appropriate message.
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Using the ROI Calculator
Use the ROI Calculator as a planning tool that calculates your return on investment (ROI) on process improvement.
The ROI calculator makes the following calculations:
l

Resource costs for time saved

l

Reduced error rates

l

Automated troubleshooting

l

Automated documentation

l

Resource realignment

l

Training benefits

l

Knowledge capture

Automation Anywhere calculates the ROI based on the results of automating processes. The ROI is a cumulative dollar amount from
running tasks.
As the basis for the ROI calculations, you can set the hourly personnel rate to calculate hourly savings. For more information, see the
'ROI Settings' in the ROI Calculator.
To make the ROI calculations easy to understand and useful in sharing, you can view the ROI as a graphical chart.

Note: You can reset the ROI at any time by clicking 'Reset ROI' button.
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You can also generate ROI related reports using the Report Designer as shown:
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Uploading and Downloading Tasks to the Server
Applicable to Small Business and Enterprise editions only.
This topic describes how to use the Repository to move automation tasks to and from the server.
l

The Automation Anywhere client provides an easy-to-use facility for communicating with the server.

l

To launch the Repository facility, click on the Repository tab on the main client screen.

l

Ensure the client is already registered with the server.

Refer Registering a Client with the Server/Control Room for details.
You can use the Repository to perform the following tasks:
l

Transferring tasks between the client and server.

l

View the date and time that a task was last modified on the client or the server.

l

View any new tasks that have been created on a client or uploaded to the server.

l

Compare task files to identify differences between versions of the files that reside on the client and server.

Refer Comparing Files that Reside on the Client and Server for details.

Uploading a Task to the Server
You can upload tasks to the server (or the Control Room Repository Manager using any of the four methods:
1. Selecting Upload from the Action button drop-down list

2. Clicking the 'Upload' button at the top right 'Task List' pane
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3. Right clicking the selected task and choosing 'Upload'

4. Selecting the task from the Repository feature:

l

When the task is successfully uploaded, a confirmation window is displayed. Click OK.

l

The task is displayed in the Server Repository Manager.

Note: If you have configured Version Control, you will have to add comments while uploading the
task. Learn More

Downloading a Task from the Server
To download a task from the Server (or Control Room Repository Manager), you must use the Repository facility. Follow these steps:
1. In the main Automation Anywhere window, click on the Repository tab. The Repository facility is displayed, with a split screen showing files that reside on the server as well as the client.
2. Highlight the task file that you want to download to the client.
3. Click the Download button. The task is copied to the client.
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Note: Be aware that files that are downloaded to the client with same names will be overwritten.
Before downloading files, be sure that the latest version of the task is on the server.
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Comparing Files that Reside on the Client and Server
Your team of automation users can create, upload, edit, and run many tasks, moving task files between the client and server. Maintaining several copies of task files and having multiple users modify single tasks can require the need for users to view how and when
a task file was last changed.
This topic describes how to compare versions of task files that reside on the client and server.
Using the Compare File feature, you can compare two different versions of a task file to identify any recent changes. You can view
these differences by using the Task Actions List panes that are generated after running the comparison.
To run a comparison of two task files, follow these steps:
1. Launch the Repository facility by clicking on the Repository under Manage tab on the main client screen. Make sure that the client
is already registered with the server.
2. Highlight the task file you would like to compare by clicking once on the file name, either in the Server or Client pane. In presence
of a file with duplicate name in the Client or Server, the Compare button is enabled.

3. Click on the Compare button to run the comparison. A new window is launched, displaying the comparison results.

l

If no differences between the files are found, the message "No differences found." is displayed at the top.

l

If differences are found, the number of differences is displayed at the top.

l

Differences in the task file actions are displayed in the following colors:
n

BLUE: Changed. Task actions that have been changed are marked in blue.

n

GREEN: Inserted. Task actions that have been newly inserted are marked in green on the client, and are shown as a blank
line on the server.

n

RED: Deleted. Task actions have been deleted are marked in red on the server, and are shown as a blank line on the client.
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Automation Anywhere Client FAQs
1. How does the Client communicate with Server?
2. Can I download/upload all types of documents?
3. What is the process of registration?
4. What do I do in case of an 'Account Lockout'?

How does the Client communicate with Server?
In the main Client window click on 'Repository' tab to communicate with the server. You can directly upload, download or compare any
task on the server with the one on the client. Refer Uploading and Downloading Tasks to the Server for details.

Can I download/upload all types of documents?
Yes. You can download/upload all types of documents.

What is the process of registration?
The first time you start the client, it will ask you to login and when you click 'Login' (not 'Later') after inputting your credentials, you are
registered with the server (Control Room/Server), automatically. Refer Login to Automation Anywhere Client for details.

What do I do in case of an 'Account Lockout'?
After the minimum allowable attempts have been exhausted for logging in to the Client account, it is locked for use. It can be unlocked
only by the Control Room administrator, if a threshold value has been set in the Control Room. If the default domain policy is enabled,
you are required to contact your System Administrator.
Refer Using Client Control Center for details.
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Files Folders FAQs
1. Can I create a file with any extension?
2. If I use a Files / Folders command like "Delete Files 'c:\MyPrgs\*.*' " , will this delete all the files in the sub-folders too?
3. Can I get list of all the file names in a folder to perform some operation on it?
4. Can I provide value for file/folder name when the task runs?

Can I create a file with any extension?
Yes, you can create file with any extension using the 'Create File' sub command in the Files/Folders command.

If I use a Files / Folders command like "Delete Files 'c:\MyPrgs\*.*' ", will this delete all the files in the subfolders too?
No, this command will delete all the files in the current folder only. In the above example it will delete all the files in 'c:\MyPrgs' directory
only.

Can I get all the file names in a folder to perform some operation on it?
Yes, you can use the "Loop for Files in a <folder>"command.
Here $FileName$ will have next filename inside the specified folder in each Loop execution. You can use this System variable to perform any operation inside the Loop - End Loop block.

Can I provide value for file/folder name when the task runs?
Yes. Automation Anywhere has a 'Prompt' command to provide value at run time. You can provide value for any window, prompt for
file/folder and even prompt for yes/no as well.
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IF Condition FAQs
1. Can I execute certain commands only if a window exists?
2. Is it possible for me to know if one of my software is running or not? I want to do certain action only if that software is running.

Can I execute certain commands only if a window exists?
Yes. There are number of conditions in IF command. One of them is 'If Window Exists' .

Is it possible for me to know if one of my software is running or not? I want to do certain action only if that software is running.
Yes, you can use If Condition (If Application Running) to see if any application is running or not. You can specify the exe name that you
want to test in the If condition. For e.g. consider the following script
If Application Running ('F:\WINNT\system32\calc.exe')
Comments: Add your commands when the Calculator program is running
End If
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Internet FAQs
1. What is E-Mail Notification?
2. What is this 'Email Settings' displayed in the Notification tab in the properties window?
3. Does your automation software provide any facility to send an email?

What is E-mail Notification?
You can use E-mail notification when you want to be notified that a task has finished running. An e-mail will be sent to the addressed
specified along with the status of the task that was running and few other properties.

What is this 'Email Settings' displayed in the Notification tab in the properties window?
This Button will open up the Options user interface that allows you to set the outgoing mail server, its port number and Exchange
Server authentications, if any. Every mail that you send or receive requires the mail server. You have to obtain this information from
your Internet E-mail provider or you may obtain it from the configuration section of your e-mail program.

Does your automation software provide any facility to send an email?
Yes, Automation Anywhere provides a command 'Send mail'. You can use this command to send e-mails to anyone. Note that this command will get information about the e-mail Server, its port number and Exchange Server authentications, if any, from the Mail Setting in
the Options menu every time a task runs.
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Loops FAQs
1. What is a Loop Command?
2. I want to do particular action on all the folders inside a folder. How do I do that using your automation software?
3. Can I get all the file names inside a folder using the Loop command?

What is a Loop Command?
A loop command allows repeated execution of a group of commands when these commands are placed inside the 'Loop “ End Loop"'
block. The number of the times these commands are executed will depend on the type of Loop command selected. The 'Loop - End
Loop' block might also contain within it another 'Loop - End Loop' block i.e. nested loop commands.

I want to do particular action on all the folders inside a folder. How do I do that using your automation software?
You can use the Loop command (Start Loop 'Each folder in '<folder>') in Automation Anywhere. If there are 'n'™ folders in the specified
folder then this loop will be executed 'n'™ times. You can get each folder's name using the $FolderName$ system variable inside this
loop block.

Can I get all the file names inside a folder using the Loop command?
Yes, you can get the file name using the System variable $FileName$ inside a specified folder by using the Loop command " Start
Loop'Each File' in '<folder>'.
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Manage Windows Control FAQs
1. How to use and manage Windows Controls to get check-box or radio button status in Automation Anywhere?
2. Does a task recorded using MWC work in the background?
3. Why aren't some controls highlighted when I try to capture them using MWC?

How to use and manage Windows Controls to get check-box or radio button status in Automation Anywhere?
Manage Windows Controls command allows you to work with windows controls like check-boxes and radio buttons. With this command you can find out if the radio button or check box is checked or not. Automation Anywhere supports only standard Windows
check-boxes and radio buttons.
Click on Manage Windows Control in Task Editor and select the appropriate radio button. Select the window to capture the check box
or radio button. The value captured can be assigned to a variable.

Does a task recorded using MWC work in the background?
Yes. A task recorded using MWC works in the background.

Why aren't some controls highlighted when I try to capture them using MWC?
We capture standard Windows control using MWC. Client controls and Java are not supported by MWC. In such cases, controls are not
highlighted.
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Moved Icons-Menus FAQs
1. I recorded a task that opens a program from Start Menu > Programs and while running the task, the menu to open that program has
moved. It clicks on a wrong program name and hence opens a wrong program. Do I need to re-record the task?
2. Will my task run correctly even if files, program shortcut icons in the Quick Launch and the Desktop have moved?

I recorded a task that opens a program from Start Menu > Programs and while running the task, the menu to
open that program has moved. It clicks on a wrong program name and hence opens a wrong program. Do I
need to re-record the task?
No, the SMART Automation Technology built into Automation Anywhere provides a powerful feature that lets you use your original
task. You can check an option from Tools > Options >'Move Icons/Menus' . After selecting this option when you run a task it opens the
same program that was opened while recording even if the menus have moved.

Will my task run correctly even if files, program shortcut icons in the Quick Launch and the Desktop have
moved?
Apart from a few exceptions, opening of most of the files and shortcut icons from both Quick Launch and Desktop will run correctly if the
icons have moved from their original location. Note that, the 'Move Icons/Menus' should be checked in Tools > Options menu for this
feature to be enabled.
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Report Designer FAQs
1. What is Report Designer?
2. Can I print my report generated by Report Designer?

What is Report Designer?
Report Designer allows you to create your custom reports. Automation Anywhere features Task Run (i.e. whether they were successful
or not), Task Timeline(i.e. run, created, modified and deleted), Workflow Run, Workflow Timeline, ROI and Visual Logs reports.
Reports can be generated by day, week, month as well as 'all time'. You can also generate a report for a custom date range.

Can I print my reports generated by Report Designer?
Yes. You can print a report generated by Report Designer directly from Automation Anywhere. Just click on the Print logo in the top left
corner of the graph.
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Recordings FAQs
1. How do I record a task using Automation Anywhere?
2. Does it matter if the window size and locations of my applications change between recording and running?
3. Do I need to finish all my work in one application before moving onto the next application or can I switch back and forth between
various applications while recording?
4. Can Automation Anywhere work if computer is locked? Can I record a task to unlock the computer?
5. Is it possible to execute a task in stealth mode when computer is locked?
6. Can I stop the task while it is running?
7. Can I pause the task while it is running?
8. Can my recorded activity run in background, while I have control of mouse and keyboard so that I can do other things?
9. I use remote access software to access a remote machine. Can I record a task that performs activities using remote access software?
10. I recorded a task on 'abc.xls' but I want to run it on xyz.xls, how do I do that?
11. Is it possible to password protect my task?

How do I record a task using Automation Anywhere?
You can easily create new task using SMART task recorder. Click 'RECORD'; perform the activities on your computer that you want to
record, click 'STOP' and then 'SAVE' the recorded activities to a task. You can playback your recorded actions by selecting the task and
then click the 'RUN' button. For further details refer to the Help file.

Does it matter if the window size and locations of my applications change between recording and running?
No. Automation Anywhere's SMART Automation Technology automatically adjust to changes of window size and location.

Do I need to finish all my work in one application before moving onto the next application or can I switch back
and forth between various applications while recording?
You can switch back and forth between various applications while recording.

Can Automation Anywhere work if computer is locked? Can I record a task to unlock the computer?
Yes. Automation Anywhere offers secure Auto Login technology. Auto Login allows scheduled tasks to run even when computer is
locked. When you schedule a task you can enable Auto Login capability. If Auto Login in enabled, and if computer is locked, Automation Anywhere will unlock the computer, run the task and lock it back.

Is it possible to execute a task in stealth mode when computer is locked?
Yes. To enable the task to run in stealth mode check Properties->Security-> Run this task in stealth mode option. This will hide the execution of the task. To allow the task to run when computer is locked, enable Auto Login capability. Auto Login allows scheduled tasks to
run even when computer is locked. When you schedule a task you can enable Auto Login capability.
An additional security option can also be set, where if you want to lock mouse and keyboard while task is running, just select 'Disable
mouse and keyboard for this task' option from Properties->Security.

Can I stop the task while it is running?
Yes. Hold the Escape Key for 2-3 seconds.

Can I pause the task while it is running?
Yes. Press â€˜Pauseâ€™ on your keyboard. This will temporarily stop the execution of the task. Click on the â€˜Resumeâ€™ button that
will appear at the bottom right hand corner of your screen to continue running the task from where it was paused.

Can my recorded activity run in background, while I have control of mouse and keyboard so that I can do other
things?
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One of the distinguishing features of Automation Anywhere is its ability to run tasks in background. Advanced technologies like Web
recorder, Object recorder and hundreds of powerful actions allow you to run many of your tasks in background. Few tasks like task
recorded with standard recorder requires control of mouse and keyboard and therefore cannot run in background. Few other obvious
exceptions include commands that requires screen, like taking screenshots or comparing images on the screen, but a vast majority of
actions allow the task to run in the background.

I use remote access software to access a remote machine. Can I record a task that performs activities using
remote access software?
Yes. Automation Anywhere supports all the remote access software.

I recorded task on 'abc.xls' but I want to run it on xyz.xls, how do I do that?
You can run the same task with different files of the same program. By default the task will only run on the specific file(s) it was recorded on. However you can check 'Enable this task to run with other similar files and windows' option under the Properties>General tab.
Now for example if you recorded a task on abc.xls, you can run this task on def.xls, xyz.xls or any other *.xls files

Is it possible to password protect my task?
Yes, it is possible to password protect a task. While saving the task click on the Password Protection checkbox and specify the password. Alternatively, you can password protect a saved task by going into the Security tab in the main screen of Automation Anywhere.
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Scripting FAQs
1. I have been using VBScripts and JScript to accomplish some of my routine work. Can I somehow reuse them in your automation
software?
2. How do I know if my Script ran without any Error?

I have been using VBScripts and JScript to accomplish some of my routine work. Can I somehow reuse them
in your automation software?
Yes. Not only you can integrate disparate scripts like VBScripts & JScripts within an Automation Anywhere task but you can use in-built
automation services like repeat, notification, etc., on VBScript & JScripts as well. For more information about Automation Anywhere
check Automation Software.
Automation Anywhere Editor has a command 'Run Script' . You can use this command to Run your VBScript or JScript files from Automation Anywhere. You can even pass arguments to your VBScript and JScript files as you might have been doing it to run it through
command prompt. You can also have return values, if any, to your VBScripts and JScript files.

How do I know if my Script ran without any Error?
You can use the 'If Script Successful' sub-command inside the 'If command'. This command will run the script and will execute the 'If End If' block only if the script ran successfully.
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Tasks FAQs
1. Can I run many tasks in a batch?
2. When I use "Run Task" command, how do I know if the task has successfully completed?

Can I run many tasks in a batch?
Yes, You can create a new task in which you can use 'Run Task' command to run your individual tasks.

When I use "Run Task" command, how do I know if the task successfully completed?
You can use the 'If Task Successful' sub-command inside the 'If command'. This command will run the task and will execute the 'If - End
If' block only if the task ran successfully.
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Triggers FAQs
1. Can I execute a task based on availability or non-availability of any file, folder, performance or service?
2. Is there any way to get an alert whenever I receive a new email?

Can I execute a task based on availability or non-availability of any file, folder, performance or service?
Yes, it is possible to execute a task with Triggers, based on availability or non-availability of any file, folder, performance or service.
There are triggers based on Window (open or close), File (create, delete, renamed or modified), Performance (CPU usage, free disk
space, process count) and Process and Services.

Is there a way to perform a task when a new email arrives?
Yes. Automation Anywhere has a trigger functionality that can perform any task when a new email arrives. You need to set the'Email
Message Trigger' on the task.
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Variables FAQs
1. How do I use a variable in the task?
2. If I create a variable for one task, can I use it in another task?
3. List variables can have many different text values. When I use the list variable which value will be executed?
4. Is it possible to store special characters like Tab key in a variable?
5. I have to run a task that needs to use a different value for a variable in every repeat. How do I do that with your automation software?
6. What are these System Variables $CurrentDirectory$, $FolderName$ and $FileName$?

How do I use a variable in the task?
You can use variable inside different commands like'Insert Keystrok', 'Open Program/File','Files/Folders'. In all the commands variable
names are specified by enclosing the variable names in between the $ sign. For e.g. $Password$

If I create a variable for one task, can I use it in another task?
Variables created for one task are only available locally for that task and not for any other task. But, if you have upgraded from a lower
version to version 5.5 and above, all the variables created in the lower versions will be available to you as global variables that can be
used with any task.

List variable can have many different text values. When I use the list variable which value will be executed?
Every time a task comes across a list variable during the playback, the next text value in the sequence of the list variable is used. If the
list variable reaches the last text value then its subsequent reference will return the first text value.

Is it possible to store special characters like Tab key in a variable?
Yes, you can store any special character as a text value in a variable.

I have to run a task that needs to use a different value for a variable in every repeat. How do I do that with your
automation software?
Automation Anywhere provides "Loop â€“ End Loop" commands. You can place your repetitive task inside a Loop â€“ End Loop block.
You can use a List variable inside it for data that keeps on changing with each loop.

What are these System Variables $CurrentDirectory$, $FolderName$ and $FileName$?
These system variables are used with commands 'Loop for Folders in a folder' or 'Loop for Files in a folder'.
Consider a command in the task - "Loop for Folders in a <folder>".
Here the <folder> is the specified folder on which the Loop will execute. Its full path is available at execution time by the system variable "$CurrentDirectory$"
If <folder> has 'n' number of folders, the loop will be executed 'n' times. Each time the $FolderName$ variable will have the next
folder's name inside the specified folder.
Now if the task is like "Loop for Files in a <folder>".
Then $FileName$ will represent the next file name inside the specified folder.
Outside the loop $CurrentDirectory$, $FolderName$ and $FileName$ doesn't have any usage.
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Visualize Technology FAQs
1. What is Visualize Technology in Automation Anywhere?
2. What is SnapPoint in Automation Anywhere?
3. What is Image Recognition in Automation Anywhere?

What is Visualize Technology in Automation Anywhere?
Automation Anywhere Premier has an in-built Visualize Technology that allows for pictorial and storyboard views of the automated
task. Visualize Technology is used in the different views in Task Editor, to capture images on demand with SnapPoint and Image
Recognition with the IF command.

What is SnapPoint in Automation Anywhere?
In Automation Anywhere Premier when a task is recorded the images of all mouse clicks and keystrokes are captured automatically.
But when a task is created in Task Editor the images need to be captured on demand. SnapPoint allows you to capture images on
demand; just enable SnapPoint and set it for the commands that you want.

What is Image Recognition in Automation Anywhere?
Image Recognition is another feature of the Visualize Technology available in Automation Anywhere Premier. Image Recognition
allows the recognition and comparison of images. It allows your automated task to "see".
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Web Recorder FAQs
1. What is a Web Recorder?
2. What is Web Data Extraction? How do you extract data with Web Recorder?
3. How do you check for broken links with Web Recorder?
4. What is Manage Web Control?
5. Can Automation Anywhere automate web based processes? If yes, what type of websites can be automated?

What is a Web Recorder?
Web Recorder reliably and accurately records and automates web based tasks. Automation Anywhere Web Recorder understands all
the web controls. You can open or close browser, perform clicks, fill forms, import data from the web, download files, extract data,
extract source, check for broken links and much more.

What is web data extraction? How do you extract data with Web Recorder?
Extracting structured or unstructured data from the Internet automatically with the help of scripts is web data extraction or screen scraping. Automation Anywhere as a data extraction or screen scraping software is both flexible to suit any kind of web technology or page
format and is also non-intrusive.
See two demos below to see how to use Automation Anywhere web recorder for data extraction.
Demo 1: Web data Extraction using intelligent pattern matching technology
Demo 2: Web data Extraction demo 2
Learn more on Web Data Extraction and Screen Scraping.

How do you check for broken links with Web Recorder?
To check for broken links with Web Recorder, go to Task Editor and select Web Recorder -> Find Broken Links command. Enter the
URL and specify if you want the entire website to be checked or just the specified webpage. Enter the path of the file to save the results
and click Save. Automation Anywhere will check for broken links as specified. You can schedule to run this task at pre-defined time.

What is Manage Web Control?
To capture image links, radio buttons, text boxes, check boxes and other web controls Automation Anywhere Web Recorder -> Manage Web Controls allows capture of web controls and assign them variables.

Can Automation Anywhere automate web based processes? If yes, what type of websites can be automated?
Yes. Automation Anywhere can automate web based processes with its Web Automation capability. You can automate any website,
even complex websites that use javascript, AJAX, Flash or iFrames.
Learn more on Web Automation
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Workflow Designer FAQs
1. What is Workflow Designer?
2. How do I use Workflow Designer?
3. How do I run Workflows?

What is Workflow Designer?
Workflow Designer allows you to create an easy to understand, intuitive graphical representation of a IT or a business processes. Automation Anywhere Premier allows any user (Business or IT) to easily create end to end business workflows.

How do I use Workflow Designer?
Open Workflow Designer (Shortcut Ctrl+K). Drag-n-drop the objects from the toolkit to design an entire business process.
Workflow Designer provides four objects to design a Workflow:
l

Start

l

Run Task

l

Condition (IF)

l

End

How do I run workflows?
Running a workflow is very easy. Just click on the Run button in the Workflow Designer. The other option is to click on the workflow in
'MyWorkflow' file in the Task List and click Run.
On running the workflow through the Workflow Designer, it highlights the part of the workflow that is being carried out. Once, the workflow has completed running, it highlights the complete path taken.
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Other FAQs
1. I recorded a task that opens a program from Start Menu > Programs and while running the task, the menu to open that program has
moved. It clicks on a wrong program name and hence opens a wrong program. Do I need to re-record the task?
2. Will my task run correctly even if files, program shortcut icons in the Quick Launch and the Desktop have moved?
3. Can I get the snapshot and/or log data into file when error occurs?
4. Can I execute DOS commands on remote terminal?
5. My scheduled tasks do not run?
6. My task is big. How do I test only a few commands that I have added in the task?
7. I want to copy a command and use it at many places. Do I need to create the command every time?
8. I have created a keystroke which contains complex sequence of keys, which I use repeatedly in many of my task. Do I need to copy
the keystroke every time I need to create a new task?
9. I have recorded a task that can be repeated as it is; only one text has to be replaced every time. I need to enter this text while running the task. How do I do that in your automation software?
10. Can I edit multiple commands at the same time? Is it possible to replace window title in all commands?
11. What happens to a triggered or scheduled task if a high priority task is already running?
12. Can I use Automation Anywhere as a macro recorder?
13. Can I use Automation Anywhere to integrate Excel commands with other applications?
14. How does Automation Anywhere carry out database automation?

I recorded a task that opens a program from Start Menu > Programs and while running the task, the menu to
open that program has moved. It clicks on a wrong program name and hence opens a wrong program. Do I
need to re-record the task?
No, the SMART Automation Technology built into Automation Anywhere provides a powerful feature that lets you use your original
task. You can check an option from Tools > Options >'Move Icons/Menus' . After selecting this option when you run a task it opens the
same program that was opened while recording even if the menus have moved.

Will my task run correctly even if files, program shortcut icons in the Quick Launch and the Desktop have
moved?
Apart from a few exceptions, opening of most of the files and shortcut icons from both Quick Launch and Desktop will run correctly if the
icons have moved from their original location. Note that, the 'Move Icons/Menus' should be checked in Tools > Options menu for this
feature to be enabled.

Can I get the snapshot and/or log data into file when error occurs?
Yes, Automation Anywhere Premier has advanced error handling capabilities. You can select action like Continue or Stop Task. You
can specify error handling options like Take Snapshot, Run Task, Log data into file, Send Email and Variable Assignment.

Can I execute DOS commands on remote terminal?
Yes, using Terminal Emulator command you can perform such activities. Terminal service must be on at the remote side and policy service must be set to classic. You can upload any file on FTP, Start/Stop services and execute DOS commands on remote terminal.
Learn more about Terminal Emulator.

My scheduled tasks do not run?
If your scheduled tasks don't run, follow the simple checklist to fix the problem.

1. Ensure that you have provided the username/password: For security reasons Windows XP requires your Windows XP username &
password to run scheduled task. For more information on what to do if you don't have password read Why username/password?
On any other Windows operating system, if your account requires a password to log on, then you need to provide that password
while scheduling the task, otherwise you don't need to provide a password.
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2. If you have multiple account ensure that you have provided the correct username/password: If you have multiple accounts on same
computer like one domain account and one local account, please make sure the username that you have provided is the same
username you have used to login to the computer. The tasks will not work if you scheduled the task using one user Account and
now you are logged into another user Account. Automation Anywhere automatically fills the username that you are logged in as.
3. Check Status in Control Panel->Scheduled Tasks window: Please go to Control Panel->Scheduled Tasks window. Select the task
that corresponds to your task (it start with your task name) and right-click and select 'Run'. See if it runs. If it does not run please see
what the 'Status' column shows.
4. Schedule Calculator Application: If your task still doesn't run go to Control Panel->Scheduled Tasks. Click on Add Scheduled Task.
From the list of applications, please select Calculator as shown below. If the calculator does not run then your scheduler service is
not installed correctly on your computer.

My task is big. How do I test only a few commands in the task?
Select the command that you do not want to run. Right-click and select 'Disable'. Save the task and run it. while running the task it will
not run the commands that are disabled. To enable the commands again right-click and select 'Enable'.

I want to copy a command and use it at many places. Do I need to create the command every time?
No. You can use the 'Duplicate' function by Right click on command and select 'Duplicate'. This command Duplicates the currently
selected command. You can then just drag the newly created command using mouse.

I have created a keystroke that contains complex sequence of keys that I use repeatedly in many of my tasks.
Do I need to copy the Keystroke every time I need to create a new task?
No. You can right click on that Keystroke and click on 'Convert To Variable'. You can then save the keystroke as a variable.

I have recorded a task that can be repeated as it is; only one text has to be replaced every time. I need to enter
this text while running. How do I do that in your automation software?
1. Open the Task in the Editor
2. Right click on the Keystroke which you have to enter every time.
3. Click on the "Convert to Prompt" in the pop-up menu.
4. Enter the message that should be displayed which running.
5. Save the task.
6. While running, a dialog box will appear that will ask you to input the text that you wanted to enter.
7. Once you click ok then entered text will be typed.

Can I edit multiple commands at the same time? Is it possible to replace window title in all commands?
Yes. Bulk Edit is available for commands like keystrokes and delay. Select multiple commands of keystrokes or delay and right click on
it. Select'Bulk Edit' option; specify the new details for the selected commands.
To replace the window title, select any command that has a window in it; right click and select 'Change Window Title' option. You can
replace particular command's window title or you can change all commands windows title in a task.

What happens to a triggered or scheduled task if a high priority task is already running?
In the above case currently running high priority task will continue and all other task will be in queue.
Automation Anywhere features advanced task-queuing technology. This technology ensures that every task will complete based on its
priority, regardless of how many other tasks interrupt the running task.
The order of execution is decided by the priority (high, medium and low). If two tasks in a queue have the same priority, the precedence is decided by the category (triggered, scheduled and manual) of the tasks. Thus, if the two tasks have the same priority, a
triggered task has higher precedence, followed by scheduled tasks, then manual tasks.

Can I use Automation Anywhere as a macro recorder?

Other User
Resources:

Automation Anywhere can be used as an intelligent keyboard macro recorder and mouse macro recorder that allows you to easily create, edit and run macros.
l

Automate keystrokes and save thousands of clicks to automate repetitive tasks.

l

Record keyboard & mouse macros or use point & click wizards to create automated tasks in minutes.

l

To learn more: http://www.automationanywhere.com/landing/macro-recorder.htm

Can I use Automation Anywhere to integrate Excel commands with other applications?
Automation Anywhere has an advanced Excel integration and Excel automation feature. Automation Anywhere allows automation of
data transfer between Excel and any web or windows based application like Salesforce, SAP, Access, SQL, etc.
Learn more on Excel Automation.

How does Automation Anywhere carry out database automation?
Automation Anywhere works with any SQL databases like Oracle, MS SQL, Sybase, etc. to transfer, maintain or update databases.
Automation Anywhere's database automation solution can take data from various databases, web and in-house applications, collate
them and generate reports.
Learn more on Database Automation.
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Common Error Messages
This section provides you with information about common error messages that Automation Anywhere issues.
ERROR 429: ActiveX Component Can't Create Object
l

Description: Error occurs due to problem in loading the User Interface of TA/AA

l

Solution: 'Run Time Error 429' surfaces when the 'GDIPlusWrapper.dll' gets corrupted. You can type the below mentioned command under Start - Run - cmd:
For Windows 7 32 bit - regsvr32 C:\WINDOWS\system32\GDIPlusWrapper.dll
For Windows 7 64 bit - regsvr32 C:\WINDOWS\sysWOW64\GDIPlusWrapper.dll

Also See...
l

Debugging Tasks

l

Enabling the Debugging Option
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Enabling the Debugging Option
Automation Anywhere provides a facility that enables you to debug your more complex automation tasks. Debugging tasks can be useful for automating longer, more complicated business or IT processes.
To enable the debugging option, follow these steps:
1. Open the task in the Task Editor.
2. Click on the Debug menu, and select Enable Debugging.
3. Use the toolbar to insert breakpoints in your task.
4. Debug the task line-by-line using the Step Over (F10) functionality.
You can use the Set SnapPoint feature in a task to capture images of the task while it runs.

Using the Debugging Option
You can use the Debugging option to do the following:
l

To debug your task one command at a time, insert a breakpoint next to each command. This makes the task pause at the breakpoint.

l

To insert a breakpoint, select a command and insert a breakpoint by clicking F9.

l

To remove a breakpoint, select the command and click F9.

l

Select the Step Over feature to move one command at a time.

l

To clear all breakpoints, click Clear All Breakpoints.

l

To stop debugging, click on the Debug menu and select Disable Debugging.
Note: Automation Anywhere does not save debugging information and breakpoints. When you close
the Task Editor, all breakpoints are lost.

Also See...
l

Using the Error View

l

Logging into Windows when Application Paths Change
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Frequently Asked Questions
l

How does a user register as a Client with Automation Anywhere?

l

Will a change in the domain name affect the working of my Client?

l

Why is the client only able to view the 'Run' button?

l

How do I copy an Excel cell and move to the next cell in the record?

l

How do I paste data in an application and move to the next item?

l

How do I create time stamps for files using Automation Anywhere system variables?

l

What is the recommended way to open an application as part of a task?

How does a user register as a Client with Automation Anywhere?
1. Launch Automation Anywhere by clicking the Automation Anywhere Client icon.
2. In the Client Login window, click on the Server Settings link.
3. Enter the Server IP Address. If the client is on the same system as the server, enter 'localhost'.
4. Select the server Port used for the server.
5. Click on Apply and OK.
6. In the main client window, click on the Tools menu and select Server Communication.
7. Enter the user name and password provided while registering the client in the Automation AnywhereEnterprise Control Room.
8. Click the Login button.
9. If registered correctly, the message 'Registration Successful' is displayed.

Will a change in the domain name affect the working of my Client?
Yes. The Client that has already been registered and has a domain change, will have to be re-registered as the domain name is
required especially while scheduling tasks and using the Auto-Login feature.
Note You can verify the correct Domain Name in the Machine Information section of Control Room for
that particular Client.
The Client that has had a domain name changed, can do any of the following (in the sequence mentioned):
1. Change the Application Path in Tools > Options > Advanced Settings. This will ensure that all the data that was available in the
earlier path is available to the Client in the current domain.
2. Create a New Client. However, it is recommended that you use this option as a last resort.

Why is the client only able to view the 'Run' button?
If the Server Administrator does not grant permissions to a client, the client cannot view privileges other than Run.
1. To procure adequate permissions, request Create Task permissions from your Server Administrator.
2. The Administrator grants the Create Task privilege using the Enterprise Control Room, in the Client Control Center, using the Client
Information section.
3. For Upload, Download, Delete, and View privileges for a particular folder on the server, request Access Control List permissions
from the Enterprise Control Room.
4. After the Access Control List is updated in the Client Control Center and the Create Task privilege is granted, the client must relogin.
5. The client should now be able to communicate with the server using the new privileges.
For more information, see Using Client Control Center.

How do I copy an Excel cell and move to the next cell in the record?
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When you highlight the Excel cell and use Ctrl+C to copy a cell, it copies an extra ENTER keystroke with the data. To copy only the cell,
follow these steps:
1.

Use the following keystrokes:

These keystrokes copy the cell data.
2. To move the cursor to the next cell after copying the current cell, use the following keystrokes:
l

ENTER to move one row down in the same column

l

TAB to move to the next cell to the RIGHT in the same row

l

Shift + ENTER ( [SHIFT DOWN][ENTER][SHIFT UP] ) to move one row up in the same column

l

Shift + TAB ( [SHIFT DOWN][TAB][SHIFT UP] ) to move to the next cell to the LEFT in the same row

l

To skip a cell, use the corresponding key twice. For example, to move RIGHT to alternate cells, you must enter [TAB][TAB]

How do I paste data in an application and move to the next item?
Most applications support the keyboard shortcut Ctrl+V to paste data that has been copied to the clipboard. To paste the data using the
keyboard, follow these steps:
1. Ensure that the cursor is in the correct cell in a table, or in the correct control in a browser page, etc.
2.

Type Ctrl+V. To simulate Ctrl+V in Automation Anywhere, use: [CTRL DOWN]v[CTRL UP].
These keystrokes will paste the data in your application.

3. Use the following examples as a guide in how to move to the next record or cell in your application using the keyboard:
l

Use the TAB key to move from a highlighted link to the next link in an Internet Explorer web page.

l

Use the [RIGHT ARROW] to move to the next cell in the same row in a Microsoft Word table.

l

Some applications also support using the Space bar to move to the next control or button.

How do I create time stamps for files using Automation Anywhere system variables?
Automation Anywhere provides the following system variables that you can use to append time stamps:
l

Year

l

Month

l

Day

l

Hour

l

Minute

l

Second

l

Date

You can combine these variables to create a custom time stamp.

Examples:
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l

To append Year, Month, and Day at the end of ABC, you can use:
ABC$Year$$Month$$Day$

l

To create a complete time stamp with date and time, you can use:
ABC$Year$$Month$$Day$$Hour$$Minute$$Second$

l

You can also include text characters between the variables, for example:
ABC$Year$-$Month$-$Day$

l

To configure your own format for the Date variable, click on the Tools menu and select Variable Manager. Click on System Variable
and then Date. If you use the Date variable to append a date to file names, be sure no slashes (/) exist in the date format, because
file names in Windows might not use the / character.

What is the recommended way to open an application as part of a task?
The recommended methods for opening an application in a task include:
l

When you record a task, double-click the application icon on the desktop.

l

Click on the Start menu, and then Programs. Select the application.

If the location of these icons change, resulting in an error when the task runs, follow these recommendations:
1. Open the task in the Task Editor.
2. Select the actions that involve navigating to menu items and clicking. They might involve several mouse moves and mouse clicks.
3. Delete these actions.
4. Replace them with single-line commands that you create by double-clicking the Open Program/File command and specifying the
path to the application. The Open Program/File dialog includes a text box in which you can type parameters that Automation Anywhere can pass to the application.
5. The task can now open your application, regardless of where the icon is located.
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Logging into Windows when Application Paths Change
Occasionally, the application path for your Automation Anywhere tasks might require changing. For security reasons, you can set the
Windows Login option in Advanced Settings to change the application path of your tasks.
Follow the steps given below:
1. Go to Tools -> Options -> Advanced Settings
2. Select the Application Path check-box if un-checked.
3. Click on the browse button

l

The Windows Login command window is invoked:

4. Enter these parameters:
l

Username: Enter the user name you created in User Accounts. How do I create a User Name and Password?

l

Password: Enter the password that is associated with your user account.

l

Domain Name: Specify the domain name. If not specified, the Windows Login uses the computer's domain name.

The new application path takes effect after you restart Automation Anywhere.
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Object Cloning Command - Unable to find <object property name>
The Show Tip functionality of Automation Anywhere helps you easily understand and thereby rectify the error pertaining to object not
found that is encountered when using the Object Cloning/SMART Recorder command.
On execution of a task, if an object is not found you will be shown an error that takes into consideration the various parameters that
have been input.

To view the message click on 'Show Tip' link. This will display a possible solution. If however, this does not suffice, you can click on the
'Learn more' link which will guide you to this topic.

Tips displayed
While using wild-card when the Search criteria do not match
1. Click on Show Tip link on the Error Message.
2. The Error messages clearly indicates the object not found with recommended action.
3. The user can try modifying the Search Criteria with Wild Card.
4. Use * for specific properties.
5. One can use * at beginning, end or middle for any property.
6. One can also view the same tip details in Test Log as shown below.
<content missing>

More Tips as per Technology when Object not found
l

MSAA: If object not found and HTML Properties are checked in Search Criteria then Provide wildcard support in value or Uncheck
HTML properties like HTML Href, HTML InnerText.
If object not found and HTML Properties are not checked in Search Criteria then check other Unique properties like Name, Value,
Parent, Index

l

Silverlight: If object not found then check other Unique properties like Name, Value, Parent, Content

l

Flex: If object not found then check other Unique properties like Name, Value, ObjectID, Parent

l

UI Automation:
l

Java: If object not found then check other Unique properties like Name, Value, ObjectID, Parent, Index

l

HTML: If object is not found then check other Unique properties like HTML Tag, HTML Tag-Index, HTML Name, HTML ID.

If object not found and HTML Properties are checked in Search Criteria then Provide wild-card support in value or Un-check HTML
properties like HTML Href, HTML InnerText

When to modify Search Criteria when objects do not have common/default properties
1. Click on Show Tip link on the Error Message.
2. The Error messages clearly indicates the object not found with recommended action.
3. Modify the search criteria to include unique object properties for the test to execute successfully.
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4. If object property is dynamically changes during run time, try un-checking properties, and the object will be found.
5. One can also view the same tip details in Test Log as shown below.
<content missing>
Below table displays the main search criteria for different objects with respect to various technologies.
Textbox/Static Text
Type
Path

Link/Image
Type
Path

Other
Type
Path

.NET/WPF

Name
Object ID

Name
Object ID

Name
Object ID

3.

Silverlight

Parent
Name

Parent
Name

Parent
Name

4.

Flex

Class
Index

Class
Index

Class
Index

5.

MSAA

Name

Name

Name

6.

MSAA-HTML

HTML ID
HTML Name
HTML Inner Text

HTML Href
HTML Name
HTML Inner Text

HTML ID
HTML Name

7.

HTML

HTML Value
HTML Tag
HTML Type
HTML Title
HTML Name
HTML ID
HTML TagIndex

HTML Href
HTML Inner Text
HTML Value
HTML Tag
HTML Type
HTML Title
HTML Name
HTML ID
HTML TagIndex
HTML Frame Src
HTML Frame Name
HTML Frame Path

HTML Value
HTML Tag
HTML Type
HTML Title
HTML Name
HTML ID
HTML TagIndex

1.

Common to All

2.

HTML Frame Src
HTML Frame Name
HTML Frame Path
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HTML Frame Src
HTML Frame Name
HTML Frame Path

Troubleshooting Object Cloning
This topic explains you what to do when you are unable to capture objects in Internet and/or Intranet websites using Object Cloning
Command.
If you are unable to capture objects in Internet and/or Intranet websites using Object Cloning Command, consider checking the security
settings that are used for that site.
Go to Internet Explorer > Settings > Internet Options > Security.

For Websites Not Assigned to Security Zone
In case the website is not assigned to any security zone inInternet Explorer,level of security set for the Internet zone is applied to it by
default. To capture objects from such websites using Object Cloning Command, set the security level at Medium-high or lower.

For Websites Assigned to Security Zone
l

To capture objects in Local Intranet Websites
If your website is assigned only to Local Intranet security zone in Internet Explorer, set the level of security in Local Intranet to
Medium-high or lower and turn off ActiveX Filter.
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l

To capture objects in Local Intranet Websites assigned to Trusted zone
If your Local Intranet website is assigned to Trusted sites security zone in Internet Explorer, set the level of security in Trusted sites
to Medium-high or lower and turn off ActiveX Filter.
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l

To capture objects in Internet Websites
For websites in Internet zone, set the level of security in Internet to Medium-high or lower.

l

To capture objects in Internet Websites assigned to Trusted zone
If the Internet website is assigned to Trusted sites security zone in Internet Explorer, set the level of security in Trusted sites to
Medium-high or lower.
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Troubleshooting Information
These topics provide troubleshooting information to help you diagnose and fix problems that might arise while installing, configuring,
and using an Automation Anywhere client.
Information pertaining to the following has been described:
l

Troubleshooting Installation Issues

l

Running a Task - Troubleshooting

l

Scheduling - Troubleshooting

l

Auto-Login Issues

l

Triggers not working correctly with Microsoft Office files

l

Capture button disabled in Web Recorder despite clicking Launch

Troubleshooting Installation Issues
1.Error while unpacking program, code LP5
If you receive an error while unpacking the program code, you might need to add Automation Anywhere to the firewall exceptions list.
Follow these steps to add Automation Anywhere to the exceptions list:
1. Open the Windows Control Panel (all items view).
2. Click on the Windows Firewall icon.
3. Click on the "Allow a program through Windows Firewall" link in the left blue pane.
4. Click on the Change Settings button.
5. Allow an existing exception by completing these steps:
a. On the left side, check the program exception name box to allow the program through Windows Firewall.
b. Check (allow) the box for each Private or Public network location for which you want the program to have access through
Windows Firewall.
6. Add a program exception by completing the following steps:
a. Click on the "Allow another program" button.
b. If the Automation Anywhere program is listed, click on the program to highlight it.
c. If the Automation Anywhere program is not listed, click on the Browse button and navigate to: "C:\Program Files\Automation
Anywhere\Automation Anywhere.exe" This is the Automation Anywhere executable file location.
d. Click the Open button.
e. Click the Add button.
7. When done, click OK.
8. Close the Windows Firewall window.

2. MSSTDFMT.DLL Error Windows 7 only
If you receive this error message, follow these steps to resolve it:
1. Download the file 'mssfdfmt.zip' from the location:
2. http://www.dll-files.com/dllindex/dll-files.shtml?msstdfmt
3. Save this file to any location on your system and extract it.
4. Copy the MSSTDFMT.DLL file from the downloaded folder and paste it to this folder location: 'C:\Windows\syswow64\sysWOW64'
5. In the folder 'sysWoW64', locate the file 'cmd.exe'.
6. Right click on 'cmd.exe' and click on 'Run as administrator'. A Windows command prompt window is displayed showing 'C: \Windows\system32>'
7. Type: Regsvr32 C:\Windows\SysWOW64\MSSTDFMT.DLL and press Enter to register the file.
Completing these steps should resolve the error.
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Back to the top

Running a Task - Troubleshooting
A task that contains Microsoft Excel commands runs very slowly. In this case, follow these steps:
1. Disable Debug mode.
2. Remove or reduce Delay commands by 1 second.
3. Minimize the Excel files. While Excel is in a maximized state, it displays the user interface, consuming resources.
4. Stop capturing screen shots while running the task. Follow these steps:
a. On the Automation Anywhere main window, click on the Tools menu and select Options.
b. Select Run Time Settings.
c. Uncheck the option: "Capture Screenshots while Running a Task".
Be aware that screenshots will not be captured while running the task, so monitoring progress is more difficult.
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Scheduling - Troubleshooting
1. Scheduled Task Not Running
If a scheduled task fails to run using the scheduler, follow these steps to resolve the problem:
1. Ensure that you specify the correct Windows user name and password.
l

If your account requires a password to log on, specify that password when scheduling tasks. Otherwise, no password is
required.

2. If you have multiple accounts, ensure that you have provided the correct user name and password. If you have multiple accounts
on the same computer (such as a domain account and a local account), verify that the user name provided is the same as that used
to log onto the computer.
3. Scheduled tasks do not run if you schedule them using a user account different from that logged on. Automation Anywhere automatically fills in the user name that was used to log in.
4. Check the status in Control Panel by completing the following steps:
a. Open the Windows Control Panel and go to Administrative Tools > Task Scheduler.
b. Select the task corresponding to your task (the name begins with your task name) and right-click on it.
c. Click on Run to verify that the task runs.
l

If the task does not run, check the Status column and go to Step

Note: The above steps are valid only for Automation Anywhere Small Business version.
Schedule the Calculator Application by completing these steps:
1. Open the Control Panel and click on Administrative Tools.
2. Click on the Task Scheduler.
3. In the Active Tasks drop-down, select Calculator (see figure below). If the calculator does not run, the scheduler service is not
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installed properly on your computer.

To verify that it is running, complete the following steps:
1. Click on the Windows Control Panel and select Administrative Tools and then Services.
2. Verify that the status of the Task Scheduler service reads 'Running.'
3. If the Task Scheduler is not running, right-click on it and select Start. Also, ensure that the 'Startup type' is set to 'Automatic'. This
starts the service automatically the next time you start your system.
l

Restart the Task Scheduler.

If the Task Scheduler still fails to run, complete the following steps:
1. Click on the Windows Control Panel and select Scheduled Tasks.
2. In the Advanced Menu, click 'Stop using Task Scheduler.'
3. Wait 10 minutes.
4. Click on 'Start using Task Scheduler.'

2. Migrating schedules to a newer version
If using a version prior to 8.0, you are required to migrate schedules in the Client from earlier versions to the latest one.
A schedule migration utility, bundled within the setup, is available post installation. Run this utility to save time on automating path
updates, which are now required to run the older schedules, successfully.
All you need to do is:
1. Run the migration utility without Admin privileges to migrate all the schedules by the logged in user. A logged in user need only
provide his/her Windows credentials
2. Run migration utility with Admin privileges to migrate all the schedules pushed by the Control Room admin. User will need to
provide their Windows credentials to complete this activity.
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Note: After migration, all schedules of earlier version, pushed by the Control Room admin will be
visible to the user. However, the new schedules will continue to remain invisible on the Client side.
Schedule migration utility path:
<AA Installation Path>\AutomationScheduleMigration.exe
For instance:
C:\Program Files (x86)\Automation Anywhere Enterprise 8.0\Client\AutomationScheduleMigration.exe
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Auto-Login Issues
You have issue with Auto-Login? Check the below:
l

Ensure that SAS.dll is present in system32 (e.g. C:\Windows\System32) folder in case of Windows 7 OS and above. If it is not there,
then copy the same from the product installation folder (e.g. C:\Program Files\Automation Anywhere 7.1\Client\32-Bit OR from 64Bit; depending on OS)

l

Verify for proper working of Ctr+Alt+Del:

l

Registry: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System\SoftwareSASGeneration

l

Value: Dword 3

l

Verify Auto-Login Registry and value.
[HKEY_CLASSES_ROOT\CLSID\{75A22DF0-B81D-46ed-B119-CD30507BD614}]@="Automation.CredentialProvider"
[HKEY_CLASSES_ROOT\CLSID\{75A22DF0-B81D-46ed-B119-CD30507BD614}\InprocServer32]@="Auttomation.CredentialProvider.dll""ThreadingModel"="Apartment"

l

Verify Auto-Login service is enabled and running.

l

Goto services.msc -> 'Automation Anywhere Enterprise Auto Login Service'
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l

Credentials cross-check:
1. Select Task > Provide schedule > Enter window authentication credentials with domain e.g. User name :domain\username
& Password
2. If the schedule has been successfully added, go to Tools > Option > Auto-login Settings. Check the username and password.

l

It should match.
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Triggers not working correctly with Microsoft Office files
To use a trigger for Microsoft Office file when a file is modified, we need to use the condition for File -> When file is renamed.
The trigger will be fired correctly for modified as well as renamed conditions. This is the inherent behavior for Microsoft Office.
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Capture button disabled for options 'Extract Source' and 'Execute Java Script' in Web Recorder command
The 'Capture' button will get enabled for options:
l

Extract Source - if the page that is launched has an iFrame.

l

Execute Java Script - if the page that is launched has a java-script.
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Contact Technical Support
After completing the previous steps, if you are unable to run your task using the Task Scheduler, it is likely that the Scheduler service is
not installed correctly on your computer. Please contact Automation Anywhere Technical Support for further assistance.
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Using the Error View
The Automation Anywhere Task Editor provides two options for viewing and fixing task errors and working with task variables. To activate the Error View and the Variable Manager, click on these links:

Error View
Use the Error View to manage errors that occur in your tasks. This view is automatically updated when the Error Handling feature is
used.

Variable Manager
Use the Variable Manager to create and manage variables that you use in your tasks. You can add, edit, or delete local (user-defined)
variables.
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Variable Watch Table
Use the Variable Watch Table to track the values of your variables. The Variable Watch Table is enabled when you enable Debug
Mode by clicking on the Enable Debugging link.
You can move the Variable Watch Table, as well as expand it as required.
To view how variables dynamically change, click the Add or Remove buttons. You can view both user-defined variables and system
variables.
Use the Variable Watch Table as part of your debugging process.

Also See...
l

Enabling the Debugging Option

l

Logging into Windows when Application Paths Change
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